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Preface

This document describes the steps for installing and configuring the components of 
the Argus Safety Solution application.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For information about Oracle's commitment to 
accessibility, visit the Oracle Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

About This Book
This manual contains following chapters:

Chapter 1, "Product Overview"
Provides an overview of the Argus Safety application.
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Chapter 2, "Getting Started"
Provides information about how to begin using the Argus application.

Chapter 3, "Active Cases"
Provides information about how to access an active case.

Chapter 5, "Case Actions"
This chapter describes the lifecycle of a case: entering or importing a case, updating a 
case, and deleting a case.

Chapter 4, "Case Form"
Provides information about how to use the Argus Safety Case Form.

Chapter 5, "Case Actions"
Provides information about the following:

■ Finding and opening cases

■ Processing cases

■ Closing, saving, copying, and deleting cases

■ Using the medical and code review functions

■ Using the print function and printing cases and medical summaries

■ Viewing case revisions

Chapter 6, "Advanced Conditions"
Provides information about how to use Advanced Conditions.

Chapter 8, "MedDRA Browser"
Provides information about using the MedDRA Browser.

Chapter 9, "Argus Affiliate Module"
Provides information for using the Local Affiliate Module.

Chapter 10, "Argus Reports"
Provides information about Argus reports and how to create and use them.

Chapter 11, "Dashboards"
Provides information about using the Argus dashboards.

Chapter 12, "Utilities"
Provides information about how to use various Argus utilities.

Chapter 13, "About dsNavigator"
Provides information about using dsNavigator.

Conventions
The following text conventions are used in this document:
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Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action such as Buttons, Dialog boxes, Check boxes, Combo 
boxes, Drop-down lists, Labels, Option (Radio) buttons, Tabs, Text 
boxes, etc.

"between quotation 
marks"

Information that may appear as-is on screen, or information provided 
by the user.

NOTE Information that should be noted before proceeding with the 
instructions.

IMPORTANT Important information that must be noted to ensure accurate, reliable, 
or safe behavior of the system

TIP Information that enables easier completion of the current task or helps 
in completing other tasks.

Bold Underline Link indicating that additional "pop-down" information is available.

ALL CAPITALS Keyboard keys

Initial Capitals Names of user interface elements, modules, applications, proper nouns, 
etc.
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1Product Overview

Argus Safety/Argus Safety Japan is a complete pharmacovigilance software system 
designed to solve the pharmaceutical industry’s toughest regulatory challenges. It 
provides the most comprehensive global Adverse Events (AE) case data management 
and regulatory reporting in the pharmaceutical industry. Argus Safety Japan brings the 
single global database for the Japanese market to include localization and regulation 
support.

Application Map
The Argus Safety suite of products support drug safety business processes from an 
easy-to -understand user interface. The application map includes the following:

■ Argus Console

– Code Lists

– Business Configuration

– Access Management

– System Configuration

– Tools

■ Active Cases

– Last Access Cases

■ Worklist

– New

– Open

– Action Items

– Coding Action Items

– Contacts

– Reports

– Bulk Transmit

– Bulk Print

– Bulk E2B Transmit

– Local Labeling

– Coding Status
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– Letters

– Intake

– Literature Intake (Japan only)

■ Case Actions

– Open

– New

– New Case from Image

– Close

– Save

– Copy

– Medical Review

– Coding Review

– Print

– Delete

– Case Revisions

■ Reports

– Compliance

– Aggregate Reports

– Periodic Reports

– Bulk Reporting

– E2B Pending

– Processed E2B

■ Utilities

– Change Password

– MedDRA Browser

– User Login List

– Logs

– E2B

– Case Undelete

– Batch Reports

– Blank Report Forms

– End of Study

– Clear Cache

– Advanced Condition Library

■ Dashboards

– Open Case Summary

– Open Action Items
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– Quick Signal Reports

– Increased Frequency Wizard

– Expedited Report Status

– Workflow Status

– Reports Due Soon

– Personal Argus Status

– Case Workload
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2Getting Started

This chapter discusses how to start working with the Argus application and access 
Help files. It also explains how to perform some generic operations in the application.

■ Logging In

■ About the Argus Home Page

■ Basic Features

Logging In and Out
Ensure that before starting Argus Safety, the Argus Safety Administrator of your 
company has created an account for you and that you have the correct Username and 
Password for the system. Be aware of the following:

■ If you enter an incorrect password three (3) consecutive times, the system disables 
the Login button and displays the following message:

Your account has been locked due to 3 consecutive failed login attempts. Please 
contact your System Administrator.

The number of times the user is permitted to enter an incorrect password is 
configurable. The default is 3. For information about configuring Argus Safety see 
the Oracle Argus Administrator’s Guide.

■ The Date/Time format reflect s the 24-hour format used by the Web server.

■ When you click the name of an enabled/disabled module, the system opens the 
Oracle Web site pages to enable you to access information about the module in a 
new Internet Explorer window as follows:

http://www.oracle.com/relsys/index.html

Logging into the Argus Application
Use the following procedure to log in to the Argus application.

To log in to the Argus application
Use the following procedure to login to the Argus application:

1. Open Microsoft Internet Explorer and enter the Uniform Resource Locator (URL) 
for Argus Safety Web in the Address bar. 

2. When the Argus login screen opens,enter your username and password in the 
appropriate fields.
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3. Select the appropriate database from the Database drop-down list and click Login.

4. Once the system authenticates your log in, you can access the modules whose 
names are in Bold text. For more information, click the following Single Signon 
link.

To log out of the Argus application
Click Logout on the top-right frame of the window to log out of the application.

Note: Available modules appear in bold text on the log-in screen. 
Once the system authenticates your log-in information, you will be 
able to access these modules. 

Note: If you get an error message such "Unable to connect to the 
database," you may not have permissions to access the database. 
Please contact your database administrator for assistance. 

Note: If your login ID fails three times in a row, the system presents 
the following error message: "The log in button has been disabled due 
to 3 consecutive incorrect entries of Username or Password. Please 
refresh the page to enable the Login button."
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About the Argus Home Page
The Argus Safety application Home page odisplays a list of Cases Assigned, Contact 
Log Entries and Action Item Entries sections specifically for the logged-in user.

Home Page Sections and Fields
The following table lists and describes the section and the fields it contains.

Section Name Field/ Control Name Description

Search Case Case Quick Launch Enables you to enter number 
of a specific case to search for.

Cases Assigned (Country) Case Number Displays the name of the 
country the case belongs to. 
The Case Number is in 
brackets.

Report Type Displays the report type of the 
case.

Product Displays the product name.

Workflow State Displays the workflow state.

Event Displays the event name.

Contact Log Entries (Country) Case Number Displays the name of the 
country to which the case 
belongs, with the Case 
Number listed in brackets.

Contact Date Displays the contact date.

Description Displays the description of the 
case.
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Additional Tabs
The Argus Safety menu displays additional tabs, if you have permission to use the 
associated applications. The following is an illustration of additional tabs that may 
display.

Quick Launch Toolbar
Quick Launch enables you to navigate through the application more quickly and more 
efficiently. Click the relevant

Quick Launch icons on the to perform different actions. The Quick Launch Toolbar is 
on the top right side of the screen. 

To enable you to perform the quick launch, the menu bar also lists the quick launch 
shortcut keys in parentheses.

Action Item Entries (Country) Case Number Displays the name of the 
country the case belongs to. 
The Case Number is in 
brackets.

Due On Displays the date when the 
case is due.

Description Displays a description of the 
case.

Tab Name Description

Argus Console The system displays this tab if you have administrator 
permissions.

Argus Insight The system displays this tab if you have permission to 
use Argus Insight.

Argus Perceptive The system displays this tab if you have permission to 
access the Argus Perceptive application.
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Place the cursor over each icon to view the tool tip, which describes the role of each 
icon.The following table lists and describes the function of each icon and includes each 
associated shortcut key. 

Note:  Shortcut keys are driven off a combination of Common Profile 
switches and menu access rights. For example, the "Case Save" 
shortcut / icon is visible only to users who have been granted access 
to save the case in the group configuration. If the menu option is 
disabled in the group configuration for a user, the respective shortcut 
/ icon will be removed as well. Certain shortcuts / icons such as Field 
Validation are enabled only through a common profile switch. These 
switches are described in the Common Profile Switch document. 
Shortcuts / icons that are driven through common profile switches are 
global to all users and are not controlled by group permissions.

Icon Tool Tip Description Shortcut Key

New Case from 
Image

Displays a new case from an 
image.

CTRL+ALT+G

New Case Displays the Initial Case Entry 
dialog. This is similar to 
performing Case Actions - 
New Case.

CTRL+ALT+N

Open Case Displays the Case Search 
dialog. This is similar to 
performing Case Actions - 
Open Case.

CTRL+ALT+O

Close Case Performs the same functionality 
as Case Actions - Close Case.

CTRL+ALT+C

Print Case Displays the Case Print dialog. 
This is similar to performing 
Case Actions - Print Case.

CTRL+ALT+P

Save Case Saves the case with any changes 
made.

CTRL+ALT+S

Forward Case Displays the Case Routing 
dialog and enables you to 
forward the case.

CTRL+ALT+>
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Error Messages
The system displays error messages in pop-up boxes. Every popup box has a Copy 
link that enables you to copy the message text to the clipboard so that you can use it 
later.

Searching for a Case
You can search for the following:

Return Case Displays the Case Routing 
dialog and enables you to 
return the case.

CTRL+ALT+<

Worklist Displays the Worklist dialog. 
This is similar to performing 
Worklist - XXX option.

Note: XXX is defined within the 
User Configuration for the 
default Worklist option. If no 
default Worklist option is 
defined, then Worklist - New is 
displayed.

CTRL+ALT+W

Lock Case Displays the Case Lock or Case 
Unlock dialog. This is similar to 
performing Locking or 
Unlocking Cases in the 
Activities Tab.

CTRL+ALT+L

Medical Review Displays the Medical Review 
dialog. This is similar to 
performing Case Actions - 
Medical Review.

CTRL+ALT+M

Coding Review Displays the Coding Review 
dialog. This is similar to 
performing Case Actions - 
Coding Review.

CTRL+ALT+Q

Draft Report Displays the Report List of All 
the Expedited Reports. This is 
similar to selecting View Draft 
Report.

CTRL+ALT+R

E2B Check Performs the function that 
prints the E2B Report - DTD 
Length Check Warnings and 
E2B report - DTD Validation.

CTRL+ALT+E

Validation Check Performs case validation. CTRL+ALT+V

Icon Tool Tip Description Shortcut Key
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■ A specific case

■ An existing case

■ A duplicate case

To search for a specific case
1. Type the case number in the Case Quick Launch field of the Home page and click 

Open.

2. The system displays the case details

To search for an existing case
1. Select Case Actions --> Open.

2. Enter the case search criteria in the appropriate fields.

3. Click the link displaying a case number to view the case details. By default, each 
section and header column is sorted by Case Number in ascending order.

4. Select the checkbox for any of the headers to enable that section. The sections in 
which the checkbox is not selected display at the bottom of the screen.

To search for a duplicate case
1. Select Case Actions --> New.

2. Enter the case search criteria in the appropriate fields to determine whether a 
duplicate case is already in the system. 
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Sharing a Case Series
You can share a case series between Argus and Argus Insight as follows:

■ Sharing a Case Series in Argus with Argus Insight

■ Sharing a Case Series in Argus Insight with Argus

Sharing a Case Series in Argus with Argus Insight
In Argus, a case series can be made available through the Case Search dialog.

1. Search for and select a case in Argus.

2. Open Argus Insight.

3. The system writes case series belonging to the alert to the Argus case-sharing 
table. 

4. Select Make Active from Argus to make the Case Search dialog case series active in 
Argus Insight.

5. If Argus Insight was already open, the Active Case series in Argus Insight is 
replaced with cases from Argus.

Sharing a Case Series in Argus Insight with Argus
A case series can be made available from Argus Insight through Active Case Series. To 
share a case series in Argus Insight with Argus

1. Go to Case Actions and then click Open.

2. Click Result from Argus Insight to create a search result with the same cases as the 
Active case series in Argus Insight.

Basic Features and User Actions
This section discusses the basic features and common user actions available 
throughout Argus Safety. These features can be used when working in different 
sections of the Argus application. 

Common Icons. The icons shown below are common to all modules within Argus:

Icons Description

These icons help the user to traverse to the left or right side in a page.

Note: These arrows will not be visible if there is no need to scroll the tabs.

A standard Notes dialog is available.

Note: If the notes are filled in, the dialog displays a Notepad icon. 
Otherwise, it is shown as empty by the icon, without any flags.
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Sorting on Columns
The user can sort on all the columns by clicking the header column. 

Configuring the Display View for a Case  To configure the display view for a case

1. Click the Page-Size drop-down list to configure the number of cases to be 
displayed. 

2. You can scroll through the pages by page increments as defined by the Page Size 
drop-down list.

3. You can also go directly to a range of cases from the Displaying Rows drop-down 
option.

Field Justifications  The fields that display in the application are either required or 
optional. Each field type displays with a different colored icon:

■ Required fields display with a red icon.

■ Optional fields are displayed with a green icon.

Click the icon next to a field to view its corresponding Field Justification dialog. The 
image below shows the Field Justification Dialog:

Re-arranges the entered items by moving them up or down.

Depicts the column that is being sorted currently.

Enter a justification for an optional field.

Indicates that a field has been overwritten or that you can enter data in an 
initial justification field.

Tip: Click the same column header again to toggle between 
ascending and descending order.

Note: By default, 100 cases appear on the page but the user can select 
up to 2000 cases to be displayed within one page.

Icons Description
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This field warning justification dialog asks the user for a justification to perform the 
selected action. To overwrite the warning:

■ Enter a specific reason

■ Select a standard reason from the message box.

Enter a justification by doing one of the following:

4. Click OK to overwrite the field justification warning.

5. The orange icon changes to green.

Common Right Click Options
The following table lists and describes common right-click options.

Getting Help
Argus Safety provides you with two main sources of online help: 

■ Field-level Help

■ Task-based Online Help

To get help performing a particular task: 
■ From the Help menu, select Online Help.

■ When the Argus Safety Online Help opens use the Contents, Index, or Search tabs 
to locate the required information.

Right-click option Description

Re-arrange Re-arranges all the information.

Copy Copies all the information.

Delete Deletes all the information entered in the tab.
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To get information about a particular field on the Case Form
Double-click the label associated with the field. For instance, on the Case Form, you 
can double-click the Country label to obtain information about this field

Changing Your Password
When you log on to the system for the first time, it change the password that has been 
assigned to you.

To change your password
1. Select Change Password from the Utilities menu. 

2. The Change Password dialog box opens.

3. Enter your current password in the Old Password field.

Note: LDAP users cannot change their passwords.
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4. Enter the new password in the New Password field and confirm the new 
password by re-entering it.

5. Click OK to change your password. Your password has now been changed.

Entering Dates
Several fields in the Argus Safety user interface enable you to enter dates. Fields that 
accept full dates appear in the "dd-mmm-yyyy" format. You enter the month using 
numbers, or alphabetic characters.

Appropriate formats for entering English dates are as follows:

■ DDMMMYYYY where MMM is the three-character abbreviation for the month 
(e.g., MAR, APR, JUN, etc.)

■ DDMMMYY where MMM is the three-character abbreviation for the month and 
YY is the two-digit numeric value for the year (e.g. 09, 10, etc.)

■ DDMMYYYY where MM is the two-digit value identifying the month (e.g., 01 = 
January, 02 = February, etc.) and YYYY is the four-digit value for the year.

■ DDMMYY

■ DD-MMM-YYYY

■ DD-MMM-YY

■ DD-MM-YYYY

■ DD-MM-YY

■ DD.MM.YY

■ DD.MMM.YY

■ DD.MM.YYYY

■ DD.MM.YY

■ DD/MMM/YYYY

■ DD/MMM/YY

■ DD/MM/YYYY

■ DD/MM/YY
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In English date fields, if the numbers entered for a month are appropriate, they are 
automatically converted to letters corresponding to that month (For example, entering 
"03" for the month will automatically convert month field to "MAR"). 

Some fields can also accept partial dates in case the exact date is not known. Fields that 
allow partial dates appear in the "??-???-0000" format. For reporting purposes, missing 
days of the month are approximated to the 15th of the month and missing months are 
approximated to the month of June. Valid partial dates must comprise of either a year, 
or a year and a month. A partial date that comprises of a day and the year, but not the 
month, is not accepted.

After you enter the date and tab out of the date field, the system verifies that the date 
you entered is valid for the year and month.

When entering dates in Argus J, the system converts dates to the following format 
YYYY/MM/DD (i.e., 2001/11/30). Appropriate formats for entering dates are as 
follows:

■ YYMMDD 

■ YYYYMMDD

■ YY-MM-DD

■ YYYY-MM-DD

■ YY.MM.DD

■ YYYY.MM.DD

■ YY/MM/DD

■ YYYY/MM/DD

Using the Data Entry Abbreviation (DEA) to Enter Dates  You can enter a year using the Date 
Entry Abbreviation function from the Code List Maintenance screen. The DEA 
indicates a particular year during the reign of a specific emperor. For example, H 
indicates Heisei and indicates the first year of his reign. When you enter following 
H1-01-08, the system converts the date to 1989/01/08 when you tab to the next field. 

Acceptable formats for entering dates using the DEA are as follows:

■ DEAYMMDD 

■ DEAYYMMDD

■ DEAY-MM-DD

■ DEAYY-MM-DD

■ DEAY.MM.DD

■ DEAYY.MM.DD

■ DEAY/MM/DD

■ DEAYY/MM/DD

Tip: Ensure that the dates are displayed accurately in the 
date-month-year format by entering the date in the given format and 
wait till the entered dates get displayed in the field. To enter the 
current date in a field, press the '=' key on the keyboard and tab out of 
the field.



Additional Tabs

2-14 Oracle Argus Safety Japanese User's Guide

Entering Multiple Language Text
Certain fields on the Case Form allow you to enter text in languages other than 
English. The non-English text that is entered in these fields can also appear on 
expedited reports.

To enter text in a language other than English:

1. Click the English language icon.

2. Use the pane associated with English to enter the English language text. Open the 
tab associated with the required language to enter text in that language.

3. After completing text entry, you can perform a spell-check for the text.

4. Once you enter text in another language, the icon associated with that language 
opens adjacent to the field on the Case Form.

Languages Supported in Argus Safety
The table below displays different icons representing different languages.

Icon Language

English

German

French

Spanish

Italian

Japanese
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3Active Cases

Active Cases are cases that have already been opened or are currently in use. The 
system logs any cases you view in the active case list.

Opening Active Cases
Follow these steps:

1. Log in to Argus.

2. When system opens the Home page, click Active Cases.

3. The system displays a list of the last 10 cases you accessed in the Last Accessed 
Cases drop-down list.

4. Click any of the links to select and open an active case
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4Case Form

The Case Form is the most important section of the Argus Safety user interface.

Case Form Functions
The Case Form enables you to do the following:

■ Enter case-specific information

■ Enter case-specific information

■ Log preliminary information about cases

The Case Form has eight (8) tabs as follows:

■ General Tab

■ Patient Tab

■ Products Tab

■ Events Tab

■ Analysis Tab

■ Activities Tab

■ Additional Info Tab

■ Regulatory Reports Tab

■ PMDA Tab

Each tab enables you to capture specific information about the case and is designed to 
capture similar information in each of its subsections. 

All tabs of the Case Form also display read-only information about case priority and 
status.

Note: Some sections in each tab enable you to make multiple entries. 
For example, you can have more than one reporter in the Reporter 
Information section of the General tab. Each individual entry is 
identified by another set of tabs in the section.
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To access the Case Form
1. Search for an existing case.

2. When the application displays the search results, locate the appropriate case 
number and click the case number link.

3. The system opens the Case Form with information about the case.

Case Form Features
The case form provides features to help you use it more effectively. 

General Case Form Usage Information
When using the Case Form, be aware of the following:

■ The maximum number of Products and Events is 200 per case.

■ The drop down values for elements such as Yes/No/Unk is not hard coded. The 
system retrieves the values from a look-up table. This affects the following:

– Reporter Information | HCP

– Device Information | Improper usage/Storage Field

■ The system defaults to the first button on every message box pop up dialog. When 
the user clicks Enter or the space bar, the system validates the choices.

■ The user can enter a hyperlink (e.g. http://www.oracle.com and 
https://www.oracle.com) in the Field Label Help for the Case Form Fields

■ When the user clicks a hyperlink, the system opens the link in a new Internet 
Explorer browser window.

– Contact Logs | Group and Users

– Action Items | Groups and Users

The following Case Form fields are type ahead fields:

■ The WHO Drug browser displays the WHO Drug Version on the browser dialog. 
The browser dialog is configured in System Configuration | Case Form 
Configuration.

■ Users can enter decimal numbers with up to three (3) decimal places in the UDF 
Number fields on all tabs. If the user does not enter a decimal, the system does not 
display trailing zeroes.

Using Password Acceptance Dialog Boxes
The system displays the User Name in read-only mode in following dialog boxes 
where the user must enter a password to start processing:

■ Activities Tab: Case Lock/Unlock

■ Activities Tab: Case Archive/Un-Archive
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■ General Tab: Unblind Case

■ E2B Acceptance/Rejection for Initial, Follow-up, and Notification

■ Affiliate Acceptance/Rejection of Events

■ Case Actions: Delete/Undelete

Initial Case Entry
When using the BookIn dialog box, be aware of the following:

■ You can enter the attachment classifications and their descriptions on the Initial 
Case entry dialog.

■ The field labels are the same as those defined in the Field Labels and the Case 
Form

– The lengths for the Classifications type ahead field and the Description field 
are the same as those on the Additional Info tab

– The system filters classifications by user sites and the attachment 
classifications permissions.

– When you select the URL Reference, the system hides the Classifications and 
Description fields.

■ The system transfers the values the user enters in the Classifications and 
Description fields after the cases have been booked in.

■ f the system does not find any cases during a duplicate search, it places the 
following message in the search results section: No cases found.

■ When you try to book in a clinical trial case and select a study where the country 
of incidence value does not match the list of countries defined in the study 
configuration, the system displays the following warning message in the standard 
Argus Safety warning message dialog box: 

The country of incidence does not match the country list specified for the selected 
study.

– If no countries are specified in the study configuration for the selected study, 
the warning message does not display.

– If the user selects the study before entering the COI, the system performs the 
validation

■ The user can right click on the row and select the following:

– Case Summary -- The system displays the Case Summary (Current 
functionality).

– Medical Summary Report -- The system displays the Medical Summary report 
PDF only if the user has access to the Medical Review dialog box. If the user 
does not have access, the system hides the Medical Summary Report option. 

– Print -- The system launches the Case Form print dialog box. If the user has 
permission to access the Print Case dialog, the user can print the Case Form. If 
the user does not have access to the Case Form print dialog box, the system 
hides the Print Case option.

Zoom Function
The Zoom feature enables you to increase or decrease the font size of the text.

1. Click the Zoom icon across the Case Form tabs.
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2. The Zoom dialog enables you to increase or decrease the Font Size of the text on 
the Zoom dialog.

3. Click Adjust Font Size to increase or decrease the font size.

■ Click + to increase the font size up to five (5) font sizes in one-size increments. 

■ Click - to decrease the font size to the current by increments of 1.

This feature is available on the following dialogs:

■ Reporter Notes

■ Patient Notes

■ Patient Other Relevant History Notes

■ Patient Lab Data Notes

■ Patient Relevant Test

■ Parent Medical History

■ Parent Other Relevant History Notes

■ Product Notes

■ Case Analysis: Narrative. This is also available on the Medical Review Dialog.

■ Case Analysis: Abbreviated Narrative. This is also available on the Medical 
Review Dialog.

■ Case Analysis: Company Comment. This is also available on the Medical Review 
Dialog.

■ Case Analysis: Local Evaluator Comment. This is also available on the Medical 
Review Dialog.

■ Case Analysis: Administrative Notes. This is also available on the Medical Review 
Dialog.
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■ Case Analysis: Evaluation in light of similar events in the past. This is also 
available on the Medical Review Dialog.

■ AffSAPS: Future Actions.

■ Activities: Contact Log Description. 

■ Activities: Action Item Description. This is also available on the Medical Review 
Dialog.

■ Activities: Routing Comments

■ Notes and Attachments: Description

Case Form Drop-down Options
The Case form for the following fields includes Type Ahead functionality. This feature 
automatically suggests possible options as term names as you are entering the text. If 
you double-click on the field, the system shows the standard drop-down values for the 
field.

The following is a list of fields with type ahead functionality:

■ Accidental Exposure

■ Action Taken

■ Action Type

■ Age Groups

■ Age Units

■ Anatomical Locations

■ Attachment Classification

■ Attachment Keywords

■ Birth Type

■ Case Classification

■ Causality Category

■ Condition Type

■ Contact Type

■ Delivery Types

■ Device Preliminary Comments

■ Device Subcomponents

■ Device Type

■ Dosage Frequency

■ Dosage Units

■ Ethnicity

■ Evaluation Reason

■ Event Frequency

■ Event Intensity

■ Event Outcome
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■ Fetal Outcome

■ Formulation

■ Gender

■ Intermediary

■ Lab Result Assessment Terms

■ Lab Test Type

■ Manufacturers

■ Occupations

■ Package Units

■ Reference Type

■ Report Media

■ Report Type

■ Reporter Type

■ Routes of Administration

■ Study Center 

Argus Safety Case Form User Preferences
Argus Safety remembers your actions as you navigate through the Case Form.

The system can return to the same location on the tab after you tab to a different form. 
For example, you are on the 8th reporter in the Reporter Section on the General tab 
and move to another location in the application. When you return to the General tab, 
the system takes you directly to the 8th Reporter because it was the last Case Form 
location that you accessed before moving out of the Case Form.

User preferences are only applicable during the same session for a case, irrespective of 
the Case Status (read-only or editable). If you exit from the case and open a new case, 
the system resets the preferences.

Quick Navigation
Each page displays the navigation flow used to access the page. The following table 
lists shortcut keys to help you navigate more easily and quickly.

Argus Safety Japan Split Screen Feature
For Argus Safety Japan users, a split screen icon enables you to view both English and 
Japanese screens. By default, the system displays the  Case Form screen in Japanese. 
When you choose to view the screen in both English and Japanese, place the mouse 
cursor over the split screen icon shown in the following illustration

Shortcut Key Output

CTRL+SHIFT+# Goes to the tab indicated by the # entered. (1=General tab, 2=Patient 
tab, etc.)

ALT+SHIFT+# Goes to the sub-tab as indicated by the # entered (= Product 1, Product 
2, etc.)Note: The maximum # for the sub entities is 10 which pertains to 
ALT+SHIFT+1 for the first entity within the tab till ALT+SHIFT+0 for 
the 10th entity within the tab.
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When you place the mouse on the split screen icon, the system displays the split screen 
drop-down menu as shown in the following illustration.

The following table lists and describes the items on this menu.

When using the split screen feature, be aware of the following:

■ The scroll bar is available only in the editable part of the split screen. The enables 
the screens to scroll at the same time so you see the same portion of the screen in 
both English and Japanese.

■ The split screen drop-down menu is also available on the following case for 
analysis tabs:

– MedWatch Info

– BfArM Info

– PMDA

– AFSSaPS Info

Country Choose this Icon To:

Splits the Japanese screen horizontally. The 
system places the Japanese text on top and the 
English text on the bottom. The Japanese text is 
editable but the English text is read-only.

Splits the Japanese screen vertically. The system 
places the Japanese text on the left and the 
English text on the right. The Japanese text is 
editable, but the English text is read-only.

Displays the full screen in Japanese.

Splits the English screen horizontally. The system 
places the English text on top and the Japanese 
text on the bottom. The English text is editable but 
the Japanese text is read-only.

Splits the English screen vertically. The system 
places the English text on the left and the 
Japanese text on the right. The English text is 
editable, but the Japanese text is read-only.

Displays the full screen in English.
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■ If the case is first found outside Japan, the Argus Safety user enters the data. The 
Japanese case form window has all common field items enterby the English user in 
Japanese.

■ If the case is first found in Japan, the English screen has the Equivalent English 
information enterdd in the common fields on the case form. 

■ If you use the minimize/maximize button on one  of the split screens, the  system 
also minimizes/maximizes the other screen to keep the same view between the 
editable and non-editable windows.. 

Multi-Lingual Text Box
The system provides a multi-lingual text editor as shown in the following illustration.

You can only edit the Japanese text field; the English text field is read-only.

General Tab
The General tab is designed to capture case information in categorized sections that 
capture category-specific information. The General tab enables you to enter or view 
information such as type of report, literature information, and so forth. The following 
is an illustration of the General tab.

The General tab has four sections as described in the following table.

Section Purpose

General Information Contains information about the report type, receipt dates, etc.

Study Information Contains information about clinical trial details, if appropriate.
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General Usage Information
When using the General Tab be aware of the following:

■ The system saves all filtering criteria the user enters on the Reporter Look Up 
dialog as user preferences while it populates the reporter information on the 
General Tab. 

– If you have reporter information in the case, the system continues to display 
the reporter information in the Reporter Lookup dialog and automatically 
performs a search.

– After performing the search the system retains the search criteria as user 
preferences. The next time you perform a search, the system displays these 
preferences. 

– When you log out, the system retains the user preferences and makes them 
available the next time you log in to the system

– You can click Clear to clear all the values in the filtering elements. 

– If the system cannot find any reporters during a search, it displays the 
following message in the reporter look up dialog:

No reporters found

■ If a priority has not been assigned to a case, the system hides the Case Priority 
field label.

■ If a case owner has been assigned to the case, the system displays the name of the 
case at the top of the Case form. If a case owner has not been assigned, the system 
hides the Case Owner label.

■ The Project ID can be 40 characters long. Users can scroll in the field.

■ The Study Name field can be 70 characters long.

■ When the Classifications field is hidden, the system does not display the 
classification section on the Case Form.

■ The mandatory fields identified in the E2B Mapping in the factory or custom 
profiles are identified with an icon on the Case Form fields on the Case From and 
Medical Review dialog boxes.

■ All popup message boxes that had only an OK or Cancel button have a Clipboard 
button that enables you to copy the message content to the clipboard for later use.

Dynamic Workflow Indicators
Dynamic workflow indicators track the amount of elapsed time it takes to complete a 
workflow step.

■ The first number represents the time left or exceeded for a given workflow step

■ The second number indicates the time left till the reporting deadline.

■ Time is expressed in days (d), hours (h), and minutes (m) respectively.

The icon changes based on the amount of elapsed time for the workflow step.

Reporter Information Contains information about Reporter details.

Literature 
Information

Contains information about Literature cases.

Section Purpose
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If the time to complete the case process exceeds the allocated time, the system displays 
the value in red with the time displayed as a negative value. Only archived, locked 
cases do not display the dynamic workflow indicator.

General Tab: General Information Section
The following is an illustration of the General Information section on the General tab.

General Information Fields  The following table lists and describes the fields in the 
General Information section.

Icon Denotes

Traffic Light No status can be indicated, for example if no timing is defined in the 
workflow.

Red Traffic Light The timing has been exceeded.

Yellow Traffic Light The timing is in danger of being exceeded.

Green Traffic Light The timing is in good standing.

Field/Control Name Description

Report Type Select the item that best describes the type of report. Choice of 
report type determines availability of fields relating to clinical 
studies and/or literature references.

Note: Clinical study reports prompt the user for information 
relating to the study, and literature-based reports enable the user to 
select the journal and reference on which the case is based.

Country of Incidence Select the country where the adverse event occurred. The E2B icon 
identifies fields required for E2B.

Initial Receipt Date Enter the date your company became aware of the case. Argus 
Safety uses this date throughout all reports.

Note: This date can be changed only prior to regulatory report 
submission.

Central Receipt Date Enter the date on which this information was received by Central 
Safety.

Initial Justification Enables you to enter the initial justification reason. The entry in 
this field is displayed as per the reason entered when the case is 
being booked in.

Aware Date This item is read-only. It displays the most recent significant 
follow-up when such follow-up information was specified. If not, 
the initial receipt date is displayed.
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General Tab: Study Information Section
The Study Information section enables you to enter information about case studies.

Study Information Fields and Field Descriptions  The following table lists and describes the 
fields in the Study Information section.

Follow-up (#) Follow-up number automatically increments based on updates to 
the Follow-up Received field.

The figure displayed within "()" denotes the number of follow-ups 
added to the case.

Note: The order of the Follow up dates is maintained. For instance, 
on sorting the Follow-up, the serial number still displays the order 
of entering the follow-ups. The Follow-up headers can be sorted by 
the Follow-up Received and Follow-up Safety Received Columns. 
Click on the header to sort in ascending order or to sort in 
descending order. By default, the sorting is in descending order of 
the Follow-up Received Date.

Follow-up Received Click Add to enter the date on which follow-up information was 
received by your company. You can select whether the case has 
significant follow-up information.

Note: If you select Yes, the Significant check box is selected. When 
sorting on follow-ups, by default, the dates are sorted in 
descending order of the Follow-up Received Date.

Central Received Enter the date on which follow-up information was received by 
Central Safety.

Significant Click the checkbox if the follow-up is significant.

Data Clean up Click the checkbox to mark the Follow up as a Data Clean up 
version. This version is used in the Data Lock Point for Case 
Versioning in and System Reports.

Follow-up Justification Enables you to select a pre-defined justification for Follow-up. 
Click the icon to view the standard justifications dialog. 

You can select a pre-defined justification from this dialog or enter a 
new justification. Refer to the screen shot given below the table.

Classification Select up to 50 case classifications used to categorize a case. Click 
Add to enter additional case classifications.

Case Requires Follow-up Select this check box if the case requires follow-up information.

Field/Control Name Description

Project ID Enter the Project ID, or select one from the list. Selecting a Project ID 
automatically creates items in the Study ID list.

Center ID Select the appropriate center ID from the list.

Study Phase Enables you to enter the Study Phase for the configured study.

Note: This field is pre-populated if you select a Study with an 
already-configured Study Phase.

Field/Control Name Description
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Study Restrictions  To enter pre-defined Study Information

1. Click Select to choose from the already available list of study information. 

2. When the Clinical Trial Selection dialog opens, enter Project, Study, and Center 
information as appropriate.

The Clinical Trial Selection dialog allows you to select a clinical trial from the list 
configured by the Administrator.

Study Name The study name is entered automatically based on the study that is 
selected.

Study Type The study type is entered automatically based on the study that is 
selected.

Week # Enter the week number of the study during which the adverse event 
occurred.

Visit # Enter the visit number of the study during which the adverse event 
occurred.

Blinding Status Depending on the type of study, this item is entered automatically by 
the system. You need special access rights to use any of the Broken By 
entries.

Note: The Unblind Case dialog appears when you try to unblind a 
study. For Not Blinded studies, saving the case or generating a report, 
you can enter the actual drug (vs. placebo) given to the patient.

Study Description The study description is entered automatically based on the study that 
is selected.

Observe Study Type The value selected from this drop-down list is populated in the Case 
Form Study Section when the Clinical Study is selected.

Unblinding Date This item is automatically entered by the system. If you double-click 
the date in this item, the Unblind Case dialog is displayed. If the date 
of unblinding is more recent than the date for the most significant 
follow-up information, an automatic follow-up is generated.

Field/Control Name Description
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3. Click Search to generate the search results.

4. Choose the appropriate study information from the list and click Select.

5. The details of the selected Study Information are added to each field in the Study 
Information section

General Tab: Reporter Information
The Reporter Information section enables you to enter information about the person 
providing the case-related information. The following is an illustration of the Reporter 
Information section.

Tip: To broaden the search results, enter as little information as 
possible. Select the required clinical study and study center and click 
Select.
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When using this section, be aware of the following:

■ The Reporter Rearrangement dialog also shows the number of Reporters present 
in the case. It displays the First Name and Last Name, followed by the Reporter 
Type in brackets, as entered in the reporter information dialog.

■ You can also view all the Reporters by clicking the Quick Launch icon. 

■ Click any Reporter Name to view the details of the selected Reporter tab.

■ Click the New tab to add a new reporter anytime. You can add a maximum of 100 
reporters.

■ The Primary Reporter is identified by the Reporter icon on the Reporter 
Information tab.

Reporter Information Fields
The following table lists and describes the fields in the Reported Information section.

Field/Control 
Name Description

Notes Click this button to enter free text notes relating to this reporter.

Note: This field supports multiple language entry. You can click on a flag, 
select the language tab, and enter information.

Sal. Enter the reporter's salutation.

First Name Enter the reporter's first name.

Middle Name Enter the reporter's middle name.

Last Name Enter the reporter's last name. The Select button displays the Reporter 
Selection dialog. If you select a reporter from this dialog, the system 
automatically completes the case form reporter fields.

Suffix Enter the reporter's suffix; for example, HR, or MED.

Health Care 
Professional

Select Yes, No, or Unk (Unknown) to indicate whether the reporter is a 
health-care professional.

Occupation Select the reporter's occupation from the list.

Address Enter the reporter's address.

Institution Enter the reporter's institution.

Department Enter the reporter's department.

City Enter the reporter's city.

State/Province Enter the reporter's state, province, or county.

Postal Code Enter the reporter's postal code.

Country Select the country name. The Administrator maintains this list.



Case Form Functions

Case Form 4-15

Adding Reporter Information  You can add reporter information by clicking the Select 
button and entering data in the Reporter Lookup dialog box.

To add reporter information
1. Click Select in the Reporter Information section.

2. When the system opens the Reporter Lookup dialog box, enter the required search 
criteria in the fields and click Search.

Phone Number Enter the reporter's telephone number.

Alternate Phone Enter another telephone number for the reporter, if available.

FAX Number Enter the reporter's fax number.

Reporter ID If known, enter the Reporter ID. This automatically completes the Case 
Form reporter fields.

Reporter's 
Reference #

Enter the Reporter's Reference # for the case.

Email Address Enter the reporter's email address.

Reporter Type Select the Reporter Type. The Administrator maintains this list.

Report Media Select the medium of the report. The Administrator maintains this list.

Intermediary If appropriate, select the type of intermediary. The Administrator 
maintains this list.

Report sent to 
Regulatory 
Authority by 
Reporter?

Make a selection, as appropriate to the case.

Protect 
Confidentiality

If this check box is selected, the name and address of the reporter do not 
appear on regulatory reports and the reporter's information displays 
"NAME AND ADDRESS WITHHELD".

Primary Reporter Identifies the primary reporter. Only one primary reporter is permitted 
per case. The primary reporter is the reporter whose name appears on the 
regulatory reports. The tab that identifies the primary reporter is 
displayed in blue as compared to the other reporter tabs.

Correspondence 
Contact

If this check box is selected for a reporter, the reporter's address 
information is used in letters. You can select more than one reporter as 
the correspondence contacts for the case.

(New) Tab Creates details for a new reporter.

Tip: You can choose to search either by Search Cases or by Search 
List Maintenance.

Field/Control 
Name Description
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3. The Search results for the entered search are displayed.

4. When the system displays the search results, choose the appropriate reporter 
information from the list and click Select.

5. The system adds the selected, pre-defined information to the fields in the Reporter 
Information section.

Reporter Lookup Dialog Box Fields  The following table lists and describes the fields in the 
Reporter Lookup dialog box.

Field/Control Name Description

First Name Enter the first name of the reporter.

Last Name Enter the last name of the reporter.

ID Enter the ID of the reporter.

Institution Enter the institution of the reporter.

MR Select this button if the reporter is a Medical Representative (MR).

Physician Select this button if the reporter is a Healthcare Physician.

Department Enter the department of the reporter.

Reporter Type Enter the reporter type.

Address Enter the address of the reporter.

City Enter the city of the reporter.

State/Province Enter the state/province of the reporter.

Postal Code Enter the postal code of the reporter.

Phone Number Enter the phone number of the reporter.

Country Enter the country of the reporter.

Search Cases Click this button to search for cases that match the specified search 
criteria.



Case Form Functions

Case Form 4-17

J Reporter Lookup Dialog Box
The following table lists and describes the fields in the J Reporter Lookup dialog box 
shown in the following illustration.

Search List 
Maintenance

Click this button to search the list maintenance for the specified criteria.

Field/Control Name Description

First Name Enter the first name of the reporter.

Last Name Enter the last name of the reporter

Reporter ID Enter the reporter’s ID

Institution Enter of select the institution.

Institution ID The unique value that identifies the institution.

Reporter Type Enables you to select the reporter type from the drop-down 
list.

Address Enter the address of the reporter.

City Enter the city of the reporter.

State/Province Enter the state/province of the reporter.

Postal Code Enter the postal code of the reporter.

Phone Number Enter the phone number of the reporter.

Country Enables you to select the reporter’s country.

Field/Control Name Description
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When using the  Reporter Lookup dialog box, be aware of the following:

■ The "Search all the reporters who belong to the institution found from the current 
search item" checkbox is enabled only when the "Search List Maintenance" radio 
button is selected.

■ You can select multiple reporters in the search results table. Hold down the Shift 
key and click each item to select it.

■ When this option is enable, the system places the multiple reporter informtion in 
the Case Form when you click Select.

■ When you click Select, and one or more rporters are already in the Case Form, the 
system adds these reporters on the Case Form.

■ When you select multiple reporters, the information replaces the current tb and 
adds a new tab for each additional report.

General Tab: Literature Information Section
This section enables you to enter a literature reference for the case. You can enter the 
information manually or you can enter pre-defined literature information by click the 
Select button and selecting from the list of pre-defined references.

Click the Quick Launch iconto view all the items present in the case. This information 
appears in the format: (Journal Name Yea Vol: Pages)

Search Cases Click this button to search for cases that match the specified 
search criteria.

Search List Maintenance Click this button to search the list maintenance for the 
specified criteria.

Search all the reporters who 
belong to the institution found 
from the current serch item

When checked, enables you to search for all reporters linked 
to the specified institution. The result list shows all the 
reporters belonging to the institution

When you click this checkbox the system does the 
following:

■ Searches for all reporters matching the specified 
criteria.

■ Retrieves a list of all institutions the reporter’s results 
belong to.

■ Searches for additional reporters and adds them to the 
results set when the institution is the only search 
parameter.

Field/Control Name Description
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Literature Information Fields and Field Descriptions  The following table lists and describes 
the fields in the Literature Information section.

To enter pre-defined literature information
1. Click Select to choose from the already available list of literature information.

2. When the Literature Reference dialog opens, locate and select the appropriate 
reference in the list and click Select.

3. The details of the selected literature information are added to each field in 
Literature Information.

Patient Tab
This section of the Case Form helps you to enter patient information such as the 
patient's past medical history and current conditions, and laboratory tests and test 
results. The medical information entered here could be very useful to the person 
analyzing the event. For example, if the adverse event was a rash that developed after 
applying a topical product, the knowledge that the patient has a history of allergic 
reactions could be relevant.

The Patient tab includes the following tabs: Patient and Parent.

■ Patient Tab

■ Parent Tab

Field/Control 
Name Description

Select Selects a literature reference directly from the list of literature articles entered by 
the Administrator.

Note: If the required literature article is not present in the list, details of the 
article can be entered by using the remaining fields in the section.

Journal Enter the name of the journal in which the article appeared. This value gets 
displayed in italics.

Author Enter the name(s) of the author(s) of the article.

Title Enter the title of the article.

Volume Enter the volume of the particular journal.

Year Enter the year in which the article was published.

Pgs Enter the journal page numbers in which the article appears.
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Patient Tab: Patient Information
The Patient tab includes the following sections:

■ Patient Information

■ Patient Details

■ Other Relevant History

■ Event Death Details

■ Lab Data

■ Relevant Tests

Patient Information Fields  The following table lists and describes the function of each 
field.

Field/Control 
Name Description

Patient Info From 
Reporter button

Copies name and address information from the Reporter section of the 
General Tab into the Patient Information section.

Current Medical 
Status Button

Captures details about the history and the current condition of the patient 
from the dialog.

Note: The items that appear in the Current Medical Status dialog 
automatically map to the fields for the German BfArM tab on the 
Analysis tab. Changing the values on the BfArM tab does not affect these 
items.

Sponsor Identifier Enter the Sponsor Identifier of the patient.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection 
dialog.

Pat. ID Enter the Patient Identifier number.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection 
dialog.

Randomization # Determines which drug was administered to the patient during the 
course of the study.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection 
dialog.

Number of Patients Enter the number of patients involved in the adverse event.
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Neonate Information Section  When using the Neonate Information section, be aware of 
the following:

■ You can delete neonate information by right clicking the neonate and selecting the 
Delete option.

■ The system tracks changes to the neonate information in the audit log.

Pregnancy Information  The Pregnancy Information section enables you to enter data 
about a pregnancy.  When using this section be aware of the following new fields: 
Gravida and Para. These fields enable you to capture numerical gravida and para 
information.

Entering Current Medical Status  Use the following procedure to enter information about 
the patient's current medical status.

1. Click Current Medical Status in the Patient tab of the Case Form.

2. The Current Medical Status form opens as a pop-up.

First Name Enter the first name of the patient.

Note: During book-in, the system transfers the appropriate patient name 
to the relevant name and initials fields. If the Patient Name or Initials are 
three characters or less, this is transferred to the Initials field.

MI Enter the middle initial of the patient.

Last Name Enter the last name of the patient.

Initials Enter the patient's initials. Existence of the patient's first, middle, or last 
name automatically populates this field.

Protect 
Confidentiality

If this check box is selected, the patient's name and address will not 
appear on any of the regulatory reports and the patient's information will 
show the word PRIVACY.

Child only Case If this check box is selected, then the pregnancy [Detail] button is 
accessible from the Parent information tab only and no longer through 
the Patient tab directly.

Address This field and the following four fields allow you to enter the patient's 
address.

City Enter the patient's city.

State/Province Enter the patient's state, province, or county.

Country Select the country. The Administrator can adjust this list.

Postal Code Enter the patient's postal code.

Phone Number Enables you to enter the phone number of the patient.

Field/Control 
Name Description
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3. Select the choices that apply to the patient from the items in the form.

If you don't know whether a particular condition applies for the patient, select 
Unk.

4. Click OK to save the current medical status.

Copying Patient Information from Reporter Information  If the patient and the reporter are the 
same person, the reporter information entered in the General tab can be copied to the 
Patient tab.

Reporter Information
If the patient and the reporter are the same person, the reporter information entered in 
the General tab can be copied to the Patient tab.

Click Patient Info From Reporter in the Patient tab to copy the reporter information. 
The reporter information is copied.

Patient Details Section
The Patient Details section enables you to enter information, including pregnancy 
data, about a patient. The following is an illustration of the Patient Details section.

Patient Details Fields and Field Descriptions  The following table lists and describes the 
fields in the Patient Details section.

Field/Control 
Name Description

Date of Birth Enter the patient's date of birth. You can enter a partial date if the actual 
date is unavailable.
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Entering Pregnancy Information  Use the following procedure to enter pregnancy 
information.

1. Select Yes from the Pregnant drop-down list, if applicable.

This field is shown as active only after the Gender field in this section is selected 
as Female.

The Pregnancy Information section is displayed.

2. Enter the available pregnancy information in the form.

3. Click OK to save the pregnancy information.

The following lists and describes the fields on the Pregnancy Information form.

Age Calculates the patient's age, from the date of birth and earliest event onset 
date, if both full dates are available; otherwise, you can enter the age 
manually.

 Units Select the age units. (i.e., days, weeks, months, years)

Note: If both the date of birth and event onset date are available, the Age 
Units field is automatically calculated. The Administrator can adjust this 
list.

Age Group Select an age group. If the age group is entered manually, the Age and Age 
Units fields are disabled. The Administrator can adjust this list.

Note: This field is automatically filled in when the Age and Age Units 
fields are both entered.

Ethnicity Select the patient's ethnicity. The Administrator can adjust this list.

Occupation Select the patient's occupation. The Administrator can adjust this list.

Weight Enter the patient's weight.

Weight Units Select the appropriate weight unit.

Height Enter the patient's height.

Height Units Select the appropriate height unit.

Gender Select the patient's gender.

Note: If the patient is male, the system automatically disables the 
Pregnancy field.

When the Gender is set to Female, the Pregnancy drop down is enabled 
and set to Unknown.

Pregnant Make the appropriate selection.

Note: If Yes is selected, a Details button will appear. Click Details to enter 
pregnancy information.

Date of LMP Enter the date of the Last Menstrual Period, if applicable. A partial date 
can also be entered.

Breastfeeding Select the checkbox, if applicable.

User Defined Enables the user to enter information about the patient.

UD Text 2 -- UD 
Text 9

Enables users to enter information about the patient.

Field/Control 
Name Description
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Event Death Details
The Event Death Details section enables you to enter information about the death of a 
patient.

The following table lists and describes the fields in the Event Death Details section.

Field/Control Name 
Name Description

Due Date Enter a due date or an approximate due date, if known.

Weeks at Onset Enter the number of weeks of pregnancy at the time the event occurred, 
if known. The maximum entry allowed in this field is 50.

Prospective/Retrospe
ctive

Select if the information was Prospective or Retrospective.

Note: A prospective information is one where the company hears of the 
case before the baby is born to the patient who took the drug.

In a retrospective case, a company gets to know after the baby is born.

Weeks at Exposure Enter the number of weeks of pregnancy at the time of exposure, if 
known. The maximum entry allowed in this field is 50.

Trimester of 
Exposure

Make the appropriate selection.

Number of Fetus This tab allows entry of data for a baby who is born to the patient. Click 
New to make an additional entry.

Delivery Date Enter the date of the delivery.

Weight Enter the birth weight

Weight Units Select the appropriate weight units.

Delivery Type Select the delivery type from the list. The Administrator can adjust this 
list.

Birth Type Select the birth type from the list.

Fetal Outcome Select the fetal outcome from the list.

APGAR Score Enter the APGAR scores-up to three per neonate.

Delivery Notes Enter notes on the case.

Field/Control 
Name Description

Date of Death Enter the date of death

Autopsy Done? Select whether autopsy was done.

Note: If Autopsy Done is set to No or Unknown, the Autopsy Results 
Available is shown as No.
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Other Relevant History Section
The Other Relevant History section enables you to enter information that might be 
useful. The system enables you to copy the Other Relevant History rows by selecting 
the row and clicking Copy. The following is an illustration of the Other Relevant 
History section.

Other Relevant History Fields and Field Descriptions  The following table lists and describes 
the fields in the Other Relevant History section.

Autopsy Results 
Available?

Select if autopsy results are available.

Note: The Autopsy Results Available? field is enabled only if the 
Autopsy Done? field is marked as Yes. However, if Autopsy Results 
Available is changed to No and Autopsy Result rows exist, you will be 
asked to delete the rows first. Click Yes to delete the data.

Add Click this button to add a Cause of Death and Autopsy Results row.

Note: A user can add multiple records, up to 50 entries.

Delete Enables you to delete a highlighted row.

Up/Down Click Up to move the record up and click Down to move the record down.

Note: Ordering reflected on the case form displays the same ordering as 
displayed in the E2B report repeatable tags.

Cause of Death Describes the cause of death.

Description as 
Reported

Displays the description reported by the reporter.

Autopsy Result Describes the autopsy results.

Encode Encodes the event reported by the reporter.

Field/Control 
Name Description

Start Date Enter the start date of the condition. You can enter a partial date if the 
actual date is not available. You can also choose not to enter a date.

Note: If you click Add but do not enter a date, the Date column is 
removed.

Once the date is entered and there is a test associated with the date, you 
cannot clear the date but can only modify it. To remove the date column, 
individually delete all the cells in that Date column.

Stop Date Enter the stop date of the condition. You can enter a partial date if the 
actual date is not available. You can also choose not to enter a date.

Ongoing If the condition is ongoing, select the Ongoing check box.

Field/Control 
Name Description
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Lab Data Section
The Lab Data section provides data about lab test and test results. The maximum 
number of lab test data on the Case Form is 2000. The following is an illustration of the 
Lab Data section.

Condition 
Type/Verbatim/In
dication/Reaction

Select a condition type from the list. The Administrator can adjust this list.

Note: If the Condition Type value is Medical History Episode and the 
term is not encoded, the value entered in the Description field is 
appended to the Patient Notes value. However, if the Condition Type 
value is Other Relevant Therapy and the term specified in the 
Description field is not encoded, then this record is not transmitted at all.

Encode Click this button to encode the term.

Note: To view the complete MEDDRA hierarchy for the encoded term, 
click the encoding status icon.

Coded 
PT/Description of 
condition 
LLT/Indication 
PT/Reaction PT

Enter a term to describe the condition. You can either manually encode or 
auto-encode, if you have been so configured by the Administrator.

In manual mode, type the description (for example, Fever).

In Auto-encode mode, enter a partial description and press ENTER or 
TAB.

The appropriate coding dialog appears.

In either mode, you can click Encode and modify the encoding. If the 
condition type is historical drug, the encoding will be done with WHO 
drugs.

Note: To view the complete MEDDRA hierarchy for the encoded term, 
click the encoding status icon.

Indication PT Enter a term to describe the indication.

Note: This field is visible on the case form only if the condition type 
selected in the List maintenance is Patient Other Relevant Therapy.

Reaction PT Enter a term to describe the reaction.

Note: This field is visible on the case form only if the condition type 
selected in the List maintenance is Patient Other Relevant Therapy.

Notes Enter any notes that are relevant to the condition.

Copy Enables you to copy a row. After you copy the row, the focus will be on 
the newly copied row.

Add Enables you to add a row to the relevant history. After you add the row, 
the focus will be on the new row.

Delete Enables you to delete a row from the relevant history.

Up Enables you to move up a row in the relevant history.

Down Enables you to move down a row in the relevant history.

Field/Control 
Name Description
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Lab Data Fields and Field Descriptions  The following table lists and describes the fields in 
the Lab Data section.

Using the Lab Data Section  When using the Lab Data section, be aware of the following:

■ A single, vertical scroll bar has been placed beneath the header and date 
information in the Lab Data section. This enables the date to be seen at all times.

– To keep all the rows together, all rows in the Lab Data Test as Reported " and 
Results/Units  use this scroll bar.

– A maximum of three (3) rows is visible at all times.

You can perform several different actions in the Lab Data section as follows:

To enter a Lab Test Name
1. Click Add Test.

2. Enter a partial description of the lab test in the Lab Test Name dialog.

3. Click Search. Select the required lab test from the search results.

Selecting a Lab Test Group
The system enables you to select  a lab test group from   the dialog box shown in the 
following illustration.

Field/Control Name 
Name Description

Lab Data Section

Date Enter the date the test was carried out. Partial dates are allowed for in 
this field.

Test 
Name/Assessment

Enter a lab test name, or select from the list. Also select the assessment 
from the list below the Test Name.

Select Lab Test Group Enables you to select one or more lab test groups.

Result/Units Enter the test result, including the appropriate units and select a term to 
describe the qualitative assessment of the results. The Administrator 
can modify the list of possible assessments.

Norm Low/Norm 
High

The Test Name list can retrieve details of the normal range for the test 
selected (if the Administrator has entered the normal range into the 
list). Otherwise, enter the values manually.

Encode Click this button to encode the term.

Note: To view the complete MedDRA hierarchy for the encoded term, 
click the encoding status icon.

Notes Enter notes pertinent to this case.



Case Form Functions

4-28 Oracle Argus Safety Japanese User's Guide

When selecting a lab test group, be aware of the following:

■ When you click Select, the system popultes the Lab Test Group with a list of lab 
tests that match the selected lab test group.

■ If lab test data is already on the Case form, the system appends the lab test group 
after the last lab test. 

■ The Import/Export buttons enable you to import/export lab test data. 

– When you click Import the system opens a dialog box to enable you to enter 
the name of the file to import.

– You can copy the lab test results to the English field. When you check this 
check box, the system copies all test results to the English case form fields. The 
default is checked.

– The system does not commit imported data until you save the case.

– When there are multiple same dates for the same thes, the system sorts the 
data by sequence number.

– If data is alread in the lab data field of the case form, the system displays the 
following message: "Data already exists in the case form field. If you continue, 
the data will be overwritten. Do you want to proceed?"

– The system validates the fields before mapping the data to the case form.

– If there are errors, the system provides error information.

– If the system encounters an error, it displays the following message: "There are 
errors in the import data. Click Detail to check the error detail."

– When imported data exceed the maximum field length, the system returns the 
following message: "Imported data exceeds the maximum length. The import 
cannot continue."

– When all the data is mapped, the system displays the following message: 
"Import completed successfully."

Arranging Entries in a Specific Order
Click the Order icons to arrange entries in a specific order.

Adding Additional Rows
Click the Add button to add more rows.

Deleting Entries
Click the button, to highlight the row for removal.

Sorting the Entries
The Lab data can be sorted in chronological order by Date of the Test and 
alphabetically by the Test Name.

If there are partial dates entered, the date is displayed at the beginning of the month, 
and year for the date entered.

Copying or Pasting Rows in Lab Data
Click the icon to highlight the row to be copied or pasted to an empty cell after a Test 
Date has been added. You can also use the right-click functionality to copy or paste 
data.
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Viewing the Hierarchy of the Event Term
1. Click the icon to view the entire hierarchy of the Event Term.

2. Click outside the MedDRA hierarchy dialog to close this hierarchy listing.

Viewing Notes
Click the icon to view display the Notes in a Zoom dialog.

Arranging the Lab Test data  Click the arrow button to arrange the Lab Test to the right 
Lab Test. This shall only be available when the Lab Test has been entered for the same 
date.

Click the arrow button to arrange the Lab Test to the Left Lab Test. This shall only be 
available when the Lab Test has been entered for the same date.

Relevant Tests Section  This section enables you to enter additional information about 
any relevant tests, such as toxicology. The following is an illustration of this section.

Patient Tab: Parent Information
The following is an illustration of the Parent tab.

Parent Information Section  The following is an illustration of the Parent Information 
section on the Parent tab.

Parent Tab Fields and Field Descriptions
The following table lists and describes the fields on the Parent tab.

Field/Control Name 
Name Description

Parent Initials Enter initials about the parent.



Case Form Functions

4-30 Oracle Argus Safety Japanese User's Guide

Other Relevant History Section  The Other Relevant History section enables you to enter 
information that might be useful. The system enables you to copy the Other Relevant 
History rows by selecting the row and clicking Copy. The following is an illustration of 
the Other Relevant History section.

Other Relevant History Fields and Field Descriptions
The following table lists and describes the fields in the Other Relevant History 
section.

Date of Birth Enter the parent's date of birth. You can enter a partial date if the actual 
date is unavailable.

Age Calculates the parent's age, from the date of birth and earliest event 
onset date, if both full dates are available; otherwise, you can enter the 
age manually.

 Units Select the age units.

Note: If both the date of birth and event onset date are available, age 
units field is automatically calculated. The Administrator can adjust 
this list.

Gender Select the parent's gender.

Note: If the parent is male, the system automatically disables the 
Pregnancy field.

When the Gender is set to Female, the Pregnancy drop down is enabled 
and set to Unknown.

Date of LMP Enter the date of the Last Menstrual Period, if applicable. A partial date 
can also be entered.

Weight Enter the parent's weight.

Weight Units Select the appropriate weight unit.

Height Enter the parent's height.

Height Units Select the appropriate height unit.

Parent Breastfeeding Select the check box, if applicable.

Medical History Captures information about the parent's medical history.

Field/Control Name 
Name Description
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Field/Control Name Description

Start Date Enter the start date of the condition. You can enter a partial date if the 
actual date is not available. You can also choose not to enter a date.

Note: If you click Add but do not enter a date, the Date column is 
removed.

Once the date is entered and there is a test associated with the date, you 
cannot clear the date but can only modify it. To remove the date 
column, individually delete all the cells in that Date column.

Stop Date Enter the stop date of the condition. You can enter a partial date if the 
actual date is not available. You can also choose not to enter a date.

Ongoing If the condition is ongoing, select the Ongoing check box.

Condition 
Type/Verbatim/Indic
ation/Reaction

Select a condition type from the list. The Administrator can adjust this 
list.

Note: If the Condition Type value is Medical History Episode and the 
term is not encoded, the value entered in the Description field is 
appended to the Patient Notes value. However, if the Condition Type 
value is Other Relevant Therapy and the term specified in the 
Description field is not encoded, then this record is not transmitted at 
all.

Encode Click this button to encode the term.

Note: To view the complete MEDDRA hierarchy for the encoded term, 
click the encoding status icon.

Coded 
PT/Description of 
condition 
LLT/Indication 
PT/Reaction PT

Enter a term to describe the condition. You can either manually encode 
or auto-encode, if you have been so configured by the Administrator.

In manual mode, type the description (for example, Fever).

In Auto-encode mode, enter a partial description and press ENTER or 
TAB.

The appropriate coding dialog appears.

In either mode, you can click Encode and modify the encoding. If the 
condition type is historical drug, the encoding will be done with WHO 
drugs.

Note: To view the complete MEDDRA hierarchy for the encoded term, 
click the encoding status icon.

Indication PT Enter a term to describe the indication.

Note: This field is visible on the case form only if the condition type 
selected in the List maintenance is Patient Other Relevant Therapy.

Reaction PT Enter a term to describe the reaction.

Note: This field is visible on the case form only if the condition type 
selected in the List maintenance is Patient Other Relevant Therapy.

Notes Enter any notes that are relevant to the condition.

Copy Enables you to copy a row. After you copy the row, the focus will be on 
the newly copied row.

Add Enables you to add a row to the relevant history. After you add the row, 
the focus will be on the new row.

Delete Enables you to delete a row from the relevant history.

Up Enables you to move up a row in the relevant history.

Down Enables you to move down a row in the relevant history.
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Products Tab
The Products tab enables you to enter and view details about products and dosage 
regimens. The Products tab contains the name of the drug that has been entered within 
that tab. For Blinded Studies, the Blinded Product Name gets displayed in the tab.

When a user has no access to view unblinded information on the Case Form, the 
following fields are hidden:

■ Drug Code

■ Study Drug

■ Formulation

■ Concentration

■ Outside Therapeutic Range

■ Dose

■ Dose Description

■ Daily Dosage

■ Regimen Dosage

■ Patient Route of Administration

■ Parent Route of Administration

■ Package ID

■ Pack Units

■ Batch\Lot

■ Expiration Date

■ Total Dosage Units

■ Total Dose to Primary Event

General Usage Information
When using the Products tab, be aware of the following:

If the study has been unblinded and a study drug had been selected, the selected 
Study Drug Name is displayed. You cannot view unblinded information and the tab 
continues to show the Blinded Product Name.

You can enter details of more than one product and more than one dosage regimen for 
a company product for which multiple licenses exist (for example, drug and vaccine, 
or drug and device).

Depending on the type of license (drug, vaccine, or device), different views are 
available in the Products tab. If the selected item is not a company product or if a 
license for a company product does not exist, all three views are always available.

Time Measurement Fields  You can enter seconds in the following fields:

■ Argus > Case Actions > Open > (Select a Case) > Event tab > Event sub tab > 
{event description} sub tab > Event Information section (middle of screen)

– Onset From Last Dose field

– Duration field

– Onset Latency field
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■ Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab > 
{Product Name} sub-sub tab (drug) > Dosage Regimen section (lower 1/3 of 
screen)

– Duration of Regimen

■ Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab > 
{Product Name} sub-sub tab (drug) > Product Details section (lower 1/3 of screen

– Duration of Administration

– Time between First Dose/Primary Event

– Time between First Dose/Primary Event

■ Any number following by the letter "s" defaults to "#sec."

■ The system interprets the seconds the user enters in the following formats where:

# is a number from 0 to 9

#s -- The system automatically changes the format to # sec.

# s -- The system automatically changes the format to # sec. 

# sxx

where: 

x is other letters -- The system automatically changes the format to # sec

■ The Temporal View and the Case Form printout display the seconds.

■ The E2B import and export case functions support seconds and M2 Validation for 
the defined fields.

Date of Mfr Field  You can enter a partial date in the Date of Mfr field. The MedWatch 
(Device) and EU Device Reports print the partial dates entered in the field.

The Products tab includes three tabs: Drug, Device, and Vaccine.

Products Tab: Drug Tab
The Products tab displays the Drug section by default as shown in the following 
illustration.

The Drug tab includes the following sections:

■  Product Information 
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■ Product Indication

■ Dosage Regimens

■ QC Info

■ Product Details

 Product Information Section  The Products Information section enables you to enter 
information about the drug being used for the case. The following is an illustration of 
the Product Information section.

Product Information Fields and Field Descriptions
The following table lists and describes the fields and controls in the Product 
Information section.

Field/Control Name Description

Suspect

Concomitant

Treatment

Indicates whether the drug 

Product Name The name of the product associated with the adverse event.

Generic Name The generic name of the product

Company Drug Code The unique value the company uses to identify the drug.

Obtain Drug Country The name of the country where the drug was obtained.

Drug Code The unique value that identifies the drug.

WHO Medicinal 
Product ID

The WHO Drug code used to identify the drug

Formulation The form in which the drug was administered (liquid, tablet, capsule, 
etc.)

Drug Authorization 
Country

The country where the drug was authorized for use.

Manufacturer The company that manufactured the drug.

Concentration The amount of the drug that was administered.

Unit The drug unit (i.e., mg, tsp, etc.)

Interaction Identifies the drug interaction, if any.

Contraindicated?

Study Drug Not 
Administered

Check this box if this is a study drug and was not administered.
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Product Indication Section  The Product Indication section enables you to enter 
information about the indicator of the adverse event. It includes two fields: Reported 
Indication and Coded Indication

Reported indication is the reported reaction and Coded Indication is the code for the 
reaction. The two values may be the same, but they may also be different.

QC Info  The QC Info section enables you to enter quality control information. The 
following is an illustration of the 

QC Info Fields and Controls
The following table lists and describes the fields in the QC Info section.

UD Number 1 -- UD 
Number 9

Field/Control Name Description

QC Safety Date Enter the QC department reference number for the 
analysis.

QC Sent Date Enter the sent date.

QC Cross Reference Enter the QC department reference number for the 
analysis.

Date Returned Enter the date returned.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is 
incorrect, a Lot Number Lookup dialog is displayed, that 
allows you to enter select from the existing lot numbers.

Field/Control Name Description



Case Form Functions

4-36 Oracle Argus Safety Japanese User's Guide

Product Details Section  The Product Details section enables you to enter information 
about the drugs being used for the case. The following is an illustration of the Product 
Details section

Product Details Fields and Field Descriptions
The following lists and describes the fields in the Product Details section.

Complaint Categories Date Enter a date for complaint categories.

Complaint Categories Text Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

Analysis Categories Date Enter a date for analysis categories.

Analysis Categories Text Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

Analysis Summary Date Enter a date for an analysis summary.

Analysis Summary Text Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

QC Result Date Enter the date the result of the analysis was received by the 
QC department.

QC Result Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

QC Comment Enter any comment relating to the analysis.

Field/Control Name Description

First Dose This date is defined as the earliest regimen start date and is entered 
automatically.

Last Dose This date is defined as the latest regimen stop date and is entered 
automatically. If the Ongoing check box is selected, this field will not be 
filled in.

Duration of 
Administration

This field is calculated automatically if full dates are available for first 
and last doses. It is the difference between the first and last dose for all 
dosage regimens.

Note: If the duration is five days or more, the duration displays in 
number of days. If less than five days, it displays in days and hours.

Total Dosage This field is calculated automatically based on daily dose, duration, and 
frequency. If each regimen is associated with different dosage units, this 
field is not calculated automatically.

Total Dosage Units This field is calculated automatically based on daily dose, duration and 
frequency. If different regimens have different dosage units, this field is 
not calculated automatically.

Time between First 
Dose/Primary Event

Enter the time from the first dose to the onset of the primary event.

Field/Control Name Description
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Dosage Regimens Section  The Dosage Regimens section enables you to enter 
information about the size and frequency of drug doses being given to a patient. The 
following is an illustration of the Dosage Regimens section.

Time between Last 
Dose/Primary Event

Enter the time from the last dose to the onset of the primary event.

Total Dose to Primary 
Event

Enter the total dose of drug given before the onset of the primary event.

Action Taken Select the appropriate item from the list. If no change or dose increased 
is selected, the Dechallenge Results and Rechallenge Results sections 
below are not available. The Administrator can adjust the values in this 
list.

Abuse Select this check box if the patient abused the product (For example: 
Painkillers taken without pain).

Overdose Select this check box if the patient took an overdose of the product.

Tampering Select this check box if the product appeared to have been tampered 
with before it was used.

Taken Previously / 
Tolerated

Select the appropriate response from the list.

Was Protocol 
Followed?

Click the appropriate button to indicate whether the protocol was 
followed during the study.

Note: This item is only available for study products.

Dechallenge Make the appropriate selection depending on whether the drug was 
stopped.

If you select Neg or Pos or Unk, the Dechallenge Date is enabled.

Select N/A to disable the Dechallenge date.

Date Enter the date when the dechallenge was carried out.

Rechallenge Results Make the appropriate selection depending on whether the drug was 
taken again. If Pos or Neg or UNK is selected for the Rechallenge field, 
the Rechallenge Start Date/Time, Rechallenge Stop Date/Time, and 
the Rechallenge Outcome fields are enabled.

Start Date/Time Enter the date and/or time when the rechallenge was started.

Stop Date/Time Enter the date and/or time when the rechallenge was stopped.

Additional Product 
Tabs

Click the additional product tabs to switch views. The products may 
have one or two letter icons next to it. The following are the icon names, 
and what they mean:

VC- Vaccine view selected

DR- Drug view selected

DV- Device view selected

S- Suspect Product

C - Concomitant Product

(New) Tab Enter information about a new product.

Field/Control Name Description
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Dosage Regimens Fields and Field Descriptions
The following lists and describes the fields in the Dosage Regimens section of the Drug 
tab.

Field/Control Name Description

Start Date/Time Enter the start date and time of the dosage. Entry of time information is 
optional, and you can enter partial dates.

Stop Date/Time Enter the stop date and time of the dosage. Entry of time information is 
optional, and you can enter partial dates.

Note: If no Stop Date is entered, Onset from Last Dose is calculated 
automatically from the Event Onset Date and the most recent Stop Date 
or the most recent Start Date.

Ongoing Select this check box if the drug treatment is ongoing. The Stop Date, 
Duration of Regimen, and Last Dose fields are removed if this check 
box is selected.

Outside Therapeutic 
Range

Select this check box if the drug has not been used in accordance with 
the label or has been used for outside the Therapeutic Range. Consult 
your Administrator for further company-specific information on the 
use of this field.

Duration of Regimen This value is calculated automatically, based on regimen start and stop 
dates (if full dates are entered for the start and stop dates). If the value 
is entered manually, the duration units (for example: minutes, hours, 
days, months, or years) must also be entered along with the actual 
duration.

Note: The Administrator can set the duration to be inclusive or 
exclusive. In Inclusive mode, the starting day counts in the calculation 
of the duration; in Exclusive mode, it does not.

Dose # Enter the drug dose number.

Dose Enter the dose received by the patient.

Dose Units Select the dose unit. The Administrator can adjust this list.

Frequency Select the frequency. The Administrator can adjust this list.

Dose Description This value is automatically entered by using the values from Dose, 
Dose Units, and Frequency. If necessary, you can change this value. 
However, if Dose, Units, or Frequency information is changed, this 
value will be recalculated.

Daily Dose This value is calculated automatically depending on the dose and 
frequency. It can be manually overwritten. If either the dose or the 
frequency fields are blank, this field is not calculated automatically.

Daily Dose Units This value is derived automatically from the dose unit.

 Regimen Dosage This value is calculated automatically depending on the daily dose, 
duration, and frequency. This total can be overridden. If the daily dose 
is blank or the frequency fields are 0, this field is not calculated 
automatically.

 Regimen Dosage 
Unit

This value is derived depending on the Daily Dose Units.
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Study Drug Information  You can enter a Study Drug for a Non-Configured Study entered 
in a case and mark a current product as a study drug.

To mark a product as a study drug
1. Right click on any suspect product in the case.

2. Select Make Study Drug to mark the current product as a study drug.

Be aware of the following:

■ The system disables the drug type to make the product a Concomitant or 
Treatment option.

■ Study Drug is a read-only field that contains the product name selected by the 
user.

■ For non-configured studies in the case, the system displays the following for all 
study drugs in the case:

Study Drug Not Administered.

Products Tab: Device Tab
The Device tab enables you to enter information about devices being used for a 
particular case. It has the following subsections:

■ Product Informationi

■ Product Indication

■ Product Delivered by Device

■ Device Information

 Product Information Section  The following is an illustration of the Product Information  
section of the Device tab.

 Route of 
Administration

Select the route of administration. The Administrator can adjust this 
list.

Parent Route of 
Administration

Select the route of administration for the parent. The Administrator can 
adjust this list.

Accidental Exposure Select the type of Accidental Exposure from the list. A non-modifiable 
list of items is provided for this list.

Package ID Enter the package ID.

Pack Units Select the package presentation information of the product. The 
Administrator can adjust this list.

Batch/Lot # Enter the batch and/or lot number(s).

Expiration Date Enter the expiration date. Enter a partial date if the full date is not 
known.

(New) Tab Click this tab to create a new dosage regimen entry.

Field/Control Name Description
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 Fields and Field Descriptions
The following table lists and describes the fields in the  section.

Field/Control Name Description

QC Info Click QC Info to enter quality control information in the Quality 
Control dialog box.

Multiple Language 
Text

Click Multiple Language Text to open the Multiple Language Text dialog 
box.

Notes Click the Notes icon to enter notes related to the product.

Select Displays the product selection dialog.

Select a product from the list of company products click Select.

The relevant fields are added to the Case Form.

Encode Click Encode to retrieve the code.

Suspect/ 
Concomitant/ 
Treatment

Make the appropriate selection for the product you are entering. The 
drug types indicate the involvement of the product with the adverse 
event(s) reported for the case.

Suspect indicates that the product may have caused the adverse event(s).

Concomitant indicates drugs that are taken with the suspect drug.

Treatment is the drug taken to treat the adverse event.

Product Name Enter the name of the product using the Select button or by entering a 
partial product name. Type a partial product name and press TAB. This 
displays the Product Selection dialog. If only one product is found, this 
information is entered without showing the dialog. If no match is found 
in the company product list, the WHO Drug Dictionary is searched for a 
possible match through the WHO Drug Dictionary Dialog. If a match is 
still not found, the text you initially typed in, is used as is.

Note: If the study is blinded, the Blinded Name of the clinical study is 
displayed in this field. If a user has access, the selected Study Product 
Name for Unblinded cases is shown.

Generic Name Enter the generic name of the drug in a manner similar to the Product 
Name. If the study is blinded, the Generic Name is replaced with the 
Study Name of the product.

Note: This name is entered automatically depending on the chosen 
company product.

Company Drug Code Displays the licensed country for the selected company product.

Obtain Drug Country Country the drug is licensed in.

Drug Code Enter the WHO-DRUG code.

WHO Medicinal 
Product ID

Displays the Medicinal ID associated with the selected WHO drug.

Note: This ID is populated only if a WHO-drug is selected.
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Searching for Products  You can perform two types of searches in the  section:

■ Product Browser Search

■ WHO Drug Coding Search

Product Browser Search
To search for a product

1. Click Select in the Products tab.

2. The Product Browser dialog is displayed.

Device Type Indicates the type of device being used for this case.

Formulation Select the formulation of the product. The Administrator can adjust this 
list.

Note: This field is entered automatically depending on the product.

Drug Authorization 
Country

Enter the company drug code.

Note: This name is entered automatically depending on the chosen 
company product.

Manufacturer A different Manufacturer can be selected from the drop-down list and 
can still be kept as a company product.

Concentration After a drug and formulation have been entered, select the concentration 
from the list, or enter the concentration. If this information is changed 
manually, the product is marked as a non-company product.

Note: This field is entered automatically depending on the chosen 
product. The concentration cannot be modified for a Study drug.

Units Select a concentration unit. The Administrator can adjust this list.

Interaction? Indicates whether the case involves a drug interaction

Contraindicated? Indicates whether the drug was administered contrary to its indication. 
Make the appropriate selection to indicate whether the drug was 
contraindicated in this case.

Study Drug Select the study treatment the patient received from the list. If the study 
is Blinded, this field is disabled. The Administrator can adjust the 
information in this list. Drugs listed here are dependent on the Study ID 
selected for the General tab.

Note: This field is applicable for Unblinded or not blinded clinical trial 
cases only.

Field/Control Name Description
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3. Click Select to start searching.

4. When the system opens the Product Browser dialog box, Click the entities 
displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For 
example, if Product Name is searched, it displays the Product Name as well as the 
Family Name and Trade Name.

5. Search for Products based on the following criteria:

■ Ingredient

■ Family

■ Product Name

■ Trade Name - Searches the License Trade Name

6. Click the Full Search check box to select all these criteria when searching.

7. Click Select.

8. The results based on the search criteria are displayed and the user can select the 
Product.

9. Click Clear to remove the entered search criteria.

WHO Drug Browser Search
Be aware of the following when using the WHO Drug Browser search function:

■ The system enables you to perform a full search from the WHO Drug browser 
when you select the Full Search option.

– By default, the system performs a like search (e.g., CUREALL%)

– You can use the percent (%) sign to perform wildcard searches

– If you click Full Search, the system performs a full search (e.g., %CUREALL%)
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■ The system also enables you to search for drug formulation and country. However, 
this is available only if you select the WHO Drug C format. Otherwise, the option 
is disabled.

■ When you click Clear, the system clears the search criteria you entered.

■ After the system performs the search, you can sort the results on all the fields.

To perform a WHO Drug Browser Search
1. Select the Encode button to open the WHO Drug Coding dialog.

2. You can use both the WHO Drug B Format as well as the WHO Drug C Format 
using the same browser.

Select either the WHO Drug B format or the WHO Drug C format from the Case 
Form Configuration dialog where the Dictionaries are chosen for encoding.

3. Enter your search criteria in these fields and click Search to display the product 
attributes that match the given search criteria:

■ Trade Name - the trade name of the product

■ Formulation / Strength - the Formulation / Strength (sequence 3 and 
sequence 4) of the product.

■ Country - The Sales Country Code of the Product as defined in the WHO 
Dictionary

■ Generic - Whether Generic - Yes or No.

The following criteria are not available for display or searching in the WHO 
Drug B Format:

– Formulation

– Strength 

– Generic

– Medicinal Product ID
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– Product Type

4. Click Select to copy the selected drug to the Product tab.

5. Click Cancel to close the selection dialog without making any updates to the 
Product tab.

The WHO Drug Coding Dialog has the following fields:

J Drug Browser  

When using the J Drug browser, be aware of the following:

■ Clicking Enclode enables the Drug Coding (J-Drug) dialog box.

■ The system store both the WHO and the J codes. 

■ The system uses the WHO drug code in the English screen for global cases.

■ You can search for a product by typing the product name in the Description field 
and/or entering the drug code in the Code field and clicking Search.

■ The system searchs the J Diction and returns a list of products in Japanese 
character order.

■ The system places a list of prodcts from J Drug in the "Proprietary J-Drug" list box. 
Scroll through the list and click a product to select it. Click Select to choose the 
product used for the case.

■ When you click Select, the system closes this screen and populates the following 
fields in the Case Form:

– Product Name

– Generic Name

– J Drug Code

Entering Quality Control Information  You can enter quality control information by clicking 
the QC Info button and entering the appropriate information in the Quality Control 
dialog box. Click the following link to see an illustration of the Quality Control dialog 
box and information about the fields in it.

About the Quality Control Dialog Box
The following is an illustration of the Quality Control dialog box.

Field Description

Product Type Select the type of product from the drop-down list. Note: All is 
displayed as the Product Type by default.

ATC Code Enter the ATC Code up to a maximum of 10 characters.

Drug Code / 
Medicinal Prod ID

Searches on either criterion as per the radio button selected for the 
search. By default, the Drug Code option is selected.

Trade Name / 
Ingredient

Searches on either criterion as per the radio button selected for the 
search. By default, the Trade Name option is selected.

Formulation Enables you to search based on the drug formulation.

Country Enables you to search for a drug based on the country where the drug 
was sold.
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The following table lists and describes the fields in the Quality Control dialog box.

Field Description

QC Safety Date Enter the QC department reference number for the analysis.

QC Sent Date Enter the sent date.

QC Cross Reference Enter the QC department reference number for the analysis.

Date Returned Enter the date returned.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is incorrect, a Lot 
Number Lookup dialog is displayed, that allows you to enter select 
from the existing lot numbers.

Complaint 
Categories Date

Enter a date for complaint categories.

Complaint 
Categories Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Categories 
Date

Enter a date for analysis categories.

Analysis Categories 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Summary 
Date

Enter a date for an analysis summary.

Analysis Summary 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

QC Result Date Enter the date the result of the analysis was received by the QC 
department.
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Product Indication Section  The following is an illustration of the Product Indication 
section of the Device tab.

Product Indication Fields and Field Descriptions
The following table lists and describes the fields in the Product Indication section.

QC Result Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

QC Comment Enter any comment relating to the analysis.

Field/Control 
Name Description

Reported 
Indication

By default, the value of this field is populated with the Product Indication 
from the Product Configuration, if set up by the user. If not, you can enter a 
term into the Reported Indication field.

Note: Argus Safety automatically encodes this information. You can also 
click Encode to open the coding dictionary dialog.

Coded Indication This field is populated with the encoded term when the user enters data in 
the reported indication field and tabs out.

Encode 
(Indication)

Opens the MedDRA Browser with the term already populated from the 
Coded Indication field.

Note: To view the complete MEDDRA hierarchy for the encoded term, click 
the Encoding Status icon.

Add Adds a new Indication row.

Note: Only two indications are visible at a time

Delete Click this button to delete the selected Indication row.

M/W Info The MW Info dialog allows you to enter the following device information:

■ Usage of Device: Make the appropriate selection to indicate whether 
the use of the suspect medical device was the initial use, reuse, or 
unknown.

■ Is this a single-use device that was reprocessed and reused on a 
patient?: Indicate whether the device was labeled for single use. If the 
question is not relevant to the device being reported (for example, an 
X-ray machine), leave the select box cleared.

■ Single Use Device: This field will be populated by information on the 
form.

■ Name and Address of Reprocessor: Enter the name and address of the 
reprocessor.

Field Description
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■ Device Evaluated by Mfr: Select the Not returned to mfr. check box if 
an evaluation could not be made because the device was not returned 
to or made available to the manufacturer. Select Yes if an evaluation 
was made for the suspect medical device. You can attach a summary of 
the evaluation and select the Yes,Summary Attached. If an evaluation 
of a returned suspect or related medical device was not conducted, 
select the No check box and attach an explanation or provide an 
appropriate code from the coding manual (Part II, Subpart A).

■ If no, provide reason: If the Device Evaluated by Mfr is "No," then 
select a reason from the drop down.

■ Type of Follow-up Report: Select the appropriate check boxes that most 
accurately describe the nature of the follow-up (supplemental) report 
as follows:

■ Correction - Changes to previously submitted information.Additional 
information - Information concerning the event that was not provided 
in the initial report because it was not known/available when the 
report was originally submitted.Response to FDA request - Additional 
information requested by FDA concerning the device/event.Device 
evaluation - Evaluation/analysis of device.

■ Evaluation Codes: Click Select to enter the applicable codes from the 
categories listed. Follow the instructions in the dialog to enter the 
evaluation codes. Conclusion codes must be entered even if the device 
was not evaluated.

■ USC 360i(f) correction/removal reporting number: Enter the number 
that the FDA assigned to the corrective action. If the FDA has not yet 
assigned a number, the internal number assigned to the action by the 
company is used.

■ If remedial action indicated, check type: Select the applicable actions. If 
other, specify the type of action in the space provided (for further 
reference, see 21 U.S.C. 360h and 21 CFR part 803).

■ Additional manufacturer narrative: Select the check box (if applicable) 
and enter any additional information, evaluation, or clarification of 
data presented in previous sections.

■ Corrected Data: Select the check box if corrected data.

■ Select if the device was an Adverse Event or a Product Problem.

Field/Control 
Name Description
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EU / CA Device The EU/CA Device dialog allows you to enter the device information. 
Fields are marked by either an EU flag or a Canadian flag to indicate which 
entity is mapped to the field. The following list describes each field in 
detail:

■ Accessories Associated Devices: Enter associated devices and/or 
accessories involved in the incident.

■ Software Version: Enter relevant software version.

■ Incident or Near incident: Select the appropriate incidence type.

■ Identification of notified body involved in Conformity Assessment: 
Enter identification number of the Notified Body involved in the 
conformity assessment procedure (if any) and the date(s) of the 
attestation(s).

■ Was the device labeled sterile?: Select the appropriate choice.

■ Reporting firm is aware of other similar incidents having an impact on 
the current report: Select the appropriate choice.

■ If yes, to which countries: Enter appropriate countries.

■ Device distributed within the following EEA Countries: Enter 
appropriate countries.

■ Current location of device: Enter the present location of the device that 
was involved in the incident.

■ Where was the device purchased: Enter the establishment where the 
device was purchased.

■ Address: Enter the address of the location where the device was 
purchased.

■ Expected date of follow-up report: Enter the expected date of 
follow-up report.

■ Importer: Enter the name, address, telephone, and fax of the importer.

■ Initial Corrective Action: Enter corrective action for the Initial report.

■ Initial Project Timing: Enter projected timing for the Initial report.

■ Final Corrective Action: Enter corrective action for the Final report.

■ Final Project Timing: Enter projected timing for the Final report.

■ Investigation Result: Enter the results of investigation from the 
follow-up.

■ Further Investigation: Enter the details of further investigation from 
the follow-up.

CID Number Enter the Control Identification Number.

Global ID Enter the Global Identification number. When you add a second device 
product to a case that already contains a device product with a Global ID 
number, the same number populates the new device added. Changing the 
Global ID number for the new product updates all products in the case to 
have the same Global ID number.

Device 
Subcomponent 
Name

Select the sub-component of the device.

Device 
Subcomponent 
Lot#

Enter the lot number for the sub-component of the device.

Field/Control 
Name Description
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Product Delivered by Device Section  The following is an illustration of the Product 
Delivered by Device section

Product Delivered by Device Fields and Field Descriptions  The following table lists and 
describes the fields in the Product Delivered by Device section.

Device Information Section  This section enables you to enter information about the 
device being used. The following is an illustration of the section.

Device Information Fields and Field Descriptions  When using the Device Information 
section, be aware of the following:

■ You can enter up to 20,000 characters in the Additional Manufacturer Narrative 
field.

■ The device evaluation codes have been updated to reflect FDA standards. Go to 
the following link for more information: 
http://www.fda.gov/cdrh/mdr/373_appdxb.html.

■ The evaluation method is available is the following site: 
http://www.fda.gov/cdrh/mdr/373.html.

■ The evaluation results are available at the following site: 
http://www.fda.gov/cdrh/mdr/373_appdxd.html.

The following table lists and describes the fields in the Device Information Section

Field/Control Name Description

Type of Drug Select the type of drug from the drop-down list.

Other Mfg Product Displays the Other Manufacturing Product.

Add Adds another row.

Delete Deletes the highlighted row.

Field/Control Name Description

Lot # Enter the lot number of the device.

Expiration Date Enter the expiration date. Enter a partial date or no date if the full date 
is not available.

Date of Mfg Enter the month and year of manufacture of the suspect medical device.
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EU/CA Device Dialog Fields and Field Descriptions
The EU/CADevice Fields dialog includes the following fields:

■ NCA Reference Number

■ Identify to what other NCA's this report was also sent

■ Number of Patients Involved

■ Number of Devices Involved

■ User facility reference number

■ Remedial Action by HC Facility

■ Usage of Medical Device

■ Other

Device Age (Approx.) Enter the age of the device.

Model # Enter the model number of the device.

Serial # Enter the serial number of the device.

Catalog # Under Catalog#, enter the exact catalog number as it appears in the 
manufacturer's catalog, device labeling, or accompanying packaging.

Other # Under Other #, enter any other applicable identification number (for 
example: component number, product number, part number, bar-coded 
product ID).

Date Implanted If the device is implantable, enter the date of the implant. Enter a partial 
date if the full date is not available.

Date Explanted If the device is implantable, enter the date of the explant, if any. Enter a 
partial date if the full date is not available.

Improper 
Use/Storage

Indicate if the device was improperly used or stored.

Operator of Device Select the type of person operating or using the suspect medical device 
on the patient at the time of the event. For instance, Health Professional 
applies to a physician, nurse, or respiratory therapist. Lay User applies 
to the person being treated, a parent, or a spouse. Other applies to a 
nurse's assistant, or orderly.

If other If the operator of the device is other, enter the operator of the device.

Trained User Indicate if the operator of the devices was trained to use the device.

Device Available for 
Evaluation

Indicate whether the device is available for evaluation. Also, indicate 
whether the device was returned to the manufacturer and if so, the date 
of the return.

Preliminary 
Comments

Enter or select preliminary comments.

Malfunction Indicate if the devices malfunctioned.

Malfunction Type Make the appropriate selection to indicate the type of reportable event. 
For an event associated with a malfunction, the FDA refers users to 
applicable sections in 21 CFR Part 803 reporting guidelines.

Manufacturer/Impor
ter Awareness Date

Enter the date when the manufacturer became aware of the event

Return Date Enter the Device Return Date.

Field/Control Name Description
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■ Update to Initial Report (Follow-up Report)

■ Final Report

The following table provides attribute information for the device fields

When you select the EU/CA Device option, the system prints the fields on the Case 
form. The system tracks the fields and any updates in the audit log.

Products Tab: Vaccine Tab
The Vaccine section of the Products tab enables you to enter information about a 
vaccine. The Vaccine tab includes the following sections:

■ Product Information

■ Product Indication

■ Vaccine Information

 Product Information Section
The following is an illustration of the  section on the Vaccine tab.

 Fields and Field Descriptions
The following table lists and describes the fields in the Product Information section.

Field/Control Name Name Field Length Field Type

NCA Reference Number 100 characters Alphanumeric

Identify to what other NCA's 
this report was also sent

2000 characters Alphanumeric

Number of Patients Involved 3 characters Numeric

Number of Devices 3 characters Numeric

User facility reference number 20 characters Alphanumeric

Remedial Action by HC 
Facility

1000 characters Alphanumeric

Usage of Medical Device N/A Check box

Other 15 characters Alphanumeric

Update to Initial Report 
(Follow-up Report)

N/A Check box

Final Report N/A Check box

Field/Control Name Description

Notes Enter notes related to the product.

WHO Medicinal 
Product ID

Displays the Medicinal ID associated with the selected WHO drug.

Note: This ID is populated only if a WHO-drug is selected.

Obtain Drug Country Enter the country where the drug was purchased.

Drug Authorization 
Country

Displays the licensed country for the selected company product.
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Product Name Enter the name of the product using the Select button or by entering a 
partial product name.

Type a partial product name and press TAB. This displays the Product 
Selection dialog. If only one product is found, this information is 
entered without showing the dialog. If no match is found in the 
company product list, the WHO Drug Dictionary is searched for a 
possible match through the WHO Drug Dictionary Dialog. If a match is 
still not found, the text you initially typed in, is used as is.

Note: If the study is blinded, the Blinded Name of the clinical study is 
displayed in this field. If a user has access, the selected Study Product 
Name for Unblinded cases is shown.

Select Displays the product selection dialog.

Select a product from the list of company products click Select.

The relevant fields are added to the Case Form.

Drug Code Enter the WHO-DRUG code.

Encode Click Encode to retrieve the code.

Suspect/Concomitan
t/Treatment

Make the appropriate selection for the product you are entering. The 
drug types indicate the involvement of the product with the adverse 
event(s) reported for the case.

Suspect indicates that the product may have caused the adverse 
event(s).

Concomitant indicates drugs that are taken with the suspect drug.

Treatment is the drug taken to treat the adverse event.

Generic Name Enter the generic name of the drug in a manner similar to the Product 
Name. If the study is blinded, the Generic Name is replaced with the 
Study Name of the product.

Note: This name is entered automatically depending on the chosen 
company product.

Company Drug Code Enter the company drug code.

Note: This name is entered automatically depending on the chosen 
company product.

Manufacturer A different Manufacturer can be selected from the drop-down list and 
can still be kept as a company product.

Study Drug Select the study treatment the patient received from the list. If the study 
is Blinded, this field is disabled. The Administrator can adjust the 
information in this list. Drugs listed here are dependent on the Study ID 
selected for the General tab.

Note: This field is applicable for Unblinded or not blinded clinical trial 
cases only.

Formulation Select the formulation of the product. The Administrator can adjust this 
list.

Note: This field is entered automatically depending on the product.

Interaction? Indicates whether the case involves a drug interaction

Contraindicated? Indicates whether the drug was administered contrary to its indication. 
Make the appropriate selection to indicate whether the drug was 
contraindicated in this case.

Field/Control Name Description
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Searching for Products  You can perform two types of searches in the  section:

■ Product Browser Search

■ WHO Drug Coding Search

To perform a search in the Product Browser dialog box  1.Click Select in the Products tab.

2. The Product Browser dialog is displayed.

3. Click Select to start searching.

4. When the system opens the Product Browser dialog box, Click the entities 
displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For 
example, if Product Name is searched, it displays the Product Name as well as the 
Family Name and Trade Name.

5. Search for Products based on the following criteria:

■ Ingredient

■ Family

■ Product Name

■ Trade Name - Searches the License Trade Name

6. Click the Full Search check box to select all these criteria when searching.

7. Click Select.

8. The results based on the search criteria are displayed and the user can select the 
Product.

9. Click Clear to remove the entered search criteria.

WHO Drug Browser Search  Be aware of the following when using the WHO Drug 
Browser search function:

■ The system enables you to perform a full search from the WHO Drug browser 
when you select the Full Search option. 

– By default, the system performs a like search (e.g., CUREALL%)

– You can use the percent (%) sign to perform wildcard searches

– If you click Full Search, the system performs a full search (e.g., %CUREALL%)

■ The system also enables you to search for drug formulation and country. However, 
this is available only if you select the WHO Drug C format. Otherwise, the option 
is disabled.

■ When you click Clear, the system clears the search criteria you entered.

Concentration After a drug and formulation have been entered, select the 
concentration from the list, or enter the concentration. If this 
information is changed manually, the product is marked as a 
non-company product.

Note: This field is entered automatically depending on the chosen 
product. The concentration cannot be modified for a Study drug.

Units Select a concentration unit. The Administrator can adjust this list.

Field/Control Name Description



Case Form Functions

4-54 Oracle Argus Safety Japanese User's Guide

■ After the system performs the search, you can sort the results on all the fields.

To perform a WHO Drug Browser Search
1. Select the Encode button to open the WHO Drug Coding dialog.

2. You can use both the WHO Drug B Format as well as the WHO Drug C Format 
using the same browser.

Select either the WHO Drug B format or the WHO Drug C format from the Case 
Form Configuration dialog where the Dictionaries are chosen for encoding.

The WHO Drug Coding Dialog has the following fields:

3. Enter your search criteria in these fields and click Search to didisplay the product 
attributes that match the given search criteria:

■ Trade Name  -- the trade name of the product

■ Formulation / Strength  -- the Formulation / Strength (sequence 3 and 
sequence 4) of the product.

■ Country  -- The Sales Country Code of the Product as defined in the WHO 
Dictionary

■ Generic - Whether Generic - Yes or No.

The following criteria are not available for display or searching in the WHO 
Drug B Format:

– Formulation

– Strength

– Generic

– Medicinal Product ID

– Product Type

4. Click Select to copy the selected drug to the Product tab.

5. Click Cancel to close the selection dialog without making any updates to the 
Product tab.

Entering Quality Control Information  You can enter quality control information by clicking 
the QC Info button and entering the appropriate information in the Quality Control 
dialog box. Click the following link to see an illustration of the Quality Control dialog 
box and information about the fields in it.

Field/Control Name Description

Product Type Select the type of product from the drop-down list. Note: All is 
displayed as the Product Type by default.

ATC Code Enter the ATC Code up to a maximum of 10 characters.

Drug Code / Medicinal 
Prod ID

Searches on either criterion as per the radio button selected for the 
search. By default, the Drug Code option is selected.

Trade Name / 
Ingredient

Searches on either criterion as per the radio button selected for the 
search. By default, the Trade Name option is selected.

Formulation Enables you to search based on the drug formulation.

Country Enables you to search for a drug based on the country where the 
drug was sold.
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About the Quality Control Dialog Box
The following is an illustration of the Quality Control dialog box.

The following table lists and describes the fields in the Quality Control dialog box.

Field/Control Name Description

QC Safety Date Enter the QC department reference number for the analysis.

QC Sent Date Enter the sent date.

QC Cross Reference Enter the QC department reference number for the analysis.

Date Returned Enter the date returned.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is incorrect, a Lot 
Number Lookup dialog is displayed, that allows you to enter select 
from the existing lot numbers.

Complaint 
Categories Date

Enter a date for complaint categories.

Complaint 
Categories Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Categories 
Date

Enter a date for analysis categories.

Analysis Categories 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Summary 
Date

Enter a date for an analysis summary.

Analysis Summary 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.
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Product Indication Section
The following is an illustration of the fields in the Product Indication section of the 
Vaccine tab.

Product Indication Fields and Field Descriptions
The following table lists and describes the fields in the Product Indication section.

QC Result Date Enter the date the result of the analysis was received by the QC 
department.

QC Result Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

QC Comment Enter any comment relating to the analysis.

Field/Control Name Description

Product Indication Section

Reported Indication By default, the value of this field is populated with the Product 
Indication from the Product Configuration, if set up by the user. If not, 
you can enter a term into the Reported Indication field.

Note: Argus Safety automatically encodes this information. You can 
also click Encode to open the coding dictionary dialog.

Coded Indication This field is populated with the encoded term when the user enters 
data in the reported indication field and tabs out.

Encode (Indication) Opens the MedDRA Browser with the term already populated from the 
Coded Indication field.

Note: To view the complete MEDDRA hierarchy for the encoded term, 
click the Encoding Status icon

# of Siblings Enter the number of siblings for patients who are children under the 
age of five.

Birth Weight For patients who are children under the age of five, enter the birth 
weight. For example: 3260g, 3.26kg, or 7lb 4oz. If a number without 
units is entered, the following units are assumed: < 32 - Pounds 32-200 - 
Ounces >200 - Grams

Birth Weight Units Select the appropriate weight units.

Add Adds a new Indication row.

Note: Only two indications are visible at a time

Delete Click this button to delete the selected Indication row.

Order Allows the user to move an indication up and down.

Obtain Drug Country Enter the country where the drug was purchased.

Interaction Indicates whether the case involves a drug interaction

Contraindicated? Indicates whether the drug was administered contrary to its indication. 
Make the appropriate selection to indicate whether the drug was 
contraindicated in this case.

Field/Control Name Description
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Product Details Section
The following is an illustration of the Product Details section.

Product Details Fields and Field Descriptions
The following table lists and describes the fields in the Product Details section.

Vaccine Information Section
The following is an illustration of the Vaccine Information section. It has the following 
sections:

■ Vaccine Information

■ Vaccine Administration

■ Prior Adverse Events

■ Vaccine History

Field/Control Name Description

Product Details Section

Action Taken Select the appropriate term. If you select Dose Increased or No change, 
the dechallenge and rechallenge fields are disabled. The Administrator 
can adjust this list.

Dechallenge Results Indicates the drug stopped for the purpose of determining if it was the 
drug that caused the adverse event. Click the appropriate button

Date Enter the date the dechallenge was carried out

Taken Previously / 
Tolerated

Select the appropriate response from the list.

Rechallenge Results Make the appropriate selection depending on whether the drug was 
taken again. If Pos or Neg or UNK is selected for the Rechallenge field, 
the Rechallenge Start Date/Time, Rechallenge Stop Date/Time, and 
the Rechallenge Outcome fields are enabled.

Start Date/Time Enter the date and/or time when the rechallenge was started.

Stop Date/Time Enter the date and/or time when the rechallenge was stopped.

Abuse Select this check box if the patient abused the product (For example: 
Painkillers taken without pain).

Overdose Select this check box if the patient took an overdose of the product.

Tampering Select this check box if the product appeared to have been tampered 
with before it was used.
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Vaccine Information Fields and Field Descriptions
The following table lists and describes the fields in the Vaccine Information section.

Field/Control Name Description

Start Date/Time Enter the vaccination date. Enter a partial date if the full date is not 
available.

Dose Number Enter the vaccine dose number.

Dose Enter the vaccine dose.

Units Select the dose unit. The Administrator can adjust this list.

Patient Route of 
Administration

Enter the route of administration or a short code for the route of 
administration. The system automatically decodes your entry. The 
Administrator can adjust this list.

Parent Route of 
Administration

Enter the route of administration or a short code for the route of 
administration. The system automatically decodes your entry. The 
Administrator can adjust this list.

Anatomical Location Select the anatomical location of the vaccination. The Administrator can 
adjust this list.

Package ID Enter the package ID.

Batch / Lot # Enter the batch and/or lot number(s).

Expiration Date Enter the expiration date. Enter a partial date or no date if the full date 
is not available.

Vaccine 
Administration

Enter the Vaccine Information. Items entered here are used to complete 
the VAERS form.

Prior Adverse Events Enter the Prior Adverse Events.

Vaccine History Enter the vaccine history.
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Entering Vaccine Administration Information  The following is an illustration of the Vaccine 
Administration form.

To enter vaccination information
1. Enter the relevant vaccination information items in the form.

2. Click OK to save the entered vaccine information.

The following table lists and describes the fields in the Vaccine Administration form.

Field/Control Name Description

General Information

Vaccinated At Select the most appropriate item from the list to describe where the 
patient was vaccinated.

State Enter the state where the patient was vaccinated.

County Enter the county where the patient was vaccinated.

Purchased With Select the most appropriate item from the list to describe how the 
vaccine was purchased.

Person Completing 
Form Relationship to 
Patient

Select an appropriate item from the list.

Reported Previously Select an appropriate item from the list.

Illness at time of 
Vaccination

Enter the illness, if known.

CDC/FDA VAERS # Enter the verification number.

Required ER Visit Select this check box if the event required a visit to the emergency room 
or doctor.

Administrator

Administered By Enter the name of the person who administered the vaccine.

Resp. Physician Enter the name of the physician responsible for the patient.

Facility name Enter the name of the facility where the vaccine was administered.

Address Enter the address of the facility where the responsible physician works.

City Enter the city of the facility where the responsible physician works.

State Enter the state of the facility where the responsible physician works.

Postal Code Enter the postal code of the facility where the responsible physician 
works.

Phone Enter the telephone number of the facility where the responsible 
physician works.
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Entering Prior Adverse Events Information  The following is an illustration of the 
VaccinePrior Adverse Events form.

To enter prior adverse events information
1. Enter the relevant vaccination information items in the form.

2. Click OK to save the entered prior vaccination adverse event information.

The following table lists and describes the fields in the Vaccine Prior Adverse Events 
form.

Vaccine History Section
The following is an illustration of the Vaccine History section of the screen.

Vaccine History Fields and Field Descriptions
The following table lists and describes the fields in the Vaccine History section.

Field/Control Name Description

Patient Select whether the details refer to the patient or to a sibling.

Vaccine Enter the name of the vaccine.

Dose # Enter the dose number of the vaccine.

Age Enter the patient's age at onset of the event.

Age Units Select the appropriate age unit from the list.

Adverse Events Enter a term that describes the adverse event.

Field/Control Name Description

Date Enter the date of vaccination. Enter a partial date if the full date is not 
available.

Route of Admin Enter the route of administration or a short code for the route of 
administration. The system automatically decodes your entry. The 
Administrator can adjust this list.

Vaccine Enter the name of the vaccine.

Anatomical Location Select the anatomical location of the vaccination. The Administrator can 
adjust this list.

Dose # Enter the vaccine dose number.

Manufacturer Enter the vaccine manufacturer or select a manufacturer. The 
Administrator can adjust this list.
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Events Tab
The Events tab enables you to enter or view details for adverse events associated with 
a case. The following is an illustration of the Events tab.

General Usage Information
When using the Events tab, be aware of the following:

– You can change the listedness for a drug at the individual level.

– This limitation also applies to the Medical Review and Local Labeling dialogs.

■ The field labels for the Event Assessment tab are updated and configured on the 
Argus Console

■ When you modify the Event outcome on the Events Tab, and the event outcome 
and case outcome don't match, the system displays the following message:

Case Outcome may no longer match events.

■ If the Death Seriousness criteria on the Event tab are unchecked, the event 
outcome reverts to empty and is not set to fatal.

■ On the Death Details screen, the Autopsy Results field defaults to blank instead 
of No. If the value is incorrectly set, the system sets it to null during the upgrade.

Dose Enter the vaccine dose.

Units Select the dose unit. The Administrator can adjust this list.

Batch & Lot # Enter the batch and/or lot number(s).

Add Adds a new Indication row.

Note: Only two indications are visible at a time.

Delete Click this button to delete the selected Indication row.

Field/Control Name Description
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■ On the Event Assessment tab, the system displays the Notes icon beside the event 
term if the preferred term has associated notes on the datasheet.

■ If the datasheet does not have notes for the preferred term, the system does not 
display the Notes icon.

■ This is also true for the Medical Summary and the Local Labeling dialog

■ When you click the Notes icon, the system displays the notes in read-only mode.

■ The system populates the "To be coded" value on the MedDRA popup dialog box 
when you click the green checkbox for the MedDRA hierarchy. This applies to the 
following area where the MedDRA dialog box appears.

– Patient Tab: Other Relevant History: Description

– Patient Tab: Other Relevant History: Reaction

– Patient Tab: Other Relevant History: Indication

– Patient Tab: lab Tests

– Product Tab: Product Indications

– Event Tab: Event Coding

– Analysis Tab: Company Diagnosis Syndrome

– Console: Business Configuration: Products: Datasheets

– Console Business Configuration: Products: Product Indications

– Console: Codelists: Lab Tests

– Console: Codelists: Always Serious Term List

■ The Event to Exclude from Report Field enables you to identify information not to 
include in a PMDA expedited report.  

– The default for this check box is unchecked.

– When this check box is checked, you are required to enter a justification for 
this action in the Reason to Exclude from Report dialog box.

– After you enter the justsification, the system places a symbol to the right of the 
field.

– You must have at least one event in a report. If you try to exclude all events 
from the report, the system presents the following message: "All the events are 
excluded from reports. If you want to  report, at least one event is necessary. 
Proceed?" 

– The system does not retrieve evenst that are excluded from a report as part of 
CSPSR (Clinical Study Periodic Safety Report) unless it has been configured to 
include them in such a report.  

The following is an illustration of the MedDRA dialog box.
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When you click the Recalculate button, the system does not recalculate listedness 
where the Event Assessment Listedness already has a case justification ( generated 
automatically or manually overwritten).

Field Properties for Help Text/Default Labels  The following table describes the field 
properties for the Help Text/Default Labels.

Field Calculations
The following table describes the calculations the system uses for each field.

Default Field Label Default Help Text

Onset from First Dose This date is defined as the earliest regimen start date to 
Onset and is completed automatically.

The Date calculation is based on the Case Form 
Calculation for Inclusive or Exclusive

Onset from Last Dose This date is defined as the latest regimen stop date to 
Onset and is completed automatically.

The Date calculation is based on the Case Form 
Calculation for Inclusive or Exclusive.

Total Dose to Event The system calculates this value based on daily dose 
and duration.

Units The system provides this value based on the dosage 
units entered.

Action Taken Select the appropriate term from the drop-down list 
(e.g., Dose Increased, Withdrawn, etc.). The 
Administrator may adjust the values in this list.

Other The value can only be entered when the Action Taken is 
"Other."

Dechallenge Results Select the appropriate option.

Rechallenge Results Select the appropriate option.

Event occurred as consequence of Select the appropriate option.

Term Select the appropriate option.

Most Important Diagnosis? Select the appropriate option.

Event more specific/severe than PT? Select the appropriate option.
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Events Tab: Event Tab
The Event information tab enables you to encode adverse events, record the criteria for 
the seriousness of each event, and display the results of automated assessments to 
determine whether events are listed in data sheets. It also lists the licenses for the data 
sheets. The Event information tab includes the following sections:

■ Event Information

■ Event Coding

■ Seriousness Criteria

■ Nature of Event

■ Details

Field Calculation

Total Dosage The sum of all Total Regimen Dosages.

First Dose to Onset The system calculates this value based on the first dose stop date and 
the event onset date, if present.

If any regimen start date is null, the system sets the First Dose to Onset 
is to null.

The system does not automatically use partial date entries for the 
Regimen Start and Stop Date/Time fields to calculate First Dose to 
Onset.

The user can overwrite this field.

Last Dose to Onset The system calculates this value based on the last dose stop date and 
the even onset date, if present.

If the regimen start date is null, the system sets the Last Dose to Onset 
is to null.

The system does not automatically use partial date entries for regimen 
Start and Stop Date/Time fields to calculate the Last Dose to Onset.

The user can overwrite this field.
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Event Information Section  The Event Information section enables you to enter 
information about the event information including diagnosis, patient history, intensity, 
and so forth. 

Event Information Fields and Field Descriptions
The following table lists and describes the fields in the Event Information section.

Field/Control Name Description

Description as 
Reported

Enter the verbatim term used by the reporter, or patient, to describe the 
adverse event. As you type, the term is automatically copied under 
Description to be Coded. Verbatim English translations of foreign 
languages may also be entered here.

Relationships Click the Relationshipsbutton to view the Diagnosis-Event 
Relationships dialog. This allows you to group symptoms and signs 
with diagnoses. This requires at least two events and a diagnosis.

Encode Click this button to search for the term entered under Event 
Description. The entered term is checked in the MedDRA dictionary.

Term Highlighted by 
Reporter

Make the appropriate selection to indicate whether the person 
reporting the event considered it to be serious.

Note: Selecting Yes does not mark this case as Serious automatically.

Diagnosis Make the appropriate selection to indicate whether the event is a 
diagnosis.

Description to be 
Coded

If necessary, the verbatim term can be modified in this field. For 
example, the original term may need to be split, or enhanced with an 
anatomical location. The Administrator can prevent manual encoding 
of the description. If automatic encoding is enabled, the term can be 
auto-encoded to the included term level.

Patient Has Prior 
History?

Make the appropriate selection to indicate whether the patient has had 
a prior history or has suffered from the same event in the past.

Onset Date/Time Enter the date/time when the event started. Enter a partial date if the 
full date is not available.

Onset from Last Dose This field is calculated automatically from the event onset date and 
most recent stop date listed in the dosage regimen details of the suspect 
drug(s). You can also enter or modify the field manually. This field is 
removed if the dosage regimen is ongoing.

Stop Date/Time Enter the date/time when the event stopped.

Duration This field is calculated automatically from the event start and stop 
dates. You can also enter or modify the duration manually.

Onset Latency This field is calculated automatically from the earliest first dose date of 
the suspect drug(s) to onset date. You can also enter or modify the 
duration manually.Note: Onset Latency = Onset Date - First Dose.

Intensity Select the category of severity of the event. The Administrator can 
adjust this list.

Frequency Select the frequency of the event from the list. The Administrator can 
adjust this list.

Was this event 
related to the conduct 
of a study?

For clinical trial cases only. Make the appropriate selection to indicate 
whether the event was associated with the conduct of a study. Consult 
your Administrator for further company-specific information on 
completing this field.

Associated with 
Rechallenge?

Only available if a suspect drug was rechallenged. Make the 
appropriate selection.
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Understanding the Diagnosis-Event Relationship  Argus Safety allows you to group events 
in a case, and/or to associate them with particular diagnoses. These determinations 
can be made by your company or simply as reported to your company. This feature 
aids significantly in the interpretation and review of individual case reports. It is also 
useful in summary reports as it enables the reporting of diagnoses only, while 
retaining database records of individual event terms.

Click the Relationships button in the Event Information section of the Eventstab to 
open the Diagnosis-Event relationship dialog.

Associating a symptom with a diagnosis  Click the up or down arrows to associate a 
selected symptom with a diagnosis. In Argus Safety Web, select the symptom and click 
Move Up or Move Down.

Example:

Such Adverse Events (AE) might be entered into the database as follows:

This example demonstrates how defining a diagnosis-event relationship can clarify an 
adverse event report. Suppose an initial case report describes a patient suffering from 
"Somnolence," "Sore Throat," and "Fever."

AE #     Diagnosis AE Term (Associated AEs)

 1    Somnolence 

Product Only available if event is associated with rechallenge. A list of all 
suspect products that were rechallenged is displayed. Select the 
product associated with this event from the list. You can identify 
multiple products to be associated with a single event.

Dropped from Study 
due to Event

For clinical trial cases only. Select this check box if the subject was 
dropped from the study due to this adverse event.

Treatment Received? Make the appropriate selection to indicate whether the event required 
treatment.

Outcome of Event Select the outcome of the event. The Administrator can adjust this list. 
If Fatal is selected, Death is selected in the list of seriousness criteria.

Note: If the Death check box is subsequently cleared, the outcome still 
remains fatal.

Receipt Date Enter the date on which information about this event was received by 
your company.

Lack of Efficacy Select this check box, if appropriate.

Progression of 
Disease

Select this check box, if appropriate.

Adverse Drug 
Withdrawal Reaction

Select this check box, if appropriate.

Infection Select this check box, if an infection has occurred.

Note:  To use this feature, the case must contain at least two events 
and, at a minimum, one diagnosis. The events related to a diagnosis 
are listed on top in this dialog and the symptoms are indented with 
respect to the diagnoses. You can group events together and associate 
them with individual diagnoses.

Field/Control Name Description
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2    Sore Throat

 3    Fever

For reports on all events, they would appear on a CIOMS-I form as:

■ Somnolence [SEDATION]

■ Sore Throat [SORE THROAT NOS]

■ Fever [PYREXIA]

Suppose a follow-up report then supplies information that the patient also had 
neutropenia, and had been diagnosed as suffering from agranulocytosis (the cause of 
the sore throat and fever). The somnolence was considered to be co-incidental, and 
unrelated to any other adverse events.

Neutropenia and agranulocytosis would be entered onto the system, and a 
diagnosis-event relationship established as follows:

These events would appear on a CIOMS I form as:

■ AGRANULOCYTOSIS

■ [AGRANULOCYTOSIS]  ([SORE THROAT],

■ [PYREXIA NOS], [NEUTROPENIA])

■ Somnolence [SEDATION]

■ This immediately gives a clear clinical picture of the case.

Using the MedDRA Browser  The MedDRA application searches the term dictionary for a 
match at the Lower level term or at the Synonym level. If a match is found, the 
following fields are automatically populated: Term code, Preferred Term, Included 
Term, High Level Term, Group Term and Body System/SOC.

Click the icon to view the MedDRA Browser.

Configuring Regulatory Reporting Rules  The regulatory reporting rules can be configured 
to look at any type of criteria but are mainly configured to look at Seriousness, 
Listedness, Causality, and Outcome. Out of these, Listedness and Causality can be 
captured and controlled (using the event assessment section) down to an individual 
license basis.

This granularity allows individual license holders to override the normal listedness 
and causality assessment to control the need for submissions to their local regulatory 
authority. Each affiliate could either suppress the need for a report by demoting the 
criteria, or add the requirement for a report by promoting the listedness or causality.

This serves to promote the global reporting automation while maintaining the level of 
individual local affiliate control that is often needed.

AE # Diagnosis AE Term (Associated AEs)

1 Yes agranulocytosis

2 (sore throat)

3 (fever)

4 (neutropenia)

5 Somnolence
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Event Coding Section
The Event Coding section enables you to enter information about the event. The 
following is an illustration of the Event Coding section.

The following table lists and describes the fields in the Event Coding section.

When the following fields are encoded, the system enables you to copy either the PT or 
the LLT based on the  "Description as Reported" common profile swith. When the 
application cannot find match Japanese data, it automatically copies the English term 
in the Japanese "Description as Reported" field. The following rule applies to all Argus 
J applications:

When Japanese to English code is executed and the system cannot find matching data, 
you must enter a manual Engish translation in the English split window in the 
"Description as Reported" field as follows:

■ Patient Tab: Patient Lab Data 

■ Patient Tab: Other Relevant History Indication

■ Patient Tab: Other Relevant History Reaction

Note: To obtain an assessment of the adverse event, the product 
must be in the company's suspect product and the event must be 
encoded.

Field/Control Name Description

Body System/SOC Displays the body system or System Organ Class. This item is 
automatically entered from the event dictionary that is used and it 
cannot be edited.

Lower Level Term Displays the ART code. If you have appropriate access rights, click 
Encode to view the associated coding dialog.

Preferred Term Displays the preferred term. This item is automatically entered from the 
event dictionary that is used and it cannot be edited.

Preferred Term Code Displays the preferred term code. This item is automatically entered 
from the event dictionary that is used and it cannot be edited.

High Level Term Displays the High Level Term when the MedDRA coding dictionary is 
used. This item is not displayed when event encoding is done using the 
WHO-ART dictionary. This field cannot be edited.

High Level Group 
Term

Displays the high-level group term when using the MedDRA coding 
dictionary. This field is not shown when coding with WHO-ART. This 
field cannot be edited.
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■ Parent Tab: Other Relevant History Indication

■ Parent Tab: Other Relevant History Reaction

■ Product Tab: Product Indication

■ Event Tab: Event Verbatim

■ Event Tab: Cause of Death

■ Event Tab: Autopsy Results

■ Analysis Tab: Company Diagnosis/Syndrome 

Seriousness Criteria Section
The Seriousness Criteria section enables you to identify how serious the event was. 
For example, did the result in death or was it life threatening. The following is an 
illustration of the Seriousness Criteria section.

Seriousness Criteria Fields and Field Descriptions
The following table lists and describes the options in the Seriousness Criteria section.

Entering Death Details  Use the following procedure to enter details about a death.

1. Select the Death check box under Seriousness Criteria.

2. The form for EventDeath Details appears

Field/Control Name Description

Death Displays the Death Details dialog

Note: If you un-check the Death option in the Seriousness Criteria, 
you are required to confirm the deletion of the death details.

Hospitalized Displays the Event Hospitalization dialog.

Medically Significant Select this check box to display the seriousness as medically significant.

Life-threatening Select this check box to display the seriousness as life-threatening.

Disability Select this check box to display the seriousness as a disability.

Intervention 
Required

Select this check box to display the seriousness as requiring 
intervention.

Congenital Anomaly Select this check box to display the seriousness as a congenital anomaly.

Other Select this check box to enter explanatory text. It is mandatory to enter 
text, specifying the Other Seriousness Criteria.
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3. Enter information for the items in the form.

4. Click OK to save the entered Death Details.

The following table lists and describes the fields in the Event Death Details section.

Entering Hospitalization Details  Use the following procedure to fill out the 
Hospitalization Details form.

To complete the Hospitalization Details form
1. Select the Hospitalized check box under Seriousness Criteria.

2. The form for Hospitalization Details appears.

3. Enter information for the items in the form.

4. Click OK to save the entered Hospitalization Details.

The following tables lists and describes the fields in the Hospitalization Details form.

Field/Control Name Description

Date Enter the date of death. You can enter a partial date if the exact date is 
unavailable.

Autopsy Done? Make the appropriate selection.

Cause of Death Enter a term to describe the cause of death. Click Encode to display the 
associated encoding dialog.

Autopsy Results 
Available?

Make the appropriate selection.

Autopsy Results Enter Information about the autopsy results.
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Nature of Event Section  The Nature of Event section enables you to identify the nature 
of the event from the drop-down list. You can add a maximum of 50 such Nature of 
Event rows.

Details Section  This section enables you to enter notes related to the event. If Reported 
Causality is entered when the case is booked-in, the system automatically transfers it 
to this field. The following is an illustration of the Details section.

Events Tab: Event Assessment Tab
The Event Assessment tab enables you to capture causality and listedness information 
for a case. All encoded events in the case are compared with the listed events for 
company products (agents) associated with the case. The following is an illustration of 
the Event Assessment tab.

Field/Control Name Description

Hospitalization Start 
Date

Enter the first date of the patient's hospitalization associated with this 
adverse event. If the exact date is not available, you can enter a partial 
date in this field.

Hospitalization End 
Date

Enter the last date of the patient's hospitalization associated with this 
adverse event. If the exact date is not available, you can enter a partial 
date in this field.

Duration of 
Hospitalization 

This field is automatically calculated by the system, based on the start 
and end dates entered. This field is calculated using 24-hour 
increments. You can also manually enter the number of days the patient 
was hospitalized.

Event caused initial 
hospitalization

Select this check box if the event is associated with the initial 
hospitalization of the patient.

Event caused 
prolonged 
hospitalization

Select this check box if the event prolonged hospitalization.

Discharge summary 
available

Select this check box if a discharge summary is available.
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Event Assessment Tab Fields and Field Descriptions
The following table lists and describes the fields on the Event Assessment tab.

Filtering in the Event Assessment Tab  The following table lists and describes how the 
system filters each field on the Event Assessment tab.

Field/Control Name Description

Recalculate Refreshes the Event Assessment section with the newly entered data if 
new suspect products or events are entered, or the Event Relationship 
is modified.

Product This field is populated when events are entered in the Products tab and 
is displayed in the following format:

■ First Line - Product Name

■ Second Line - Generic Name

Causality Source This field defines the source of causality calculation.

Causality as Partner This field stores the Partner Level Causality defined within the cases.

Causality as 
Reported

Indicates the degree of reported causality.

Causality as 
Determined

This field is populated automatically, along with the information 
entered in the Reported Causality field.

Event This field is populated when events are encoded and are displayed in 
the following format:

■ First Line - Event PT (Verbatim)

■ Second Line - LLT

D/S Displays the Diagnosis/Symptom details by D or S in line with the 
Events.

Seriousness Severity 
Duration

Displays the Seriousness, Severity and the Duration of the Event.

Datasheet Displays the datasheet(s) for the agent.

License Displays the license(s) for the agent.

Listedness Indicates whether the system found the event on the datasheet for this 
product.

Field/Control Name Description

Product The product filter drop down list contains all products listed in the 
event assessment. The user can filter on all the products which are 
present in the Event Assessment dialog.

Event Contains a drop down of values of distinct Event PT. The user can filter 
on all the products which are present in the Event Assessment dialog.

D/S Contains a drop down values of D for Diagnosis or S for Symptoms.

Datasheet Contains a drop down of values of distinct Datasheets.

Licenses Contains a drop down of values of distinct Countries of the Licenses.

Note:  Only the assessment rows that match the selected criteria 
display in the filtering results.
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User Actions on the Event Assessment Tab  The following table list user actions and the 
results of those actions.

The Event to Exclude from Report Field enables you to identify information not to 
include in a PMDA expedited report. 

■ The default for this check box is unchecked.

■ When this check box is checked, you are required to enter a justification for this 
action in the Reason to Exclude from Report dialog box.

■ After you enter the justification, the system places a symbol to the right of the 
field.

■ You must have at least one event in a report. If you try to exclude all events from 
the report, the system presents the following message: "All the events are excluded 
from reports. If you want to report, at least one event is necessary. Proceed?" 

■ The system does not retrieve events that are excluded from a report as part of 
CSPSR (Clinical Study Periodic Safety Report) unless it has been configured to 
include them in such a report. 

Events Tab: Product -- Event Details Tab
The Product -- Event Details tab enables you to enter information for an adverse event 
related to a specific product. The following is an illustration of the Product -- Event 
Details tab.

Product -- Event Details Tab Fields and Field Descriptions
You can enter data in the following fields at a Product Event combination level:

■ Most important diagnosis?

■ Event more specific/severe than PT?

■ Action taken

■ Other text

■ Onset from First Dose

■ Onset from Last Dose

User Action Result

Click Datasheet 
column's icon

The system does the following:

■ Displays the license view

■ Displays the datasheet view

■ Displays the License column

■ Enables the icon for the License column

Click Product Name 
link

Displays the for the selected product

Click Event 
Description link

Displays the Event Information for the selected event

Click License 
Description link

Displays the as defined in the License Configuration

Click Datasheet 
Description link

Displays all the configured terms in the datasheet
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■ Total Dose to Event

■ Units

■ De-challenge Results

■ Re-challenge Results

■ Event Occurred as a Consequence of

■ Term

Be aware of the following:

■ By default, all the new fields are hidden in the Event Assessment. If all the fields 
are hidden, the system also hides the Product-Event details tab.

■ You can enter data in the Event Occurred as Consequence of field from the type 
ahead.

– When you select the Event Occurred as Consequence of field, the list of 
corresponding values configured in the Argus Console is available for the user 
to select from the Term list.

– You can add or delete elements in the Event Occurred as Consequence of 
fields.

– You can enter a maximum of 20 entities in the Event Occurred as 
Consequence of field. After the user enters 20 entities, the system disables the 
Add button.

■ Filtering for Product. The product Filter drop-down list contains all products 
listed in the event assessment.

– You can filter on products on the Event Assessment dialog.

– By default, the system displays all the products with the <ALL> option.

– When filtering, the system displays only the assessment rows that match the 
product you selected.

■ Filtering for Event. The Event Filter contains a drop-down list of values of distinct 
events.

– You can filter on events in the Event Assessment dialog.

– By default, the system displays all events with the <ALL> option.

– When filtering, the system displays only the assessment rows that match the 
events you selected.

■ The Product Event details are tied to the Event Assessment section. You can 
access these details only if your user group permissions give them access.

■ The system tracks case updates in the audit log.

■ The system prints the additional fields on the Case Form print out. The additional 
fields are linked to the Event Assessment section of the case form printout.

The following table lists and describes the fields on the Product -- Event Details tab.

Field/Control Name Description

Product Enables you to select a product whose event details you want to review.
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Analysis Tab
The Analysis tab enables you to generate or view a narrative description of the case, 
together with other notes. In addition, it also enables you to enter information required 
for generating the MedWatch 3500A, BfArM, and AFSSaPS reports.

The typical users of this tab are responsible for:

■ Making a medical assessment of the case

■ Approving the case for completeness and accuracy.

The following is an illustration of the Analysis tab.

As Reported 
Causality/As 
Determined Event PT 
(Description)/LLT

Enables you to view details about a specific adverse event if more than 
one is associated with this product.

Most Important 
Diagnosis?

Enables you specify whether this is the most important diagnosis.

Event More 
specific/severe that 
PT?

Enables you to indicate whether treatment more serious than PT was 
required for this adverse event.

Onset from First 
Dose

The amount of time from the first dose was taken until the time the 
adverse event occurred.

Onset from Last Dose The amount of time from the last dose was taken until the time the 
adverse event occurred.

Total Dose to Event The total number of doses until the event occurred.

Units The amount of each dose given to the patient.

Action Taken Enables you to enter the action take when the adverse event occurred.

Other Other information related to the adverse event.

Dechallenge Results ~

Rechallenge Results ~

Event Occurred as a 
Consequence of

The cause of the adverse event.

Term ~

Add Click Add to add another row.

Delete Click Delete to delete a specific row.

Field/Control Name Description
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Case Analysis Section
The Case Analysis section of the Case Analysis tab enables you to enter narrative 
information about the adverse event. The following is an illustration of the Case 
Analysis section.

Case Analysis Fields and Field Descriptions
The following table lists and describes the fields in the Case Analysis section of the 
Case Analysis tab.
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Using Auto Narrative Templates
You can select an Auto Narrative template for the Narrative, Case Comment, 
Abbreviated Narrative, Company Comment, and Evaluation in light of similar events 
in the past.

To generate or add narrative templates
1. Click the button to view the Custom Auto Narrative Templates dialog.

2. Select the required Autonarrative from the list.

3. Click Append to append this Autonarrative to the existing narrative.

4. Click Append if this is the first narrative being added to the text area.

5. Click Replace to replace the existing narrative with the selected narrative.

Viewing Differences in Case Narratives  The system enables you to view the differences in 
case comments from previously locked versions of the case. To view these differences, 
click the Show Difference button in the Case Comments section of the Analysis Tab.

When you choose to view the differences in the two narratives, the system does the 
following:

■ Displays the differences in red with a strike out and a yellow highlight.

■ Displays additions to the narrative in black with green highlights.

■ The Narrative is read-only and you cannot modify it.

■ Use the zoom dialog to adjust the font size.

Field/Control Name Description

Narrative Click Generate to generate an auto narrative.

This feature is configured by the Administrator.

If you are not utilizing the auto narrative feature, enter the narrative 
here.

The narrative is printed on expedited reports.

Case Comment You can enter comments in this area. If you are not permitted to edit the 
auto narrative, you can use this field to provide additional details 
important to the interpretation of the case. Comments appear on certain 
expedited reports.

Abbreviated 
Narrative

Enter brief comments in this field. This item maps only to the PSUR 
report.

Company Comment Enter comments in this area. This information does not appear on 
expedited reports.

Evaluation Comment Enter an evaluation comment that takes in to consideration similar 
events that have occurred in the past.

Note:  You cannot modify the Autonarrative text if the 
Administrator has configured the system to prevent modification of 
the Autonarrative.

If an Autonarrative template has been configured in multiple 
languages, icons representing the languages display above the text 
area.
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■ The system displays the last revision number of the case and date and time stamp 
in the following format:

■ (Last revision # X as of YYYY MMMM)

where:

■ The system disables the button if there is no previously locked version of the case.

■ This function is also available on the Medical Review dialog.

Case Summary Section
The Case Summary section of the Case Analysis tab enables you to enter summary 
information about the adverse event. The following is an illustration of the Case 
Summary section.

Case Summary Section Fields and Field Descriptions
The following table lists and describes the fields in the Case Summary section of the 
Case Analysis tab.

X Is the revision number of the last case

YYYY Is the date the case was locked

MMMM Is the time the case was locked in 24-hour format.

Field/Control Name Description

Case Serious This list indicates whether the overall adverse event case is serious or 
non-serious. This assessment is automatically performed by the system 
from the Seriousness Criteria of the Events tab. If any of the 
Seriousness Criteria was selected for any event in the Event tab, Yes is 
selected automatically in the list. No is selected if the Seriousness 
Criteria is cleared for all events in the Events tab. You can modify the 
selection after entering a justification, if you have the access rights to do 
so.

Serious Notes A justification for overriding the system determination will be 
displayed in the Notes area. A green dot will appear adjacent to the 
Notes area. Click the green dot to revert to the automatic calculation for 
seriousness or to view the overriding notes.

Case Causal The system automatically determines this value from the As Reported 
and As Determined causalities in the Event Assessment section. This 
field is displayed as Yes if the As Determined causality is Yes and vice 
versa. If the As Determined causality is Unknown, this field will be 
Yes.

Case Causal Notes A justification for overriding the system determination is displayed in 
the Notes area. A green dot is displayed next to the Notes area. Click 
the green dot to revert to the automatic calculation for seriousness or to 
view the overriding notes.
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Analysis Tab: MedWatch Info Tab
The MedWatch Info tab enables you to enter additional details required for the 
MedWatch 3500A Drug Report. The following is an illustration of the MedWatch Info 
tab.

MedWatch Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the MedWatch Info tab. Be aware 
that the values in the Form section column refer to specific sections of the MedWatch 
3500A Drug Report form.

Listedness 
Determination

The value for this field is calculated from the Event Assessment section 
in the Events tab. If any row there shows Unlisted under the Listed 
column, this value is set to unlisted.

Listedness 
Determination Notes

A justification for overriding the system determination is displayed in 
the Notes area. A green dot appears adjacent to the Notes area. Click 
the green dot to revert to the automatic calculation for seriousness or to 
view the overriding notes.

Case Outcome The value for this field is also calculated from the Events tab. If the 
outcome for any event is Fatal, the case outcome is set to Fatal. If the 
case outcome is changed here, that change is not made to the event 
outcome in the Events tab.

Company 
Diagnosis/Syndrome

The company diagnosis or syndrome is entered in this field.

Notes A justification for overriding the system determination is displayed in 
the Notes area. A green dot is displayed adjacent to the Notes area. 
Click the green dot to revert to the automatic calculation for seriousness 
or to view the overriding notes.

Form Section Field Description

B1. Adverse Event / 
Product Problem

Select the applicable check boxes.

Select Adverse Event when a product is suspected to have caused an 
adverse outcome in a patient.

Select Product Problem when the defect or malfunction in the product 
could lead to a death or serious injury. Select both check boxes if a 
malfunction or product problem caused a death or serious injury.

Field/Control Name Description



Case Form Functions

4-80 Oracle Argus Safety Japanese User's Guide

Guidelines to Selecting G3 Report Source Check Boxes  The following table provides 
information about the conditions that govern when a specific check box should be 
selected.

C9. Suspect 
Medications (NDC#)

Enter the National Drug Code if you have selected the Product Problem 
check box.

F1. User Facility or 
Distributor

Indicate whether this report is from a user facility or a distributor. You 
can suppress printing of Block F of the MedWatch 3500A report by 
selecting Suppress Block F Printing.

F2. UF/Dist report 
number

Enter the complete number of the report exactly as entered in the upper 
right corner of the front screen.

F3. User facility or 
distributor 
name/address

Enter the full name and address of the user facility or distributor 
reporting site.

F4. Contact person Enter the full name of the medical device reporting (MDR) contact 
person. This is the person who is designated as the device user 
facility/distributor contact for this requirement. The FDA will conduct 
its MDR correspondence with this individual. The contact person may 
or may not be an employee of the facility. However, the facility and its 
responsible officials will remain the parties ultimately responsible for 
compliance with MDR reporting requirements.

F5. Phone number Enter the phone number of the medical device reporting (MDR) contact 
person.

F6. Date aware of 
event

Enter the date that the user facility's medical personnel or the 
distributor became aware that the device may have caused or 
contributed to the reported event.

F10. FDA codes 
Patient

FDA Device Codes

Click the first row and column of the FDA Patient and Device Codes 
section and then click Select. You can enter up to six FDA Patient 
Codes. If the entered code is not present in the FDA Codes list, it is 
erased.

F11. Report sent to 
FDA

Select this check box if a report has been sent to the FDA. If you select it, 
enter the date when the report was sent to FDA.

F12. Location where 
event occurred

Select the location of the actual occurrence of the event.

F13. Report sent to 
mfr?

Select this check box if a report has been sent to the manufacturer. If 
you select it, enter the date when the report is sent to manufacturer.

G3. Report Source Select the Report Source check boxes as applicable, to match all report 
sources specified with the Reporter Type.

See the following guidelines for selecting the check boxes.

G5. PLA# Pre-1938 / 
OTC Product

Enter the PLA number.

If the product pre-dates 1938, select Pre-1938.

If the product is an over-the-counter product, select OTC product.

If this condition is true
Select the following check 
box

Country of Incidence is not USA Foreign

Report Case type is configured to contain cases from 
Literature

Literature

Form Section Field Description
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Analysis Tab: BfArM Info Tab
Use the BfArM Info tab to enter information required for the BfArm Report. The 
following is an illustration of the BfArM Info tab.

To enter data for the BfArM report
1. Open the BfArM Info tab.

2. Select the choices that apply to the patient from the items in the form.

3. If you do not know if a particular condition applies for the patient, select Unk.

Analysis Tab: AFSSaPS Info Tab
Use the AFSSaPS Info tab to enter the imputability assessment information for the 
suspect product along with the Adverse Events. The following is an illustration of the 
AFSSaPS Info tab.

Report Case Type is configured to contain cases from Clinical 
Trials

Study

Any Reporter Type is selected as Consumer AND none of the 
reporters is identified as Health Care Professional

Health Professional

Any Reporter Type is selected as Company Representative Company Representative

Any Reporter (Primary or Other) exists in a case with a 
Reporter Type of Other, If the selected Report Type is a 
Regulatory Authority (text value) within the Argus Case, the 
Other check box should be checked and the text "Regulatory 
Authority" should be entered in the text box.

Other

Case contains a Consumer Reporter AND also does not 
contain any Health Care Professional reporters.

Consumer

Note: The User Facility and Distributor check boxes must be checked 
manually.

Enter the appropriate text if you have selected Other as a report 
source.

Note: If any of the relevant items are entered in the Current Medical 
Status form in the Patient tab, the system automatically enters them 
here. If you change any of those items in the BfArM Info tab, the 
system will not enter the data in the Patient tab.

If this condition is true
Select the following check 
box
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AFSSaPS Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the AFSSaPS Info tab.

Field/Control Name Description

Event Displays included terms for all events.

Product Enter the suspect product. You cannot enter a concomitant 
product.

Chronology Select a Chronology code. The fixed set of values is C0, C1, C2, 
and C3. Click the icon to select the Time to onset, 
Readministration and Drug Stopped Values.

The user's selection auto-calculates the Chronology for the 
Product - Event combination.

Semiology Select a Semiology code. The fixed set of values is S1, S2, and 
S3.

Click the icon to select the Semiology Outcome, 
Complementary Test, and Other Explanation.

The user's selection auto-calculates the Semiology for the 
Product - Event combination.

Bibliography Select a Bibliography code. The fixed set of values is B0, B1, B2, 
and B3.

Imputability Imputability Calculation:
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Analysis Tab: PMDA Tab
The PMDA tab enables you to enter information required for generating PMDA 
reports and includes the following tabs:

■ General Tab

■ Comments Tab

PMDA General Tab
The PMDA General tab has several sections as follows:

■ Keyword Search Product Assessment

■ Reason for Research Report

General Tab: Keyword Search Product Assessment
The PMDA General tab is used to collect product information in an assessment table. It 
collects this information when:

~ Select from one or more of the following checkboxes:

■ Poursuite de l'étude sans modification du protocole

■ Poursuite de l'étude avec amendement au protocole

■ Arrêt de l'étude

■ Arrêt du développement du produit

■ Autres

The text box after Autres supports fifty characters. If the 
Autres checkbox is not checked, the field is disabled.

You can click Copy to Local Evaluator Comment to copy 
imputability values to the Local Evaluator Comment field and 
place the imputability text-equivalent at the beginning of the 
text that currently exists in the field. Copy to Local Evaluator 
Comment is visible only if the language for the "Local 
Evaluator Comment" field is French.

Future Actions Enter a text description for future actions.

Field/Control Name Description
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■ The case is a foreign case

■ One or more non-company products have been used in the case and are marked as 
"Suspects."

■ The suspected company product has an equivalent Japanese license.

When using the PMDA General tab, be aware of the following:

■ If a non-company suspected drug is in a foreign case, the system uses the product 
trade name and the generic name for the matching check with keywords from the 
Reportable Product Keyword screen.

■ The system uses the keyword to find the related company product family the 
suspected product belongs to.

■ The system matches the keyword with either the product name or the generic 
name fields on the case form. 

■ If the system finds a keyword match, the system assesses the Japanese license for 
the product family on the PMDA tab. If there are multiple Japanese licenses, the 
system lists all of them on the PMDA tab.

■ In this section, Listedness is always "Unknown."

■ This table enables the user to assess product reportability.

■ The system automatically minimizes this section if any of the following are true: 

– The case is a Japanese COI case

– The case is a foreign COI case that does not include non-company suspected 
products.

– The case is a foreign COI case without non-company suspect products, but 
none of the keyword match the Product Trade Name or the Generic name.

PMDA General Tab Fields
The following table lists and describes the fields on the PMDA General Tab.

Field/Control Name 
Name User Display

Product Company products found based on the on the J Reportable keyword

Event PT 
(Description)/LLT

Case events

D/S Read-only D/S information

Seriousness Severity 
Duration

Read-only event information

Reported Causality Reported Causality. This is a type-ahead drop-down list.

Determined 
Causality

Determined Causality. This is a type-ahead drop-down list.

Product Company products found based on the on the J Reportable keyword

Event PT 
(Description)/LLT

Case events

D/S Read-only D/S information

Seriousness Severity 
Duration

Read-only event information
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Information Tab: Reason for the Research Report
When the user selects Research Report on the PMDA Information tab, the system 
opens the Reason for subject of the Research Report dialog box to enable you to enter 
the reason for the research report. However, be aware that the dialog box opens only 
when any suspected drug license table has one of the following reporting categories 
selected: 

■ Reporting Category

■ Research/Infection Report (Marketed Drug)

■ Research/ADR Report (Market Drug)

■ Research/Infection Report (Investigational Drug) 

■ Research/ADR Report (Investigational Drug)

■ Research Report (Quasi Drug)

■ Research Report (Cosmetics)

Justification Dialog Box Fields
The following table lists and describes the fields in the Justification dialog box.

Reported Causality Reported Causality. This is a type-ahead drop-down list.

Determined 
Causality

Determined Causality. This is a type-ahead drop-down list.

Product Company products found based on the on the J Reportable keyword

Field/Control Name 
Name Description

Reason of Research 
Report

Title of the UI

Field/Control Name 
Name User Display
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PMDA Tab: Field Label Rules, User Defined Fields, and Help 
The PMDA Information tab supports the use of user-defined fields. 

PMDA Comments Tab
The Comments tab captures narrative data for various elements reported in the E2B 
reports submitted to PMDA. 

The following table lists and describes the fields on the Comments tab.

Assessment Result Read-only field that contains the value from the Literature intake 
assessment or the reporting category selected on the PMDA General 
tab. The value in this field can be one of the following:

■ Not Necessary 

■ AE Case (Reporting Category A, B, C, D, H, I, J, K) 

■ Research/Infection Report -- Marketed Drug (Reporting Category 
E) 

■ Research/ADR Report -- Market Drug (Research Category F)

■ Research/Infection Report -- Investigational Drug (Reporting 
Category L)

■ Research/ADR Report -- Investigational Drug (Reporting Category 
M)

■ Research Report -- Quasi Drug (Reporting Category 0)

■ Research Report -- Cosmetics (Reporting Category P)

■ Measures in foreign countries including discontinuation of 
manufacture, recall and withdrawn -- Marketed Drug (Reporting 
Category G)

■ Measures in foreign countries including discontinuation of 
manufacture, recall and withdrawn -- Investigational Drug 
(Reporting Category N)

Reason of Research 
Report

Section Title

Possibility of 
occurrence of serious 
disease such as 
cancer, disorder, or 
death

Choose Yes or No to indicate whether the possibility exists or not

Significant change on 
event or infection 
occurrence number, 
frequency, and 
condition

Choose Yes or No to indicate whether there has been a significant 
change.

It doesn’t have 
acknowledged 
effectiveness

Choose Yes or No to indicate whether the drug is considered effective.

Problems Enter a description of any problems with the drug. You can enter a 
maximum of 20,000 characters in this field.

Field/Control Name Description

Product License No. Enables you to select a specific product from the drop-down list to 
apply the comments to.

Field/Control Name 
Name Description
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Activities Tab
The Activities tab presents detailed information about the contact log, routing 
comments, action items, and Case Lock/Closure.

The following is an illustration of the Activities tab.

Activities Tab: Contact Log Section
The Contact Log section of the Activities tab enables you to:

Track correspondence related to individual cases.

Display scheduled letters

Comment on 
Incomplete

Enables you to enter information about an incomplete report.

E.G. Cure all MKT A sample license for which the narratives are being written All 
narratives written in the various text boxes apply to this license.

Countermeasure for 
the future

Enables you to enter information about future countermeasures based 
on an evaluation made by the reporting company about the adverse 
effect (i.e., infection, etc.). For a foreign case, you can enter the 
countermeasures taken by the Japanese reporting company, but not the 
foreign company.

Other Reference Enables you to enter additional information.

Comment of Sender Enables you to enter the sender’s comment.

Remarks 1 -- 4 Enables you to enter additional comments.

Copy the comments 
in this tab to other 
reporting licenses

Click this button to copy all the comments to other licenses in the list. 
The button is disabled when there is a single product.

Generate When clicked, the system populates the text fields using the Japanese 
narrative template.

Field/Control Name Description
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The following is an illustration of the Contact Log section of the Activities tab.

Contact Log Fields and Field Descriptions
When using the Contact Log section, be aware of the following:

The number displayed in parenthesis in the header of each section - Contact Log, 
Action Item, Routing Comments, Case Lock/Archive - displays the total number of 
entities within the section.

You can choose to view All Action Items or only Open Action Items, which shall 
display all the Open Action items within the case. By default, All Action Items are 
displayed.

You can sort Action Items by clicking on the column headers.

The system remembers the sort order on for the duration of the case.

The following table lists and describes the fields in the Contact Log section of the 
Activities tab.

Generating Letters  You can generate letters from the Contact Log section. When 
generating letters, be aware of the following:

■ The placeholders for the original letter template can be replaced by information 
that is specific to the current case.

■ A letter is only added to a search if the Correspondent check box is checked.

Field/Control Name Description

Date The date is automatically inserted by the system when a letter is 
scheduled or generated through the Letters menu. You can enter the 
date on which the letter is manually scheduled or generated. 

Click the letter icon to open the Letter Preview dialog. This allows you 
to view a letter or to modify it if it has not been sent already.

Code Select from a list of values to set the contact code for this entry. The 
Administrator can adjust the information in this list.

e-mail button Click to send an e-mail message.

Description Enter a brief explanation for the letter, for example, "Initial Letter," or 
the details of a phone conversation.

New Letter button Click this button to generate a new letter

Group/User Select a group responsible for the Contact item. From the list below, 
select a user from the selected group who will be responsible for the 
action. The Contact Item will appear in the Worklist for selected user. If 
"Any" is chosen as the group, the Action Item appears in all the users' 
Worklist. The Administrator can adjust the information in these lists.

Date Sent The date is automatically inserted when a letter is sent through the 
letter menu. You can also manually enter the date the letter was sent. If 
this field is completed, the letter will become read-only.
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■ The Administrator can configure the system to generate letters automatically and 
to schedule them for a specific number of days after receiving details of an adverse 
event. For example, the system might schedule an Initial Response Letter to be 
sent the day after an adverse event is received. Auto letter scheduling is triggered 
when a case is initially saved.

■ Letters cannot be auto-generated unless the "Date" [contact log date] is reached, to 
ensure that the latest information for the case has been updated to the letter.

■ If the Primary Reporter is marked as a correspondence contact, the system sends 
Auto-scheduled letters are sent to the Primary Reporter. Otherwise, the letter is 
sent to the first correspondence contact.

■ Auto-scheduled letters appear in the Contact Log section of the Case Form. You 
can view or print them by double clicking the letter icon. You can also edit letters 
that have not been sent. The system does not automatically send letters. You must 
send or remove letters manually.

■ In addition to auto-scheduling letter, you can also configure auto action items, 
which prompt you to follow-up with a correspondent after a letter has been 
scheduled and sent. Auto action item scheduling is triggered once the sent date 
has been entered for a letter. Auto action items appear in the Action Items section 
on the Case Form and in the Action Items tab of the Worklist.

■ The system uses the following naming convention to when saving letters in the 
Uploaded letters folder:

XXXX_YYYY.RTF

where:

■ The system replaces all special characters in the case number with an underscore ( 
_ ) character.

■ The CFG_PLACEHOLDER SQL limit is 4000 characters rather than 1000.

Use the following procedure to generate a letter.

To generate a letter
1. Go to Contact Log in the Activities tab and click New Letter.

2. The Custom Letter Templates dialog opens.

XXXX Is the current case number

YYYY Is the current letter numbering format (i.e., date and time the letter was 
generated)
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3. Select the required letter template from the list and click OK to open the letter in a 
separate window.

4. Make the necessary changes to the letter text.

5. Select File-->Save to save the changes.

6. If you modified the letter, select Yes.

This attaches the letter to the Case Form by browsing to the location where you 
saved the changes.

7. After saving the letter, the system displays it in the Contact Log section of the 
Activities tab.

8. The system creates an action item for following-up on this letter in the Action 
Items section of the Activities tab.
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Scheduling Action Items for Letters  When specifying or changing the Date Sent field in a 
letter, you can schedule an action item if you wish to do so.

■ If an action item is not specified, the field is blank.

■ Any Action Item can be updated on the screen immediately after a case has been 
saved.

■ Unless the Action Item has already been marked as completed, each time the Date 
Sent field is changed for a letter, the corresponding action item (if one exists) is 
also updated with a new Due Date of Date Sent of the Letter and the number of 
days specified for the Action in the Letter configuration

Opening a Message Editor  To open a message editor
1. Click the letter icon to open the message editor.

2. The system opens the message editor.

The following table lists and describes the fields in the dialog box

Activities Tab: Action Items Section
The Action Items section enables you to view or enter details of action items for the 
case and to assign responsibilities for actions. The following is an illustration of the 
Action Items section.

Action Items Fields and Field Descriptions  The following lists and describes the fields in 
the Action Items section.

Field/Control Name Description

To Displays the e-mail address specified for the Primary Reporter in the 
Case Form.

You can edit this field.

From Displays the email address specified in the Return Email Address in 
Argus Console>Code Lists>Letter Configuration. You can edit this field 
also.

Subject Displays the Case Number and the Description of the Contact log.

You can edit this field.

Send Enables you to send the e-mail to the intended recipient.

Field/Control Name Description

Date Open Enter the date the action item was created. Open action items appear in 
the Worklist of the user who is responsible for the action item. They 
also appear in the Open Action Items Report.

Code Select an Action Item code from the drop-down list. This will display 
the description of the selected Action Item Code. The Administrator 
can adjust this list.
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Activities Tab: Routing Comments Section
The Routing Comments section displays workflow routing information and 
comments for the case. It also contains a read-only sub-section on Case 
Locking/Closure. The following is an illustration of the Routing Comments section.

Routing Comments Fields and Field Descriptions
The following table lists and describes the fields in the Routing Comments section.

Routing Cases  If the case meets the routing rules specified by the Administrator, you 
can use the Case Routing dialog box to route a case to the next workflow state. When 
using the Routing Forward Cases function, be aware of the following:

■ Non-Enterprise Workflow managers cannot view all the Workflow States below 
the line if the Workflow States are assigned to Sites in the Workflow Configuration.

■ Only Enterprise Workflow managers have access to all sites for routing cases 
ahead in the Workflow.

■ If the Workflow state does not have defined site, all workflow managers can see it.

Description Selecting an Action Item code automatically enters information into this 
field. The text can be modified as required. The Administrator can 
adjust this list.

Group/User Select a group responsible for the Action Item from the given 
drop-down list. From the drop-down list below this, select a user from 
the selected group who will be responsible for the action. The Action 
Item will appear in the Worklist for the selected user. If "Any" is chosen 
as the group, the Action Item appears in all the users' Worklist. The 
Administrator can adjust these lists.

Due Enter the date on which the action item is to be completed.

Completed Enter the date on which the action item was completed. A red border 
indicates a completed action item while a green border indicates an 
incomplete action item.

Field/Control Name Description

Date Displays the date the case was routed to a new workflow state. This 
field is automatically generated when a case is routed.

User Displays the name of the user who routed the case. This field is 
automatically generated when case is routed.

Comment Displays the routing comment.

Route button Routes the cases.

Return button Returns the case to the previous state.

Field/Control Name Description
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To route a case
1. Click Route in the Activities tab of the Case Form to open the Case Routing 

dialog box.

2. From the Route to Next State drop-down list, select the state to which you would 
like to route the case.

If only one workflow state can be selected for the Next Route state, that state can 
be selected by default in the Route to Next State field.

3. From the Route to User drop-down list, select the user or user group to route the 
case to.

4. Enter the routing comments in the Comments field

OR

Click Select to select a comment from a list of pre-defined routing justifications.

To select text from the pre-define list of routing justifications
1. Click on the Select button in the Case Routing dialog to open the Routing 

Justification dialog box.

2. Select the required justification from the justification list displayed under Select a 
standard justification for this field. The system highlights the selected row.

3. Click OK.

4. The system closes the Routing Justification dialog box and displays the selected 
justification text in the Comments field in the Case Routing dialog box.

5. Click OK to route the case.

Returning Cases  If necessary, you can return a case to its previous workflow state.

To return a case to its previous workflow state
1. Open the case.

2. Click the Return button in the Activities tab of the Case Form.

3. When the system opens the Case Routing dialog box, enter your password in the 
Password field.

4. From the Route to User drop-down list, select the user or group the case needs to 
be returned to.

5. Enter any routing comments in the Comments field.

6. Click OK to return the case to its previous workflow state.

Activities Tab: Case Lock/Close Section
The Case Lock/Close section enables you to lock a case, unlock a locked case, and 
formally close a case. You must lock the case before you can generate a report. The 
following is an illustration of the Case Lock/Close section on the Activities tab.

Note: The system displays disabled users in the user drop-down list 
in alphabetical order with an asterisk (*) at the end. You can view the 
total number of times the case has been routed in the header section, 
excluding the blank rows.
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When closing a case, be aware of the following:

■ If the Auto-schedule Later checkbox for expedited reports is checked and you try 
to archive a case, the system displays the following message:

Case xxxx cannot be closed while Auto Schedule Later is checked. Please uncheck 
the option for the Auto Schedule Later option on the Regulatory Reports tab or 
wait for the Report Scheduling to complete before attempting to archive the case.

■ The system displays this same message when you close single or multiple cases 
from the New/Open dialog on the Worklist.

Case Lock/Close Fields and Field Descriptions
The following table lists and describes the fields in the Case Lock/Close section of the 
Activities tab.

Locking a Case  To lock a case
1. In the Case Lock/Close section of the Activities tab, click Lock.

2. The system opens the Case Locking dialog box.

Field/Control Name Description

Case Status Enables you to unlock, lock, or close a case after entering the 
appropriate user information.

■ Unlock -- Enables you to unlock a case if you have the appropriate 
permissions. To unlock a case, enter the password you use to log 
on to Argus Safety.

■ Lock -- Enables you to lock a case if you have the appropriate 
permissions. The current date will be used for the lock date. To 
lock the case, enter the password you use to log on to Argus Safety 
in the Case Locking dialog box.

■ Close -- Enables you to close a case if you have the appropriate 
permissions. To close the case, enter the password you use to log 
on to Argus Safety in the Case Closure dialog box.

Closure Date Date on which the case was locked or closed. If a locked case is being 
viewed by a user, any other user who tries to access the same case will 
have read-only access to the case.

■ Cases should be closed only after all action items for the case are 
complete, all expedited regulatory reports have been submitted, 
and all the expected follow-up information has been received. If a 
closed case that is closed requires modification, the case must be 
re-opened by using the password.

■ A case may be either locked or closed, but not both. A locked case 
will be moved from the locked state to the closed state without 
having to unlock first.

■ Note: Case closure should not be confused with closing the Case 
Form. Closing of the Case Form refers to removing the current 
Case Form from the screen.

Lock or Closed By Displays the name of the user who locked or closed the case.

Notes Displays relevant information about the case lock or closure.
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3. Enter your Argus Safety password in the Password field.

4. Enter any notes in the Notes field.

5. Click OK.

6. The system displays the locking notes in the Notes field of the Case Lock/Close

Unlocking a Case  Use the following procedure to unlock a case.

To unlock a case
1. In the Case Lock/Close section, select Unlocked from the Case Status drop-down 

list.

2. When the system opens the Locked Case dialog box:

1. Type your password in the Password field.

2. Type any relevant information in the Notes field.

3. Click OK.

3. When the system opens the Case Unlock dialog box, click one of the following:

■ Significant F/U

■ Non-significant F/U

■ Other

Setting the Focus for a Follow-up Event  After unlocking a case, the system sets the focus 
for significant/non-significant follow-up events as follows:

1. When you click the Significant F/U button on the Case Unlock dialog, the system 
automatically displays the case General tab, checks the Significant check box for 
both drugs and devices (if enabled by the profile switch), and sets the focus on the 
Follow-up Received Date.

Screen: Argus > Case Actions > Open > (Select a Case) > General Tab > General 
Information Section > Follow-ups sub-section (middle of screen).

■ The system checks to determine whether the Significant check box is checked.

■ The system sets the focus on the Follow-up Received Date.

2. When a case is unlocked and you select the Non-Significant F/U button from the 
case unlock pop-up dialog, the system automatically displays the case General tab 
and sets focus on the Follow-up Received Date.

Argus > Case Actions > Open > (Select a Case) > General Tab > General 
Information Section > Follow-ups sub-section (middle of screen)

■ The Significant check box is not checked.

■ Focus is on the Follow-up-Received Date.

■ You can add multiple follow-ups.

Note:  To unlock a case from the Locked/Archived state, select the 
Unlocked value from the Case Status drop-down list. This will 
display the Archived Case or Case Lock dialog. The dialog box 
requires you to specify your password and the reason for unlocking 
the case. The case is unlocked/archived after you enter this 
information.
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Argus > Case Actions > Open > (Select a Case) > General Tab > General 
Information Section > Follow-ups sub-section (middle of screen)

– If you add a single follow-up, the Add button remains available for the 
user to add additional follow-ups.

– Currently, the Add button disappears after the user adds a single 
follow-up. The user must save, close and reopen the case before he/she 
can add an additional follow-up.

■ A hyperlink in the follow-ups section enables you to open the link in a 
different dialog box.

Additional Information Tab
The Additional Information tab enables you to attach notes and other items to the 
case. For example, you could attach a fax message that came in as part of the case and 
needs to be scanned and attached or an electronic file received by e-mail. It also 
enables you to set up cross-references to other cases such as links between cases 
referring to mothers and children. The total number of attachments and references 
attached to a case display in the header.

The following is an illustration of the Additional Information tab.

When using the Additional Information tab, be aware of the following:

■ The system shrinks the main widow up to 60% and opens the attachments from 
the Notes and Attachments dialog in a new browser window.

■ The system opens any hyperlinks that appear on the Additional Info tab in a new 
Internet Explorer window if the selected reference is HTTP/URL Reference.

■ When you click the hyperlink and a reference case is present, the system opens a 
case number irrespective of the selected reference type when you clicked the 
hyperlink.

■ If no sites are defined for the attachments classification, the system permits all 
users to view the attachments on the Additional Info tab.

■ The system only permits users who belong to the site defined on the attachment 
classifications to view the attachments.
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■ The system filters the attachment classifications based on the sites a user has 
permission to access.

■ The Case Form/Case Listing reports printout hides the row.

■ The system permits Workflow Enterprise to view all attachments across all sites

Additional Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the Additional Info tab.

Field/Control Name Description

Notes and Attachments

Classification Select a classification that describes the attachment. The Administrator 
can adjust this list.

If any attachment classification has the E2B Additional Report checked 
and the attachment is an file in either .XLS, .TXT, .TIF, .DOC/.RTF, 
>PNG, >JPG or >BMP formats, the selected attachment is converted to 
a PDF file.

This PDF file is then merged into a single PDF file, which comprises 
text converted to PDF from all the attachments present in the case.

The single merged PDF comprises each attachment as a link by the 
classification name provided for the attached file.

Date The current date is automatically entered in this field. You can also 
enter a date manually.

Incl. Reg. Sub Select this checkbox to merge PDF attachments within the case form. 
The Incl. Reg. checkbox identifies the attachments to be included as an 
appendix to the Expedited Reports. On selecting this checkbox, the 
Expedited Reports - CIOMS I, CIOMS I (Local), US FDA MedWatch 
3500 Drug and 3500 A Device print an appendix page before each 
attachment. This is added to the case, and marked as Inc. Reg. Sub 
checked.

Note: The checkbox is available only if a PDF is selected as an 
attachment.

Keywords Enter keywords related to the case or click Select.

Description Enter a description of the attachment.

Attach File Inserts a file attachment into the case. Maximum file size is 4 GB.

Add Inserts a row for an additional attachment.

Delete Deletes the selected row.

Attach Documentum 
Link

This option is visible only if Documentum is available.

Click Searching for Documentum to search for and attach 
Documentum.

References Type Select a reference type from the list, for example, a parent-child link. 
The Administrator can adjust this list.

ID # Enter the case number of the case that is to be referenced.

Note: Click Select to search for the case that is to be referenced. You can 
also use this field to record the reference number for external cases.

Notes Notes can be entered here for reference.

Select Opens the Case Selection dialog for the selected ID.

Add Inserts a row for an additional attachment.
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Searching for Documentum Links

To search for Documentum links
1. Click the Attach Documentum Link button to open the Documentum Lookup 

screen.

2. Enter the desired search criteria as per Type Name, Attribute Name and Search 
String, and click Search.

3. Select the desired link from the row displaying the search results.

4. Click Select to select the link from the list.

Attaching Files to a Case
You can attach from 1 to 99 files to a case.

To attach files to a case  In the Notes and Attachments section of the Additional Info 
tab, click Attach File to open the Attachment dialog box.

1. Click Browse to locate a file attachment.

2. Select the file and click OK

Entering Keywords
You can associate keywords with a case in the Notes and Attachments section.

To attach keywords to a case
1. Go to the Notes and Attachments section and click Select.

2. When the system opens the Attachment Keywords dialog box:

■ Select a keyword from the Select a keyword to add to the list drop-down list.

■ The system displays the selected keywords in the Keywords field.

3. Click OK

Attaching References to a Case

To add a reference to a case
1. Locate the References section and click Select.

2. When the system opens the Case Search Criteria dialog box, enter the appropriate 
search parameters and click Search.

3. When the system displays the search results in the Total Number of Rows section, 
select the desired search criteria from the list and click Select to view details about 
the selected case.

Regulatory Reports Tab
The Regulatory Reports tab enables you to:

■ View all scheduled reports

Note: To view an attachment, click the icon associated with the 
attachment
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■ Schedule new reports

When a new case is created, there are no reports associated with it. As data is entered 
and the case is saved, the regulatory report scheduling algorithm determines which 
reports, if any, will be required for that case.

The reports determined to be necessary appear in the Regulatory Reports tab. You can 
manually schedule reports via the Reports menu or by clicking the Regulatory Reports 
Tab. You can also add comments to the existing reports. The comment section can also 
be updated to enter the notes for the report even after the report has been submitted.

The following is an illustration of the Regulatory Reports tab.

General Usage Information
When using the Regulatory Reports tab, be aware of the following:

■ The case submission date must be on or after the initial receipt date for the case. If 
the submission date is before the initial receipt date, the system displays the 
following message:

Please enter the Submitted Date greater than the Initial Receipt Date of the Case

■ The system displays the time component for the date generated on the Case 
Form|Regulatory Reports tab using the IE offset of the client machine for the 
display.

■ The system displays the time component for the date generated on the Report 
Details using the IE offset of the client machine for the display.

■ When you manually schedule an expedited report, the system places the word, 
Manual, in the Notes field along with the current notes information.

■ When you manually schedule a report, the system enables you to check "Blind 
Product Study" on the Schedule New Expedited Report dialog box to blind the 
study products if they are in the case.

Regulatory Report Tab Fields and Field Descriptions
The following table lists and describes the fields on the Regulatory Reports tab.
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Field/Control Name Description

Status The notification log provides a list of reports which have been 
scheduled, generated, or submitted. The following report status are 
available indicated by the icons in the regulatory reports tab:

■ Report has been routed and approved by a user.

■ Report has been routed and disapproved by a user.

■ Report has been scheduled but not saved.

■ Report has been scheduled and saved.

■ Report has been scheduled and generated.

■ Report has been scheduled/generated and it is past its due date of 
submission.

■ Report has been scheduled/generated and submitted.

■ Report has been marked as submission not required by a user.

Seq Displays the sequence (Initial, Follow-up, etc.)

Destination Displays regulatory authority to which the report is to be submitted.

Report Type Displays the type of regulatory report like US IND Summary, BfARM 
Form 643, etc.

License Type Displays license information.

License # Displays the license number.

Generated Displays the date when the regulatory report was generated (if 
applicable). The system date on which it is generated is used as the 
default value.

Local Comment Displays a local comment, if it exists.

Submitted Displays the date the regulatory report was submitted (if applicable). 
The system date on which it is generated is used as the default value. 
This date does not initially appear on the Case Form when submitted. It 
is displayed when the case is re-opened.

Notes Displays notes entered when the report was created.

Due Displays the date the regulatory report is due for submission to the 
regulatory authority (if applicable). This field is auto-calculated based 
on the initial receipt date or on the basis of the most recent significant 
follow-up date. It can also be specified manually by entering the date in 
the Due Date section.

Responsible Displays the name of the user responsible for the report.

Auto Schedule 
button

Initiates Auto-Scheduling of expedited reports according to the 
configuration for this feature, for example, Always, Significant, Manual, 
or None.

Auto Schedule 
Device button

Schedules regulatory reports, using the Device rules.

Schedule New Report 
button

Schedules a new expedited report.

Auto Schedule Later This item appears if the system is configured for auto-schedule of 
expedited reports using Argus Safety Service. Select this check box 
when the system is about to run the auto-scheduling against this case 
after the case is locked.

Auto Schedule 
Device Later

Select this check box to run the auto-scheduling for only devices.
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Grouping Regulatory Reports
You can group reports by selecting the appropriate grouping structure from the 
Organized by drop-down list. You can group reports as follows:

■ Report Type/Submit Category/Reporting Destination

■ Report Type/Reporting Destination

■ Report Type/Reporting Group

The numbers in parentheses next to each folder indicate the number of reports in the 
folder.

The following are definitions of the terms used in the reporting structure.

■ Report Type -- Can be either Expedited or Periodic reports. The system generates 
a folder for each type.

■ Reporting Destination contains all defined code list items for Reporting 
Destinations that have at least one report scheduled within the case.

If no reports are scheduled for a defined reporting destination, no folder will be 
created for this destination. All the folders which are the reporting destinations under 
each folder are sorted alphabetically.

■ Pending Reports -- Reports that have not been submitted or are marked as 
non-submitted.

■ Submitted Reports --All submitted reports.

■ Marked as Non-Submit --Reports that have not been submitted.

■ Reporting Group -- Contains all user groups assigned to the scheduled expedited 
or scheduled in the case

Grouping by Report Type/Submit Category/Reporting Destination  The Expedited folder 
contains the following:

■ Pending Reports by Destination

■ Submitted Reports by Destination

■ Non-Submitted Reports by Destination

The Periodic folder contains single case report forms (MedWatch, VAERS or CIOMS) 
that were generated as part of a Periodic Report.

■ Pending Reports by Destination

■ Submitted Reports by Destination

■ Non-Submitted Reports by Destination

Grouping by Report Type/Reporting Destination  The Expedited folder contains a sub-folder 
for reporting destinations that have at least one scheduled report.

The Periodic folder contains the single case report form (MedWatch, VAERS or 
CIOMS) generated as part of a Periodic Report are listed in the Periodic section. If no 
report was generated, the system does not create sub-folders.

Grouping by Report Type/Reporting Group  The Expedited and Periodic folders contain 
sub-folders for each group that has generated a report. If a group has not generated a 
report, the system does not create a sub-folder.
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5Case Actions

This chapter discusses the actions that can be performed on the existing cases.

Working with Cases
This section provides information about actions that can be performed on existing 
cases. It includes discussions of the following:

■ Finding and Opening Existing Cases

■ Creating a New Case

■ Processing a Case

■ Closing a Case

■ Saving a Case

■ Copying a Case

■ Performing a Medical Review

■ Performing a Coding Review

■ Printing Cases

■ Printing Medical Summaries

■ Deleting a Case

■ Revising a Case

Finding and Opening Existing Cases
You can find and open a case from the Case Open form shown in the following 
illustration.

To find and open an existing case
1. Select Case Actions --> Open to view the Case Open form.

2. Enter or select the appropriate search criteria in the form fields and click Search.

3. When the system displays the search results, locate the appropriate case in the list.

4. Click the link associated with the Case ID.

5. The system opens the Case Form for the selected case.

6. You can now review the case details and enter further information in the Case 
Form.
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General Usage Information
When using the Case Open dialog box, be aware of the following:

■ You can print all the cases in the current view from the Case Actions|Open 
dialog.

■ If you search for a case that has been deleted, the system displays the following 
message:

The case number being searched is deleted in the system. Please reactivate the case 
to allow processing of the case from Utilities|Case Reactivate Option.

■ This message appears across the application where you use the case number to 
search for a case as follows:

– Worklist -- All dialogs

– Last Accessed Cases from the Menu

– Person Argus Status

■ Case Search while adding the Case as a reference

– If a blinded user views the case information from the Case Summary, the 
system displays the Blind name instead of the Study Drug name in the 
product information.

– When you view the case details, the system displays the same folder structure 
on the Regulatory Reports tab. This enables you to view the expedited and 
periodic in an organized tree structure.

Case Open Form Fields and Field Descriptions
The following table lists and describes the fields on the Case Open form.

Note: You can open the 10 most recently-accessed cases without 
going through the preceding process. These cases appear under Active 
Cases.

Field/Control Description

Search For Select the criteria by which the case must be searched for and enter an 
appropriate search item, if applicable.

Note: You can search for cases based on multiple study identifiers. The 
option, "Pri/Stdy/Othr/Cntr/Rptr/Pat" supports entry of Project ID, 
Study ID, Other ID, Center ID, Reporter ID, and Patient ID values 
separated by the "/" (forward slash) character. Any or all fields may be 
present.

Full Search Select this check box, if necessary.

Full search is best explained with an example. If the full search option is 
not used and the item that is entered under Search for is "AB", then a 
string such as "ABCESS" will match "AB", but a string such as "LABOR" 
will not. If the full search option is used, both these items will match 
"AB". Also, items whose first few letters sound similar (like "TIM" and 
"TIN") will also appear in the search results.

Product Family Select the Product Family that the case belongs to, if applicable.
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Search Results Contents
The Search Results under Total Number of Rows display a list of cases as specified in 
the Search Criteria (Default Criteria is Date Range of Last 30 days). The previous 
search results are displayed if a search was performed by the user during the same 
session without logging out.

The following table lists and describes the Search Results columns and contents.

Sharing a Case Series
You can share a case series from:

■ Argus to Argus Insight

■ Argus Insight to Argus

To share a case series from Argus to Argus Insight
1. Click the [Argus Insight] option to automatically activate the same case series in 

the search result.

2. Argus Insight automatically makes the same case series active that is present in 
the search result of the Case Search dialog in Argus.

Date Range Select a relevant Date Range, if applicable.

Tip: To enter a customized date range, select Custom Date Range from 
the list.

■ Enter an appropriate date range in the custom date range dialog and 
click OK.

■ Select the Follow-up radio button to search on Follow-up Dates, 
including the Significant and Non-Significant Follow-ups.

Advanced 
Condition

Select an advanced condition for the case, if applicable.

Note: Click AC to create a new advanced condition.

Result from Argus 
Insight

Enables you to create a search result with the same cases as the Active 
Case Series in Argus Insight.

Search Click Search to display the list of cases that match the search criteria.

Column Description

Total Number of 
Rows

Displays the total number of results found to match the search criteria.

■ Displaying Rows. The number of rows being displays.

■ Page Size. The number of rows that display on each page.

■ <<  >>. Click to scroll through the search results.

Lock State Displays the Lock Status - whether the case is locked or unlocked.

Click the icon displaying the lock status for more information.

Case Number Displays the unique Case Number of each case. Click the case number 
link to open the case.

Date Displays the date when the case was opened.

Product Displays the Product related to the case.

State Displays the State that the case belongs to.

Field/Control Description
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To share a case series from Argus Insight to Argus
Click the Result from Argus Insight button in Case Search to create a search result 
with the same cases as the Active Case Series in Argus Insight.

Be aware of the following:

■ If there are no cases in the Active Case Series in Argus Insight or no Active Case 
Series exists, the system generates an "empty" search result.

■ If there are cases in the Argus Insight Case series that no longer exist in Argus, 
they are excluded from the case series in Argus.

■ You can also make the Case Search dialog case series active from within Argus 
Insight through the Case Series menu option Make Active from Argus in Argus 
Insight.

■ A case is excluded from the case series, if a case series from Argus contains cases 
that are not present in the data mart.

Processing a Case
When your company receives initial case information you enter this information on 
the Initial Case Entry form. After entering this information, it must be verified, or 
checked for duplicates (possibly by another user) to ensure that duplicate information 
is not entered in the database. Once the information is verified, you can book in the 
case or enter additional case data.

The following is an illustration of the Initial Case Entry form.

Initial Case Entry Fields and Field Descriptions
The following table lists and describes the fields in the Initial Case Entry form.

Note: : If Argus Insight is already open, the system replaces the 
active case series in Argus Insight with cases from Argus.

Field Description

Initial Receipt Date Enter the date on which your company became aware of the case. The 
Receipt Date cannot be entered as a partial date.
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Central Receipt 
Date

Enter the date on which this information was received by Central Safety.

Country Enter the country where the adverse event occurred. You can select the 
appropriate country from the list.

Note: This may or may not be the reporter's or the patient's country of 
residence.

Report Type Select the item that best describes the type of report. This determines the 
fields that are made available for entering case information.

Note: The report type also impacts the duplicate search. For example, 
selecting Sponsored Trial makes the Study ID and Protocol ID fields 
available. The Administrator can adjust the information in this list.

Project ID Enter the Project ID of the case.

Study ID This item is applicable to clinical trial cases only. Enter the study ID. Click 
Select to choose the study ID from the Clinical Trial Selection dialog.

Center ID This item is applicable to clinical trial cases only. Click Select to choose the 
Center ID from the Clinical Trial Selection dialog.

Initial Justification The values of this field are configurable through the standard Argus 
Justifications dialog. This field is reflected in the General tab of the Case 
Form and is also available for duplicate searching for cases.

Click the green dot to view and select justifications from the Argus 
Justification dialog.

Product Name Enter the name of the product associated with the case. If the adverse 
event(s) are associated with more than one product, each additional 
product can be added from the Case Form.

Note: Enter the most suspect product here. Click Select to search for a 
product from the Trade Name Product Lookup dialog. Several items are 
automatically entered on the Case Form based on the product selected 
here.

Generic Name This field can be used to enter the generic name of the product. This field 
will be automatically entered when a product is selected from the Trade 
Name Product Lookup dialog.

Description as 
Reported

Enter a brief verbatim description from the reporter that describes the 
event that is most clinically important in the case. The icon denotes that 
the event is encoded. Click the icon to populate the MedDRA hierarchy 
dialog.

Onset Date/Time Enter the date/time for the onset of adverse event symptoms.

Sal. First Name 
Middle Name Last 
Name

Enter the reporter's salutation, first name, middle name and last name.

Suffix Enter the reporter's name suffix, if applicable.

Country Enter the reporter's country.

State/Province Enter the reporter's state/province or county.

Postal Code Enter the postal code or zip code.

Intermediary Enter the type of intermediary for the case, if applicable.

Patient Name or 
Initials

Enter the patient's name or initials. The system can search for cases on 
initials, first name, and last name.

Pat. ID Enter the patient's ID.

Field Description
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Booking in Cases and Entering Initial Case Information
From the Initial Case Entry form, you can decide to book-in a case before entering 
further case information in the Case Form.

To enter initial case information
1. Select Case Actions --> New to open the Initial Case Entry form.

2. Enter preliminary case information in the form.

3. Click Search to determine whether information related to this case has already 
been entered.

4. A list of cases that match the criteria you entered on the form is displayed. Inspect 
the search results for a duplicate case.

DOB Enter the patient's Date of Birth (dd-MON-yyyy).

Note: When entering the month, enter 1 for JAN, 2 for FEB, 3 for MAR and 
so on.

Age Enter the patient's age. When searching for duplicates, the system will 
retrieve all ages that begin with the number that was entered for the 
search. For example, searching for "5," will retrieve patients aged 5, and 50 
through 59.

Units Enter the age units (days, months, or years).

Gender Select the patient's gender from the list. The Administrator can adjust the 
information in this list.

ID Enter the value to search for a Reporter Reference number, Case Reference, 
and Case number.

Keyword Enter a keyword when searching for duplicates. Keywords are only used 
for searching for cases.

Journal Title These items are applicable to literature cases only. Click Select to choose a 
journal and title from the Literature Reference dialog. The Administrator 
can adjust this list.

Full Search (Like 
Soundex)

Check the Full Search (Like, Soundex) check box to perform a full search, 
including Soundex search for cases.

Tip: Soundex enables you to search for cases with similar phonetics.

Note: You can configure the number of cases that display in the 
Bookin dialog in the Page Size drop-down list. By default, 100 cases 
appear on the page. You can choose to display up to 2000 cases on a 
single page.

Note: Fields displayed with a red flag are required fields and must 
contain a value.

Note: : If a duplicate case exists, open the case to enter further 
information (if any) related to the existing case. Click the link 
associated with the case 

Field Description
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5. If a duplicate case does not appear, click Continue in the Initial Case Entry form to 
display the BookIn and Attachments and References sections.

6. Enter the relevant information in sections like Causality, Seriousness, Attachments 
and References.

■ Under Reported Causality, select the reporter's assessment of causality. The 
causality relationship is the causal relationship between the clinically most 
important event and the suspect drug that is entered in the Initial Case Entry 
form.

■ For Seriousness Criteria, select the appropriate check boxes to indicate the 
seriousness of the case, as appropriate.

7. If the case is not serious, select the appropriate check box under Case is 
Non-Serious. The Non Serious Section of the Initial Case Entry dialog is 
differentiated by a | between the Serious criteria and the Non Serious Criteria.

8. Click Add to add an attachment

9. Select File Attachment or URL Reference, as appropriate.

To insert a file attachment
1. Select File Attachment from the list and click Browse.

2. Click the New Case from Image button - is the first button (from left) in the Quick 
Launch bar. This button opens the Windows Open dialog, which helps you to 
browse to the default location from where the file(s) can be attached.

To insert a URL Reference
1. To insert a URL Reference, select URL Reference from the list.

2. Enter the URL after "http://".

Note:

■ Select only the criteria that applies to the clinically most important 
adverse event.

■ If you select the Death check box, you can enter the death details 
from the dialog that automatically appears. If you select the 
Hospitalized check box, you can enter hospitalization details from 
the dialog that automatically opens.

■ Either a seriousness criterion or a non-serious criterion must be 
entered before a case can be booked in.

■ When a Duplicate Search is performed, the system will remember 
the results until the user logs out of the system or performs a 
duplicate search again. When the Bookin screen is opened, the 
search results from the last search are displayed again.

Note: This location is configured can be configured by the 
administrator in Argus Console under System Configuration > 
Common Profile Switches > Case Processing.
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To search for and insert a document
1. Select Documentum Link and click Add.

2. The Document Lookup dialog is displayed.

3. You can search for a document from the database by specifying a search criterion 
in this dialog.

4. Click BookIn.

5. If the Administrator has configured the system for automatic numbering of cases, 
the automatically assigned case number opens. If the numbering of cases is 
manual, you can enter the appropriate case number.

Checking for Duplicates

To check for duplicates
1. Check whether the case information that is being entered in the Initial Case Entry 

form has been entered previously (possibly by another user).

2. Enter the information related to the case in the Initial Case Entry form.

3. Select the Receipt Range Limits radio button to check for duplicates based on the 
dates entered in the form. Click Search. A list of cases that match the criteria 
entered in the form opens.

4. Inspect the list to determine if any case contains duplicate information.

Understanding Receipt Range Limits
The following table provides information about using Receipt Ranges.

Note: Once you click the Bookin button, it is hidden from the screen. 
The button is enabled only if the Save operation fails or when the case 
is booked in successfully. Mandatory fields are denoted by an orange 
border across the field in the Bookin dialog.

Note:

■ When a case is booked in, the case may be assigned to a specific 
user and it will be given a particular state, depending on the 
configuration set up by the Administrator.

■ The case can not be booked in without these fields populated: 
Product, Event, Receipt Date, Report Type, Country of Incidence 
and Seriousness.

■ These are noted by an orange border across the field label and 
identified by an orange flag to indicate that these are required 
fields.

Tip: When you book-in a case, a dialog that prompts you to open the 
newly created case is displayed.

Click Yes to open the case.
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Closing a Case
This section provides information about how to close a case. Once a case is closed, you 
can do the following:

■ You can view a closed case in the Case Form in read-only mode.

■ View reports generated for the case

■ Preview new drafts

■ View report details

■ View drafts of reports that haven't been generated

You cannot create expedited reports for cases that have been formally closed. For that 
reason, you cannot close a case that has pending scheduled reports.

To close a case
1. Select Case Actions --> Close.

2. When the system opens the Save Case dialog box:

Click Yes to save and close the case

OR

Click No to close the case without saving it.

After you close a case, the system does the following:

Field Description

No date 90 days before System Date and 2 days after System Date.

Full Onset Date 10 days before Onset date and 90 days after Onset Date.

Full Initial Receipt 
Date

60 days before Initial Receipt Date and 60 days after Initial Receipt Date.

Note: This default date range for searching on Initial Receipt Date can be 
disabled by un-checking the Receipt Range Limits radio button on the 
Initial Case Entry dialog.

Partial Onset Date Based on the Full Date Range - if only the year is entered, the date range 
becomes: 10 days before the end of the previous year and 90 days after end 
of the year.

Partial Initial 
Receipt Date

Based on Full Date Range - if only a year is entered, the date range 
becomes: 60 days before end of previous year and 60 days after the end of 
the year.

Note:

■ If an Initial Receipt Date is not entered but an Event Onset Date 
has been entered, the search will default to look for cases with 
Initial Receipt Dates 10 days before and 90 days after the event 
onset date. This feature can also be disabled directly on the dialog 
by un-checking the Receipt Range Limits check box. If you do not 
check anything, the default date range shall be 90 days before and 
2 days after the current date.

■ The Duplicate Search permits you to sort in ascending or 
descending order in the duplicate search results. You can also use 
wild card searches on all text fields in the BookIn dialog.
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1. Opens the next active case, if you have active cases that you are working on. If 
there are no active cases, the system displays the default Worklist.

2. Displays the Personal Argus Status if the default Worklist option is <None>.

Saving a Case
This menu option enables you to save a case.

To save a case
1. Click the Case Number of the case you want to save.

2. When the system opens the Case Form, select Case Actions --> Save.

3. When the system opens the Case Form Saving dialog box, click OK.

Copying a Case
Argus enables you to save all or part of a case and stores the copy in the database as a 
separate case. When copying cases, be aware of the following:

■ Clicking the case reference in any copied case opens the original case.

■ You can select specific sections of the case to copy.

■ If your system is configured for manual case numbering, the system prompts you 
to enter a new Case ID. Otherwise, the system automatically assigns a new Case 
ID. The following is an illustration of the Case ID Number dialog box.

To copy a case
1. Select Case Actions --> Copy.

2. When the system opens the Case Copy -- Webpage dialog box, enter the number 
of copies you want to make and click Yes to copy the case.

3. When the system displays the Case Copy dialog box, click the appropriate check 
boxes to select the portions of the case you want to copy

OR

Click Select All to copy the entire case.

4. Click Copy.

5. The system saves and opens a copy of the case with a new case number and 
presents a message. Click OK.

Using the Medical Review Function
Use the Medical Review function to quickly and efficiently add important information 
to a case. The Medical Review form has three (3) tabs as follows:

■ Medical Review Tab

■ Temporal View Tab

■ Action Items/Addl Info Tab

Note: Depending on whether the system is configured for automatic 
case numbering, the system either generates a case ID or enables you 
to enter the case ID for this case.
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To access Medical Review
1. Select Case Actions --> Medical Review.

2. The system opens the Medical Review form.

3. Click on the appropriate tab.

Common Actions
The following table lists and describes the actions you can perform from all Medical 
Review tabs.

Field Description

View Draft Select a report from the drop-down list and click View Draft to generate a 
draft version of the report based on the open case.

Note: This report form type is saved as a default and the next time the user 
opens the Medical Review for another case, this is defaulted to the Report 
Form selected previously.

The Draft report does not display all the changes made to the Case until 
the case has been saved in the database.

Zoom/Unzoom Click the zoom icon to view the selected dialog on a much bigger scale.

Click Un-Zoom icon to revert back to the earlier view.

Return Case Click Return Case to open the return route dialog and save the 
information.

Forward Case Click Forward Case to open the forward route dialog and save the 
information.

When the case has been routed and the form is closed, you cannot route 
from the case form Activities tab till the case has been closed and 
re-opened.
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Using the Medical Review Tab
The Medical Review tab has three sections as shown in the following illustration:

■ Case Narrative

■ Case Assessment

■ Event Assessment

The system displays the user-defined fields in the Medical Review dialog box, if they if 
been enabled on the Case Form Analysis tab. If they have not been enabled, they do 
not display on the tab.

Enter information in the Case Narrative, Case Assessment and Event Assessment 
sections.

About the Case Narrative Section  The Case Narrative section is fixed and cannot be 
changed. However, you can choose from the drop-down options associate with the 

Save and Close Click Save and Close to save and close the case.

Note:

■ An (S) is displayed for Serious events.

■ An (F) is displayed for Fatal events.

■ An (LT) is displayed for Life Threatening events.

■ An (H) is displayed for Hospitalized events.

Field Description
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fields to view any of the other narrative fields. The system saves the view as a default 
and uses it when you open the Medical Review for another case.

You cannot choose the same Narrative field in from the drop-down lists. For example, 
the first selected narrative field you selected is disabled in the second drop-down list. 
The following is an illustration of the Case Narrative section.

About the Case Assessment Section  The Case Assessment section enables you to provide 
information about case details. The following is an illustration of the Case Assessment 
section.

Select whether the case is serious or not from the Case Serious drop-down list. In a 
similar manner, select relevant information about Company Agent Causal, Listedness, 
and Case Outcome from the drop-down lists.

About the Event Assessment Section  The Event Assessment section allows you to 
understand more about the events. The following is an illustration of the Event 
Assessment section.

Event Assessment Fields and Field Descriptions
The following table lists and describes the fields in the Event Assessment section.

Field Description

Product This field is populated when events are entered in the Products tab and is 
displayed in the following format:

■ First Line - Product Name

■ Second Line - Generic Name
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Filtering in the Event Assessment Section
The following table describes how the each field of the Event Assessment section is 
filtered:

User Actions within Event Assessment
The following table lists user actions and their result.

Causality as 
Reported/

Causality as 
Determined

Event PT 
/Description/LLT

Causality as Reported -- Indicates the degree of reported causality.

Causality as Determined -- This field is populated with information 
entered in the Reported Causality field.

Event PT/Description/LLT -- This field is populated when events are 
entered in the Events tab and displays in the following format:

■ First Line - Event PT

■ Second Line - Verbatim

■ Third Line - LLT

D/S Displays the Diagnosis/Symptom details by D or S in line with the 
Events.

Seriousness 
Severity Duration

Display the Seriousness, Severity and the Duration of the Event.

Data Sheet Displays the data sheets for the agent.

License Displays the licenses for the agent.

As Determined 
Listedness

Indicates whether the system found the event on the datasheet for this 
product.

Field Description

Product The product filter drop down list contains all products listed in the event 
assessment. The user can filter on all the products which are present in 
the Event Assessment dialog.

Event Contains a drop down of values of distinct Event PT. The user can filter 
on all the products which are present in the Event Assessment dialog.

Diagnosis Contains a drop down values of D for Diagnosis or S for Symptoms.

Data Sheet Contains a drop down of values of distinct data sheets. All the blank data 
sheets display as a single row of <Unspecified>.

Licenses Contains a drop down of values of distinct Countries of the Licenses. All 
the Licenses which are not associated to a data sheet displays under 
<Unspecified> or are aligned with the data sheet view.

Note: Only the assessment rows that match the selected criteria are 
displayed in the filtering results.

User Action Result

Click Datasheet 
column's "plus" 
icon

Displays the license and data sheet views and displays the License 
Column and enable the "-" for the License Column.

Click Product 
Name

Displays the Product Information dialog for the selected product

Field Description
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Attaching Cases from the Medical Review Screen
Notes and Attachments and Contact Log sections appear on the Case Form Addition 
Info tab to the Medical Review screen as follows:

■ The new functions appear on the Action Items/Addl Info tab.

■ The performance of the Medical Review dialog remains the same while initially 
loading the dialog.

■ The system displays user-defined fields in the Medical Review dialog box if they 
have been enabled on the Case Form Analysis tab.

Using Temporal View Tab
Click Temporal View tab to view a read-only version of the case before routing. The 
following is an illustration of the Temporal View tab.

Click Event 
Description

Displays the Event Information dialog for the selected event

Click License 
Description

Displays the Product Information as defined in the License Configuration.

Click Datasheet 
Description

Displays all the configured terms in the data sheet.

User Action Result
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The information displayed in the Temporal View tab is taken from the information 
entered in the Case Form section. Click the following links for information about each 
section on the Temporal View tab.

About the Summary Section  The Summary section provides read-only summary 
information about the case.

The following table lists and describes each field in the Summary section.

Field Description

First Suspect 
Product

Displays the name of the primary suspect product.

Generic Name Displays the generic name of the primary suspect product.

Coded Indication Displays information about the product indication.

Gender Displays the gender of the patient.

Age Displays the age of the patient.

Report Type Displays the report type.

Reporter Type Displays the type of reporter reporting the event.

Company 
Diagnosis/Syndro
me

Displays the company diagnosis.
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About the Display Options Section  The Display Options section enables you to select 
information to view in the Event Assessment section of the form. The following is an 
illustration of the Display Options section.

The following table lists each check box and describes the information that displays in 
the Event Assessment section.

About the Event Assessment Section  The Event Assessment section provides summary 
information about the adverse event.

The following table lists and describes the information in the Event Assessment 
section.

Case Serious Displays whether the case is serious or not.

Company Agent 
Causal

Displays the case causality status.

Field Description

Suspect Products Select the check box to view Suspect Products in the Event Assessment 
Section.

Non-Suspect 
Products

Select the check box to view Non-Suspect Products in the Event 
Assessment Section.

Patient History Select the check box to view Patient History in the Event Assessment 
Section.

Patient Lab Data Select the check box to view Patient Lab Data in the Event Assessment 
Section.

Relevant Tests Select the check box to view Relevant Tests in the Event Assessment 
Section.

Events - All 
Events, Serious 
Events Only

Select the check box as required to view All Events/Serious Events Only 
in the Event Assessment Section.

Field Description

ID Denotes the type of event. For example, HOSP means Hospitalized.

Info Click the Info icon (i) to view details about the selected entity.

Item Displays the item name.

Field Description
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The system opens a unique dialog box for the event you have chosen to view. 

About the Relevant Tests Section  The Relevant Tests section provides information about 
any tests that were performed.

The following lists and describes

Using the Action Items/Addl Info Tab
The Action Items/Addl Info tab enables you to enter contact log information, 
information about action items, and notes and attachments. The tab has three sections 
as shown in the following illustration. The sections are:

■ Contact Log

■ Action Items

■ Notes and Attachments

Start Displays the date from when the event assessment began.

Stop Displays the last date of the event assessment.

Duration Displays the duration of the event assessment.

Name Contents

View Death Information Information about a death resulting from an adverse event.

View Event Information Information about the adverse event.

Hospitalization Information Information about the hospitalization that resulted from an 
adverse event.

View Patient History Historical information about the patient associated with the 
adverse event.

Product Information Information about the product that caused the adverse 
event.

Field Description

Relevant Tests Displays information about any relevant tests, if any.

Zoom/Unzoom Click the Zoom icon to view the report on a bigger scale.

Click the Unzoom icon to revert to the earlier view.

Flag Icon This icon displays the language text that is supported.

Notes Icon Click this icon to view/enter notes.

Field Description
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About the Contact Log Section
The Contact Log section enables you to track correspondence about an adverse event. 
The following is an illustration of the Contact Log section.

Contact Log Fields and Field Descriptions
When using the Contact Log section, be aware of the following:

■ The number displayed in parentheses in the header of each section - Contact Log, 
Action Item, Routing Comments, Case Lock/Archive - displays the total number 
of entities within the section.

■ You can choose to view All Action Items or only Open Action Items, which shall 
display all the Open Action items within the case. By default, All Action Items are 
displayed.

■ You can sort Action Items by clicking on the column headers.

■ The system remembers the sort order on for the duration of the case.

The following table lists and describes the fields in the Contact Log section of the 
Activities tab.
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Generating Letters  You can generate letters from the Contact Log section. When 
generating letters, be aware of the following:

■ The placeholders for the original letter template can be replaced by information 
that is specific to the current case.

■ A letter is only added to a search if the Correspondent check box is checked.

■ The Administrator can configure the system to generate letters automatically and 
to schedule them for a specific number of days after receiving details of an adverse 
event. For example, the system might schedule an Initial Response Letter to be 
sent the day after an adverse event is received. Auto letter scheduling is triggered 
when a case is initially saved.

■ Letters cannot be auto-generated unless the "Date" [contact log date] is reached, to 
ensure that the latest information for the case has been updated to the letter.

■ If the Primary Reporter is marked as a correspondence contact, the system sends 
Auto-scheduled letters are sent to the Primary Reporter. Otherwise, the letter is 
sent to the first correspondence contact.

■ Auto-scheduled letters appear in the Contact Log section of the Case Form. You 
can view or print them by double clicking the letter icon. You can also edit letters 
that have not been sent. The system does not automatically send letters. You must 
send or remove letters manually.

■ In addition to auto-scheduling letter, you can also configure auto action items, 
which prompt you to follow-up with a correspondent after a letter has been 
scheduled and sent. Auto action item scheduling is triggered once the sent date 
has been entered for a letter. Auto action items appear in the Action Items section 
on the Case Form and in the Action Items tab of the Worklist.

Use the following procedure to generate a letter.

To generate a letter
1. Go to Contact Log in the Activities tab and click New Letter.

Field Description

Date The date the letter was generated and sent. The following icons may be 
present:

Click the letter icon to open the Letter Preview dialog. This allows you to 
view a letter or to modify it if it has not been sent already.

Date Sent The date is automatically inserted when a letter is sent through the letter 
menu. You can also manually enter the date the letter was sent. If this 
field is completed, the letter will become read-only.

Code The contact code for this entry. The Administrator can adjust the 
information in this list.

Click this e-mail button to open a message editor.

Description Enter a brief explanation for the letter, for example, "Initial Letter," or the 
details of a phone conversation.

New Letter Click this button to generate a new letter

Group/User Select a group responsible for the Contact item. From the list below, select 
a user from the selected group who will be responsible for the action.

The Contact Item will appear in the Worklist for selected user. If "Any" is 
chosen as the group, the Action Item appears in all the users' Worklist. 
The Administrator can adjust the information in these lists.
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2. The Custom Letter Templates dialog opens.

3. Select the required letter template from the list and click OK to open the letter in a 
separate window.

4. Make the necessary changes to the letter text.

5. Select File-->Save to save the changes.

6. If you modified the letter, select Yes.

This attaches the letter to the Case Form by browsing to the location where you 
saved the changes.

7. After saving the letter, the system displays it in the Contact Log section of the 
Activities tab.

8. The system creates an action item for following-up on this letter in the Action 
Items section of the Activities tab.

Scheduling Action Items for Letters  When specifying or changing the Date Sent field in a 
letter, you can schedule an action item if you wish to do so.

■ If an action item is not specified, the field is blank.

■ Any Action Item can be updated on the screen immediately after a case has been 
saved.

■ Unless the Action Item has already been marked as completed, each time the Date 
Sent field is changed for a letter, the corresponding action item (if one exists) is 
also updated with a new Due Date of Date Sent of the Letter and the number of 
days specified for the Action in the Letter configuration

Opening a Message Editor  To open a message editor

Click to open the message editor.

The following table lists and describes the fields in the dialog box

About the Action Items Section
The Action Items section enables you to enter action items and their related 
information. The following is an illustration of the Action Items section.

Field Description

To Displays the e-mail address specified for the Primary Reporter in the 
Case Form.

You can edit this field.

From Displays the e-mail address specified in the Return E-mail Address in 
Argus Console>Code Lists>Letter Configuration. You can edit this field 
also.

Subject Displays the Case Number and the Description of the Contact log.

You can edit this field.

Send Enables you to send the e-mail to the intended recipient.
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The following tables lists and describes the fields in the Action Items section.

About the Notes and Attachments Section
The Notes and Attachments section enables you to view notes and attachments 
associated with a case. The following is an illustration of the Notes and Attachments 
section.

Using the Coding Review Function
The Coding tab provides a single entry point for viewing and coding several kinds of 
information. The following is an illustration of the coding tab.

Field Description

Date Open Enter the date the action item was created. Open action items appear in 
the Worklist of the user who is responsible for the action item. They also 
appear in the Open Action Items Report.

Due Enter the date on which the action item is to be completed.

Completed Enter the date on which the action item was actually completed.

Code Select an Action Item code from the drop-down list. This will display the 
description of the selected Action Item Code. The Administrator can 
adjust this list.

Description Selecting an Action Item code automatically enters information into this 
field. The text can be modified as required. The Administrator can adjust 
this list.

Group/User Select a group responsible for the Action Item from the given drop-down 
list. From the drop-down list below this, select a user from the selected 
group who will be responsible for the action. The Action Item will appear 
in the Worklist for the selected user. If "Any" is chosen as the group, the 
Action Item appears in all the users' Worklist. The Administrator can 
adjust these lists.
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General Information
The following is an illustration of the General Information section of the Coding tab.

The following table lists and describes the fields in the General Information section.

Product Information
The following is an illustration of the Product Information section of the Coding tab.

The following table lists and describes the fields in the Product Information section.

Event Information
The following is an illustration of the Event Information section of the Coding tab.

Field Description

Report Type Identifies the type of case.

Study Info Displays study information about of the case.

Patient Info Identifies the patient's age & gender.

Literature Info Displays information about the Primary Literature of the case.

Field Description

Product Name Displays the product name.

Dosage Form Displays the configured formulation for the drug.

Strength / Unit Displays the configured Concentration and Units for the drug.

Indication Verbatim Identifies the indication associated with the product.

IND Coded (LLT) Displays the Coded PT with LLT in parenthesis.
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The following table lists and describes the fields in the Event Information section.

Death Information
The following is an illustration of the Death Information section on the Coding tab.

The following table lists and describes the fields in the Death Information section.

Patient Information
The following is an illustration of the Patient Information section on the Coding tab.

The following table lists and describes the fields in the Patient Information section.

Field Description

Event verbatim Event name as reported.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Seriousness Displays the Event Seriousness for the Event.

Severity Displays the Event Intensity for the Event.

Duration Displays the Event Duration for the Event.

Field Description

Cause of Death Displays the coded or un-coded event verbatim for cause of death.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Field Description

Patient -- Other Relevant 
history: Condition Type

Displays the condition type of the patient's previous history.

Patient -- Other Relevant 
history: Verbatim Coded 
(Description)

Displays the condition of the patient's previous history.

Coded PT (LLT) Displays the Coded PT with LLT in parentheses.
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Lab Data
The following is an illustration of the Lab Data section on the Coding tab.

The following table lists and describes the fields in the Lab Data section.

Parent Information
The following is an illustration of the Parent Information section on the Coding tab.

The following table lists and describes the fields in the Parent Information section.

Patient -- Other Relevant 
history: Condition Type if 
equal to Historical Drug

Displays the condition type of the patient's previous history.

Patient -- Other Relevant 
history: Verbatim Coded 
(Description)

Displays the condition of the patient's previous history.

Coded PT (LLT) Displays the Coded PT with LLT in parentheses.

Indication Verbatim Displays the Indication Verbatim for the Historical Drug.

Indication Coded PT (LLT) Displays the Coded PT with LLT in parentheses.

Reaction Verbatim Displays the Reaction Verbatim for the Historical Drug.

Reaction Coded PT (LLT) Displays the Coded PT with LLT in parentheses.

Field Description

Test Name Displays the Lab Data Verbatim for the Lab Data.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Results / Units Displays the entered Results and Units for the Lab Data.

Normal High / 
Low

Displays the configured Normal High and Low with Units for the Lab 
Data.

Field Description

Condition Type Displays the condition type of the Parent previous history.

Verbatim Coded Displays the condition of the Parent previous history.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Field Description



Working with Cases

5-26 Oracle Argus Safety Japanese User's Guide

Case Analysis
The following is an illustration of the Case Analysis section of the Coding tab.

The following table lists and describes the fields in the Case Analysis section.

Using the Action Item Tab
The Action Item tab enables you to view and track action items for a case. The 
following is an illustration of the Action Item tab.

Click the following link for information about the fields and controls on the Action 
Items tab.

Action Item Fields and Field Descriptions
The following lists and describes the fields and controls on the Action Item tab.

Indication Verbatim Displays the Indication Verbatim for the Historical Drug.

Indication Coded PT 
(LLT)

Displays the Coded PT with LLT in parenthesis.

Reaction Verbatim Displays the Reaction Verbatim for the Historical Drug.

Reaction Coded PT 
(LLT)

Displays the Coded PT with LLT in parenthesis.

Field Description

Company Diagnosis 
/ Syndrome 
Verbatim

Displays coded or un-coded event term for diagnosis or syndrome that 
the company ascribes to the case.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Field Description

Show Enables you to show all action items (open and closed) or show on the 
open action items.

Add Enables you to add a new action item

Delete Enables you to delete an action item.

Field Description
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Using the Print Function
The Print function enables you to print the following:

■ Case Form

■ Medical Summary

You access each of these print functions from the Case Actions menu. The following is 
an illustration of the Print Case dialog box.

Up Enables you to move to the previous action item in the list

Down Enables you to move to the next action item in the list.

Date Open Enter the date the action item was created. Open action items appear in 
the Worklist of the user who is responsible for the action item. They also 
appear in the Open Action Items Report.

Date Due Enter the date the action item is due to be completed.

Completed Enter the date the action item was actually completed.

Code Select an Action Item code from the drop-down list. This will display the 
description of the selected Action Item Code. The Administrator can 
adjust this list.

Description Selecting an Action Item code automatically enters information into this 
field. The text can be modified as required. The Administrator can adjust 
this list.

Group 
Responsibility

Select a group responsible for the Action Item from the given drop-down 
list. From the drop-down list below this, select a user from the selected 
group who will be responsible for the action. The Action Item will appear 
in the Worklist for the selected user. If "Any" is chosen as the group, the 
Action Item appears in all the users' Worklist. The Administrator can 
adjust these lists.

User Select the user responsible for handling the action item.

Print Enables you to print a list of action items

Draft Report Provides access to the Draft Reports including Medical Summary Report. 
You cannot access to Medical Review Summary Report, if you do not 
have access to the Medical Review dialog.

Code Opens the Code dialog box.

Field Description
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Accessing Print Case Form Functions
Use the following procedure to access the Print Case Form functions.

To access print Case Form functions
1. Open a case

2. Select Case Actions --> Print --> Case Form.

3. The system opens the Print Cases tabbed dialog box.

Accessing Print Medical Summary Functions
Use the following procedure to access the Print Medical Summary function.

1. Open a case.

2. Select Case Actions --> Print --> Medical Summary.

3. The system opens the Medical Summary Report.

Printing a Case
The Print Case tabbed dialog box enables you to:

■ Print a case form or any of its sections (Print tab)

■ View and print letters associated with the case (Letters tab)

■ View and print attachments associated with a case (Attachments tab)

■ Transmit case information (Transmit tab)

The following is an illustration the tabbed Print Case dialog box.
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Click the following links for information about using the Print Case dialog box and 
printing cases, letters, and attachments and transmitting cases.

Printing a Case
The Print tab contains a check box for each section of the Case Form. You can print any 
or all of the sections on the Case form. However, the system only prints the sections 
you select. When printing a Case From be aware of the following:

■ Select the Include Multiple Language Text check box, to print multiple language 
text

■ Click the Blind Study Product check box to blind product information for study 
cases

The following is an illustration of the Print tab.

To print sections of the case form
1. Click the check box for each section of the Case Form you want to print

OR

Click Select All to select all the sections of the Case Form.

2. Click Print to print the case.

Note: If the printed cases do not appear to be formatted correctly, 
adjust your printer settings.
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Viewing and Printing Letters
The Letters tab enables you to view and print completed letters.

To view and print a letter
1. Click the letter description link to display the letter.

2. When the system opens the letter, click Print to print it.

Viewing and Printing Attachments
The Attachments tab enables you to view and/or print case attachments. The system 
prints date/time information:

■ As footers on all printouts (except letters).

■ In the following format: dd-mmm-yyyy hh24: mm: ss.

To print case attachments
1. Click the attachment description link to display the attachment.

2. When the system opens the letter, click Print to print it.

Transmitting a Case
The Transmit tab enables you to transmit a case electronically.
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To transmit a case
1. Select the recipient from the Available Recipients list.

2. Select the transmission method from the Method list.

3. Enter any comments under Comments.

4. Click Transmit.

Printing a Medical Summary
The Print Medical Summary function enables you to print the medical summaries for 
a case. The following is an illustration of the Medical Summary Report.

To print the Medical Summary
1. Open a case.

2. Select Case Actions --> Print --> Medical Summary.

3. The system opens the Medical Summary Report.

4. Select File - Print in the PDF to take a printout of the medical summary.
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Deleting a Case
When you delete a case, you can no longer access it from the application. However, the 
system does not remove the case information from the database. Before the system 
permits you to delete a case, you must provide a justification. The following is an 
illustration of the delete justification dialog box.

To delete a case
1. Select Delete --> Case Actions.

2. When the system opens the Action Justification dialog box, do one of the 
following: Enter the justification manually in the Please enter a justification for 
performing this action field

OR

Select a pre-defined justification from the Select a standard justification field.

3. Type your Argus login password in the Password field.

4. Click OK.

Action Justification Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Action Justification dialog box.

Viewing Case Revisions
The Case Revisions feature enables you to view the Revisions made to cases. You can 
track the revision where follow-up information appended to the case. The follow-up 
designations are as follows:

■ (S) F/U -- Indicates that significant follow- up information is attached to the case.

Field Description

Please enter a justification 
for performing this action

Enter the text that justifies the need to delete a case.

Password Enter your password

Select a standard 
justification for this field

Contains standard, pre-configured descriptions of justifications 
for deletion.

Spell Check Checks the entered/selected text for any grammatical errors.

OK Saves the justification entered/selected for case deletion.

Cancel Exits out of this dialog without saving any justification.
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■ (NS) F/U -- Indicates that the follow-up information attached to the case is not 
significant.

The following is an illustration of the Case Details dialog box.

To view case revisions
1. Open a case.

2. Select Case Actions --> Case Revisions.

The system opens the Argus Safety Case Details dialog box. The dialog box 
provides the following information for the current case:

■ Scheduled Reports

■ Submitted Reports

■ Case Revisions

3. 4. Select the desired report from this list.

4. 5. The system displays the Audit Log Details screen containing a list of all 
revisions.
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6Advanced Conditions

Argus Safety provides a powerful search tool that enables you to build complex 
queries for retrieving system data. You can create complex or non-standard queries in 
the Advanced Conditions dialog box where you can define field-level search criteria. 
Detailed knowledge of the database schema is not required.

Advanced Conditions
Click the Advanced Conditions button to begin creating advanced conditions to open 
the Advanced Conditions dialog box.

From the Advanced Condition dialog box, you can save and retrieve sets of search 
criteria (advanced conditions) and add, edit, or delete them. Access rights and 
permissions can be assigned to individual advanced conditions. You can execute and 
modify rights to one or more groups on a per-advanced condition basis.

When using Advanced Conditions, be aware of the following:

Note: Note: Only users with execute rights for an advanced 
condition, can view the advanced condition in the drop-down list in 
the Case Open dialog.
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■ By default, the Advanced Conditions drop-down list enables you to view only the 
New, None, and already selected Advanced Conditions.

■ Select New or None from the drop-down list and click the AC button to create a 
new advanced condition.

About the Advanced Condition Screen
You can choose and rename a query set on the Advanced Condition screen. However, 
the rename function is restricted to users who have permission to modify the 
advanced condition. When you open an advanced condition or query set, the system 
places the current query name in the Name field. The following is an illustration of the 
Advanced Condition screen.

When using the Advanced Condition screen:

■ You must click Save to record changes to the advanced condition name.

■ The system disables the Save button until you enter an advanced condition name 
in the Name field.

■ If you fail to enter a name before saving, the system displays the following 
message:

Please enter the Advanced Condition name before saving. You have made changes 
to the existing item, if you press OK, changes made will be lost.

■

■ When you click Save, the system saves the query set with the new name and 
description.

■ When you click Save, the system refreshes the Query Set drop-down list.

■ You can import a XLS, XLSX or TXT file with one column containing case numbers 
as shown in the following illustration.

■ If you attempt to upload a file format other than XLS, XLSX, or TXT, the system 
displays the following message:

Only XLS or Text Files are supported for Importing cases as a Hit List.
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■ When you upload a text file, each line in the file is considered a complete case 
number.

■ When you click Import, the system enables you to browse to the file.

■ If a case is missing (cannot be found), the system displays the following message:

Case Number: XXXX is not found

■ If a case has been deleted, the system displays the following message:

Case Number: XXXX is deleted.

■ If there are multiple missing or unfound cases, the system displays all of them in 
the message dialog box.

■ If the same case has been entered multiple times; the system ignores it after it 
imports it.

■ The system can import 1000 cases/60 seconds for the Hit List.

■ After the system creates the Hit List, the user clicks Store Hit List. This system 
saves the advanced condition and stores the hit list so you can retrieve it for later 
use.

■ When you click Hit List, the system displays the cases in the hit list, and all other 
data and options, on the Case Open screen for further processing

■ When you click Export on the Hit List, the system exports the data in CSV format.

Filtering for Existing Advanced Conditions
Use the following procedure to filter for existing advanced conditions.

To filter for existing advanced conditions
1. Click in the Case Search Criteria section to open the Advanced Conditions 

Lookup dialog box.

2. Select one of the following options from the drop-down list under Filter

■ Contains - Enables you to filter for advanced conditions that contain the 
entered criteria.

■ Starts With - Enables you to filter for all advanced conditions that start with 
the entered criteria.

3. Enter the search criteria for the advanced conditions in the text box, as applicable.

4. Click Filter to display the advanced conditions matching the specified filtering 
criteria.

5. Select the appropriate advanced condition from the list.

6. Execute any of the actions below, as applicable:

■ Click OK to list the selected advanced condition in the Advanced Conditions 
drop-down list.

■ Click AC to display the details for the selected advanced condition in the 
Advanced Conditions dialog.

■ Click Cancel to close the Advanced Condition Lookup dialog without saving 
changes.

■ Select a previously selected advanced condition from the drop-down list to 
apply the search criteria for that condition.
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Viewing Results from Existing Advanced Conditions
Use the following procedure to view the results of existing advanced conditions.

To view the results of an existing advanced condition.
1. Select an Advanced Condition from the Advanced Conditions drop-down list.

2. Click Search.

3. The system displays the cases matching the criteria specified in the selected 
Advanced Condition.

4. The system displays a list of matching cases is displayed in the Total Number of 
Rows section.

Working with Advanced Conditions
This section provides information about how to create and user Advanced Conditions.

Creating, Viewing or Modifying Advanced Conditions
Use the following procedure the create, view, or modify an advanced condition.

To create an advanced condition
1. Select New from the Advanced Conditions drop-down list

OR

Click the Advanced Conditions icon. 

2. When the system opens the Confirmation dialog box:

Click Yes to create a new advanced condition query set

OR

Click No to create a new advanced condition by associating logical operators (like 
AND, OR) with items from the Case Form.

3. If you select No, the system opens an Advanced Condition Set dialog box.
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About the Advanced Condition Set Dialog Box
The Advanced Condition Set dialog enables you to search for those entities under the 
Properties tree-list, which are from either the case data or from the code list. The dialog 
box has two buttons that provide this functionality:

■ From Code List -- If you select this option, the Value drop-down list displays a list 
of all values configured in the Code List

■ From Case Data -- If you select this option, the Value drop-down list displays only 
the values actually in the cases.

■ These radio buttons display only if the selected entity belongs to a code list. Select 
the relevant entity and one of the radio buttons, as applicable to search the entity 
based on the code list or case data, as specified.

■ The Product name field can contain up to 70 characters for searching.

■ In the Suspect Product Name, Product Name 2/Study Cases, Company Product, 
Study Drug, and Primary Suspect Drug sections, you select the product from the 
company product browser instead of the drop-down values by clicking the select 
button in the Read Only text field.

■ When you click the select button, the system transfers the Product Name to the UI 
to enable you to search on the selected product.

■ Select a property type from the Properties tree list.

Additional Information about Properties
The items available in the folders in the Properties list represent Case Form fields you 
can use to perform the search in the advanced conditions. Be aware of the following:

■ You can auto-populate an Advanced Condition by right-clicking a field in the 
Properties section to enable a field-to-field comparison.

■ When you select a Property for which terms can be encoded, the system enables 
the Select button. You can use the MedDRA Browser to select (possibly) multiple 
terms for the property. Refer to Using the MedDRA Browser for Advanced 
Conditions for further details.

■ The system enables an SMQ icon when you select SMQ-related properties from the 
Properties tree-list. Click this icon to view the SMQ Info dialog. It contains details 
about the selected SMQ.

■ In the Conditions list, select a condition that must apply to the item selected 
above.

Available conditions are:

1. In the Value field, enter the value that applies to the property or select an 
appropriate value from the list.

2. If the created condition created is to be linked with another condition, select the 
appropriate logical operator from the list adjoining Value.

3. Click Add to add the newly created condition to the advanced condition.

■ equal to

■ contains

■ less than

■ greater than

■ not equal to

■ greater than or equal to

■ less than or equal to

■ exists

■ missing

■ does not contain

■ begins with
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4. Repeat steps 3 through 8 to add more conditions to the advanced condition.

5. After entering each of the conditions required for the advanced condition, click 
Save.

6. Enter a name for the advanced condition and click OK.

Sharing Advanced Conditions
The system provides the option of share advanced conditions with other users. To 
enable other users to use the advanced condition, click the Share with other users.

When sharing advanced conditions with other users, be aware of the following:

■ If an Advanced Condition is not shared with other users, the Advanced Condition 
does not appear in the Advanced Condition list for any user except the 
Administrator and the user who created it.

■ If the Advanced Condition is shared, all users in the system can view the 
advanced condition, but cannot modify it.

■ You cannot stop sharing an Advanced Condition, if the Advanced Condition is in 
use in the system.

Using Advanced Conditions
You can use Advanced Conditions from the Case Selection dialog. Use the following 
procedure to do so.

To use advanced conditions
1. Select Case Actions --> Open.

2. Depending on how the criteria is to be used, you can do the following:

■ Use a set of previously saved criteria

■ Select the appropriate set of criteria from the Advanced Condition list.

■ Select the set of criteria from the Advanced list and click the adjoining 
Advanced Condition icon.

■ Add a new condition to a set of criteria

■ Create a new advanced condition by associating logical operators (like AND, 
OR) with items from the Case Form

Tip: You can use the AND and OR logical operators to link an 
existing condition to a new condition.

■ If you are using the AND operator to link two conditions, both 
conditions must be TRUE for the advanced condition to be TRUE. 
In all other cases, the advanced condition evaluates to FALSE. 

■ If you are using the OR operator to link two conditions, the 
advanced condition is TRUE if either or both conditions are 
TRUE. The advanced condition evaluates to FALSE if both 
conditions are FALSE.

Tip: To enter a customized Date Range:

1. Select Custom Date Range from the list.

2. Enter an appropriate date range in the custom date range dialog.

3. Click OK.
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Creating an Advanced Condition Query Set
Use the following procedure to create a Query Set of Advanced Conditions.

To create a Query Set of Advanced Conditions:
1. Select New from the Advanced Conditions drop-down list or click the Advanced 

Conditions icon.

2. A dialog that prompts for the creation of an advanced condition query set opens.

3. Click Yes to create a set of advanced conditions by linking together those 
advanced conditions that have been defined previously.

4. The Advanced Condition Set dialog appears. In this dialog, previously-created 
advanced conditions can be linked together using set operators like UNION, 
MINUS, and INTERSECT.

5. Click Add to add an advanced condition to the query set. A new row opens in the 
advanced condition selection area. In this row, select an appropriate advanced 
condition from the Advanced Condition list.

6. Select an appropriate set operator from the Set Operator list. This set operator will 
link this advanced condition to the next advanced condition.

7. To add the next advanced condition to the query set, click Add.

8. Repeat steps 5 through 7 for each advanced condition that must be entered in the 
query set.

8. When each of the advanced conditions for the query set is entered, click Save.

9. Enter a name for the advanced condition and click OK.

Renaming Query Sets  You can rename a query set from the Advanced Condition Set 
screen. However, only users with the appropriate permissions can modify a query set. 
When the user opens an advanced condition or query set, the system places the 
current query name in the Name field. The following is an illustration of the 

Tip: To modify, open, or delete advanced conditions, click Open in 
the Advanced Conditions dialog. A list of all the advanced conditions 
will be displayed. In this list, select the appropriate advanced 
condition and click Open to open or modify it, or Delete to delete it.

To view or modify the SQL statement associated with an advanced 
condition, click Show SQL. Make the required modifications to the 
SQL statement, if necessary.

Note: If the required advanced condition is not already present in 
the list, it can be created by selecting (New) from the list. If an existing 
advanced condition requires modification, select it and click Edit. The 
advanced condition can be edited by a user only if it was created by 
that user.

Note: To view or modify the SQL statement associated with an 
advanced condition, click Show SQL. Make the required modifications 
to the SQL statement, if necessary.
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Advanced Condition Set screen.When renaming a query set, be aware of the 
following:

■ Click Save to update the changes to the query set name.

■ The system disables the Save button until you enter an advanced condition name 
in the Name field.

■ When you click Save, the system saves the query set with the new name and 
description.

■ When you click Save, the system refreshes the Query Set drop-down list.

■ If you fail to enter a query set name before clicking Save, the system displays the 
following message:

■ Please enter Advanced Condition Query Set Name before saving.

■ If you rename the query set and attempt to close the Advanced Condition Set 
window without clicking Save, the system displays the following error message:

■ You have made changes to the existing item. If you press OK, changes made will 
be lost.

■ When you click New, the system clears all values from the Name, Description, 
and Query Set fields.

Using the Hit List Tab
The Hit List tab enables you to search for cases that match the query set criteria for the 
advanced condition.

To search for cases
1. Click Find Now in the Hit List tab of the Advanced Conditions dialog.

2. This system runs a search based on the selected query set criteria and displays a 
list of cases (if any) that satisfy the advanced condition query set.

The following table show the operations you can perform in the Hit List tab.
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To... Do the following

Manually add an existing case to the hit 
list

Click Add and enter the Case ID in the text box

Remove a case from the hit list Click Delete

Save the hit list result for future use Click Store Hit List

Retrieve results of the saved hit list Click Retrieve Hit List

Save the hit list as a text file Click Export

View SQL for Query Click Show SQL

Run a Query Click Find
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7Worklist

The worklist is an important part of the Argus Safety user interface. Therefore, the 
Administrator may have configured your user account so that the Worklist displays 
each time you log on to the system. 

About Worklist
The worklist is an important part of the Argus Safety user interface. Therefore, the 
Administrator may have configured your user account so that the Worklist displays 
each time you log on to the system. Place the cursor over Worklist in the menu bar to 
view the available options.

General Usage Information
The worklist displays the following information:

■ New cases created in the system

■ Cases that are currently open

■ To Do items like letters, reports, and other action items

■ Transmission status of reports

■ All bulk printed reports

When using the worklist, be aware of the following

■ The Worklist dialogs have filtering options on all elements in each worklist as 
follows:

– New/Open

– Bulk Print

– Reports

– Action Items

– Bulk Transmit

– Bulk Transmit E2B Messages

– Bulk Transmit E2B Reports

– Coding Status

– Coding Action Items

– Contact/Letters
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– Letters

■ You can filter on any element by clicking the Filter icon to display the filtering 
row.

■ The system now provides a type ahead feature to enable you to filter on any 
text/date element.

■ You can minimize the filtering options by clicking the minimize icon. 

■ The paper clip icon identifies the maximize icon.

■ You can perform a Like search. In other words, if you search for "Cure," the system 
returns all elements starting with "Cure."

■ You can perform a wildcard search. In other words, if you search for "Cure" the 
system returns all elements containing "Cure."

■ The user can click the Search button to filter for reports in the reports list.

■ These filtering options are available from worklist-specific views and when 
performing case or reports drill down searches from the Dashboards.

■ The system saves all user preferences, including filtering options and filter views, 
for future use.

■ The Days Open fields on the WL|New and Open have a drop-down list with 
values of <7, 7-15, >15, and the Worklist Reports has values of 7, 15

■ The Assigned To filtering element has been removed from the Worklist New and 
Open dialogs in the MAIN filtering criteria

■ All the worklist dialogs have a refresh icon beside the View option. This enables 
you to refresh worklist dialogs that use the preference saved in the worklist 
elements.

■ All the worklist dialogs have a minimize button to minimize the filtering options. 
This increases the number of rows that display in the list.

Worklist Filtering
The Worklist Filtering options enable you to search for a specific case. The Filter 
contains editable fields that enable you to either select from a list of values or perform 
a Wild card search. This feature applies to all the Worklist Filters across all worklist 
items.

The Worklist filter in each Worklist entity contains the following filtering options:

■ View Individual

■ View Group and

■ View All

The default filter is Case Number. This enables you to enter a Case Number to search 
for results matching a specified case number.

Worklist Options
The following worklist options are available to you.

■ New and Open

■ Action Items

■ Coding Action Items
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■ Contacts

■ Reports

■ Bulk Transmit

■ Bulk Print

■ Coding Review

■ Bulk Transmit E2B

■ Local Labeling

■ Coding Status

■ Letters

New and Open
This section discusses the features provided by the Worklist - New and Open menu 
items.

■ When you select New, the system displays new worklist items that have been 
assigned but not yet accepted. You can also see unassigned cases.

■ When you select Open, the system displays all cases that have been assigned and 
accepted.

To view the Worklist - New or Open page
1. Select Worklist --> New or Worklist --> Open

2. When the system opens the Worklist - New or Worklist - Open screen, enter 

General Usage Information  When using the New/Open Worklist screen, be aware of the 
following:

■ The New/Open Worklist displays the Workflow Group and the Workflow State 
currently associated with the case.

Tip: The same fields are displayed in the Worklist - Open screen 
also.
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■ The Workflow Group is available in the Worklist New and Open printouts.

■ You can sort on this field.

■ The lock icon identifies cases that are locked.

■ The Initial Date field has been renamed Receipt Date and enables you to view the 
date the case was first received. The new name displays on the UI and on the 
Printout.

■ The system allows multiple assignments of cases for Workflow/Enterprise 
Managers only on the Worklist New/Open dialogs.

■ The system displays the user name to enable you to select a User for reassignment.

■ If the user has cases open, the system skips those cases.

■ The system tracks updates in the audit log.

■ When the user selects this option, the selected cases have the same user as 
modified by the user.

Search Case  The following is an illustration of the Search Case section.

Filtering Functions  The Filter function enables you to search for entities that are only in 
the worklist. The following is an illustration of the options available in the Filter 
drop-down list.

The following table describes the options available in the Filter drop-down list.

Field Description

Filter Performs searches for worklist items on the basis of the 
filtering criteria selected here.

Value Enables the user to select the desired Value as the search 
criterion.

Search Button Enables the user to open the selected or entered case ID.

Group Membership Enables the user to select the type of Group Membership.

Case Owner Enables the user to select the Case Owner.

Assigned To Enables the user to select who the case has been assigned to.

Only view locked Cases 
requiring Follow-up

Select this checkbox to view only those locked cases that 
require follow-up.

View Individual Enables the user to view individual items assigned to this 
group.

View Group Allows the user to view all items assigned to this user group.

View All Allows administrator and workflow manager to see all items 
in the system.

Option Description

Case Number Filters on Case Number.
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Total Number of Rows  The following is an illustration of the Total Number of Rows 
section

The following table describes the contents in the columns in the Total Number of 
Rows section.

Workflow State Displays only those workflow states that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Product Displays only those products that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event Preferred Term Displays only those Event PTs that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event as Reported Displays the name of the event as reported.

Case Report Type Displays only those Report Types that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Product Group Displays product groups where the Primary Suspect Drug occurs.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.

Field Description

Priority Displays the Priority of the Case.
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Lock Status Enables the user to view the Locked state of the case by the icon. If the 
locked icon is present, it indicates that the case is locked and vice versa.

Note: The lock icon is also displayed if the Case Status is Initial or 
Follow up. If the case is Follow-up, additionally, the Follow up number is 
also displayed.

For example: Initial or F / U: 1.

The icon (displayed in the lock state column) in the Worklist - New, 
Open and Reports screens denotes a SUSAR (Suspected Unexpected 
Serious Adverse Reaction) case.

Lock State Header Options

Click the Lock State header row. A pop-up appears listing the following 
sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Initial Date Displays the Initial Receipt Date of the Case.

Aware Date Displays the Aware Date of the case.

Note: Aware date is the latest significant follow up which is received in 
the case or the Initial Receipt Date if there are no Significant follow ups 
present in the case.

Days Open Displays the number of days that have elapsed since the Receipt Date.

Days Remaining Displays the number of days that are remaining, as configured in the 
Administration module for Case Processing.

Case Number Displays the Case Number.

Note: Click the case number to open the case.

Workflow Status Displays the current workflow status of the case.

Product Name Displays the first suspect product in question.

Generic Name Displays the generic name of the suspect product in question.

Event PT Displays the Primary Event and Verbatim, as reported.

Event Verbatim Displays the Event Verbatim, as reported, in the format Primary Event 
(Verbatim as Reported).

S/U/R Displays the Case Level Assessments:

■ S denotes Serious (Y/N)

■ U denotes Unlisted (Y/N)

■ R denotes Causality (Y/N)

Note:

■ Unknown is treated as a "?"

■ When the user clicks the SUR link, the Case Summary gets 
displayed.

Field Description
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The Worklist>New and Worklist>Open also display a status beside Priority, 
indicating that the time remaining has exceeded the allocated time.

Routing Details  This section enables you to enter case routing details.

Workflow Options
The Worklist pages have some common options for your use. To see a list of these 
options, right-click the icon Lock State icon to display an option menu.

Worklist User Options
The following tables lists the different user options and where they are available

F, LT or H ■ F denotes a Fatal (F) case

■ LT denotes Life Threatening (LT)

■ H denotes Hospitalized (H)

Note:

If any of the above are present together, then Fatal takes precedence 
followed by LT followed by H. If the case is neither of the above, No is 
displayed.

Case Type Displays report type information.

Study ID Displays the Study ID of the study cases.

Note: If Study ID is not present, this field is blank.

Reporter Type Displays the Reporter type for the Primary Reporter in the case.

Note: If Reporter ID is not present, this field is blank.

Country Displays the Country of the incident.

Assigned To Displays the current owner or "Unassigned" user to the case.

Owner Displays the Owner of the case.

By default, the first user to accept a case after book-in becomes the "Case 
Owner". The Case Owner has the access right to assign the cases that he 
owns to another user. Though a Case Owner cannot be reassigned 
automatically after the initial assignment, he can be reassigned manually 
by a Workflow manager.

Note: If Owner is not present, this field is blank.

Print List Button Allows the user to print the current worklist for reference.

Note: You can open a case in read-only mode without creating a case 
lock. Use Open in Read-Only to open the case in read-only mode. You 
cannot save a case in a Read-Only mode.

Option Description
Option available 
under Worklist

Open Read Only Opens the selected case in 
read-only mode.

New, Open

Field Description
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Accept Case Allows the user to accept the case 
and assign a user name as 
responsible for that case. A case 
marked with their name as 
responsible moves the case from 
the user's New tab to their Open 
tab.

New

Batch Accept Allows the user to accept multiple 
cases at a time (up to 10 cases).

New

Un-Accept Case Returns the case to the Open 
status.

Open

View Case Opens the case. Action Items

Batch Open Allows the user to Batch open up 
to 5 Cases.

Action Items

Case Summary Displays the Summary dialog to 
allow the user to view a summary 
of the case form data.

Action Items, 
Open, Reports

Adjust Priority Allows the workflow manager to 
modify the priority level of the 
case.

New, Open

Adjust Assignment Enables the Assigned User field for 
the selected row.

Allows a workflow manager user 
to modify the assigned user.

New, Open, 
Reports

Adjust Case Owner Enables the (re-)assignment of a 
Case Owner by a Workflow 
Manager.

New, Open

View Report Allows user to open the report. Reports

Accept Report Allows the user to accept the 
unassigned report.

Reports

Approve Report This option is enabled only if the 
report is in the Generated state. 
Select this option to automatically 
open the Routing tab of the Report 
Details pop-up window, with the 
Comment field active waiting for 
user input.

Reports

Local Labeling Allows the user to open the local 
labeling for the case that the 
expedited report belongs to, 
showing all the non-assessed local 
labeling rows.

Reports

Mark for Non-Submission Allows the user to mark the report 
required for Non-Submission. The 
report details dialog is displayed 
with focus to the Submission tab.

Reports

Mark Multiple for Non-Submission Allows the user to also mark 
Multiple reports for 
Non-Submission. The notes and 
date entered are also reflected in all 
the reports.

Reports

Option Description
Option available 
under Worklist
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Worklist Action Items
This section discusses the features on the Worklist - Action Items page as shown in 
the following illustration:

Close Action Item Allows the user to close the 
highlighted action item.

Note: Only the Owner of the action 
item can view this option, not all 
the users.

Action Items

Adjust Assignments Allows the user to adjust 
assignments for multiple cases.

Open

Print Multiple Cases Allows the user to print a case 
form from the New and Open 
worklist tabs.

New, Open

Archive Case Allows a workflow manager to 
close a case from the worklist New 
and Open windows.

New, Open

Batch Archive Allows a workflow manager to 
close multiple cases from the 
worklist New and Open windows.

New, Open

Medical Review Allows the user to view the 
Medical Review dialog (if he has 
the access rights to view it).

New, Open, 
Reports

Medical Summary Report Allows the user to view the 
Medical Summary Report (if he has 
the access rights to view it).

Reports

Coding Review Allows the user to view the Coding 
Review dialog if the user belongs 
to a group with access rights to 
Coding Review (if he has the 
access rights to view it).

New, Open

Route Multiple Cases Allows the user to route multiple 
cases to the selected workflow 
state.

New, Open

Option Description
Option available 
under Worklist
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To view the Worklist -- Action Items page

1. Select Action Items from Worklist.

2. When the system opens the Action Items screen, enter the information in the fields 
as necessary.

General Usage Information
The Worklist Action Items displays the entire description of the Action item selected in 
the Description field on the dialog. Be aware of the following:

■ The system displays the Action Item Code with the Description of the Action Item.

■ You can filter or sort the groups assigned to the Action Items.

■ The Product Name and Study ID have been combined into a single column.

■ The printout prints the new columns.

■ Worklist > Coding Action Items displays the entire description of the action item 
selected in the Description field on the dialog.

Query Management
The system generates open Query Action Items based on the advanced conditions 
rules for the action item type.

■ When the user saves the case or clicks the Generate Query icon on the Quick 
Launch toolbar, the system creates an open action item based on the profile switch.

■ The assigned group is defined in the code list. If there is no defined group, the 
default group is Unassigned.

■ The Due date for the action item is the System Date + the Due Date (in days) as 
defined in the code list.

■ The Open Date is the system date on the day the Query is created for the case.

When you click Generate Queries icon, the system generates the Action Item 
queries. These queries are based on the rules define for the Action Item types in 
Code List Maintenance where the Advance Condition satisfies the case criteria.

This item displays on the Quick Launch Toolbar when the case it open.
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Short cut key: CTRL+ALT+X

When you save or click Generate Query, the system evaluates all open query 
action types.

If, after the system schedules the action item query, unresolved queries are resolved or 
there are queries that do not meet the criteria of the Advance Conditions, the system 
closes the action item and uses the system date as the close date.

If there are open query action Items, the system does not create new action items with 
the same name when the system tries to resolve the open queries list in the case form.

Query Action Item Example
When querying action items, be aware of the following:

■ The Worklist|Action Items enable you to query only query action items by 
clicking the View Query Action Items check box.

■ By default, the system displays all types of action items to the user.

■ The system allows all open query type action items to be populated in a Letter 
template by adding the following place holder [OPEN_QUERY]. This populates 
the open queries letter template content as configured in the code list when the 
letter is being generated by the user in a separate line for each open query in the 
following format.

Example:

■ Please provide Reporter Name (Adv. Cond is Reporter name is null)

■ Please provide Physician's address (Adv. Cond is Reporter address is null)

■ Please provide Physician's phone number (Adv. Cond is Reporter phone number 
is null)

■ If the case is saved and the Reporter Name exists, the system creates two Action 
items.

■ The following is an example of a generated letter:

Attribute Tool Tip Example

Query Name Name of Query to be included in 
the letter template.

QUERY_Preg_LMP (must begin with 
"QUERY_")

Query Condition Advanced condition. If the 
condition is true, then insert text 
into the generated letter.

Patient is pregnant and date LMP 
missing (Advanced Condition)

Query Letter Text Text to be inserted in generated 
letter if Query Condition is True. If 
Query Condition is no true, the no 
query item is created.

Please provide the Date of Last 
Menstrual Period (LMP) for the 
patient.

Query Item Text Text to be display on the list of 
open queries

Patient missing Date of LMP.
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Search Case
The following is an illustration of the Search Case section.

The following table lists and describes the fields and controls in the section.

Filter Function
The Filter function enables you to search for entities in the worklist. The following 
tables describes the options available in the Filter drop-down list.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Enables the user to select the Value as the search criterion

Search Button Enables the user to open the selected or entered case ID.

View Individual Enables the user to view individual items assigned to this user.

View Group Enables the user to view all items assigned to this user group.

View All Enables administrator and workflow manager to see all items in the 
system.
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Total Number of Rows  The following is an illustration of the Total Number of Rows 
section.

The following table describes the contents of each column in the Total Number of 
Rows section.

Option Description

Case Number Displays the Case Number

Workflow State Displays only those workflow states that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Product Displays only those products that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event Preferred Term Displays only those Event PTs that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event as Reported Displays the Event as Reported

Case Report Type Displays only those Report Types that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Note: The Assigned To option is not available if you select the 
Individual radio button option from View.

Column Description

Case Number Displays the Case Number.

Note: Click the case number to open the case.

S/U/R Displays the Case Level Assessments:

■ S denotes Serious (Y/N)

■ U denotes Unlisted (Y/N)

■ R denotes Causality (Y/N)

Note:  Unknown is treated as a "?". When the user clicks the SUR link, the 
Case Summary is displayed.

Description Displays the description of the Action Item in question.

Date Open Displays the date the action item was opened.

Date Due Displays the due date.
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Coding Action Items
This section discusses the features provided on the Worklist - Coding Action Items 
page.

To view the Worklist - Coding Action Items page
1. Select Worklist --> Coding Action Items.

2. When the system opens the Coding Action Items page, enter the information in 
the fields as necessary.

Search Case
The following is an illustration of the Search Case section.

The following table lists and describes the fields in the Search Case section.

Days Open Displays the number of days for which the action item has been open.

Assigned To Displays the current owner or "Unassigned" user for the case

Print List Button Allows the user to print the current worklist for reference.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Enables the user to select a value as a search criteria

Assigned To Enables the user to search on the basis of who the case has been assigned 
to

Column Description
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Filter Functions
The Filter functionality performs searches on entities present in the worklist only. The 
following table lists and describes the options available in the Filter drop-down list.

Total Number of Rows
The following is an illustration of the Total Number of Rows section.

The following table describes the headers within Total Number of Rows:

View Individual Enables the user to view only individual items assigned to this user 
group.

View Group Enables the user to view all items assigned to this user group.

View All Enables administrator and workflow manager to see all items in the 
system.

Option Description

All Does not filter on any cases in the work list, excluding other filter 
elements that are specified, e.g. Case owner, etc.

Case Number Displays the Case Number

Workflow State Displays only those workflow states that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Product Displays only those products that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Event Preferred 
Term

Displays only those Event PTs that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Event as Reported Displays the name of the event as reported

Case Report Type Displays only those Report Types that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.

Field Description

Case Number Displays the Case Number.

Note: Click the case number to open the case.

Field Description
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Contacts
This section discusses the features provided on the Worklist - Contacts page.

To view the Worklist -- Contacts page
1. Select Worklist --> Contacts.

2. When the system opens the Worklist - Contacts screen, enter the information in 
the fields as necessary.

Search Case
The following is an illustration of the Search Case section of the Worklist -- Contacts 
screen.

S/U/R Displays the Case Level Assessments:

■ S denotes Serious (Y/N)

■ U denotes Unlisted (Y/N)

■ R denotes Causality (Y/N)

Note:

■ Unknown is treated as a "?"

■ When the user clicks the SUR link, the Case Summary gets displayed.

Description Displays the description of the Action Item in question.

Date Open Displays the date the action item was opened.

Date Due Displays the due date.

Days Open Displays the number of days for which the action item has been open.

Assigned To Displays the current owner or "Unassigned" user to the case

Print List Button Allows the user to print the current worklist for reference.

Field Description
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The following table lists and describes the fields in the Search Case section.

Filter Functions  The Filter function enables you to search for entities in the worklist. 
The following table below describes the options available in the Filter drop-down list.

Total Number of Rows  The following is an illustration of the Total Number of Rows 
section

The following table describes the columns in Total Number of Rows:

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Enables the user to select the Value as the search criterion

Select Button Enables the user to open the selected or entered case ID.

Assigned To Enables the user to select the user to whom the case has been assigned.

View Individual Enables the user to view individual items assigned to this user group.

View Group Enables the user to view all items assigned to this user group.

View All Enables the administrator and workflow manager to see all items in the 
system.

Option Description

Case Number Displays the case number.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.

Field Description

Case Number Displays the Case Number.

Note: Click the case number to open the case.

Study ID Allows the user to view the Study ID present in the case.
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Reports
This section discusses the features available from Worklist - Reports page.

To view the Worklist Reports page
1. Select Worklist --> Reports.

2. When the system opens the Worklist - Reports screen, enter the appropriate 
information as necessary.

Search Case
The following is an illustration of the Search Case section of the page.

The following table lists and describes the fields in the Search Case section.

Description Displays the description of the Action Item in question.

Product Name Allows the user to view the Product Name of the Primary Suspect Drug.

Aware Date Displays the Aware Date of the Case. Aware date is the latest significant 
follow up which is received in the case or the Initial Receipt Date if there 
are no Significant follow ups present in the case.

Date Due Displays the due date.

Days Open Displays the number of days for which the action item has been open.

Assigned To Displays the current owner or "Unassigned" user to the case.

Print List Button Allows the user to print the current worklist for reference.

Field Description
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Filter Function
The Filter function enables you to search for entities in the worklist. The following 
tables describes the options available from the Filter drop-down list.

General Usage Information  When using filtering, be aware of the following:

■ The filter options have a Study ID element that enables the user to filter cases 
within the list (not deleted).

■ This option is a type ahead that enables users to enter values for studies defined in 
the configuration.

■ The type ahead feature limits the users to 25 items in the drop-down list.

■ When the user selects type ahead values, the system performs a like search.

■ The filter options have a Reporting Group element that enables the user to filter 
cases in the list.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here.

Value Enables the user to select the Value as the search criteria.

Search Button Enables the user to open the selected or entered case ID.

Assigned To Enables the user to select the person to whom the case is assigned.

View Individual Enables the administrator and workflow manager to see individual items 
in the system.

View Group Enables the user to view all items assigned to this user group.

View All Enables the administrator and workflow manager to see all items in the 
system.

Option Description

Case Number Displays the Case Number.

Reporting 
Destination

Displays the report destination (agency) for which the report is 
scheduled.

Product Displays only those products that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Event Preferred 
Term

Displays only those Event PTs that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Report Status Displays the status of the report as Approved, Generated or Scheduled.

Case Report Type Displays only those Report Types that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Report Form Displays the description of the report.

Due Date Enter a due date.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.



About Worklist

7-20 Oracle Argus Safety Japanese User's Guide

■ This option is a type ahead that enables users to enter values for Reporting 
Groups defined for the reports in the worklist.

■ The type ahead limits the users to 25 items in the drop-down list.

■ When the user selects type ahead values, the system performs a like search.

■ The filtering elements have the Product and Reporting destinations removed from 
the list.

■ The user can mark multiple reports for approval by selecting the Mark Multiple for 
Approval option.

■ The user can view the Medical Summary report for all users who have permission 
to print the Medical Summary report.

■ The system displays the Report Details dialog and permits the user to enter the 
approval notes that are applied to all selected reports. The system skips any 
reports selected by the user that have the following statuses:

– Scheduled

– Disapproved

– Approved

■ The system hides the reports fields from the report details dialog and does not 
permit the user to access or modify any other tabs.

■ The system hides the Route button to prevent users from modifying the Report 
Status.

■ Workflow Enterprise users can access View and can modify the report details for 
all reports for all cases across multiple sites in their lists.

Filtering Reports by Report Destination  When filtering by report destination, be aware of 
the following:

■ You can click the magnifying glass icon to filter reports by report destination. The 
system displays the standard lookup dialog.

■ The Report Destination filter multi-selection screen list contains the names of all 
agencies as configured in the Argus Regulatory Authority CodeList.

■ The system displays only the report rows that match the authority/agency you 
selected.

Filtering Reports by Product Family  When filtering reports by product family, be aware of 
the following:

■ You can click the magnifying glass icon to filter reports by product family. The 
system displays the standard lookup dialog.

■ The Product Family filter multi-selection screen contains a list of all product 
family names as configured in the Argus Products Code List.

■ The system displays only the report rows that match the product you selected.

Filtering Reports by Country of Incidence  When filtering reports by country of incidence, 
be aware of the following:

■ You can click the magnifying glass icon to filter reports by country of Incidence. 
The system displays the standard lookup dialog.
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■ The Country of Incidence filter multi-selection screen contains a list of all 
available countries.

■ The system displays only the report rows that match the country of incidence you 
selected.

Total Number of Rows
The following is an illustration of the Total Number of Rows section.

The following table lists and describes the columns in the Total Number of Rows 
section.

Field Description

Selected Allows the user to select the report.

Lock State Allows the user to view the Locked state of the case by the icon. If the 
locked icon is present, it indicates that the case is locked and vice versa.

Note: The lock icon is also displayed if the Case Status is Initial or 
Follow up. If the case is Follow-up, additionally, the Follow up number 
is also displayed.

E.g. Initial or F / U: 1.

The icon displayed in the lock state column, in the Worklist - New, 
Open and Reports screens denotes a SUSAR (Suspected Unexpected 
Serious Adverse Reaction) case.

Lock State Header Options

Click the Lock State header row. A pop-up appears listing the following 
sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Status Displays the report status. Click the link displaying the report status to 
view the Report Details. Refer to the About the Report Details Dialog 
Box section for descriptions of each tab.

Case Number Displays the Case Number.

Note: Click the case number to open the case.

Country of Incidence Displays the Country of incidence.

Report Type Displays the Case Report Type.
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The following table lists and describes the options available under Lock State.

Suspect Product Displays the Trade name for which the report has been scheduled. A "+" 
displayed at the end of a Product Name indicates that more than one 
Suspect Company Products exist.

A Device Name is also displayed for those Reports which were 
scheduled for the Device.

Diagnosis Displays the Primary Event Diagnoses PT

Event Verbatim Displays the event verbatim (verbatim as reported) of the Primary 
Event.

S/U/R Displays the Case Level Assessments:

■ S indicates Serious (Y/N)

■ U indicates Unlisted (Y/N)

■ R indicates Causality (Y/N)

Note:  Unknown is treated as a "?".  When the user clicks the SUR link, 
the Case Summary gets displayed.

F or LT Indicates whether a case is fatal or life threatening as follows:

■ F identifies a Fatal (F) case

■ LT identifies a Life Threatening (LT)

Note: If any of the above are present together, then Fatal takes 
precedence followed by LT.  If the case is neither of the above, No is 
displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the description of the report. Click the link to view the DRAFT 
Report PDF.

Destination Displays the report destination (agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Displays if the report is Initial or Follow-up.

If it is a Follow-up, the follow-up number is printed.

Due Date Displays the date the report is due.

Days Past Due Displays the number of days the report is past due date.

Days Open Displays the number of days since the report has been open.

Date Scheduled Displays the Scheduled Date of the report.

Assigned Displays the name of the individual to whom the case has been 
assigned.

Downgrade Displays Yes if the report is a downgrade report.

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Report Enables the user to view the report as a PDF.

Report Details Enables the user to view the report details.

Accept Report Enables the user to accept the report.

Approve Report Enables the user to approve the report.

Field Description
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Bulk Transmit
The Bulk Transmit function lists the status for all transmission events against your 
assigned cases.

To view the Bulk Transmit page
1. Select Worklist --> Bulk Transmit.

2. When the system opens the Bulk Transmit screen, enter the appropriate 
information as necessary.

Adjust Assignment Enables the user to adjust assignment for the selected report.

Medical Review Enables the user to view the Medical Review of the case.

Print Medical 
Summary

Enables the user to print the medical summary of the case.

Case Summary Enables the user to view the case summary of the case.

Local Labeling Enables the user to view the local labeling dialog.

■ This option is available only if the user has access to Local Labeling 
within the groups to which the user belongs to.

■ The Local Labeling can also be viewed by clicking the local labeling 
icon that is displayed next to S/U/R.

Mark for 
Non-Submission

Enables the user to mark the report for non-submission.

Mark for 
Submission

Enables the user to mark the report for submission.

View Multiple 
Reports

Enables the user to view multiple reports as a PDF.

Mark Multiple for 
Non-Submission

Enables the user to mark multiple reports for non-submission.

Mark Multiple for 
Submission

Enables the user to mark multiple reports for submission.

Option Description
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General Usage Information

Search Case Section
The following is an illustration of the Search Case section.

The following tables lists and describes the fields and controls in the Search Case 
section.

Filter Function  The Filter function enables you to search for entities in the worklist. The 
following table describes the options available from the Filter drop-down list.

Total Number of Rows  The following is an illustration of the Total Number of Rows 
section.

The following table below describes the columns in Total Number of Rows section

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Enables the user to select the Value as the search criterion

Search Button Enables the user to open the selected or entered case ID.

View Individual Enable users to view individual items assigned to this user group

View Group Enable the user to view all items assigned to this user group.

View All Enable administrator and workflow manager to see all items in the 
system.

Option Description

Case Number Displays the case number

Reporting 
Destination

Displays the report destination (agency) for which the report is 
scheduled.

Report Form Displays the report form

Report Status Displays the report status
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User Options  The following table describes the user options.

Routing Details  The following is an illustration of the Routing Details section. Enter 
routing details in this text box.

Field Description

Case Number Displays the Case Number. Click the Case Number to view the case 
details.

Report Form Displays the Description of the report

Click the link to view the DRAFT Report PDF.

Fax Number Displays the fax number of the report recipient

Recipient Name Displays the name of the report recipient

Recipient Company Displays the name of the company of the report recipient

Date Created Displays the date on which the report was created.

Date Sent Displays the date on which the report was transmitted to the recipient.

# of Pages Displays the number of pages in the report

Attempts Displays the number of attempts made to transmit the report. If you are 
using Right Fax, the value of this field is displayed as 0 even if the Right 
Fax had attempted it multiple times. This is an unsupported feature in 
Right Fax.

Sender Displays the name of the sender of the report

Sender Agency 
Name

Displays the name of the agency that has generated the report

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the Report Status to view the Report Details. Refer to the About the 
Report Details Dialog Box section for descriptions of each tab.

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Transmission Displays the report in a PDF format.

Mark report as 
Submitted

Marks the report for the selected row as submitted.

Note: This option is displayed to only those users who have the access 
rights to mark a report as submitted.

Remove 
transmission

Removes the transmission log entry from the list.

Note: A report whose status is pending cannot be transmitted.

Re-transmit This option is displayed if the selected row has a status of failure or 
success. Select this option to change the status back to pending and the 
re-fax the report.

Submit Multiple 
Reports

Multiple reports that are selected from the list can be marked as 
submitted simultaneously.

Re-transmit 
Multiple

The status of multiple reports that are selected from the list can be 
changed to "pending," and those reports can be re-transmitted.

Remove Multiple 
Transmissions

Transmission of multiple reports that are selected from the list can be 
removed.
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Bulk Print
The Bulk Print function displays a separate list for all Bulk Print events against 
reports.

To view the Bulk Print page
1. Select Worklist --> Bulk Print

2. When the system opens the Bulk Print page, enter the appropriate information.

General Usage Information

Search Case Section
The following is and illustration of the Search Case section.

The following table lists and describes the fields and controls in the Search Case 
section.

Note: Reports that appear in the Bulk Transmission section or the 
Bulk Print section do not display in the Reports section of the 
Worklist.

Field Description

Filter Performs searches for worklist items on the 
basis of the filtering criteria selected here.
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Filter Function  The Filter function enables you to search for entities in the worklist. The 
following table below describes the options available from the Filter drop-down list.

Total Number of Rows Section  The following is an illustration of the Total Number of 
Rows section.

The following table below describes the columns in Total Number of Rows:

Value Enables the user to select the Value as the 
search criterion.

Search Button Enables the user to search.

View Individual Enables the user to view individual items 
assigned to this user group.

View Group Allows the user to view all items assigned to 
this user group.

View All Allows administrator and workflow manager 
to see all items in the system.

Option Description

Case Number Displays the case number

Reporting 
Destination

Displays the report destination (agency) for which the report is 
scheduled.

Report Form Displays the report form

Report Status Displays the report status

Field Description

Case Number Displays the Case Number. Click the Case Number to view the case 
details.

Report Form Displays the Description of the report

Click the link to view the DRAFT Report PDF.

Agency Name Displays the name of the agency that has generated the report

Printer Name Displays the name of the printer.

Date Created Displays the date on which the report was created.

Date Sent Displays the date on which the report was transmitted to the recipient.

Sender Displays the name of the sender of the report

Report Status Displays the Report Status

Click the Report Status to view the Report Details.
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Bulk Print User Options  Click the icon associated with each report to view available user 
options. The following table describes the Bulk Print user options.

Routing Details Section  The following is an illustration of the Routing Details section. 
Enter routing details in this text box.

Bulk E2B Transmit
The Bulk E2B Transmit function displays only those E2B Reports that are awaiting 
submission (not in submitted state) when transmitted from "Bulk Report By Form" to 
the Trading partner.

This menu option is not displayed if Interchange is not licensed or if you do not have 
access to open worklist screens based on existing File Menu Access rights in the Group 
Configuration.

The Bulk E2B Transmit page has two (2) tabs as follows:

■ Reports -- Displays the status of individual E2B Reports that are in the process of 
being transmitted.

■ Messages -- Displays the status of ESM Messages which may contain multiple 
reports.

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Report Displays the report in a PDF format.

Mark report as 
Submitted

Marks the report for the selected row as submitted.

Note: This option is displayed to only those users who have the access 
rights to mark a report as submitted.

Remove Print Job Removes the print job entry from the list.

Note: A report whose status is pending cannot be printed.

Re-print This option is displayed if the selected row has a status of failure or 
success. Select this option to change the status back to pending and the 
re-print the report.

Submit Multiple 
Reports

Multiple reports that are selected from the list can be marked as 
submitted simultaneously.

Re-print Multiple The status of multiple reports that are selected from the list can be 
changed to "pending," and those reports can be re-transmitted.

Remove Multiple 
Print Jobs

Print jobs of multiple reports that are selected from the list can be 
removed.

Note: The reports appearing in the Bulk Transmission section or the 
Bulk Print section are not displayed in the Reports section of the 
Worklist.

Field Description
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To view the Bulk E2B Transmit page
1. Select Worklist --> Bulk E2B Transmit.

2. When the system opens Bulk E2B Transmit page, entered the appropriate 
information as necessary.

General Usage Information

Reports Tab  The following is an illustration of the Reports tab.

Click the following links for information about the sections and user option on the 
Reports tab.

Search Criteria Section
The following is an illustration of the Search Criteria section.
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The following table lists and describes the fields in the Search Criteria section.

Total Number of Rows Section  The following is an illustration of the Total Number of 
Rows section.

The following table describes the columns in the Total Number of Rows section.

Field Description

Case # Displays the Case Number.

Click the Case Number to view the report.

Message Type Select a pre-defined message type.

Periodic Report This field is enabled message type "Periodic"

Start Date Enter the start date.

End Date Enter the end date.

Range Select a date range.

Search button Triggers search based on the search criteria.

Only show 
transmissions that 
have reached a 
failure state

Enable this checkbox to search for only those transmissions that have a 
failed status.

View Individual Displays all items assigned only to the individual user.

View Group Allows the user to view all items assigned to this user group.

View All Allows administrator and workflow manager to see all items in the 
system.

Stage Legend Shows the status (through colors) corresponding to each stage.

Field Description

Action Displays the icon containing the available user actions.

Tip: Click on the case lock status (unlocked, locked or archived) for 
further options.

Case Number Displays the Case Number. Click the Case Number to view the case 
details.

Case Status Displays the current workflow of the state
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Reports Tab User Options  Click the Action icon with each report to view the available 
user options. The following table below describes the available options.

Reporting 
Destination

Displays the name of the Reporting Destination

Date Created Displays the date on which the report was created.

Date Transmitted Displays the date when the report was transmitted.

Local Company 
Name

Displays the name of the local company that has sent the report.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the Report Status to view the Report Details.

Message Type Displays the ICSR message type for the transmission

Transmit Denotes Processing Report

EDI In Denotes EDI In

EDI Out Denotes EDI Out

MDN Rec. Denotes MDN Received

ACK Rec. Denotes Acknowledgement Received

Status Details Contains the details of the latest failure / success message for the 
selected row.

Print Prints the row selected by the user

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Report Details 
(Read only)

Opens the existing Report Details dialog in read-only mode.

View E2B Report 
(E2b Viewer for the 
report)

Opens the existing E2B Viewer report.

E2B Transmission 
History 
(Transmission 
History for the 
selected report)

Opens the new Transmission History screen

Remove 
Transmission

Removes the transmission log entry from the list.

Note: A report whose status is pending cannot be transmitted.

Re-Transmit This option is displayed if the selected row has a status of failure or 
success. Select this option to change the status back to pending and the 
re-fax the report.

Remove Multiple 
Transmissions

Removes transmission of multiple reports that are selected from the list.

Re-Transmit 
Multiple Reports

The status of multiple reports that are selected from the list can be 
changed to "pending," and those reports can be re-transmitted.

Submit Multiple 
Reports

Multiple reports that are selected from the list can be marked as 
submitted simultaneously.

Field Description
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Messages Tab  The following is an illustration of the Messages tab.

Search Criteria Section  The following is an illustration of the Search Criteria section on 
the Message tab.

The following table lists and describes the fields and controls in the Search Criteria 
section.

Total Number of Rows Section  The following is an illustration of the Total Number of 
Rows section.

Field Description

Agency Trading 
Partners

Enter the agency or trading partner.

Transmit Date 
Range From

Select the transmit date range.

Range Select a range to auto populate the Start Date and End Date.

Note: The Range option is cleared if the Start Date or End Date is 
changed.

Message # Range Select the message range.

Search button Triggers search based on the search criteria.

Stage Legend Shows the status (through colors) corresponding to each stage.
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The following table below describes the column in the Total Number of Rows section.

Message Tab User Options  Click the Action icon associated with each report to view the 
available user options. The following tables lists and describes the available user 
options.

Field Description

Reports Displays the number of reports.

Action Displays the icon containing the available user actions.

Trading Partner Displays the name of the agency or the trading partner.

EDI Receive Receipt Displays the EDI Receipt status.

Local Msg # Displays the Local Message Number.

Remote Msg # Displays the Remote Message Number.

File Name Displays the File Name.

Transmit to EDI Displays the Transmit to EDI Status.

EDI Tracking ID Displays the EDI Tracking ID.

EDI Transmit Date Displays the EDI Transmit Date.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the Report Status to view the Report Details.

EDI In Denotes EDI In.

EDI Out Denotes EDI Out.

MDN Rec. Denotes MDN Received.

ACK Rec. Denotes Acknowledgement Received.

Status Detail Contains the details of the latest failure / success message for the 
selected row.

Print button Prints the row selected by the user.

Print List button Allows the user to print the current worklist for reference.

Option Description

E2B Transmission History (Transmission 
History for the selected report)

Opens the new Transmission History screen

View Acknowledgement (Read only) Displays the Acknowledgment report.

Note: This menu option is not displayed if ACK 
has not been received for message.

View Reports Opens the Bulk Transmit E2B in the report view 
for all the reports in the message.
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Local Labeling
When using worklist local labeling, be aware of the following:

■ Filtering by Product Family

Click the magnifying glass icon to filter the search results by product family.

You can filter products in the Event Assessment dialog based on the selected product 
families.

On filtering, the system displays only the assessment rows matching the selected 
product families.

■ Events Assessment can show all listedness values. By default it shows listedness 
only for core datasheets and for those countries the user has permission to access.

■ The filter options have a Study ID element and a Case Number (not a type ahead) 
added to filter cases in the list.

– This option is a type ahead field that enables you to enter values for studies 
defined in the configuration.

– The type ahead limits the number of values in the drop-down list to 25.

– When you select type ahead values, the system performs a like search.

■ Sorting

Search results can be sorted by case number and product name.

■ Printing -- You can print the current view of the Worklist as defined by the filtering 
and sorting criteria.

■ Saving

The system remembers the filtering and sorting selections for a particular session.

The system displays the default settings on the Worklist - Local Labeling for a new 
user session.

■ The system displays the total number of rows in the Search header section (e.g., 20 
cases of a possible 450 with 0 cases being processed.)

■ You can configure the number of cases to display on the Page Size drop-down list 
in the Search dialog (based on the profile settings for paging as a read only value).

■ The system displays the number of cases currently in view and automatically 
updates the range based on the page size specified in the Search dialog (read 
only). For example, if you select 100, the system divides the displays rows into 
groups of 100 cases.

■ You can go directly to a range of cases from the Displaying Rows drop down list.

■ You can scroll through the Search results page-by-page, as defined by the Page 
Size drop-down list.

■ You can filter search results by Product:

– The product Filter drop down list contains all products listed in the event 
assessment.

View xml acknowledgement Displays business level acknowledgement

Option Description
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– The system enables you to filter on the Products in the Event Assessment 
dialog.

– By default, the system displays all the products with the <ALL> option.

– When filtering, the system displays only the assessment rows for the product 
you selected.

■ Events assessment can show all listedness values. By default, it shows listedness 
only for the core datasheets and countries you have permission to access.

■ Event

– The Event Filter contains a drop down values of distinct Event PT.

– The system enables you to filter on the events in the Event Assessment dialog.

– By default, the system displays all events with the <ALL> option.

– When filtering, the system displays only the assessment rows that match the 
product you selected.

■ Diagnosis -- The Diagnosis Filter contains a drop-down list with the following 
values:

– D (Diagnosis)

– S (Symptoms)

– In the Events Assessment dialog, you can filter on either the diagnosis or the 
symptom.

■ By default, the system displays all events with the <ALL> option.

■ When filtering, the system displays only the assessment rows that match the 
product you selected.

■ Datasheets

– The Datasheets drop-down contains a list of distinct datasheets.

– You can filter on the datasheets in the Event Assessment dialog.

– By default, the system displays all datasheets with the <ALL> option.

– When filtering, the system displays only the assessment rows for the product 
you selected.

– All the blank datasheets display as a single row of Unspecified.

– When you click the Datasheet hyperlink, the system displays the datasheet 
notes.

■ Licenses

– The Licenses drop-down contains a list of distinct countries for the licenses.

– In the Event Assessment dialog, you can filter on licenses.

– By default, the system displays all licenses with the <ALL> option.

– When filtering, the system displays only the assessment rows that match the 
product you selected.

– All licenses not associated with a datasheet display under Unspecified and 
are aligned with the datasheet view.

– When you click the Licenses hyperlink, the system displays the license 
references.
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– You can print the current Search view as defined by the filtering and sorting 
criteria.

■ For more information about Local Labeling, see the LAM User Guide for Worklist - 
Local Labeling requirements.

Coding Status
Coding Status enables you to perform the following functions:

■ Coding Status View

■ Single Case Coding / Recoding

■ Bulk Coding / Recoding

■ Coding Status Reports

Configured users can select Coding Status through the Worklist menu. The following 
is an illustration of the Coding Status screen.

Search Conditions Section
The following is an illustration of the Search Conditions section.

The following table lists and describes the fields and controls in the Search Conditions 
section.
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Total Number of Rows Section
The following is an illustration of the Total Number of Rows section.

The following table lists and describes the columns in the Total Number of Rows 
section.

Field Description

Search For Select the criteria by which the case must be searched for and 
enter an appropriate search item, if applicable.

Note: You can search for cases based on multiple study 
identifiers. The option, "Prj/Othr/Stdy/Rptr/Pat" supports 
entry of Project ID, Study ID, Other ID, Center ID, Reporter ID, 
and Patient ID values separated by the "/" (forward slash) 
character.

Any or all fields may be present.

Full Search Select this checkbox, if necessary.

Full search is best explained with an example. If the full search 
option is not used and the item that is entered under Search for is 
"AB", then a string such as "ABCESS" will match "AB", but a 
string such as "LABOR" will not. If the full search option is used, 
both these items will match "AB". Also, items whose first few 
letters sound similar (like "TIM" and "TIN") will also appear in 
the search results.

Product Family Select the Product Family that the case belongs to, if applicable.

Date Range Select a relevant Date Range, if applicable.

Tip: To enter a customized date range, select Custom Date 
Range from the list.

Enter an appropriate date range in the custom date range dialog 
and click OK.

Advanced Select an advanced condition for the case, if applicable.

Note: Click AC to create a new advanced condition.

Search Displays the list of cases that match the entered search criteria

Field Description

Case Lock icon Depicts the lock or unlock status of the case.

Case Number Displays the case number. Click the link to view the case form.

Aware Date Displays the Aware Date for the case.

Seriousness 
Criteria

Displays the Case level Seriousness Criteria. In case the case has any Fatal 
or Life Threatening event, it is displayed as such.

Workflow State Displays the Workflow State of the case
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Coding Status Icons
The following table lists and describes the icons used to identify the coding status.

Letters
The Letters function enables you to search for letters associated with a case.

Aging (Days) If all code-able items of the case are coded completely, Aging is displayed 
as the Number of days from the Initial Receipt Date to the date when 
latest item of the case was coded.

If any code-able item of the case is not coded, Aging is displayed as the 
Number of days from the Initial Receipt Date to the system date 
(Database Server).

Coding State If all the events / products are encoded, the coding state is denoted with 
a green check mark.

If the case has even a single code-able item as not coded, the coding state 
is shown as a red cross mark.

Icon Description

Displays that the verbatim text has not yet been coded.

Displays that the verbatim text has been successfully coded.

Is displayed if the verbatim text has been submitted to Central Coding, 
but no result has been returned to Argus yet.

Is displayed if the term was submitted to Central Coding for coding and 
returned a status of error either from Central Coding or Argus.

Field Description
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To access the Worklist - Letters page
1. Select Worklist --> Letters.

2. When the system opens the Worklist - Letters page, enter the appropriate 
information.

Search Case Section
The following is an illustration of the Search Case section.

The following table lists and describes the fields and controls in this section.

Total Number of Rows Section
The following is an illustration of the Total Number of Rows section.

The following table below describes the columns in the section.

Field Description

Current Letter Select the current letter from this list

Date Range Allows the user to select a date range from which cases may be selected. 
The selection made from the Date Range drop-down list automatically 
populates the From and To fields.

Show only those 
cases with no 
previous 
notifications

Allows the user to filter the case list search to only those cases that have 
not had any correspondence letters sent.

Advanced 
Condition

Select an Advanced Condition from the list

AC Creates a query for an Advanced Condition

Search button Displays the results matching the search criteria

Field Description

Action Displays the Action icon

Case ID Displays the Case ID. Click the Case ID to view the case details.

Date Displays the date

Reporter Displays the reporter name

Last Notification Displays the last notification date
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J Literature Book-in
In Japan, the Drug Safety receives literature data from JAPICWMDIS (World Medical 
& Drug Information Service). This data includes a literature list of company-related 
drugs. When the safety division receives this information , it assesses the content and 
determines reportability for each type of literature on the list.

Import Tab
In Argus J, you can import these literature data files and assess reportability from the 
loaded data. The system enables you to book-in all necessary data. Select  Literature 
Intake from the Worklist menu to open the New Literature Case Intake Worklist 
screen. 

The following table lists and describes the fields on the New Literature Case Intake 
Worklist screen.

Field/Control Name Description

Import Date Range Enables you to import literature data for a specific time period.

Start Date The beginning date for the import.

End Date The end date for the import.

Range The Range field of the data.

Search Click Search to filter the import items.

Total # of Rows The number of rows that display on a page.

Displaying Rows The rows that the system currently displays.

Page Size The number of rows that the system is configured to display on each 
results page.

Import Date The date the literature data is loaded to the system from the shared 
folder. The date is in YYYY/MM/DD format.

Literature Type The type of literature to display. Right=click to select the type to 
display.

Search Equation 
Number

The unique value associated with a specific search.

Document Number The unique value that identifies a specific document.

Product Family The produc family name associated with the Search Equation number 
or the name that has matching ingredients with the WMDIS data. 

The system displays all ingredients from WMDIS literature data inside 
a particular product family.  

■ A  forward slash (/) separates single product families with 
multiple ingredients.

■ A semi-colon (;) and /or a plus sign (+) is used to separate separate 
product

■ If you add the data manually, the system places an asterisk (*) after 
the product family name.

Ingredients This column displays individual ingredent length.

Title The title of the piece of literature.

Author The name of the person who wrote the literature.

Journal The name of the journal the literature was published in.

Vol. The volume number of the issue the literature was printed in.
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When using the Import tab, be aware of the following:

■ You can filter all column items.

■ Tabulation and sorting functions are available for your use.

■ All Worklist basic functions are available to you.

■ You can use a background process to import.

■ The system permits you to import both JAPIC and WMDIS data.

– If the data format does not match the JAPIC or WMDIS formats, the system 
does not import the file and places it in the Failures fold with the error 
description files.

– The system assumes the contents are valid.

■ The system imports the data and stores it in a shared table. 

■ The system does not validate the data content.

■ The system can import .xls and .xslx files for WMDIS.

■ When the system imports literature data, it sorts the data by date in descending 
order (newest at the top).

■ If there are multiple items with the same date, the system sorts them by internal 
sequence number.

■ The following right-click options are available in any row:

– Accept -- Enables you to accept a highlighted. When clicked, the system 
displays "Accepted" in the Screening column.

* If a product Family is not specified for the selected item, the system opens 
the Modify Product family dialog box to enable you to select a valid 
product family.

* When an item is marked as accepted and assigned to a use, the system 
moves the data item to the Proccessing tab and saves the user name and 
date time stamp (GMT) in the source file.

* If the system does not assign a user for an item, the data remains on the 
Import tab until a user is assigned.

Issue The number that identifies the specific issue of the journal in which the 
literatue appeared.

Page The page the data starts on.

Publish Year The year the journal was published.

Screening This column contains the screening results. It displays the one of the 
following:

■ Accept /Assigned User Name

■ Reject

Assigned to Displays the name of the assigned user, if applicable.

Add Individual 
Information

When clicked, the system enables you to add individual literature 
information.

Print List Enables you to print the list of data.

Field/Control Name Description
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– Reject -- enables you to reject the highlighted item. When clicked, the system 
displays "Rejected" in the Screening column. 

* When you reject an item, the system opens a Justification dialog box, to 
enables you to enter or select a justification for rejecting the item.

* Rejected by the Standard Screening is the default value in the dialog box.

* Once an item is rejected, the system moves the data item to the Processed 
tab and saves the user name and date time stamp (GMT) in the source file.

– Assign User -- Enables you to assign  another user to be the owner of the data 
item. The system opens the ’’Reassign" dialog to enable you to assign an 
owner. 

– Assign Literature Type -- Enables you to specify the Literature Type from the 
Console J Codelist. When clicked, the system opens the popup so you can 
assign an owner.

– Modify Product Family -- Enables you to define a product family for the 
literature when a Product Family is not available.

– Print Monitoring Check Report -- Enables you to print the Monitoring Check 
Report  form in PDF format.

– Multiple Accept  -- The Multiple Accept option enables you to accept all 
selected row items.

* When the system encounters any accepted items with a Product Family, it 
displays the following error message: "At least one product family is 
missing from the selected items. Only items with a product family are 
marked "Accepted."

* If the system encounters locked records, it displays the following message: 
"Data is being used by another user. The system cannot process this data.

– Multiple Reject  -- The Multiple Reject option enables you to reject all selected 
items.

* When you reject an item, the system opens the Justification dialog box to 
enable you to enter a reason for rejecting the item.

* The default value is "Rejected by the Standard Screening."

* The justification you enter in this dialog box applies to all selected items.

* If you are a trying to process locked records, the system displays the 
following message "Data is being used by another user. The system cannot 
process this data."

– Assign Multiple Users -- The Assign multiple users option enables you to 
assign users for the assessment in the Processing tab for all selected rows.

– Assign Literature Type to Multiple Items -- The Assign Literature Type to 
multiple items option enables you to specify the literature type for all selected 
rows.

– Literature Duplicate Search -- Enables you to perform a duplicate search. 

The following table lists and describes the fields on the Duplicate 

Field/Control Name Description

Title Displays the title of the current search item.
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When performing a duplicate search, be aware of the following:

Vol. Displays the volume number associated with the current search item.

Issue Displays the issue associated with the current search item.

Page Displays the number of the page where the current search item appears.

Publish Year The year the current search item was published.

Search from 
Literature Intake

When selected, the system executes the search from the Literature 
Intake Import tab, Processing tab, and Processed tab.

This is the default.

The system executes the search on all Import, Processing, and 
Processed tabs. Howeve , the search result does not include the original 
search item. 

Search from the Case 
Data

When selected, the systm executes the search from the case data.

Search Click Search to start the search operation.

Reject Literature 
Information

When clicked, the system removes the selected line from the imported 
list.

Close Duplicate 
Search

Cancels the search operation and closes the Duplicate Search screen.

Total # of Rows The total number of rows in the search results.

Displayed rows The total number of rows currently displayed.

Page Size The maximum number of data rows that appear on a page.

Search Equation 
Number

The unique value that identifies the search operation.

Document Number The unique numeric identifier assigned to a selected piece.

Ingredients A list of ingredients discussed in the literature.

Title The title of the piece of literature.

Author The author of the article.

Journal The name of the Journal in which the article appeard.

Vol The volume number associated with the journal in which the article 
appeared.

Issue The issue of the journal in which the article appeared.

Publish Year The year the article was published.

Status/Case Number The status of the data. This can be one of the following:

■ Accepted -- the data is marked as "accepted."

■ Rejected -- the data is marked as "rejected."

■ Not necessary -- the data is asses and processed and is deemed 
"not necessary."

■ Case Number -- Displays the number of the case if the the data is 
accepted as case in the Processed tab.

Screening Owner The user name of the person who first accepted the imported literature.

Assessment Owner The user name of the person who performed the second assessment.

Field/Control Name Description
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■ A duplicate search searches for title, vol, issue, page and publish year and is 
executed in the Processed imported literature date and the Case Data.

■ By default, the system searches processed data.The system enables you to search 
for case data by selecting a radio button.  When you do so, the system displays the 
data in the table at the bottom of the screen. 

■ You can modify field content and click the sesarch button as in E2B Duplicate 
Search. 

■ You can use the % character to perform a partial search. 

■ When the system displays the search result, it enables the Reject Literature 
Information button if it finds at least one duplicate. When you click the button, the 
system marks the original item "rejected."  

■ If the result set contains more than 1000 items, the system only displays the first 
1000 items. 

■ When you execute a duplicate search from the Case Data tab, the columns that do 
not appear in the Case data (Search Equation Number, Document Number, Issue, 
Screening Owner, and Assessment Owner, are left blank.

■ The system displays the generic name for the ingredients in the Case Data.

■ The system displays Author J, Title, J, and Journal J in Japanese. If Japanese values 
are not availble, the system displays the English values.

■ When you click "Add Individual Information" button, the system enables you to 
enter data about an individual piece of literature. The system opens the Add 
Individual Information dialog box. 

■ When you click Select, the system opens the Literature Lookup dialog to enable 
you to select literature from the Code list.

■ When you click Add, the system adds the entered nformation to the Import table. 

■ When you click Cancel, the system closes the section.

Processing Tab
The Processing tab enables you to provide information for processing literature data. 

The following table lists and describes the fields and controls on the Processing tab.

Field/Control Name Description

Date Range Enables you to enter a range of import or 
screening dates.

Start Date The date to start the search.

End Date The date to end the search

Range The range field for the data. This is the value from 
the Date Range code list item.

Search Click Search to initiate the search.

View Individual All Enables you to view a single piece of data or all 
retrieved items.

Total # of rows The total number of rows in the search results.

Displaying rows The total number of rows that are displaying.



About Worklist

Worklist 7-45

The following right-click options are available in any row:

■ Assessment

■ Assessment Result

■ Multiple Assessment

■ Create Case/Process Unnecessary Assessment

Assessment
When you select Assessment from the drop-down list, the system opens the 
Justification dialog box.

The following table lists and describes the fields on the Justification dialog box.

Page Size The total number of rows to displays on a single 
page.

Import Date The date the literature is loaded into the system 
from the shared folder.

Literature Type The selected literature type.

Search equation number The unique value that identifies this search query.

Document Number The unique value that identifies a specific 
document.

Ingredients The list of ingredients referenced n the piece of 
literature.

Title The title of the article.

Author The author of the article.

Magazine Name The name of the publication where the article 
appeared.

Vol The vol of the magazine in which the article is 
published.

Issue The specific issue  in which the article is 
published.

Page The page on which the article appears.

Publish year The year the article was published.

Assessment Enables you to view the result of the second 
assessment (when available).

When you click Assessment, the system opens the 
Justification dialog box.

Owner The assigned owner of the literature.

Print List Enables you to print the list.

Field/Control Name Description

Assessment Result This drop-down list enables you to select the assessment result 
you want to view. 

Possibility of occurrence of 
serious disease such as cancer, 
disorder, or death

Enables you to choose whether to include assessments where 
there is a possibility of serious disease.

Field/Control Name Description
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Assessment Result Drop-Down List
The Assessment Result drop-down list includes the following items. The selection you 
make determines what is mapped to the case form.

Multiple Assessment
Selecting this option enables you to assess all selected row items. 

Create Case/Process Unnecessary Assessment

When you select this option the system does the following:

■ If "Assessment" for the Literature data is marked "not necessary," the system 
moves the data to the Processed tab.

Significant change on event or 
infection occurrence number, 
frequency and condition.

Enables you to choose whether to include assessments where 
there has been a significant change in and event or condition.

Doesnt’ have acknowledged 
effectiveness

Enables you to choose whether to include assessments where 
there hasn’t been any acknowledged effectiveness.

Problems Enables you to enter information about any problems.

Item Description

Not Necessary Select this item to move the data item to the Processed tab 
after the "Create Case/Process Unnecessary Assessment" 
action.

AE Case Select this item to move the data item to the Processed tab 
after the "Create Case/Process Unnecessary Assessment" 
action.

Research/Infection Report 
(Marketed Drug)

Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Research/ADR Report 
(Marketed Drug

Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Research/Infection Report 
(Investigational Drug)

Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Research/ADR Report 
(Investigational Drug

Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Research Report (Quasi Drug) Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Research Report (Cosmetics) Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Measures in foreign countries 
including discontinuation of 
manufacture, recall and 
withdrawn (Marketed Drug)

Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Measures in foreign countries 
including discontinuation of 
manufacture, recall and 
withdrawn (Investigational 
Drug)

Select this option to move the data item to  Analysis/PMDA 
General/Reporting Category.

Field/Control Name Description
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■ If Assessment for liter data is marked with any of the other options, the system 
opens the Book-in screen with all the literature data populated. The system copies 
the assessment result to Case Data.

■ When you select "Create case/Process unnecessary assessment," the system 
verifies there is a valid Japanese license available to the product family. If the 
product family doesn’t have a Japanese license, the book-in fails and the system 
displays the following message: "This product family does not have a valid 
Japanese license."

■ If a matching product family does not exist at the time of the book-in, the system 
does not populate the product on the book-in screen. 

■ If an assessment is not completed for the literature data you select "Create 
Case/Process Unnecessary Assement," the system displays teh following message: 
"Assessment result does not exist."

■ When booking is complete, the system presents the following message: "New Case 
<case name> successfully created. Do you want to open the case?"

■ Once the booking is complete the system moves the processed item to the 
Processed tab.

Processed Tab
The Processed tab enables you to provide information about processed literature data. 

The following table lists and describes the fields and controls on the Processing tab.

Field/Control Name Description

Date Range Enables you to enter a range of import or 
screening dates.

Start Date The date to start the search.

End Date The date to end the search

Range The range field for the data. This is the value from 
the Date Range code list item.

Search Click Search to initiate the search.

Total # of rows The total number of rows in the search results.

Displaying rows The total number of rows that are displaying.

Page Size The total number of rows to displays on a single 
page.

Import Date The date the literature is loaded into the system 
from the shared folder.

Literature Type The selected literature type.

Search equation number The unique value that identifies this search query.

Document Number The unique value that identifies a specific 
document.

Product Family The product family referenced n the piece of 
literature.

Title The title of the article.

Author The author of the article.

Magazine Name The name of the publication where the article 
appeared.
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When using the Processed tab, be aware of the following:

■ The grid only displays accepted literature data.

■ The Status Detail field opens when you highlight a single item. 

Vol The vol of the magazine in which the article is 
published.

Issue The specific issue  in which the article is 
published.

Page The page on which the article appears.

Publish year The year the article was published.

Screening Enables you to view the screening results.

Date The screening date.

Owner The assigned owner of the literature.

Assessment Enables you to view the assessment results.

Date The assessment date

Assigned The user name of the person who performed the 
assessment.

Field/Control Name Description
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8MedDRA Browser

The Medical Dictionary for Regulatory Activities (MedDRA) can be used to encode 
diseases, symptoms, signs, and so forth.

This chapter describes the MedDRA Browser. When using MedDRA J Browser, the 
following are different: 

■ English MedDRA terms are searched in the English MedDRA Browser, and 
Japanese MedDRA J terms are searched in the MedDRA J Browser.

■ When a specific term is selected by the user, the bottong table of the MedDRA J 
Browser displays all terms in the hierarchy in both English and Japanese, side by 
side. The English MedDRA Browser displays all terms, in English only.

MedDRA Browser Functionality
The Medical Dictionary for Regulatory Activities (MedDRA) can be used to encode 
diseases, symptoms, signs, and so forth. In Argus Safety, using such a dictionary 
provides consistency when assigning terms for adverse events. When loading the new 
MedDRA dictionary, the system places a check mark in the default MedDRA browser 
check box.

The following is an illustration of the MedDRA Browser screen.
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To view the MedDRA Browser
1. Select Utilities --> MedDRA Browser.

The system opens the MedDRA Browser screen.

Using the MedDRA Browser
Your Argus Safety Administrator might have configured the system to use the 
MedDRA Browser for encoding events or indications.

If this is the case, the MedDRA Browser dialog opens when you click the Encode 
button. The dialog can also be invoked while creating Advanced Conditions or by 
selecting MedDRA Browser in the Utilities menu.

MedDRA Browser Dialog Fields and Field Descriptions
The following table lists and describes the fields in the MedDRA Browser dialog box.

Note: Unlike MedDRA - Browser V9.0, MedDRA - Browser V10.0 
does not display the Special Category field. However, it displays the 
MedDRA SMQ drop-down list. This list enables the user to select from 
all available Standard MedDRA Queries (SMQs).

Field Description

Coded Version Shows the version of the dictionary under which this event was 
originally encoded.

Terminology Allows you to select the version of the dictionary in which you wish to 
encode this event.

Full Search If you select this check box, the search text you enter will be matched 
within each word of the terms. If this check box is cleared, the system 
will only return the terms that begin with the text you entered.
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MedDRA Searches and Search Results
Use the following procedure to search for terms.

Execute these steps to search for terms:
1. Enter the required term in one of the five levels of encoding.

2. You can enter as little information as necessary in order to get a broader set of 
results. Alternatively, you can enter the term under Search All Levels to search for 
the term across all levels.

3. Select the Full Search check box, if necessary.

Full search is best explained with an example: If the full search option is not used 
and the item that is entered under Search for is "AB", then a string such as 
"ABCESS" will match "AB", but a string such as "LABOR" will not. If the full search 
option is used, both these items will match "AB."

4. Press ENTER. A list of search results opens.

About Search Results  When using search results, be aware of the following:

■ You can click the Select button to transfer the selected terms to the Case Form or 
the Advanced Conditions dialog, depending on where the browser was invoked 
from. The button only becomes available after terms at all levels have been 
selected.

■ If you double-click an LLT term, a Term Details dialog appear. The dialog displays 
the following details about the term:

– Indicate if the term is current or non-current

Special Category You can select a special category in the MedDRA dictionary from this list 
in order to display the terms related to that category.

Clear Clears all entries in the dialog.

Search All Levels You can enter text in this field and press ENTER in order to search for the 
text across all of the five levels of the dictionary.

SOC column System Organ Class. You can enter text in this field to search for the term 
in this particular level.

HLGT column High Level Group Term. You can enter text in this field to search for the 
term in this particular level.

HLT column High Level Term. You can enter text in this field to search for the term in 
this particular level.

PT column Preferred Term. You can enter text in this field to search for the term in 
this particular level.

LLT column Low Level Term. You can enter text in this field to search for the term in 
this particular level.

Synonyms This level can list company-specific synonyms for LLT terms.

Print Creates a report of the information that is currently on the dialog. This 
report will be in PDF format.

Select Click this button to enter the terms that have been selected into the 
encoding.

Cancel Click this button to close the dialog without making any changes.

Field Description



MedDRA Browser Functionality

8-4 Oracle Argus Safety Japanese User's Guide

– MedDRA code for the highlighted term

– Primary SOC code and term

– Secondary SOC code(s) and term(s), if applicable

– Dictionary identifier

■ When you select a term in a particular column, the other columns will be filled-in 
with the appropriate terms that correspond to the selected term.

■ The Primary SOC Path is highlighted by using bold text for the path.

■ To perform a synonym search, select an LLT among the search results. A synonym 
for the LLT will appear in the Synonyms column. When you select a synonym, the 
LLTs for that synonym will appear in the Synonyms column.

Using the MedDRA Browser for Advanced Conditions  When you select a field for which the 
terms can be encoded in the Advanced Conditions dialog, the Select button appears.

Click this button to view the MedDRA Browser dialog. You can search and select the 
required terms from the MedDRA browser. These terms are automatically transferred 
to the Advanced Conditions dialog.

MedDRA Recoding
The MedDRA recoding tool displays the following options for each case with the 
existing data elements after the case number in the XLS export or tab delimited file:

■ Current Workflow State.

■ Current Workflow Group.

■ If Excel is the output format and the number of record returned is more than 60K, 
the system splits the record set into multiple worksheets of 64K each.

■ These options are available for the end user logs.

■ The SOC/HLGT/HLT/PT/LLT and Synonym columns in the MedDRA schema 
and the MedDRA table have been expanded to 250 characters to conform to the 
ICH guidelines.

The following table lists the tables that support MedDRA Recoding and their locations 
in the Argus application.

Argus Database Table Location in Argus

CASE_PAT_HIST Argus Safety > Case Form > Patients Tab > Parent Section > 
Other Relevant History

CASE_EVENT Argus Safety > Case Form > Events Tab > Event Information

CASE_PROD_INDICATIONS Argus Safety > Case Form > Products > Products Indication

CASE_ASSESS Argus Safety > Case Form > Events Tab > Event Assessment 
> Event PT (Description)/LLT

CASE_DEATH_DETAILS Argus Safety > Case Form > Events Tab > Seriousness Criteria 
> Death Details > Cause of Death & Autopsy Details

CASE_LAB_DATA Argus Safety > Case Form > Patient Tab > Lab Data

LM_PRODUCT Argus Console > Business Configuration > Products and 
Licenses > Primary Indication

LM_LAB_TEST_TYPES Argus Console > Code Lists > Lab Test Type



MedDRA Browser Functionality

MedDRA Browser 8-5

MedDRA Recoding Logic
The following logic is used during the MedDRA recoding:

1. Get the Lower Level Term (LLT).

2. Check LLT_Code column in the MEDDRA_PREF_TERM_LLT table to see if LLT is 
not current (LLT_CURRENCY = N).

Decisions:

■  If LLT cannot be found in MEDDRA_PREF_TERM_LLT then record as 
exception to be noted in LOG file.

■ If LLT is not current then get PT_CODE from MEDDRA_PREF_TERM_LLT 
and use as LLT (Each PT exists as LLT also - always).

■  If LLT is current then keep LLT as it is.

3. If a current LLT can be found in previous step then continue with next step else go 
to 1 and select next set of Terms.

4. Based on the LLT, get the Preferred Term (PT_CODE) from MEDDRA_PREF_
TERM_LLT. Get the rest of the hierarchy from MEDDRA_MD_HIERARCHY, 
based on PT_CODE and PRIMARY_SOC_FG = 'Y'.

5. Match all the 5 levels of Code and Description and update the data, if required.

6. Populate the following columns:

■ DICT_ID = Current MedDRA Dictionary ID, present under Case Form 
Configuration.

■ CODE_STATUS = 1 (displaying that this set of terms has been encoded).
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9Argus Affiliate Module

Argus Affiliate Module Information
Please see the Oracle® Argus Affiliate User's Guide for detailed information about each 
option available to Central and Affiliate Users under the Local Affiliate menu.
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This chapter contains detailed information about Argus reports.

Reports
Several different kinds of reports are available in Argus. You can access them from the 
Reports menu. When using reports, be aware of the following:

■ The system prints a DRAFT watermark across the entire page starting from the 
bottom left to top right for the following on all pages:

– ALL Expedited reports including E2B CIOMS and MedWatch on the E2B 
Viewer

– ALL Periodic Reports including Expedited reports part of the Periodic and 
Aggregate reports part of Periodic

■ If you select Internal or a value for Other text for PSUR/CTPR reports, the system 
prints "Internal" or the other text value as the watermark on the PDF reports that 
include the expedited reports that are part of the periodic for all pages.

■ The  screen has a Study ID filter option that enables you to filter cases in the list.

■ When using the Study ID filter, be aware of the following:

– The Study ID is a type ahead field the system enables you to enter the study 
ID values defined for cases.

– There can be a maximum of 25 items on the drop-down list.

– When you select values from the drop-down list, the system performs a like 
search.

■ The system prints the user-defined summaries in the order they are listed in the 
Periodic report.

This chapter discusses these reports in detail and also about the reports in the 
following categories. The following is a list of all available Argus reports.
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Compliance Reports
This section lists the different Compliance Reports in Argus and discusses about each 
of them in detail.

Place the cursor over the Compliance option in the Reports tab to go to any of the 
Compliance Reports.

About Expedited Reports
Expedited Reports provide access to the list of previously scheduled or generated but 
not submitted expedited reports.

Apart from viewing these reports, you can also schedule a new expedited report from 
this dialog.

Depending on the regulations set forth by the Regulatory Authorities, expedited 
reports might need to be submitted for the adverse events pertaining to your 
company's products.

You can generate several different kinds of expedited reports as follows:

■ CIOMS-I Form (English)

■ CIOMS-I Local Form (English)

■ CERFA 65-0040 (French)

■ CERFA 65-0044 (French)

■ Compliance Reports

■ Expedited Reports

■ Periodic Reports

■ Submitted Reports

■ Aggregate Reports

■ Case Data Analysis 
Reports

■ CIOMS II Line Listing 
Reports

■ Case Listing Reports

■ Memorized Reports

■ Periodic Reports

■ Clinical Trial Periodic 
Reports

■ ICH PSUR Reports

■ US IND Periodic Reports

■ US NDA Periodic Reports

■ Bulk Reporting

■ Incoming E2B Reports

■ Processed E2B Reports

■ Report Mapping
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■ MHLW Clinical (Japanese)

■ MHLW Spontaneous (Japanese)

■ US FDA MedWatch Form 3500A (English)

■ US FDA MedWatch Form 3500A (English) Drug Only

■ MCA Clinical (English)

■ MCA Spontaneous (English)

■ US FDA VAERS Form (English)

■ EU EMEA Clinical Form (English)

■ EU EMEA Spontaneous Form (English)

■ EU Device Vigilance Initial Form (English)

■ EU Device Vigilance Final Form (English)

■ German BfArM form 643 / PEI Form (German) French CERFA (French)

■ E2B

■ Spain Clinical

■ Spain Spontaneous

■ Canadian Device Form

■ Canadian Expedited Form

General Usage Information  When using Expedited Reports, be aware of the following:

■ The following expedited report forms do not print a follow up number when the 
user selects DRAFT on the Regulatory Reports tab or when he/she selects the 
Quick Launch Draft option:

■ US FDA MedWatch Drug/Device

■ US FDA VAERS

■ CIOMS I/CIOMS I (Local)

■ French CERFA

■ Spanish Spontaneous/Clinical

■ The system enables you to print draft expedited reports from the Batch Print or 
Create Reports without printing DRAFT on the reports from the Case Open or the 
Reports | Compliance | Expedited Reports dialog.

■ When you select the Draft option, the system enables you to print a DRAFT 
watermark on the expedited reports.

■ If you do not enter a value, the system does not print a watermark on the 
expedited reports.

■ You can enter a maximum of 10 characters in the text field.

Storing Expedited Reports in Documentum  Argus Safety lets you store your Expedited 
Reports in Documentum.

■ Mark an Expedited Report as submitted from within Argus. to insert the report 
into the Documentum system as a PDF.
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■ If the report is to be transmitted via fax or email, Argus Safety Service marks the 
report as a successful submission in Documentum only after the fax or email 
transmission has succeeded.

Understanding Follow-up Reports  Follow-up reports are created when significant 
follow-up information is entered for the case. This is indicated by entering follow-up 
information in the General Information section of the General tab and when one of 
the following two things happens:

■ Data for a case changes

■ Update information for a case has been entered

■ Depending on the configuration set up by the Administrator, the system analyzes 
the scheduled reports prior to the data changes to see if they are still required.

■ If the system determines that they are not required, the report status is marked as 
"Downgrade". New reports are automatically scheduled, if required.

■ If the system determines the report is still needed and needs to be updated, one of 
two functions can take place depending on the configuration done by the 
Administrator:

– The system overwrites the report

– The system schedules a new report in addition to the old report

■ If the system has been configured to overwrite the existing report, the report status 
becomes "New Data Available."

■ In the Worklist, the status for this report shows "New Data Available" for this 
report. When you re-generate the report, you can select whether or not you would 
like to re-generate the report with the new data.

■ If the system is configured to create a follow-up report, the previous report 
remains in its current state and a new report is scheduled with the status of 
"Scheduled."

■ If a report has been previously submitted, this report is never deleted under any 
configuration.

Viewing a Summary of Expedited Regulatory Reports  The following table below describes 
how to view a summary of Expedited Regulatory Reports:

User Options  Several common features are available in the Expedited Reports section. 
These include:

■ Lock State Header Options

To.. Do..

View the regulatory reports for a 
particular case (scheduled, generated and 
submitted)

Open the Regulatory Reports tab of the Case 
Form.

View all scheduled, generated, and 
approved reports, as well as other 
outstanding action items

Select Reports from the Worklist menu.

View a list of all scheduled, generated, and 
approved reports

Select Compliance | Expedited from the Reports 
menu.

View all the submitted reports in the 
system

Select Compliance |Submitted from the Reports 
menu.
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■ Lock Icons

■ Lock Icon Options

Lock State Header Options
Click the Lock State header row to sort on the following category of cases. A pop-up 
appears listing the following sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

Click on the required option to sort cases based on the selected case categorization.

Lock Icons
The following table describes the meaning of each icon when attached to a case.

Lock Icon Options
Click the lock icon to view the list of options described in the following table:

Note: The icon displayed in the lock state column in the Reports-> 
Compliance - Expedited and Submitted screens denotes a SUSAR 
(Suspected Unexpected Serious Adverse Reaction) case. 

Icon... Identifies...

A case marked for a Periodic ICSR submission.

A locked case.

An unlocked case

A SUSAR (Suspected Unexpected Serious Adverse Reaction) case.

Field Description

View Report Displays the details of the selected report.

Report Details Displays specific information about the report as entered in the 
Regulatory Reports section.

Note: The information displayed in the fields of the Report Details 
dialog is fetched from the data entered in the Regulatory Reports 
section of Case Form. Refer to the About the Report Details Dialog Box 
section for descriptions of each tab.

Case Summary Displays the Case Summary dialog

Remove Report Deletes the report from the case on being asked for a justification.
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Scheduling Reports  Use the following procedure to schedule reports.

1. Open the case for which the report has to be scheduled.

2. When the system displays the Case Form for the selected case, select Regulatory 
Reports --> Schedule New Reports.

3. When the system opens the Schedule New Expedited Report dialog box, enter the 
appropriate information in the fields in the dialog box.

4. Click OK to schedule the report.

5. Save the case to save the report.

Schedule New Expedited Reports Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Schedule New Expedited 
Report dialog box.

Mark for 
Non-Submission

Displays the Submission tab in the Report Details dialog.

Select No for Mark for Non-Submission and enter the reason for the 
non-submission.

Remove Multiple 
Reports

Deletes multiple reports from the case on being asked a justification.

Mark Multiple for 
Non-Submission

Displays the Submission tab in the Report Details dialog. Select No for 
Mark Multiple for Non-Submission and enter the reason for the 
non-submission. This is applied to all selected reports.

Field Description

Product Select the relevant company product from the list. All company 
products associated with the particular case appear in the list.

Note: The items appearing in the drop-down list are listed in the 
following format:

Trade Name, Product Name, Formulation, Concentration and 
Indication.

License # Select the appropriate license.

Note: The items appearing in this drop-down list are listed in the 
following format:

Country of License, License Type and License Number

Field Description
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Generating Reports  You can generate a report using either of the following procedures.

Method 1: Generating a Report
1. Verify that the relevant case has been locked and the required report has been 

scheduled.

2. Open the selected case to display its associated Case Form.

3. Open the report from the Regulatory Reports tab of the Case Form.

4. When the system opens the Regulatory Reports details for the selected case, locate 
the relevant report and click the Final link to generate the report.

5. The system generates the selected report.

Method 2: Generating a Report
1. Verify that the relevant case has been locked and the required report has been 

scheduled.

2. Select Case Actions --> Open to view the Case Open form.

3. Click Search to view cases matching the search criteria.

Destination Select the regulatory authority for which the report is to be 
scheduled.

Form Select the type of the report that is to be created.

Message Type Select the Message Type from the drop-down list.

Aware Date This drop-down list is only populated and enabled after a license 
has been selected. The Aware Dates are displayed in descending 
order of the Current Aware Date.

The list of the aware dates is determined based on the license 
type selected in the following two groups:

i. Drug/Vaccine - follow-up dates that are marked significant

ii. Device - follow-up dates that are marked as "device" 
significant

If the system is configured to not have separate significant 
indication for Drug and Device, only the standard 
(Drug/Vaccine) significant follow-up dates are considered.

The resulting expedited report Due Date is based on the selected 
Aware Date and the duration of the Due Date section.

Note: The selected Aware Date has no impact on the Actual Due 
Date if the user specifies an absolute Due Date. For instance, 
selecting a date in the Due Date field causes the report to be due 
on the specified date, regardless of the selected Aware Date.

Protect Confidentiality of 
Patient and Reporter

Select this check box if identifying information about the patient 
and the reporter must not appear on the report.

Notes Enter any relevant notes in this field.

Group Select the group that will be responsible for the report.

Cover Letter Select a cover letter for the report, if relevant.

Due Date Specify the due date of the report by selecting the number of 
days after which it will be due, or by specifying the exact date.

Field Description
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4. When the system displays the search results, click the Lock State icon and select 
Case Details.

5. When the system opens the Argus Safety Case Details dialog, open the 
Scheduled Regulatory Reports folder and select the relevant regulatory report.

6. The system automatically generates the report.

Approving Reports  Use the following procedure to approve reports.

1. Open the case associated with the report that needs to be approved.

2. When the system opens the Case Form, click the Regulatory Reports tab to 
displays the case details.

3. Click the icon associated with the report you wish to approve and select View 
Report Details.

4. When the system opens the Report Details dialog, click the Routing tab.

5. When the system opens the Routing tab, select Approved from the State 
drop-down list and click Route.

6. When the system opens a dialog box, enter the required information and click OK 
to approve the report.

Creating Unscheduled Expedited Reports  Use the following procedure to create 
unscheduled expedited reports.

1. Select Reports --> Expedited --> Compliance.

Expedited Reports Dialog Box Fields and Fields Descriptions

Note: ■To preview a report in draft mode, click the DRAFT link for 
the report in the Case Form.

■ You do not need to lock the case to preview a report in draft 
mode.

■ If you have access rights to view or print blinded information, you 
are prompted to select whether you would like to view a blinded 
or unblinded version of the report. If your access rights disallow 
you from viewing or printing unblinded information, you can 
view only a blinded version of the expedited report. The 
following items are not displayed when viewing a blinded version 
of the expedited report:

■ Clinical Treatment Given (Study Drug field)

■ Study Drug Formulation and Concentration

■ Study Drug Dose, Daily Dose and Route

■ Study Drug Batch/Lot # and Expiration Date

■ If the case is locked you can generate the report from the Worklist 
| Reports, Reports | Bulk Reporting and Reports | Compliance | 
Expedited screens.

Note: Refer to Report Routing to understand how you can route a 
report to another state.
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Field Description

Selected Click the checkbox to select the report.

Lock State Displays if the case is locked or un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Note: Click the link displaying the status to view the report details.

Case Number Displays the Case Number.

Note: Click the link displaying the Case Number to open the selected 
case.

Country of Incidence Displays the Country of Incidence for the selected case.

Report Type Displays the Report Type of the selected case.

Suspect Product Displays the Trade Name for which the report has been scheduled. A 
(+) displayed at the end of the Product Name denotes that more than 
one Suspect Company Product exists.

For Reports which were scheduled for the Device, the Device name gets 
displayed.

Diagnosis Displays the Primary Event Diagnoses PT

Event Verbatim Displays the (verbatim as reported) of the Primary Event.

S/U/R Displays the Case Level Assessments

■ S - Serious (Y/N)

■ U - Unlisted (Y/N)

■ R - Causality (Y/N)

■ Unknown is displayed by a "?"

Click the SUR link to view the Case Summary.

F / LT Denotes Fatal / Life Threatening

If the case is both F and LT, only F is displayed.

If the case is neither F nor LT, No is displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the Description of the report.

Click the link to view the DRAFT Report PDF.

Destination Displays the Report Destination (Agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Displays the status whether it is Initial or Follow-up.

If it is Follow-up, the follow-up number is also displayed.

Due Date Displays the due date. This date is based on the previously submitted 
report for the MedWatch Reports under the G7 Section for 5, 7, 10, 15 
and 30 Days.

Days Past Due Displays the number of days the report is past due date.

Downgrade Displays Yes if the report is a Downgrade Report.

View All Allows the administrator and workflow manager to see all items in the 
system.

View Group Allows the user to view all items assigned to this user group.

Individual Allows the user to view all items assigned to him.
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2. Click Batch Print or Create Report and search for the case for which the expedited 
report has to be scheduled.

3. When the system displays the search results, select the locked cases for which the 
expedited report is to be scheduled.

4. Click Batch.

5. When the system opens the Batch Print or Create Reports dialog box, enter the 
appropriate information and click OK.

6. The system generates the unscheduled expedited report.

Batch Print or Create Reports Fields and Field Descriptions
The following table lists and describes the Batch Print fields.

Print List Button Allows the user to print the current Expedited Reports List for 
referencing the current view of the Expedited Reports List.

Batch Print Allows the user to batch schedule Expedited Reports for Locked or 
Unlocked Cases.

Field Description

Reporting 
Destination

Displays the different reporting destinations.

Report Form Displays the report form types.

License Type Select the license type as investigational or marketed or any type of 
license.

Message Type Select the message type from the drop-down list

Format Enables you to print reports As Draft or As Final.

■ The Print As Final option is available only if all the selected cases 
are locked.

■ If Print As Final is selected, then the option Save with case, mark 
as submitted is also available as a checkbox option.

■ Click the options Print As Final and Save with case, mark as 
submitted to generate final Regulatory Reports and create a 
submission record with each case identical to the current 
functionality.

■ Click the options combination of Print As Final only (and not Save 
with case, mark as submitted) to generate final Regulatory Reports 
without creating a submission record with each case.

■ If the report is associated with a blinded study, select the Blind 
study product check box.

Destination Click the Printer check box to print the report

Protect 
Confidentiality of 
Reporter and Patient

Click this check box to hide the Reporter and Patient information on the 
expedited reports.

Field Description
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Creating Batch Reports  You can use the Batch Reports function to schedule and generate 
reports for multiple cases. Before using this function, verify that no cases or reports are 
open.

Use the following procedure to create batch reports.

1. Select Expedited Reports from the Reports - Compliance menu.

2. When the system opens the Expedited Reports dialog box, click Batch Print or 
Create Report.

Expedited Reports Dialog Box Fields and Field Description
The following table lists and describes the fields in the Expedited Reports dialog box.

Scheduling ■ If Run Now is selected, all the selected reports run against all 
selected cases and a PDF is generated.

■ The Run Now option is visible only when a MedWatch, MedWatch 
Drug, CIOMS, or VAERS form is selected on the Batch Expedited 
Report screen.

■ 2Select Run at and enter the appropriate date and time when the 
generation of reports should occur.

■ Note that if you select an unlocked case, the report gets printed in 
draft form only and is not saved.

Field Description

Selected Click the check box to select the report.

Lock State Displays if the case is locked or un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Note: Click the link displaying the status to view the report details.

Case Number Displays the Case Number.

Note: Click the link displaying the Case Number to open the selected 
case.

Country of Incidence Displays the Country of Incidence for the selected case.

Report Type Displays the Report Type of the selected case.

Suspect Product Displays the Trade Name for which the report has been scheduled. A 
(+) displayed at the end of the Product Name denotes that more than 
one Suspect Company Product exists.

For Reports which were scheduled for the Device, the Device name gets 
displayed.

Diagnosis Displays the Primary Event Diagnoses PT

Event Verbatim Displays the (verbatim as reported) of the Primary Event.

S/U/R Displays the Case Level Assessments

■ S - Serious (Y/N)

■ U - Unlisted (Y/N)

■ R - Causality (Y/N)

■ Unknown is displayed by a "?"

Click the SUR link to view the Case Summary.

Field Description
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1. When the system opens the Expedited Reports dialog box, search for the cases for 
which the expedited report needs to be scheduled.

2. When the system displays the search results, select the appropriate cases and click 
Batch.

3. When the system opens the Batch Print or Create Reports dialog box, enter the 
appropriate information in the fields and click OK

The Expedited Batch Printing dialog supports printing Batch CIOMS, Medwatch, and 
VAERS on Argus Web locally.

Batch Print or Create Reports Dialog Box Fields and Field Descriptions
The following tables lists and describes the fields in the Batch Print or Create Reports 
dialog box.

F / LT Denotes Fatal / Life Threatening

If the case is both F and LT, only F is displayed.

If the case is neither F nor LT, No is displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the Description of the report

Click the link to view the DRAFT Report PDF.

Destination Displays the Report Destination (Agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Displays the status whether it is Initial or Follow-up

If it is Follow-up, the follow-up number is also displayed.

Due Date Displays the due date.

Days Past Due Displays the number of days the report is past due date.

Downgrade Displays Yes if the report is a Downgrade Report.

View All Allows the administrator and workflow manager to see all items in the 
system.

View Group Allows the user to view all items assigned to this user group.

Individual Allows the user to view all items assigned to him.

Print List Button Allows the user to print the current Expedited Reports List for 
referencing the current view of the Expedited Reports List.

Batch Print Allows the user to batch schedule Expedited Reports for Locked or 
Unlocked Cases.

Field Description
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Expedited Reporting Rules Algorithm  The expedited reporting rules algorithm affects the 
following:

■ Suppression of Duplicate Reports

Field Description

Reporting 
Destination

Displays the different reporting destinations.

Report Form Displays the report form types.

License Type Select the license type as investigational or marketed or any type of 
license.

Message Type Select the message type from the drop-down list

Format Enables you to print reports As Draft or As Final.

■ The Print As Final option is available only if all the selected cases 
are locked.

■ If Print As Final is selected, then the option Save with case, mark 
as submitted is also available as a checkbox option.

■ Click the options Print As Final and Save with case, mark as 
submitted to generate final Regulatory Reports and create a 
submission record with each case identical to the current 
functionality.

■ Click the options combination of Print As Final only (and not Save 
with case, mark as submitted) to generate final Regulatory Reports 
without creating a submission record with each case.

■ If the report is associated with a blinded study, select the Blind 
study product check box.

Destination Click the Printer check box to print the report

Protect 
Confidentiality of 
Reporter and Patient

Click this check box to hide the Reporter and Patient information on the 
expedited reports.

Scheduling 1. If Run Now is selected, all the selected reports run against all 
selected cases and a PDF is generated.

The Run Now option is visible only when a MedWatch, MedWatch 
Drug, CIOMS, or VAERS form is selected on the Batch Expedited 
Report screen.

Note: If you select an unlocked case, the report gets printed in draft 
form only and is not saved.

2. Select Run at and enter the appropriate date and time when the 
generation of reports should occur.
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■ Blinded/Forced Distribution

■ Letter Placeholder for the IND Cover Letter

Suppression of Duplicate Reports
You can suppress duplicate expedited reports to be scheduled at the reporting 
destination level, according to the following criteria:

■ The Suppress Duplicate Reports option only applies to drug reports. It does not 
apply to device reports.

■ This option does not reduce the number of reporting rules the system evaluates. 
However, it does prevent the system from scheduling and generating expedited 
reports that match the duplication criteria.

■ When you select Suppress Duplicate Reports, the system uses the following 
attributes to determine whether the reports are duplicates of other reports:

– Report Form

– Reporting Destination

– Aware Date

■ If two or more duplicate reports have different due dates (regardless of license 
type), the system schedules the report with the earliest due date.

Blinded/Forced Distribution
The system enables you to configure the Blinding Study option for products in the 
case.

■ When the user selects this checkbox, the system blinds the study products for the 
report being sent to the reporting destination in a manner similar to the Bulk 
Reporting dialog option.

■ If the user selects either of the Blind Study product options (Reporting Rules or 
Bulk Reporting), the system blinds the study product information on the report 
form.

■ The system blinds only active blinded studies. It does not blind the following case 
reports even if the Blind Study product is selected

– Open Label Studies

– Study is eligible for unblinding

■ In cases where expedited reports are due, the system permits the user to 
force-distribute the reports based on user-defined reporting rules, even if case 
processing is incomplete.

■ When the user selects the Force Distribution rule, the following occurs:

■ If a case encounters a rule where a report is due is locked, the system schedules the 
report based on the rule and does the following:

– Generates the report on the due date.

– Dynamically replaces the current case comment with the force distribution 
case comment.

– Transmits the report based on the preferences defined by the reporting 
destinations.

– Displays the status in the Worklist Bulk Transmit/Transmit E2B dialogs.
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■ The AG Service Force Reporting process for expedited reports completes the 
process by:

– Checking the reports required for force distribution

– Locks the case (if it's not already locked)

– Generates the reports and makes sure it is ready for transmission

■ The system adds case comments to the following reports:

– CIOMS I

– CIOMS I (Local)

– Spanish Spontaneous

– Clinical Forms

■ If a user has a case open, the system skips the case until the user releases the case.

■ After transmitting the reports (sent to the WL Status dialogs), the system does the 
following:

– Unlocks the case

– Uses the justification of the unlock as the case comment (as defined in the 
Profile switch)

– Determines whether there are any unsubmitted reports and, if there are 
unsubmitted reports, sends the current forced distribute reports to the Bulk 
Reporting queue for transmission.

■ The system puts the following in the Notes field of the report:

– Auto-scheduled; Forced Distributed: (EU) 15 day EMEA Mkt; Cure All

– During the time the case is locked and reports are being generated, the system 
does not allow the user to edit the case. The system displays the following 
message:

– The case is in use by XXXX user

where:

– XXXX is the name of the AG Service user executing the report scheduling.

■ The notes for the Case Locking/Unlocking are the same as those defined as the 
common profile value for the Forces Distribution option; System is the user.

Letter Placeholder for the IND Cover Letter
Be aware of the following:

■ You can define a placeholder for the IND_SIMILAR_EVENTS table. The system 
uses data from this table to populate the Case Number, Protocol Number, Subject 
ID, and Adverse Event terms for previously submitted cases reporting the same 
events.

■ If the placeholder is used in a letter template, the system prints the information 
shown in the following table.

Adverse Event Report 
No. (AER#)

Protocol Number Subject ID Number Adverse Event 
Term(s)

CASE001 CUREALL P101 Verbatim[PT]
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where:

AER# is the case number when an Investigational IND MedWatch was previously 
submitted and included the same Related Event Term as the current case.

Protocol Number is the Project ID for the case in (a).

Subject ID is the Patient ID for the case in (a).

Adverse Event Terms(s) are the Related Events for the licensed product in case(a).

If no reports were submitted, the system prints None Submitted instead of the 
table.

The placeholder only prints this information when it is used in the cover letter for 
the Regulatory Report. The system uses the license associated with the scheduled 
report to track other cases where the same product license was previously 
submitted for the same events in the current case.

About Periodic Reports
This section discusses the different fields and features available in Periodic Reports.

***********************************************************************************************

General Usage Information  When using periodic reports be aware of the following:

■ You can filter cases in the following period reports based on the Case 
Locked/Archived date:

■ NDA

■ IND

■ PSUR

■ CTPR

■ When you select the Case Locked/Archived date, the system limits the cases based 
on whether the case has been locked or archived within the specified time frame.

■ The locked date is the lock date for the current case.
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■ If there is significant FU in the reporting time frame, the system considers the case 
a follow-up case in the group options of the PSUR/CTPR reports.

■ If you specify the time frame for the case locked/archived date, the system 
disables the following:

– Include Follow-up

– Exclude Follow-up

– Include Summary of Unlocked Cases

– Include Unlocked Cases

■ For the 15 day report section of the NDA Reports, the system uses the timestamp 
to determine whether there are further follow-up or downgraded cases in that 
date range.

Periodic Report Features  The following table lists and describes the data that appear in 
the columns on the Periodic Reports screen:

User Options  Common features on the Period Reports page. Click the icon associated 
with each report to view the following options:

About the Report Details Dialog Box  The Report Details dialog box includes several tabs.

General Tab
The General tab displays the general information about the report. The information on 
this tab cannot be modified.

Field Description

View All Enables the user to view all available periodic reports.

Trade Name Displays the Trade Name.

Destination Displays the name of the Destination.

Description Displays the report name. Click this to open the selected report in PDF 
format.

Due Date Displays the Due Date.

Status Opens the Report Details dialog for the selected report.

Print List Allows the user to print the current Periodic Reporting for referencing the 
current view of the Periodic Reporting.

Option Description

View Report Opens the Individual Periodic Report selected by the user.

Report Details Displays specific information about the report as entered in the 
Regulatory Reports section.

Note: The information displayed in the fields of the Report Details 
dialog is fetched from the data entered in the Regulatory Reports 
section of Case Form.
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***********************************************************************************************

The following table lists and describes the fields on the General tab.

Scheduling Tab  The Scheduling tab displays a reason for scheduling this report. It also 
shows the date on which the report was scheduled.

Field Description

Agency Displays the Reporting Destination for which the report is scheduled.

Responsibility Displays the User Group to which the report is assigned.

Date Generated Displays the date when the report was generated.

Date Submitted Displays the date when the report was submitted.

Report Type Displays the Expedited Report Form of the report.

Language Displays the language in which the report has been made.

Date Due Displays the date when the report is due.

Date Transmitted Displays the date when the report was transmitted.

Case Nullification 
Date

Displays the date when the case was nullified.

Case Nullification 
Reason

Displays the reason entered when a case is logically deleted in Argus.
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***********************************************************************************************

The following table lists and describes the fields on the Scheduling tab.

Routing Tab  The Routing tab displays the routing history of the report. To route the 
report, click Route.

***********************************************************************************************

The following table lists and describes the fields on the Routing tab.

Field Description

Scheduled On Displays the date when the report was scheduled.

Scheduled By Displays the name of the person who schedule the report.

Case Revision Displays the case revision number.

Case Number Displays the case number.

Reason for 
Scheduling

Displays the reason for scheduling the report.

Note: All fields in this tab are auto-populated as per records entered 
in Argus.

Field Description

Current State Displays the current state of the report.

State Displays the state of the report. This button is enabled when you click the 
Route button.

Date Time Displays the date and time of the report routing.

Group Displays the group of the report. This button is enabled when you click 
the Route button.

Reports Displays the type of report it is.

User Displays the state of the report. This button is enabled when you click the 
Route button.

Comments Displays routing comments entered before routing the report.
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Submission Tab  The Submission tab enables you to specify whether submission is 
required and enter a reason for not submitting the report.

***********************************************************************************************

The following table lists and describes the fields on the Submission tab.

Comment Tab  The Comment tab enables you to enter a local comment that prints out 
on that specific report when generated. Each report has its own Local Comment 
section.

***********************************************************************************************

The following describes the Local Comment field on the Report Details tab.

Field Description

Submission 
Required

Enables you to select if this report is not required to be submitted to the 
regulatory authority.

Determined On Displays the date when the report was considered not required to be 
submitted.

Determined By Displays the name of the user who decided the report was not required to 
be submitted.

Reason for 
Non-Submission

Click Select to select the reason for non-submission.
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Transmission Tab
To transmit a report

1. Click the icon associated with a report and select the Transmission tab from 
Report Details.

2. When the system opens the Report Details The Report Details dialog opens.

***********************************************************************************************

3. This dialog displays the status of reports that have been transmitted to different 
recipients.

The following table lists the fields that comprise the Report Details dialog.

4. Click OK or Cancel to approve the transmission or discard any changes, 
respectively.

5. Click the Transmit button to transmit a report. The Transmit to Recipients dialog 
is displayed.

Field Description

Local Comment Enables you to enter any remarks about the report.

Field Description

Report Form Displays the name and type of report being transmitted.

Agency Name Displays the agency name for the report.

Fax Number / 
Recipient Name

Displays the Fax Number or name of the recipient of the report.

Recipient Company Displays the name of the company that is receiving the report.

Date Created Displays the date when the report was created.

Date Sent Displays the date when the report was sent.

# of Pages Displays the number of pages present in the report.

Attempts Displays the number of attempts in transmitting the report.

Sender Displays the sender of the report.

Status Displays the transmission status of the report.
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***********************************************************************************************

6. Select the recipients of the report, as applicable from the Available Recipients list.

7. Select the method of transmission from Method, as applicable.

8. Enter remarks in Comments.

9. Click Transmit.

10. The selected report is transmitted to the specified recipients.

Creating Unscheduled Periodic Reports  To create Unscheduled Periodic Reports
1. Click the Create Unscheduled Report button

2. The system opens Periodic Reports dialog box that provides a list of configured 
reports of the following types:

■ PSUR - Containing ICH PSUR Line Listing Reports

■ IND - Containing US IND Periodic Reports

■ NDA - Containing US NDA Periodic Reports

■ CTPR - Containing CT Periodic Reports

3. Click the (+) icon against the desired category to view all the reports within that 
category.

4. Select the report you wish to create from this list and click Select.

5. When the system opens the Report Batch Printing dialog, select Run Now or Run 
at, as appropriate.

6. Select what you want printed on the report: Final, Draft, Internal, or enter Other 
information.

7. Click OK.

Note: If you select Run Now, specify PDF, RTF, or CSV from the 
drop-down menu for the report output option to generate the PSUR or 
CTPR report in the selected format.

If you select Run at, specify the date/time to schedule the PSUR 
report to be generated by Argus Safety Service. This enables only 
Final and disables all other Print As options.
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8. The system generates the periodic report.

Submitted Reports
This section provides information about how to submit and view reports. The 
following is an illustration of the Submitted Reports page.

***********************************************************************************************

The following table lists and describes the icons that appear on the Submitted Reports 
page.

Submitting Reports
Before you can mark a report as submitted, the report must first be approved.

Use the following procedure the submit an approved report.

1. Open the case for which the report has to be approved.

2. Open the Regulatory Reports tab in the Case Form.

3. When the system opens the Regulatory Reports details for the selected case, click 
the icon associated with the report you wish to approve.

4. Select View Report Details.

Field Description

View Report Enables you to view the report.

Report Details Enables you to view the report details.

Unsubmit Reports Enables you to unsubmit reports through a confirmation dialog. If you 
select the option to send a nullification report before clicking OK, a 
justification dialog also appears, as shown in the section on Deleting a 
Case.
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5. Select Submitted from the State list in the Routing tab and click Route.

6. When the system opens a dialog box, enter the required details and click OK.

7. The report is approved.

Viewing Submitted Reports
Use the following procedure to view submitted reports.

1. Select the Reports --> Compliance --> Submitted Reports.

2. When the system opens the Submitted Reports page, enter the appropriate search 
criteria and click Search.

3. The system displays the Search Results.

Submitted Reports Fields and Field Descriptions
The following table lists and describes the search fields on the Submitted Reports 
page.

Submitted Reports Search Results
The following table lists and describes the contents of the columns in the Submitted 
Reports Search Results.

Note: The Case Nullification Date is the date when the case is 
deleted, the Case Nullification Reason is the comment entered when 
the case is logically deleted in Argus.

Note: A user who has "Workflow Manager" rights can undo the 
submission of a report, if necessary.

Field Description

Destination Select one or more Reporting Destination(s).

Report Form Select one or more Report Form(s).

Submission Date 
Range

Specify a specific date range from the drop-down list.

Tip: To specify your own dates use the To and From dates.

License Type Select the License type.

Note: Only reports that have been scheduled based on the selected license 
type will be displayed.

Case ID Enter the specific case number.

Tip: Use wild cards such as 2007% to search for cases starting with 2007.

Include these 
Reports

Select the required report type or case status to be displayed.

Product Select the product as required. The reports scheduled for these products 
will be displayed.

Field Description

Status Displays the status of the report.

Case ID Displays the Case Number for the report.
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Unsubmitting Reports
Cases that are archived while unsubmitting reports can be reopened from the 
Archived Case dialog.

Use the following procedure to unsubmit such cases.

1. Enter the password and notes required in the Archived Case dialog box.

2. When the system opens the Report Unsubmit dialog box, enter the reason for 
unsubmitting the report and click OK.

3. The system unsubmits the report.

Lock State Header Options
Click the Lock State header row. A pop-up appears listing the following sorting 
options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Revision Date Displays the date when the last revision was made.

Destination Displays the destination of the report (agency name).

Time Frame (I/F-u) Displays the whether the report was initial or follow-up.

Product Displays the first suspect product for the case on which the report is 
based (expedited reports).

License Type Displays the license type of the report.

Primary Event Displays the first event term for the case on which the report is based 
(expedited reports).

Reason for 
Scheduling

Displays the reason provided for scheduling the report.

Report Form Displays the type of report scheduled (form) and initial/follow-up status 
(e.g. "Initial Report" or "Follow-up #3").

Submitted Date Displays the report's submission date.

Case Del. Date Displays the date when the case was deleted.

Blind Study 
Product

Enables you to mark the study product as blinded.

Print All Submitted 
Reports

Enables you to print all the submitted reports.

Export Enables you to export the report.

Print List Enables you to print the report as a PDF.

Tip: The icon (displayed in the lock state column) in the Reports-> 
Compliance - Expedited and Submitted screens denotes a SUSAR 
case.

Field Description
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Aggregate Reports
Argus Safety has powerful system reporting capabilities that enable you to monitor 
the following:

■ Product safety profiles

■ Case progress

■ Company productivity during the case handling process

This section provides information about the Argus Aggregate Reports.

To view an aggregate report
Select Reports --> Aggregate Reports --> <Report Type>. P

General Usage Information
When using Aggregate reports, be aware of the following:

■ The date and time printed on the following reports are the date and time the query 
is executed for case qualification. They are not the date/time the query was 
completed and the report obtained Web Server.

■ Case Listing Report

■ Case Data Analysis Report

■ The system converts the following elements that display in the case form as actual 
text on the Case Listing and CIOMS II Line Listing reports:

■ Duration of Administration

■ Time Between First Dose/Primary Event

■ Time between Last Dose/Primary Event

■ Another field has been added to the Regulatory Reports section for the report 
follow up number. The system prints the report follow-up number on the 
expedited reports in the following format:

F/U# X

where:

X is the report follow-up number.

■ For an initial report, the system prints initial in the column.

■ If there are no reports for the case in the Case Listing/CIOMS II Line Listing, the 
column is left blank.

■ This option is available on the CIOMS II Line Listing/Case Listing reports.

■ The system uses the IE offset of the client workstation to print the date and time 
component for all system-calculated fields on the Case Listing/CIOMS II Line 
Listing reports for the following fields

Table Name Column Name Local IE Adjustment

case_master close_date Yes

case_master date_locked Yes

case_routing route_date Yes

cmn_reg_reports date_approved Yes
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■ You can filter cases in the following aggregate reports based on the lock/archived 
date:

■ Case Listing

■ Case Data Analysis

■ CIOMS II Line Listing

■ When you select Case Locked/Archived date, the system limits the cases based on 
whether the case is locked/archived within the specified time frame.

■ The lock date is considered the locked date.

■ If you select the Case Patient or Reporter Information in the Case Listing or 
CIOMS II Line Listing reports and the Protect Confidentiality field is checked for 
the patient or reporter Information, the system does not print the relevant patient 
or reporter Information selected in the Case Listing or CIOMS II Line Listing 
report.

■ If you do not have permission to view the reporter or patient information, the 
corresponding reporter or patient elements selected on the Case Listing or CIOMS 
II Line Listing report are blank.

If the report doesn't have cases that meet the criteria, the system prints the PDF with a 
"No data found" message.

Using the System Reports Library
You can access the System Reports Library from Reports --> Aggregate Reports --> 
System Reports Library.

cmn_reg_reports DATE_GENERATED Yes

cmn_reg_reports date_scheduled No

cmn_reg_reports date_submission_determined Yes

cmn_reg_reports date_submitted Yes

cmn_reg_reports date_xmt Yes

rpt_routing route_date Yes
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***********************************************************************************************

When using the System Reports Library, be aware of the following:

■ The user can use the following fields to query all memorized reports:

– Report Name (type ahead)

– Description (type ahead)

– Report Type (type ahead)

– Case Data Analysis

– CIOM II Line Listing

– Case Listing

■ Author (type ahead)

■ Last Modified

– Date (date text box)

– Upgrade populates this with System Date

■ Avail. for Periodic (text box)

– Blank

– Yes

– No

■ Shared (text box)

– Blank

– Yes

– No

■ The user can enter wildcards in Name and Description fields.

■ The following are in Search and Navigation bar:
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– Displaying Records Drop-down list (standard functionality)

– Page Size Drop-down list (standard functionality)

– Back Button (page back standard functionality)

– Forward Button (page forward standard functionality)

– Search Button (executes the search with any entered criteria)

– Clear Button (clears the search drop-downs or text boxes)

■ The system displays the following columns on the screen:

– Report Name - The report name given by the user.

– Description - A description of the report as defined by the user.

– Report Type - The report type.

– Author - The name of the author of the report.

– Last Modified - The date the report was last modified. This is the system date.

– Avail. for Periodic - Indicates whether the report is available for Periodic 
reports

– Shared (See System Rule below)

■ The system displays the following buttons on the page:

– Copy

– Delete

– Open

– Execute (standard functionality)

– Export

– Transmit

■ When the user clicks the Filter icon, he/she can filter on any element.

– The system provides the type ahead feature to enable the users to filter on any 
text element.

– When the user clicks X, the system closes the filtering options.

– When the user specifies filtering criteria, the filter icon changes to the paper 
clip icon to indicate that filtering criteria has been specified.

– The system permits the user to conduct a like search, For example, if user 
searches for "Cure" the system returns all elements beginning with Cure.

– The system permits the user to conduct wildcard searches. For example, if the 
user searches for "%Cure," the system returns all elements containing Cure.

– When the user clicks Search, the system filters reports in the report list.

■ The system saves all user preferences for future use.

■ The following fields word wrap, but do not scroll:

– Report Name

– Description (200 Characters)

■ If a record in a row is available for periodic reporting, the system places a Yes in 
the Avail. for Periodic column; otherwise the system displays No in the column.
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– The user must select the available for periodic reporting option when he/she 
creates the report.

■ If the system report is shared, the system places a Yes in the Shared column; 
otherwise it displays No in the column.

– The user must set the report creation or modification options when he/she 
creates the report.

■ The user can click the column heading to sort the column in ascending or 
descending order.

– Report Name is the default sort column and is sorted in ascending order.

– Ascending (A to Z, 1&emdash;10, etc.) is the default sort order.

– A sorted column has an up or down arrow to indicate whether the column is 
sorted in ascending or descending order.

■ When the user clicks Copy, the system displays a copy of the report in the 
appropriate popup. The system displays the Case Data Analysis Report, the CIOM 
II Line Listing Report, or the Case Listing Report.

– The system names the copy of the report Copy of xxxxxx

where:

The system displays the following columns on the screen:

xxxxxx is the name of the report the system is copying.

If there are too many characters in the report name, the system truncates the 
name.

■ When the user clicks Delete, the system displays the following message:

Are you sure you want to delete?

– If the user clicks Yes, the system deletes the selected row.

– If the user clicks No, the pop-up window closes and nothing changes.

– If the report is in use, the system displays the following message:

The report which is selected is being used and cannot be deleted.

■ When the user clicks Open, the systems displays the appropriate Report pop-up 
box:

– If the has not selected a row, the system disables the Open button.

– The system determines the appropriate dialog box based on the report type.

* If the user selects a Case Data Analysis report, the system displays the 
Case Data Analysis popup.

* If the user selects a CIOMS II Line Listing report, the system displays the 
CIOM II Line Listing popup.

* If the user selects a Case Listing report, the system displays the Case 
Listing popup.

– If the selected report is in use, the system displays the following:

The report which is selected is being used by XXXX and cannot be modified.

where:

XXX is the full user name of the person using the report.



Reports

Argus Reports 10-31

■ When the user clicks Execute, the system generates the selected reports.

– If the user has not selected a row, the system disables the Execute button.

– The system creates and displays the report in PDF format just as it does when 
the user clicks OK on the individual report pages.

■ When the user clicks Export, the system generates the selected report and starts 
the export process (i.e., CSV file download).

– If the user has not selected a row, the system disables the Export button.

■ If the user clicks Transmits, the system generates the selected report and starts the 
transmit process.

– The system displays the Recipient popup.

– If the user has not selected a row, the system disables the Transmit button.

■ The Memorize button in the System Report dialog enables the user to enter the 
memorize details in the report configuration options.

– If the user fails to enter the Name in the memorize section, the system disables 
the Memorize button.

* Case Listing

* CIOMS II Line Listing

* Case Data Analysis

About Case Data Analysis Reports
The Case Data Analysis Report enables you to view quantities of cases over time in a 
Cross-Tabular Fashion. Use the following procedure to create a Case Data Analysis 
report. The following is an illustration of a Case Data Analysis Report.

***********************************************************************************************
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Creating a Case Data Analysis Report
Use the following procedure to create a Case Data Analysis report.

To create a Case Data Analysis Report
1. Select Reports --> Aggregate Reports --> Case Data Analysis.

2. In the Case Data Analysis Report view, select the information that must appear in 
the report.

3. In Row1, select the field the system uses to group cases by row.

4. In Column1, select the data the system uses to group cases by column.

5. In Row2, select the field by which each Row1 item will be categorized.

6. In Column2, select the field by which each Column1 item will be categorized.

7. Select a product family to which the report applies, if appropriate.

8. In Selection for Row1, select the value for row 1 by which the report must be 
restricted.

9. Specify an advanced condition, as appropriate.

10. Select Report Number of Cases or Report Number of Events, depending on the 
number of cases or the number of events to be entered in the report.

11. If you select Report Number of Events, you can specify the kind of events (serious 
listed, non-serious listed, serious non-listed, or non- serious non-listed) that will 
appear in the report.

12. Select whether only the top few items should be displayed and enter the number 
of items that should be displayed.

13. Select the Show  % of Total check box to specify the percentage in each cell in the 
report.

14. Select the Blinded check box to hide blinded information in the report.

15. Select the Use Case Search Results checkbox to limit the Case Data Analysis only 
to the cases present in the Case Search dialog.

16. Specify a date range for the cases that will appear in the report.

17. 1In Report Type, select whether the report is to be printed in text (data) format or 
in graphical (chart) format.

If you select Chart, you can specify the kind of chart (bar graph, line chart, etc.) 
that will be used to display the information.

18. Enter a title for the report.

Memorizing the Criteria Specified for a Particular Report.

To memorize the criteria for a specific report
1. Click Memorize to open the Memorized Report dialog box.

2. Click Save.

Saving, Deleting, or Cancelling a Report
Use the following procedure to save, delete, or cancel a report, as applicable.
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To save, delete or cancel the report, as applicable
1. Click OK in the Case Data Analysis screen to generate the report in PDF format.

2. To export a report in CSV format, click Export.

3. To transmit a report using Argus Safety Service, click Transmit

About CIOMS II Line Listing Reports
The CIOMS II line listing report is a common format desired by Drug Safety 
professionals for reviewing cases. Create this report from the CIOM II Line Listing 
dialog box shown in the following illustration.

***********************************************************************************************

Creating a CIOMS II Line Listing Report
Use the following procedure to create a CIOMS II Line Listing report.

To create the CIOMS II Line Listing report
1. Select CIOMS II Line Listing from Reports -->Aggregate Reports --> CIOMS II 

Line Listing.

2. On the CIOMS II Line Listing Criteria tab, select information for the header, footer, 
product family, advanced condition (if any), cases to include, and date.

3. Select either the Case Creation Date or Case Receipt Date radio button and 
specify a date range to run the report. 

Note: If you perform a search and return a list of cases to the Case 
Search screen, the Use Case Search Results is visible. Checking this 
box will disable all selection criteria with the exception of "Include 
Unlocked Cases". For example, the Advanced Condition and Date 
Range will be disabled.
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4. In the Line Listing tab, add or remove the appropriate fields.

5. In the Grouping tab, add or remove elements, insert a page break and change the 
sort order (if desired).

6. Click Memorize to open the Memorized Report dialog box.

7. Save, Delete or Cancel the report, as applicable.

8. Click OK in the CIOMS II Line Listing screen to generate the report in PDF 
format.

9. Click Export to export a report in CSV format.

10. Click Transmit, to use Argus Safety Service to transmit a report.

About Case Listing Reports
The Case Listing Report enables you to filter cases based on Case Initial Receipt Date 
and Case Creation Date. You can select multiple entities from the List of available 
fields using the CTRL+CLICK functionality. The following is an illustration of the Case 
Listing dialog box.

***********************************************************************************************

Creating a Case Listing Report
Execute the steps below to create a Case Listing report:

1. Select Reports --> Aggregate Reports --> Case Listing.

2. When the system opens the in the Case Listing Reports view select the 
information to appear on the report.

3. Select the fields that are to appear in the report from the Available Fields list.

4. Click Add. Repeat this process for each field that must appear in the report.
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5. Use Move Up and Move Down to arrange the fields in the Selected Fields list.

6. Select the Blinded checkbox to hide blinded information in the report.

7. Specify an Advanced Condition, if appropriate.

8. Specify a date range for the cases to be displayed in the report.

9. If you select the Include in Header check box, the selected date range is displayed 
on the report.

10. Under Sorting Order, select the fields by which the cases will be sorted. The first 
field allows you to create a list that is sorted with respect to that particular field. 
Groups of cases that are identical with respect to the first field can be sorted by 
specifying the second field.

11. Enter the title of the report.

12. Click Memorize to memorize the criteria specified for a particular report. The 
Memorized Report dialog appears.

13. Save, Delete or Cancel the report, as applicable.

14. Click OK in the Case Listing Reports screen to generate the report. The report will 
be generated in PDF format.

15. To export a report in CSV format, click Export.

16. To transmit a report using Argus Safety Service, click Transmit.

About System (Memorized) Reports
The Memorized Reports enables you to recall a memorized Case Listing, CIOMS II 
Line Listing or Case Data Analysis Report criteria. You can save (memorize) search 
criteria and reuse these criteria when generating future reports. 

The Memorized Reports dialog displays current user reports as well as reports that 
are shared by all users. Use the following procedure to create Memorized Report.

To create a Memorized report
1. Select Reports --> Aggregate Reports --> Memorized Reports to open the 

Memorized Report dialog box.

2. Select a memorized report and click Open.

3. Click the Share this report with other users check box to make the report criteria 
available to all users. Previously memorized reports appear in the Your 
Memorized Reports list.

4. Click Delete to delete a selected memorized report.

5. Select the Make available for use Periodic Reports check box to use this report in 
periodic reports like PSUR, CTPR, IND, and NDA.

Note: You cannot sort the cases by fields that do not appear on the 
report.

Note: A shared report can only be deleted by the Administrator or 
the user who created it.
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General Usage Information
When using the System (Memorized) Reports, be aware of the following.

■ The following Line Listing Available fields functionality boxes have been 
updated:

– Reports > Aggregate Reports > CIOMS II Line Listing, (Line Listing tab) to 
allow select fields.

– Reports > Aggregate Reports > Case Listing to allow the user to select fields.

– Reports > Aggregate Reports > Case Data Analysis.

■ A tree view, similar to the advanced condition tree view, has been created for the 
available fields. The fields are the same as those currently displayed and the field 
text box is read-only.

■ If you select a field from the tree view and adds it to the Selected Fields list, the 
system removes the field from the Available Fields list.

■ If the you try to add the field again, the system displays a message and displays 
the name of the selected field inside brackets ( [ ] ). If you wish to remove the 
selected field, click Yes.

Periodic Report Types
This section lists the different Periodic Reports in Argus and discusses about each of 
them in detail. Place the cursor over the Periodic Reports option in the Reports tab to 
go to any of the Periodic Reports.

You can create four kinds of periodic report.

■ Clinical Trial Periodic Reports

■ ICH PSUR Reports

■ US IND Periodic Reports

■ US NDA Periodic Reports

Storing Periodic Reports in Documentum
Argus Safety enables you store your Periodic Reports in Documentum.

When you approve an expedited report from within Argus, the system exports the 
report as a PDF file and saves it in the Documentum database by Argus Safety Service. 
From this point, you can perform document reviews within the Documentum system.

When the report is ready to be submitted, mark the report as submitted from within 
Argus. Argus Safety Service updates the status of the report within Documentum to 
Submitted.

If the report is to be transmitted via fax or email, Argus Safety Service marks the report 
as a successful submission in Documentum only after the fax or email transmission 
has succeeded.

Viewing a Summary of Periodic Regulatory Reports
You can select any of the following options in viewing the summary of a periodic 
regulatory report:

■ To view the regulatory reports for a particular case (scheduled, generated, and 
submitted), open the Regulatory Reports tab of the Case Form.
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■ To view all scheduled, generated, and approved reports, as well as other 
outstanding action items assigned to you or your user group, select Reports in the 
Worklist menu.

■ To view a list of all scheduled, generated, and approved periodic reports, select 
Periodic Reports from the Reports | Compliance menu.

Using the Library Page
The periodic reports have a library page for the following reports:

■ PSUR

■ CTPR

■ IND

■ NDA

***********************************************************************************************

The following table lists and describes the fields on the Library Page

Field/Control Name Purpose

Category Enables the user to view the report Category.

Sub Category Enables the user to view the report Sub Category.

Report Name Enables the user to view the name of the Periodic Report

Inclusion Star Date/Stop Date Enables the user to view the report start and stop dates as 
defined in the configuration.

DRAFT/FINAL Enables the user to view the draft and/or final report

Author Created Enables the user to view the name of the author who created 
the report.

Date Created Enables the user to view the date the report was created.

Date Modified Enables the user to view the date the report was last 
modified.
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When using the Library Page be aware of the following:

■ The system places the total number of records displayed on the library page in the 
Total Number of Row (x) read-only field in the Report header.

■ The user can select the number of cases to display from the Page Size drop-down 
list.

■ The page size drop-down list contains the following values:

– 50

– 100 (default)

– 250

– 500

– 1000

– 2000

■ The system displays the number of reports currently in view and the system 
automatically updates the range based on the selected page size. For example, if 
the user selects a page size of 100, the system displays reports in groups of 100.

■ The user can go directly to a range of cases from the Displaying Rows drop-down 
option.

■ The user can scroll through the reports page-by-page in increments as defined in 
the Page Size drop-down list.

■ The user can sort on all columns in the Reports view by clicking the column 
header. The system displays an up arrow or a down arrow depending on whether 
the column is sorted in ascending (A-Z, 1-10, etc.) or descending order (Z-A, 10-1, 
etc.).

■ Initially, the reports are sorted by Category.

■ The default sort order is ascending.

■ When you click the Filter icon, the system displays the filtering row to enable you 
to filter on any element.

■ The type ahead feature enables you to filter on any element except Draft/Final.

■ Click the appropriate icon to minimize the filtering options.

■ Click the X to close the filtering options.

■ If filtering criteria is defined, the system displays the filtering elements icon to 
indicate that filtering elements exist.

Justification Enables the user to view the justification for updating the 
report.

The system displays the standard Justifications dialog that 
contains the lasts justification entered by the user.

Search When the user clicks Search, the system initiates the search 
operation. When the system displays the search results, the 
user can enter search parameters in various fields and click 
Search to narrow the search results.

Clear Enables the user to clear user-entered data from the fields

Field/Control Name Purpose
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■ If filtering criteria is not defined, the system displays the no filtering elements icon 
to indicate that no filtering elements are defined.

■ The system enables you to perform a like search. For example, if the user searches 
for Cure, the system returns all elements that start with Cure.

■ The system enables you to perform wildcard searches. For example, if the user 
searches for %Cure, the system returns all elements that contain Cure.

■ When you click Clear, the system clears the filtering criteria from the fields.

■ Clicking the filter icon enables you to filter for reports in the list of reports.

■ The system saves all user preferences for future use. If the user has already entered 
filter elements, the system displays the filter details for the last search when it 
displays the dialog.

■ If another user is modifying a report, the system displays the following:

■ The report which is being selected is being used by XXXX and cannot be modified.

where:

XXXX is the full user name of the person using the report.

About Clinical Trial Periodic Reports
The Clinical Trial Periodic Reports (CTPR) are created to report the IND Annual 
reports and EU Clinical Trial Directive line listing reports to FDA.

To create Clinical Trial Periodic Reports
1. Select Reports --> Periodic --> CTPR (Clinical Trial Periodic Reports) to open a list 

of CTPR Reports.

2. To create a new report from an existing report in the list, click Copy or Modify.

3. Click New Report to create an entirely new report. The Clinical Trial Periodic 
Reports dialog opens.

4. Enter an appropriate name for the report under Report Name.

5. Use the tabs in this dialog to configure the CTPR.
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General Usage Information
When using the CTPR, be aware of the following:

■ The system enables you to group cases by Product Name and Drug Regimen 
Frequency:

■ Product Name

– This option enables you to group the Product Name - Formulation - 
Concentration with Units when the elements are separate with a hyphen ( - ).

– If an element is missing, the system does not print the hyphen ( - ).

– The system groups the cases based on the primary drug in the report.

■ Dosage Regimen Frequency

– This option enables you to group the frequency of the primary dosage 
regimen for the primary drug in the report.

– The system prints Frequency: followed by the frequency as defined above.

■ You can select datasheets for specific report types similar to the PSUR Report for 
the Inclusion criteria. If you select any rows in the inclusion criteria, the system 
disables the Datasheet selection dialog.

■ Report Type.This portion lists the report types (configured in Code List | Report 
Type) the report will be run against (LM_REPORT_TYPE). The user must select a 
report type so the system knows to save the criteria row.

■ Serious Criteria.This enables you to specify the seriousness of the cases for the 
selected report type as follows:

– Serious.Case Level or Primary Event is Serious.

– Non-Serious.Case Level or Primary Event is Non-Serious.

– If you select both Serious and Non-Serious, the system ignores the criteria.

– Fatal. At least one event has a Fatal event outcome.

– Non-Fatal.No events have a Fatal event outcome.

– If you select both Fatal and Non-Fatal, the system ignores the criteria.

■ Listedness.

– When using the case level assessment, the system does not consider the 
datasheet. Cases appear in the PSUR if the case level assessment matches the 
selected criteria.

– When using the primary event assessment in conjunction with a datasheet, the 
system uses only the As Determined listedness for the primary event when 
determining whether a case should be included in the PSUR report.

– If both Listed and Unlisted are selected, the system ignores the criteria and 
includes all listedness values (including Unknown).

■ Datasheet.This enables you to specify which Datasheet to use when looking for 
Listedness (LM_DATASHEET). The system uses the datasheet criterion only when 
you select the primary event assessment as the CMN_PROFILE assessment.

■ When you select the <ALL> datasheet option, the listedness for the primary event 
on at least one datasheet must match the selected criteria.

■ Related/Non-Related.
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– When using case level assessment, cases appear in the PSUR when the case 
level causality matches the selected criteria.

– When using the Primary Event assessment, cases appear only if the causality 
for the primary event as reported or as determined matches the selected 
criteria.

– When using the All Events assessment, cases appear if any case events with as 
reported or as determined causality match the selected criteria.

– If you select both Related and Non-Related, the system ignores the 
related/non-related criteria.

■ HCP/Non-HCP. To have a case included in the PSUR, you must identify at least 
one case reporter as a HCP or Non-HCP. If this is being used in conjunction with 
the Primary Reporter Only checkbox, the system evaluates only the primary 
reporter for this criterion.

■ Primary Reporter Only. This enables the system to perform the HCP/Non-HCP 
check against only the primary reporter. This updates the entire configuration 
whether checked or unchecked.

■ You can copy an existing template by clicking the Create from Template button on 
the CTPR reports list.

■ When you click Create from Template, the system displays the Create from 
Template dialog.

■ You can choose the CTPR Group Name (as configured in the Product Name 
configuration) from a type ahead field.

■ When you enter the CTPR Group Name in the Select CTPR Group Name field 
and the From and To dates in the Create from Template dialog and click OK the 
system does the following:

– Saves the CTPR Configuration with the new dates.

– Replaces the products in the list of selected products with all products as 
defined for the selected CTPR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected CTPR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the date ranges for the From and To date fields only for the Periodic 
Report.

– Bases the remaining configuration, including the security permissions, on the 
selected CTPR template.

■ When you enter the CTPR Group Name in the Select CTPR Group Name field 
and the From and To dates in the Create from Template dialog and click Print and 
Save, the system does the following:

– Saves the CTPR Configuration with the new dates.
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– Replaces the products in the list of selected products with all products as 
defined for the selected CTPR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected CTPR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the date ranges for the from and to date fields only for the Periodic 
Report.

– Calls the Report Batch Printing dialog.

– Bases the remaining configuration, including the security permissions, on the 
selected CTPR template.

Common Tab Fields
The Report Name, Report Category and Report Sub-Category fields are common to 
all tabs of the Reports.

The following table below describes these fields:

Subject of Report Tab  The Subject of Report tab is used to configure the report header 
and to specify the agency, products, etc. for which the CTPR is applicable.

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.
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***********************************************************************************************

The following table lists and describes the fields on this tab.

Field Description

Available Reporting 
Destination

Displays the list of configured Regulatory Agencies. Select an agency 
from the list displayed in Reporting Destination and click Add to add 
the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Likewise, select an agency from the Selected Destination list and click 
Remove to remove it from the selected destination.

Primary Agency Select the primary agency for the report.

Note: When you submit a Periodic report, it goes to the selected 
Primary Agency.

Selected Reporting 
Destination

Displays the list of agencies where the report is being sent. Select an 
agency from the list displayed in Reporting Destination and click Add 
to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Likewise, select an agency from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Report # Enter a report number for this report

Report Title Enter a report title for this report

Ingredient Automatically displays the "Ingredient" as provided in the Subject of 
Report dialog.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.
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Product Selection Tab  The Product Selection tab enables you to select the products 
included in the CTPR report.

Trade Name Automatically displays the "Trade Name(s)". Multiple trade names are 
also displayed together, separated by commas.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

International Birth 
Date

Automatically displays the earliest license awarded date, when a user 
selects an Ingredient and a Product.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

Report Footer Enter the footer for the report

Print all 
configuration criteria 
on separate cover 
page

Mark this box to print out the configuration of this report when the 
report is printed. This is only available when PDF option is selected 
during printing.

Print page numbers 
on reports

When checked, this option enables the user to print page numbers on a 
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

■ The "Include Periodic Page Numbering" option in the CTPR 
Summary Tabulations CIOMS Report section is inactive and 
grayed out.

■ The "User Periodic Numbering on the report" option on CTPR 
Summary Tabulations FDA PSUR support section is grayed out 
and inactive.

■ The "Additional Separate Page Numbering for UD Summaries" 
option on the CTPR UD Summaries tab is grayed out and inactive.

■ The system removes all existing report page numbering and the 
option to check page number check boxes on the report 
configuration tabs are grayed out and inactive.

Allow access to 
report cases through 
Hit List

When the report is run as final, it creates a Hit List, which can be 
retrieved from other areas of the application where advanced 
conditions can be selected. Click this checkbox to report cases through 
the Hit List.

Field Description
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***********************************************************************************************

The following table lists and describes the fields on the Product Selection tab.

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Available Countries This list is auto-populated and displays only the countries with a 
license containing the ingredient selected from the Available 
Ingredients list.

Selected Countries Displays the countries selected from the Available Countries list.

Indication This list contains the Indication configured for the product containing 
the ingredients in the Available Ingredients section. The selections 
made from this list get displayed in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulation configured for the product 
containing the ingredients in the Available Ingredients section. The 
selections made from this list get displayed in the Selected Products 
section.

Note: You can select multiple Formulations from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.
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License/Study Tab  The License/Study tab is used to configure the report header and to 
specify the agency, products, etc. for which the CTPR will be applicable.

***********************************************************************************************

The following tables lists and describes the fields on the License/Study tab.

Inclusion Criteria Tab  The Inclusion Criteria tab allows you to select search parameters 
for inclusion of cases in a periodic report.

Field Description

Available Licenses Contains licenses that use the ingredient selected in the Ingredient 
field. This field is automatically populated when an ingredient has been 
selected.

Selected Licenses Displays the licenses selected from the Available Licenses list by 
clicking Add/Add All. You can select Licenses that are related to 
different ingredients for a report.

Available Studies Contains studies that use the ingredient selected in the Ingredient field. 
This field is automatically populated when an ingredient has been 
selected.

Selected Studies Displays the studies selected in the Available Studies list by clicking 
Add/Add All. You can select studies that are related to different 
ingredients for a report.
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***********************************************************************************************

The top section of the dialog allows you to specify the type of cases that will be 
included in the periodic report.

The following table lists and describes the fields on the Inclusion Criteria tab.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Note: The Date Range is only available when an unscheduled CTPR is 
being created. You must specify only one date range out of Case 
Creation Date and Case Receipt Date.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select all the age group categories that apply.

Restrict Cases to 
countries where 
studies are active

References study configuration to determine if the case was submitted 
during the dates the study was active.

Note: This option is available only if a study is selected from the 
Available Studies section in the License/Study tab.

It should not be used for Centrally approved products (CAP), which 
only have an EU license.
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Using the DLP Version  DLP primarily uses two processes:

■ Next Case Revision

■ Last Case Revision

DLP Options
Be aware of the following DLP Options.

■ Last Completed Version -- This option always uses the case version with the last 
lock that existed prior to the DLP or "As of reporting" date. This option does not 
enable data cleaning

Note: DLP saves only the last revision when multiple saves are performed in the 
same job session.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.

Datasheet for 
Listedness

Select the Datasheet to look against for Listedness when running the 
report.

Note: Select the ALL datasheet to use the most conservative listedness 
for the primary event, or the Case Listedness for the tabulation.

Use Assessment in 
Cases

When selected, the CTPR Report will use the Case Event Assessment 
when performing datasheet listedness calculations.

Re-assess cases 
against datasheet in 
effect at the 
beginning

When selected, the CTPR will re-assess the cases in the line listing 
based on the Active Datasheet on or before the Start Date of the 
Reporting period.

Re-assess cases 
against datasheet in 
effect at end

When selected, the CTPR will re-assess the case in the line listing based 
on the Active Datasheets on or closest to the end date of the CTPR 
Reporting end date range without exceeding that date.

Reference Type 
(Clinical Reference 
Data Element)

Select the reference type to be displayed on the Main Listing if Clinical 
Study Reference is selected as a Data Element in the Available Data 
Elements section of the Line Listing tab.

Expeditable Only This option is enabled only when an agency has been specified on the 
Subject of Report tab. Check this option to include only those cases 
that have submitted expedited reports to the specified Primary Agency.

Exclude Follow-up 
cases

Follow-up cases are cases with a significant follow-up in the Clinical 
Trial reporting period where the initial receipt date is in a prior period. 
Check this option to exclude follow-up cases from appearing on the 
Clinical Trial report.

Include Unlocked 
Cases

Check this option to allow cases that have not been locked for reporting 
to appear on the report.

Use Datasheet 
Assessment for UDF 
Tabulations

Allows you to select datasheet for a report to make UDF tabulations.If 
no datasheet is selected, the most conservative listedness is chosen, i.e. 
Unlisted followed by Listed.

Add Cases not 
included in previous 
reporting period

Allows you to add cases which were not included in the previous 
reporting period.

You can enter the start date of the period in the Start Date field.

Field Description
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■ Next Completed Version -- This option uses the current case lock or the next 
following case lock if the case version was initiated prior to the DLP or the "As of 
reporting" date with two exceptions:

– If there is no case lock for the current version that was received prior to the 
DLP, the last (current) case revision is used.

– If there is a case version after the case lock that was created for the purpose of 
data cleaning, it is to be used instead of the first locked case revision.

– If there are multiple contiguous case versions following the first case lock for 
the purpose of data cleaning, the last case data cleaning version is used.

Dates for Using DLP/"As of reporting" Function  You can perform DLP queries for the 
following:

■ Receipt Date -- date entered by the user during case creation

■ Initial / Follow up Receipt Date

■ Safety / Safety Follow up Receipt Date

■ System Date (Case Creation Date) - date the case was physically entered

As of Reporting Function  The as of reporting function returns the same case version 
results as the DLP Options, with the only difference that the date depends on the "as of 
date" instead of a DLP date.

Availability of DLP/As of query functionality  The DLP / as of query functionality is 
available in the following application modules:

■ Periodic Reports

– PSUR including all User defined Tabulations and expedited reports within the 
Periodic Report

– CTPR including all User defined Tabulations and expedited reports within the 
Periodic Report

– IND including all User defined Tabulations

– NDA including all User defined Tabulations and expedited reports within the 
Periodic Report

■ System Reports

– CIOMS II Line Listing

– CDA Reports

– Case Listing Reports

Line Listing Tab  The Line Listing tab contains the following fields and sections:

Note: The Data Cleaning option is only available with the DLP 
option Use Next Completed Version (Includes Data Cleaning).
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***********************************************************************************************

Available Data Elements  A number of optional fields are available in the Available Data 
Elements frame. Select the check box associated with a data element to add the data 
element to the report. Be aware of the following:

■ By default, the system print s unavailable fields on the report, and they cannot be 
changed.

■ Required data elements are printed as columns in the report. The optional data 
elements are printed as separate rows below the column data for each case.

Refer to the following table for a list of data elements on this tab.

Field Description

Include Line Listing Allows you to select whether you want the Line Listing Data Elements 
printed with the CTPR Report.

Blind Line Listing 
and Summary 
Tabulations

Hides the selected listings from being displayed

Data Element Notes

As Determined Causality Optional.

As Determined Listedness Optional.

As Reported Causality Optional.

Case Abbreviated Narrative Required and multi-language available.

Case Classifications Multiple classifications are displayed in separate 
lines.
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Case Central Safety Date Optional.

Case Comment Text Optional.

Case Initial Receipt Date Optional.

Case Listedness Optional.

Case Narrative Optional.

Case Number Required.

Case Outcome Required.

Case Report Type Required.

Case Seriousness? Optional.

Clinical EUDRACT # Number Optional.

Clinical Study Reference Optional.

Company Agent Causality Optional. Displays event causality from product 
name. Multiple causalities are displayed in separate 
lines.

Country of Incidence Required.

Death Cause Optional. Multi-language available.

Death cause as reported Optional

Death Cause HLGT Optional.

Death Cause HLT Optional.

Death Cause LLT Optional.

Death Cause SOC Optional.

Dosage Regimen Batch/Lot # Optional.

Dosage Regimen Daily Dose Required.

Dosage Regimen Duration Required.

Dosage Regimen Frequency Required.

Dosage Regimen Route of 
Administration

Required.

Dosage Regimen Start Date/Time Required. For the selected product the report is 
based on. List for all dose regimens.

Drug Dechallenge? Required.

Product Indication Optional. For the selected product the report is 
based on.

Product Indication HLGT Optional. For the selected product the report is 
based on.

Product Indication HLT Optional. For the selected product the report is 
based on.

Product Indication LLT Optional. For the selected product the report is 
based on.

Product Indication SOC Optional. For the selected product the report is 
based on.

Drug Rechallenge? Optional.

Data Element Notes
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Selected Data Elements  This section lists the selected elements and enables you to 
arrange the order in which these are to be printed. Click the Up or Down buttons to 
arrange the listed elements above or below in order of priority.

Options

Event Description as Reported Required.

Event Onset Date/Time Required.

Event Preferred Term Required.

Lab Data - Tabular Optional.

Literature Author Optional.

Literature Journal Optional.

Literature Pages Optional.

Literature Title Optional.

Literature Volume Optional.

Literature Year Optional.

Literature reference Optional.

Outcome of Event Optional.

Patient Age Required.

Patient Gender Required.

Patient Initials Optional.

Patient Relevant History Optional. Multi-language.

Patient Subject # Optional.

Product Name Optional. Displays "product name (generic name) 
product type, formulation, concentration unit" "daily 
dose," "dose dose_freq, route"

Product Name Report Inclusion Optional. Prints the Products that were part of the 
CTPR Report for the case.

Displays "product name (generic name) product 
type, formulation, concentration unit" "daily dose," 
"dose dose_freq, route"

Report Comment Optional.

Study ID Optional.

Study Other ID Optional.

Study ID Protocol # Optional.

Field Description

MedDRA Hierarchy 
from 
Cases/Dictionary

Select Cases to populate the data from the case data. Select Dictionary 
to populate the data from the MedDRA dictionary.

Print Only the Term 
(Preferred Term or 
Lower Level Term)

Prints only the event Preferred Term (PT) or event Lower Level Term 
(LLT) as per the selected radio button. Select the PT option to print only 
the preferred term and not the verbatim description.

Data Element Notes
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Grouping Tab  Refer to the following table for a description of items in the Grouping 
tab.

Print Dose Text in 
place of regimen dose

Prints the dosage and frequency information from Dose Description 
field instead of Regimen Dose.

Indicate if case was 
expedited previously

This checkbox is selected if a primary agency has been selected in the 
Subject of Report tab. Cases for which an expedited report was 
previously submitted to the selected authority are marked with an 
asterisk.

English Language Provides the option to print the descriptions in English

Local Language Allows a user to specify which Local language for a multi-language 
field is to be printed i.e. the Abbreviated Narrative field.

Print event info 
(Serious, Un-listed, 
Related) as Column

Select this check box to print the Seriousness, Listedness and Causality 
under the Event Verbatim column.

Note: Events having listedness of "Unknown" are considered 
"Unlisted." If only diagnoses are assessed for event assessment, the 
events which are associated with a Diagnosis but have been marked 
with Diagnosis as "Np" display " - " for both listedness and causality.

List cases only once, 
under the primary 
event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event

List cases under all 
events, details under 
the primary event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event, while non-primary events are listed 
under their respective event hierarchy with a reference to the primary 
event body system. Therefore, use this option when grouping on Main 
Line Listing is by the Event Body System.

Print Product 
Indication for the 
product selected in 
the report

Select this option to print Product Indication for the product selected in 
the report.

Field Description
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***********************************************************************************************

Summary Tabulations Tab  The Summary Tabulations tab enables you to specify which 
summary tabulations/Listings will appear along with the line listing.

Field Description

Available Groupings Allows a user to group cases together from the given list. Select the 
desired groupings from the list and click Add to move the grouping to 
the Selected Groupings list. Up to 10 grouping options can be selected.

Selected Groupings Lists the added groupings made available from the Available 
Groupings list, and reports the groups in the order they were selected.

Ascending Select this check box to sort the selected entities in ascending order.

Page Break Select this check box to start the cases from a new page, while also 
keeping the sorting together for every selected page break.

Available Sortings Allows a user to sort cases together from the given list. Select the 
desired sortings from the list and click Add to move the sorting to the 
Selected Sortings list.

Selected Sortings Allows a user to further sort cases without a total count for each sorted 
item. Up to 3 levels of sorting can be selected from the Available 
Sortings list.
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***********************************************************************************************

The following table lists and describes the fields on the tab.

Field Description

Include Index of 
Cases in CTPR

Create an index page of case numbers, for all cases included in the 
CTPR.
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Include Summary of 
Cases Missing 
Assessments

This option creates a sub-report of cases missing one of the following 
items:

■ Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have 
been included in the CTPR line listing, but one or more of the following 
have not been assessed:

■ Case Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Cases Not Included in Report - This sub-report displays cases that 
have not been included in the CTPR line listing as a result of missing 
one or more of the following items:

■ Lock Status

■ Safety Date

■ Uncoded Event

■ Causality

Count of Cases per 
Report Type

This option prints a Sub Report that counts the number of cases versus 
the Report Type, based on the cases within the CTPR.

The Cases per Report Type can be either of the following:

Count Cases with Initial Expedited Reports: Counts cases with initial 
Expedited report.

Count of cases with "Follow-up" Expedited report: Counts cases with 
Follow-up Expedited report.

Total Count of "Initial" Cases in the Report: Counts any (serious - 
non-serious) cases received during the reporting period.

Total Count of "Follow-up" Cases in the Report: Counts any (serious - 
non-serious) follow-up cases entered during the reporting period.

Cumulative Count: Count of cases received from the start of the trial.

Event Count per 
Study Drug

Creates a sub-report with Event count per Study Drug based on the 
selected causality. 2 configurations are possible as to allow for a count 
of related events vs. non-related events.

All Study Drugs in 
Single table

Suppresses '0' current columns (with their cumulative) and print 
everything in a single cross tab.

Grouped by Study 
Drug

Prints a cross tab report for every product. Prints the cumulative totals 
even if the current period has no events.

Field Description
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CIOMS Reports

***********************************************************************************************

Cumulative Summary

***********************************************************************************************

Event Type to 
Include

Prints SUSAR events on the CTPR Report based on the option selected 
from the drop-down list:

■ Separate counts of SUSAR and non-SUSAR events

Prints SUSAR and non-SUSAR events listed separately. SUSAR 
events are marked with an asterisk

■ Combined count of SUSAR and non-SUSAR event

Prints SUSARs. Normal events are grouped into one (current 
functionality)

■ Only count SUSAR events

Prints Only SUSARs i.e. non-SUSARs would not be printed

Title Enables you to select a title.

Include Line Listing 
Tabulation

Select this check box to view a pre-defined summary tabulation of 
Report type, Seriousness and Listedness of all cases in the CTPR.

Include Initial Cases Select this check box to include initial cases in the CTPR tabulation.

Include Follow-up 
Cases

Select this check box to include follow-up cases in the CTPR tabulation.

Include Summary of 
Unlocked Cases

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.

Field Description

Print CIOMS reports 
for serious/unlisted 
cases

Allows a user to print CIOMS I forms for all Serious/Unlisted (Case 
Level) cases appearing in the CTPR.

Note: CIOMS contain Internal or Other text printed on them when the 
CTPR is printed using the Internal or Other option.

Include Periodic 
Numbering on the 
CIOMS reports

Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2, 
A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also 
contain the Periodic paging of each CIOMS report.

Field Description
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FDA CTPR Support

***********************************************************************************************

Field Description

Include Cumulative 
Summary

Select the checkbox to create a sub-report count of events, grouped by 
Product and Body System (SOC) and sorted by Preferred Term. The 
sub-report contains a previous date range count of events (comparative 
date range), a current date range count (current CTPR date range) and a 
cumulative count (all dates) of events assessed against the product(s) of 
the CTPR and matching the inclusion criteria.

Comparative Date 
Range

Allows a user to specify the previous date range as a comparison date 
for the events counted, and therefore should not overlap with the 
current date range specified on the CTPR inclusion criteria tab.

Serious Select this check box to include only serious events.

Unlisted Select this check box to include only unlisted events selected in the 
Datasheet on the "Inclusion Criteria Tab." If no datasheet is selected, 
then any Unlisted license is included.

Related Select this check box to include only those events that are assessed as 
Related or Causal.

Diagnosis Select this radio button to include only those events that are marked as 
diagnosis "Yes" and are without any symptoms associated with 
diagnosis.

Diagnosis & 
Symptoms

Select this option to include all events in the sub-report.

Separate Diagnosis & 
Symptoms

Select this option to include all SUSAR events in the CTR Report.

Field Description

FDA CTPR Support Section

Include Adverse Event 
Summary

Select this option to generate a sub-report of events from the 
line listing. This sub report is grouped by Body System and 
Preferred Term.

Note: This section can be used if the company has obtained 
an FDA waiver to submit a CTPR instead of an NDA report.
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Single Case Submission Support  

Causality Select the desired causality from the list.

Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered 
reportable in the Causality Category configuration in List 
Maintenance.

Not Causal - Counts events where the causality is considered 
non-reportable in the Causality Category configuration in 
List Maintenance.

As Determined - Counts events where 'As Determined' 
causality meets the above selected causality criteria.

As Reported - Counts events where 'As Reported' causality 
meets the above selected causality criteria.

Both - Counts events where both 'As Reported' and 'As 
Determined' causality meet the above causality criteria.

Either - Counts events where either the "As Reported" or "As 
Determined" causality meets the causality criteria.

Only Cases with HCP Reporter Select this check box to include events for only those cases 
that feature an HCP reporter

Diagnosis Select this radio button to ensure that only events marked as 
diagnosis are counted.

Diagnosis & Symptoms Select this option to ensure that all events are counted in the 
sub-report.

Separate Diagnosis & 
Symptoms

Select this option to include all SUSAR events in the CTR 
Report.

Domestic Consumer Report Enables you to select domestic consumer report.

Print Unsubmitted This option allows a user to print MedWatch or VAERS forms 
for U.S. cases. The following types of cases will be excluded:

■ Foreign Cases (Country of Incidence not equal to U.S.)

■ Clinical Trial Cases (Case Report type in list maintenance 
has "this type includes cases from clinical trials" 
checked.)

■ Literature Cases (Case Report type in list maintenance 
has "this type include case from literature" checked.)

■ Cases with submitted expedited reports to the Agency 
selected in the PSUR.

Exclude Reports that are 
Non-Serious and Listed

Allows a user to suppress MedWatch or VAERS forms from 
printing for Non-Serious listed cases where all events are 
non-serious and listed for the datasheet specified.

Use Periodic numbering on the 
Reports

Numbers the requested forms with a periodic format. (i.e. 
Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 - 1, 
Periodic Page 2 - 2, etc.) An index with the Case Number is 
also included.

Field Description
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UD Summaries Tab  The UD Summaries tab allows you to specify which summary 
listings will appear along with the line listing.

***********************************************************************************************

Field Description

Single Case Submission Support Section

Generate Periodic ICSR 
Submissions for any cases in this 
Periodic Report that does not have 
at least one scheduled single-case 
report during the reporting period 
to the following Reporting 
Destination(s): Modify

Select this check box to generate the E2B Reports only for 
the cases, where a Periodic E2B Report for the message 
type chosen, does not exist.

Select one or more trading partners from the list box.

Important: Any case that does not have an expedited or 
single case periodic submission to a trading partner, must 
have an E2b report scheduled as a part of the Periodic 
submission.

Click Modify to select a different Reporting Destination.

Schedule these single-case 
Periodic Reports to the following 
Reporting Destination

Select a single-destination trading partner for Periodic 
Reports from the drop-down list box.

Using the Message Type Select the required message type from the drop-down list 
box
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Scheduling Tab  The Scheduling tab allows you to specify details of how often the 
periodic report will be scheduled.

***********************************************************************************************

Field Description

Include these summary 
tabulations/listings based on the 
set of cases presented in the line 
listing

Allows you to select from pre-configured summary 
tabulations/listings based on Case Data Analysis, Case 
listing or CIOMS II line listing reports. These tabulations 
are based only on the data included in the line listing. 
Select the Exclude Follow-up Cases check box to filter 
out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected 
on the Inclusion criteria tab, this option is ignored and 
follow-up cases are always filtered out.

Include these summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case 
Data Analysis' template, to be included as an output for 
the all cases in the database that meet the CTPR inclusion 
criterion for all dates.

Include these summary 
tabulations/listings based on the 
Date Range

This option allows for additional sub-reports based on 
Case Data Analysis, Case listing or CIOMS II line listing 
reports to be included as an output for the cases meeting 
the CTPR inclusion criterion for the Date Range specified 
when adding the sub-report.

The dates are based on either the "Case Creation Date" or 
the "Initial Receipt Date" as entered on the CTPR 
Inclusion Criteria tab. Click the checkbox to the right of 
the sub-report to ignore considering follow-up cases for 
the sub-report.

Additional Separate Page 
Numbering for Summaries

Enables you to include additional separate page 
numbering for summaries.
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The following table lists and describes the fields on the Scheduling tab.

Scheduling Frequency  

***********************************************************************************************

The following table lists and describes the fields in the Scheduling Frequency section.

Security Tab  The Security tab is used to configure the security level for the CTPR.

Field Description

Start Date This is the International Birth Date for the CTPR product. This date is 
computed as the earliest Awarded date for any license of any type.

Recalculate Allows a user to recompute the International Birth Date of the CTPR 
Product. This date can be overwritten/manually entered, if needed.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.
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***********************************************************************************************

The following table lists and describes the fields on the Security tab.

ICH PSUR Reports
The Periodic Safety Update Reports (PSURs) are created on a periodic basis to enable 
regulatory authorities to monitor the safety of a marketed product. This information is 
used to view new data about the product acquired from appropriate sources. It helps 
relate this data to the patient exposure and also indicates whether changes should be 
made to the product information in order to optimize the use of the product. 
Requirements on the due date of periodic reports may differ for different regulatory 
authorities.

Field Description

Share this Report 
with Other Users

Click this check box to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the "Execute" or "Modify and Execute" list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the CTPR report template. 
Click Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared CTPR 
report template.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared CTPR report template.
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To create Periodic Safety Update Reports (PSURs)
1. Select Reports --> Periodic --> ICH PSUR Reports. A list of PSUR Reports opens 

in the right frame.

2. Click Copy or Modify to create a new reports from an existing report.

OR

Click New Report to create an entirely new report.

3. When the system opens the ICH PSUR Line Listing Reports dialog box, enter an 
appropriate report name in the Report Name field.

4. Use the tabs to configure the PSUR.

General Usage Information
You can group cases for the PSUR Report by Product Name and Dosage Regimen 
Frequency as follows:

■ Product Name

■ This option enables you to group the Product Name - Formulation - Concentration 
concatenated with Units separated by a hyphen ( -).

■ If any elements are missing, the system does not print the hyphen ( -).

■ The groups the cases based on the Primary Drug in the report.

■ Dosage Regimen Frequency

– This option enables you to group the frequency of the primary dosage 
regimen for the primary drug in the report.

– The system prints Frequency: followed by the frequency as defined.

■ You can copy an existing template by clicking the Create from Template button.

■ When you click Create from Template, the system displays the Create from 
Template dialog.

■ You can choose the PSUR Group Name (as configured in the Product Name 
configuration) from a type ahead field.
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■ When you enter the PSUR Group Name in the Select PSUR Group Name field 
and the From and To dates in the Create from Template dialog, and click OK the 
system does the following:

– Saves the PSUR Configuration with the new dates.

– Replaces the products in the list of selected products with all products as 
defined for the selected PSUR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected PSUR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the From and To date ranges only for the periodic report.

– Bases the remaining configuration, including the security permissions, on the 
selected PSUR template.

■ When you enter the PSUR Group Name in the Select PSUR Group Name field 
and the From and To dates in the Create from Template dialog and click Print and 
Save, the system does the following:

– Saves the PSUR Configuration with the new dates.

– Replaces the products in the list of selected products with all products as 
defined for the selected PSUR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected PSUR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the From and To date ranges only for the Periodic Report.

– Calls the Report Batch Printing dialog.

– Bases the remaining configuration, including the security permissions, on the 
selected PSUR template.

Common Fields  The Report Name, Report Category and Report Sub-Category fields 
are common to all tabs of the Reports.

The following table below describes these fields:

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.
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Subject of Report Tab  The Subject of Report tab is used to configure the report header 
and to specify the agency, products, etc. for which the PSUR will be applicable.

***********************************************************************************************

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.

Field Description

Primary Agency Select the Primary Agency.

Reporting 
Destination

Displays the list of agencies from where the report is being sent. Select 
an agency from the list displayed in Reporting Destination and click 
Add to add the report to the Selected Destination list.

You can select multiple agencies from the list of agencies such that the 
report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Field Description
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Product Selection Tab  Refer to the table below for a description of fields in the Product 
Selection tab.

Selected Destination Displays the list of agencies where the report is being sent. Select an 
agency from the list displayed in Reporting Destination and click Add 
to add the report to the Selected Destination list.

You can select multiple agencies from the list of agencies such that the 
report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Report # Enter a report number for this report.

Report Title Enter a report title for this report.

Ingredient Automatically displays the "Ingredient" as provided in the Subject of 
Report dialog.

Note: You can choose whether to view these field or not. Click the 
checkbox displayed with this field to hide or view it.

Trade Name Automatically displays the "Trade Name(s)" as provided in the Subject 
of Report dialog. Multiple trade names are also displayed together, 
separated by commas.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

International Birth 
Date

Automatically displays the earliest license awarded date, when a user 
selects an Ingredient and a Product.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

Report Footer Enter the footer for the report.

Print all 
configuration criteria 
on separate cover 
page

Mark this box to print out the configuration of this report when the 
report is printed. This is only available when PDF option is selected 
during printing.

Print page numbers 
on reports

When checked, this option enables the user to print page numbers on a 
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

■ The "Include Periodic Page Numbering on CIOMS reports" option 
on the PSUR Summary Tabulations CIOMS Reports section is 
grayed out and inactive.

■ The "Use Periodic Numbering on the reports" option in PSUR 
Summary Tabulations FDA PSUR section is grayed out and 
inactive.

■ The "Additional Separate Page Numbering for UD Summaries" in 
the PSUR UD Summaries tab is grayed out and inactive.

■ The system removes all existing report page numbering and the 
option to check page number check boxes on the report 
configuration tabs are grayed out and inactive.

Allow access to 
report cases through 
Hit List

When the report is run as final, it creates a Hit List, which can be 
retrieved from other areas of the application where advanced 
conditions can be selected. Click this checkbox to report cases through 
the Hit List.

Field Description
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***********************************************************************************************

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Indication This list contains the Indication configured for the product containing 
the ingredients in the Available Ingredients section. The selections 
made from this list get displayed in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulation configured for the product containing 
the ingredients in the Available Ingredients section. The selections 
made from this list get displayed in the Selected Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Available Products This list is automatically populated with the selections made in the 
Indication section.

Selected Products This list contains products selected by the user from the Available 
Products list. When a product is selected, the Trade Name field and 
International Birth Date fields are auto-populated with the license trade 
name ("formulation", "concentration") and earliest License Award Date 
for the product.
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Inclusion Criteria Tab  The Inclusion Criteria tab allows you to select search parameters 
for inclusion of cases in a periodic report. The top section of the dialog allows you to 
specify the type of cases that are to be included in the periodic report.

***********************************************************************************************

Click Add to add a criterion. Select appropriate items from the list of items that 
appear.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select Age Groups and then select all the age group categories 
that apply.

Use Assessments in 
Cases

When selected, the PSUR Report will use the Case Event Assessment 
when performing datasheet listedness calculations.

Re-assess cases 
against datasheet in 
effect at the 
beginning

When selected, the PSUR will re-assess the cases in the line listing 
based on the Active Datasheet on or before the Start Date of the 
Reporting period.

Re-assess cases 
against datasheet in 
effect at end

When selected, the PSUR will re-assess the case in the line listing based 
on the Active Datasheets on or closest to the end date of the PSUR 
Reporting end date range without exceeding that date.
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Inclusion Criteria  When using the Inclusion Criteria tab, the system enables you to 
exclude blinded cases from the Inclusion criteria section of the report. It also enables 
you to select All from the Inclusion criteria for the report type. This would include all 
configure report types in the report.

Line Listing Tab  The Line Listing tab contains the following fields and sections:

Expeditable Only This checkbox is available only when an agency is selected in the 
Subject of Report tab. If you select this check box, only the cases 
classified as submitted expedited reports to the specified agency are 
used.

Exclude Follow-up 
Cases

Filters out follow-up Reports from the PSUR Line Listing Report.

Include Unlocked 
Cases

Allows you to include unlocked cases in the periodic report.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.

Use Datasheet 
Assessment for UDF 
Tabulations

Allows you to select datasheet for a report to make UDF tabulations.

If no datasheet is selected, the most conservative listedness is chosen, 
i.e. Unlisted followed by Listed.

Add Cases not 
included in previous 
reporting period

Allows you to add cases which were not included in the previous 
reporting period.

You can enter the start date of the period in the Start Date field.

Field Description

Dropdown list Select the appropriate report type from the drop-down list.

Datasheet This list allows you to specify which datasheet is to be checked to 
determine the listedness (listed or unlisted) of the case.

Serious / 
Non-Serious

If you select Serious and clear Non-serious, only cases having a 
"serious" event are included and vice-versa. If you select both Serious 
and Non-Serious the seriousness criteria is ignored.

Fatal / Non-Fatal Select Fatal when at least one event has an event outcome of 'Fatal". If 
not, select Non-Fatal. If you select both Fatal and Non-Fatal, both types 
of cases are included.

Listed / Unlisted Select Listed to view only Listedness values. If you select both Listed 
and Unlisted, all Listedness values (including Unknown) are included.

Related / 
Non-Related

Relatedness refers to the more conservative of reported or company 
causality. Select Related for any reportable causality type, and 
Non-Related for any non-reportable causality type.

HCP / Non-HCP HCP refers to cases that identify a Health Care Professional in the 
Reporter section within the General tab of the Case Form.

Primary Reporter 
Only

This check box displays whether the Primary Reporter has been 
selected to determine the HCP status.

Field Description
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***********************************************************************************************

Available Data Elements  The following illustration shows the optional fields under 
Available Data Elements.

■ Select the check box displayed against each data element to add it to the report.

■ The unavailable fields are printed on the report by default and cannot be changed.

■ Refer to the table below for a list of the data elements that are included in this tab.

■ The mandatory data elements are printed as columns in the report.

Field Description

Include Line Listing

Allows you to select whether you want the Line Listing Data Elements 
printed with the PSUR Report.

Data Element Notes

As Determined Causality Optional.

As Determined Listedness Optional.

As Reported Causality Optional.

Case Abbreviated Narrative Required and multi-language available.

Case Classifications Required. Multiple classifications are displayed in 
separate lines.

Case Central Safety Date Optional.

Case Comment Text Optional.
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Case Initial Receipt Date Optional.

Case Listedness Optional.

Case Narrative Optional.

Case Number Required.

Case Outcome Required.

Case Report Type Required.

Case Seriousness? Optional.

Company Agent Causality Displays event causality from product name. Multiple 
causalities are displayed in separate lines.

Country of Incidence Required.

Death Cause Multi-language available.

Death Cause HLGT Optional.

Death Cause HLT Optional.

Death Cause LLT Optional.

Death Cause SOC Optional.

Dosage Regimen Batch/Lot # Optional.

Dosage Regimen Daily Dose Optional.

Dosage Regimen Duration Optional.

Dosage Regimen Frequency Optional.

Dosage Regimen Route of 
Administration

Optional.

Dosage Regimen Start Date/Time Required. For the selected product the report is based 
on. List for all dose regimens.

Drug Dechallenge? Optional.

Drug Primary Indication Optional. For the selected product the report is based 
on.

Drug Primary Indication HLGT Optional. For the selected product the report is based 
on.

Drug Primary Indication HLT Optional. For the selected product the report is based 
on.

Drug Primary Indication LLT Optional. For the selected product the report is based 
on.

Drug Primary Indication SOC Optional. For the selected product the report is based 
on.

Drug Rechallenge? Optional.

Event Description as Reported Required.

Event Lack of Efficacy Optional.

Event Onset Date/Time Required.

Event Preferred Term Required.

Lab Data - Tabular Optional.

Literature Author Optional.

Data Element Notes
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Selected Data Elements  This section lists the selected elements and enables you to 
arrange the order in which these are to be printed.

Literature Journal Optional.

Literature Pages Optional.

Literature Title Optional.

Literature Volume Optional.

Literature Year Optional.

Indication Displays indication for product name.

Listedness Displays datasheet, product and listedness event 
preferred term

Literature reference Optional.

Outcome of Event Optional.

Patient Age Required.

Patient Gender Required.

Patient Initials Optional.

Patient Relevant History Multi-language.

Patient Subject # Optional.

Product Name Displays "product name (generic name) product type, 
formulation, concentration unit" "daily dose," "dose 
dose_freq, route"

Product Name Report Inclusion Prints the Products that were part of the CTPR Report 
for the case.

Displays "product name (generic name) product type, 
formulation, concentration unit" "daily dose," "dose 
dose_freq, route"

Report Comment Optional.

Reporter Reference Number Optional. If you select this value the report includes 
the reporter reference number as specified in the cases 
included in the Periodic report of All reporters within 
the case.

If the case does not have values, then label is not 
printed in the Line Listing for the report.

Reporter Type Optional.

Study Blinded Status Optional. The system enables you to exclude blinded 
cases from the inclusion criteria.

Study Center ID Optional.

Study Drug Optional.

Study ID Optional.

Study ID Protocol # Optional.

Data Element Notes
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Click the Up or Down buttons to arrange the listed elements above or below in order 
of priority.

***********************************************************************************************

Options
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***********************************************************************************************

Grouping Tab  Refer to the following table for a description of items in the Grouping 
tab.

Field Description

MedDRA Hierarchy 
from 
Cases/Dictionary

Select Cases to populate the data from the case data. Select Dictionary 
to populate the data from the MedDRA dictionary.

Print Only the Term 
(Preferred Term or 
Lower Level Term)

Prints only the event Preferred Term (PT) or event Lower Level Term 
(LLT) as per the selected radio button. Select the PT option to print only 
the preferred term and not the verbatim description.

Print Dose Text in 
place of regimen dose

Prints the dosage and frequency information from Dose Description 
field instead of Regimen Dose.

Indicate if case was 
expedited previously

This checkbox is selected if an agency has been selected in the Subject 
of Report tab. Cases for which an expedited report was previously 
submitted to the selected authority are marked with an asterisk and the 
date of submission appears in the line listing.

Any case that has been previously expedited to a selected agency, is 
listed in the list of Agencies in the Subject of Reports tab.

English Language Provides the option to print the descriptions in English

Local Language Allows a user to specify which Local language for a multi-language 
field is to be printed i.e. the Abbreviated Narrative field.

Print event info 
(Serious, Un-listed, 
Related) as Column

Select this checkbox to print the Seriousness, Listedness and Causality 
under the Event Verbatim column.

Note: Events having listedness of 'Unknown' are considered 'Unlisted'. 
If only diagnoses are assessed for event assessment, the events which 
are associated with a Diagnosis but have been marked with Diagnosis 
as 'No' display '-' for both listedness and causality.

List cases only once, 
under the primary 
event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event

List cases under all 
events, details under 
the primary event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event, while non-primary events are listed 
under their respective event hierarchy with a reference to the primary 
event body system. Therefore, use this option when grouping on Main 
Line Listing is by the Event Body System.

Print Product 
Indication for the 
Product selected in 
the Report

Enables you to print the product indication for the product selected in 
the report.
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***********************************************************************************************

Summary Tabulations Tab  The Summary Tabulations tab enables you to specify which 
summary tabulations/listings will appear along with the line listing.The system 
enables you to separate the cumulative summary by seriousness, relatedness, and 
listedness. If you choose this option, the system separates the product event detail into 
the following categories: Serious/Non-Serious, Related/Non-Related, and 
Unlisted/Listed events.

Field Description

Available Groupings Allows a user to group cases together from the given list. Select the 
desired groupings from the list and click Add to move the grouping to 
the Selected Groupings list.

Selected Groupings Lists the added groupings, and reports the groups in the order they 
were selected. Up to 5 grouping options can be selected from the 
Available Groupings list.

Ascending Select this checkbox to sort the selected entities in ascending order

Page Break Select this checkbox to start the cases from a new page, while also 
keeping the sorting together for every selected page break.

Available Sortings Allows a user to sort cases together from the given list. Select the 
desired sortings from the list and click Add to move the sorting to the 
Selected Sortings list.

Selected Sortings Allows a user to further sort cases without a total count for each sorted 
item. Up to 3 sorting options can be selected from the Available 
Sortings list. This list is populated with the Mandatory Line Listing 
entities plus any optional data elements chosen for this configuration.
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***********************************************************************************************

It contains the following fields and sections:

Field Description

Include Index of 
Cases in PSUR

Create an index page of case numbers, for all cases included in the 
PSUR.
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CIOMS Reports

***********************************************************************************************

Include Summary of 
Cases Missing 
Assessments

This option creates a sub-report of cases missing one of the following 
items:

■ Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have 
been included in the PSUR line listing, but one or more of the following 
have not been assessed:

■ Case Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Cases Not Included in Report - This sub-report displays cases that 
have not been included in the PSUR line listing as a result of missing 
one or more of the following items:

■ Lock Status

■ Safety Date

■ Uncoded Event

■ Causality

Include Line Listing 
Tabulation

Select this check box to view a pre-defined summary tabulation of 
Report type, Seriousness and Listedness of all cases in the PSUR.

Include Initial Cases Select this checkbox to include initial cases in the PSUR tabulation.

Include Follow-up 
Cases

Select this checkbox to include follow-up cases in the PSUR tabulation.

Include Summary of 
Unlocked Cases

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.

Field Description

Print CIOMS reports 
for serious/unlisted 
cases

Allows a user to print CIOMS I forms for all Serious/Unlisted (Case 
Level) cases appearing in the PSUR.

Note: CIOMS contain Internal or Other text printed on them when the 
PSUR is printed using the Internal or Other option.

Field Description
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Cumulative Summary

***********************************************************************************************

FDA PSUR Support

***********************************************************************************************

Include Periodic 
Numbering on the 
CIOMS reports

Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2, 
A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also 
contain the Periodic paging of each CIOMS report.

Field Description

Include Cumulative 
Summary

Select the check box to create a sub-report count of events, grouped by 
Product and Body System (SOC) and sorted by Preferred Term. The 
sub-report contains a previous date range count of events (comparative 
date range), a current date range count (current PSUR date range) and a 
cumulative count (all dates) of events assessed against the product(s) of 
the PSUR and matching the inclusion criteria.

Comparative Date 
Range

Allows a user to specify the previous date range as a comparison date 
for the events counted, and therefore should not overlap with the 
current date range specified on the PSUR inclusion criteria tab.

Serious Select this check box to include only serious events.

Unlisted Select this check box to include only unlisted events selected in the 
Datasheet on the "Inclusion Criteria Tab." If no datasheet is selected, 
then any Unlisted license is included.

Related Select this check box to include only those events that are assessed as 
Related or Causal.

Diagnosis Select this radio button to include only those events that are marked as 
diagnosis "Yes" and are without any symptoms associated with 
diagnosis.

Diagnosis & 
Symptoms

Select this radio button to include diagnosis and symptoms together in 
the sub-report.

Separate Diagnosis & 
Symptoms

Select this radio button to include diagnosis and symptoms separately 
in the sub-report. Selecting this option means that the case numbers are 
separated by Diagnosis and Symptoms respectively.

Field Description
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Field Description

FDA PSUR Support Section

Note: This section can be used if the company has obtained an FDA waiver to submit a PSUR 
instead of an NDA report.

Include Adverse Event Summary Select this option to generate a sub-report of events from 
the line listing. This sub report is grouped by Body System 
and Preferred Term.

Causality Select the desired causality from the list.

Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered 
reportable in the Causality Category configuration in List 
Maintenance.

Not Causal - Counts events where the causality is 
considered non-reportable in the Causality Category 
configuration in List Maintenance.

As Determined - Counts events where 'As Determined' 
causality meets the above selected causality criteria.

As Reported - Counts events where 'As Reported' causality 
meets the above selected causality criteria.

Both - Counts events where both 'As Reported' and 'As 
Determined' causality meet the above causality criteria.

Either - Counts events where either the 'As Reported' or 'As 
Determined' causality meets the causality criteria.

Only Cases with HCP Reporter Select this checkbox to include events for only those cases 
that feature an HCP reporter

Diagnosis Select this radio button to ensure that only events marked 
as diagnosis are counted.

Diagnosis & Symptoms Select this radio button to ensure that all events are counted 
in the sub-report.

Separate Diagnosis & Symptoms Select this radio button to include diagnosis and symptoms 
separately in the sub-report. Selecting this option means 
that the case numbers are separated by Diagnosis and 
Symptoms respectively.

Domestic Consumer Support Select this radio button to enable domestic consumer 
support.

Print Unsubmitted This option allows a user to print MedWatch or VAERS 
forms for U.S. cases

Exclude Reports that are 
Non-Serious and Listed

Allows a user to suppress MedWatch or VAERS forms from 
printing for Non-Serious listed cases where all events are 
non-serious and listed for the datasheet specified.

Use Periodic numbering on the 
Reports

Numbers the requested forms with a periodic format. (i.e. 
Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 - 1, 
Periodic Page 2 - 2, etc.) An index with the Case Number is 
also included.
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Single Case Submission Support

***********************************************************************************************

UD Summaries Tab
The UD Summaries tab allows you to specify which summary listings will appear 
along with the line listing.

Field Description

Single Case Submission Support Section

Generate Periodic ICSR Submissions for 
any cases in this Periodic Report that does 
not have at least one scheduled single-case 
report during the reporting period to the 
following Reporting Destination(s): 
Modify

Select this checkbox to generate the E2B Reports 
only for the cases, where a Periodic E2B Report for 
the message type chosen, does not exist.

Select one or more trading partners from the list 
box.

Important: Any case that does not have an 
expedited or single case periodic submission to a 
trading partner, must have an E2b report 
scheduled as a part of the Periodic submission.

Click Modify to select a different Reporting 
Destination.

Schedule these single-case Periodic 
Reports to the following Reporting 
Destination

Select a single-destination trading partner for 
Periodic Reports from the drop-down list box.

Using the Message Type Select the required message type from the 
drop-down list box
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***********************************************************************************************

The following lists and describes the fields on the UD Summaries tab.

Scheduling Tab
The Scheduling tab enables you to specify details of how often the periodic report will 
be scheduled.

Field Description

Include these 
summary 
tabulations/listings 
based on the set of 
cases presented in the 
line listing

Allows you to select from pre-configured summary 
tabulations/listings. These tabulations are based only on the data 
included in the line listing. Selecting the Exclude Follow-up Cases 
check box filters out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected on the Inclusion 
criteria tab, this option is ignored and follow-up cases are always 
filtered out.

Include these 
summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case Data Analysis' 
template, to be included as an output for the all cases in the database 
that meet the PSUR inclusion criterion for all dates.

Include these 
summary 
tabulations/listings 
based on the Date 
Range

This option allows for additional sub-reports based on Case Data 
Analysis, Case listing or CIOMS II line listing reports to be included as 
an output for the cases meeting the PSUR inclusion criterion for the 
Date Range specified when adding the sub-report.

The dates are based on either the "Case Creation Date" or the "Initial 
Receipt Date" as entered on the PSUR Inclusion Criteria tab. Click the 
checkbox to the right of the sub-report to ignore considering follow-up 
cases for the sub-report.

Additional Separate 
Page Numbering for 
Summaries

Enables you to include additional separate page numbering for 
summaries.
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***********************************************************************************************

Scheduling Frequency  

Field Description

Start Date This is the International Birth Date for the PSUR product. This date is 
computed as the earliest Awarded date for any license of any type.

Recalculate Allows a user to recompute the International Birth Date of the PSUR 
Product. This date can be overwritten/manually entered, if needed.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned
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***********************************************************************************************

The following table lists and describes the fields in the Scheduling Frequency section.

Security Tab
The Security tab is used to configure the security level for the PSUR.

***********************************************************************************************

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

Field Description

Share this Report 
with Other Users

Click this check box to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the "Execute" or "Modify and Execute" list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the PSUR report template. 
Click Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared PSUR 
report template.
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Templates Tab  Refer to the ePSUR User Guide for a description of fields in the 
Templates tab.

US IND Periodic Reports
The system enables you to define an IND summary report. You can add a new report 
as well as copy, modify and delete existing reports.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared PSUR report template.

Field Description
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Use the following procedure to create and IND Summary Report
1. Select Reports --> IND Reports to open IND Subject of Report view.

2. Click New Report.

OR

Select an existing report from the list and click Copy or Modify.

3. When you click New Report, the IND Line Listing Reports dialog opens.

4. Enter an appropriate name for the report under Report Name.

5. Use the tabs in this dialog to configure the IND Report.

6. From each tab in the IND Summary Report, you can choose to Print all 
configuration criteria on separate cover pages (PDF Only).

Common Fields
The Report Name, Report Category and Report Sub-Category fields are common to 
all tabs of the Reports. The following table describes these fields.

Subject of Report Tab  The Subject of Report tab is used to configure the report header 
and to specify the agency, products, and other elements. Select multiple ingredients for 
a configured IND Report to view the multiple licenses to be selected for the report.

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.
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***********************************************************************************************

Field Description

Primary Agency Select the Primary Agency.

Reporting Destination Displays the list of configured Regulatory Agencies. Select an 
agency from the list displayed in Reporting Destination and 
click Add to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you 
click them.

Selected Destination Displays the list of agencies where the report is being sent. 
Select an agency from the list displayed in Reporting 
Destination and click Add to add the report to the Selected 
Destination list.

Select multiple agencies by holding the CTRL key when you 
click them.

Likewise, select an agency from the Selected Destination list 
and click Remove to prevent it from being sent to the selected 
destination.

Company Name If a regulatory agency is selected in the Subject of Report tab, 
then the company name associated with the regulatory agency 
(this association is created by the Administrator) is 
automatically entered in this field.

Product Name This field is automatically filled as per the Ingredient field.

Note: Click the checkbox corresponding to this field to choose 
whether you want this field to appear on the report.

Approval This field is automatically filled with License numbers, 
separated by commas. This is an editable field.



Reports

10-88 Oracle Argus Safety Japanese User's Guide

Product Selection Tab  Use the Product Selection tab to select product information to 
include in the report.

***********************************************************************************************

Award Date This field is populated with the earliest awarded 
Investigational License for US amongst the licenses selected. 
This field cannot be edited.

Note: Click the checkbox corresponding to this field to choose 
whether you want this field to appear on the report.

Print all configuration criteria 
on separate cover page

Click this checkbox to print out the configuration of this report 
when the report is printed. This is only available when the PDF 
option is selected during printing.

Print page numbers on 
reports

When checked, this option enables the user to print page 
numbers on a periodic report. This is the default for all report 
configurations.

If this checkbox is not checked, the following occur.

■ The "Additional Separate Page Numbering for UD 
Summaries" option on the IND Summaries Tabulation tab 
is grayed out and inactive.

■ The system removes all existing report page numbering

Allow access to report cases 
through Hit List

When the report is run as final, it creates a Hit List, which can 
be retrieved from other areas of the application where 
advanced conditions can be selected. Click this checkbox to 
report cases through the Hit List.

Field Description
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Inclusion Criteria Tab  The Inclusion Criteria tab allows you to select search parameters 
for inclusion of cases in a periodic report.

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Indication This list contains a list of all the indications for the products containing 
the selected ingredient. The selections made from this list are displayed 
in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulations configured for the product 
containing the selected ingredient and indication. The selections made 
from this list get displayed in the Selected Products section.

Note: You can select multiple Formulations from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Available Licenses This list is automatically populated with the licenses from the 
Indication section.

Selected Licenses This list contains licenses selected by the user from the Available 
Licenses list. When a product is selected, the Trade Name and 
International Birth Date fields are auto-populated with the license 
trade name ("formulation", "concentration") and earliest License Award 
Date for the product.
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***********************************************************************************************

Line Listing Tab  The following table describes the fields in the Line Listing tab.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select the Age Groups checkbox to activate the age groups and 
select all the age group categories that apply.

Options - 
Domestic/Foreign 
Cases

This option allows the user to include domestic and foreign cases 
within the periodic report. Select Domestic if Country of Incidence is 
USA and Foreign if Country of Incidence is not USA.

Expeditable Only This checkbox is available only when an agency is selected in the 
Subject of Report tab. If you select this check box, only the cases 
classified as submitted expedited reports to the primary agency are 
used.

Include Unlocked 
Cases

Allows you to include unlocked cases in the periodic report.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.
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***********************************************************************************************

Summary Tabulations Tab  The Summary Tabulations tab enables you to specify which 
summary tabulations will appear along with the line listing.

***********************************************************************************************

Field Description

Report All Events Select this option to report all events.

Report only 
Diagnosis Events

Select this option to report only diagnosis events (only the diagnosis 
events that are either explicitly marked as diagnosis or are non-related 
symptoms).

List cases only once, 
under the primary 
event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event

List cases under all 
events, details under 
the primary event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event, while non-primary events are listed 
under their respective event hierarchy with a reference to the primary 
event body system. Therefore, use this option when grouping on Main 
Line Listing is by the Event Body System.

Create a Sub Report 
for Death Cases

Select this check box to separate death cases from the main IND listing. 
If the check box is checked, all death cases (Identified by any event 
marked as death in Seriousness Criteria or any event having a Event 
Outcome as Death) are filtered out from the IND Line Listing. All death 
case show up in a sub report, called "IND Line Listing (Death Cases)."
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Scheduling Tab  The Scheduling tab allows you to specify details of how often the 
periodic report will be scheduled.

***********************************************************************************************

The following table lists and describes the fields on the Scheduling tab.

Field Description

Include these 
summary 
tabulations/listings 
based on the set of 
cases presented in the 
line listing

Allows you to select from pre-configured summary 
tabulations/listings. These tabulations are based only on the data 
included in the line listing. Select the Exclude Follow-up Cases check 
box to filter out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected on the Inclusion 
criteria tab, this option is ignored and follow-up cases are always 
filtered out.

Include these 
summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case Data Analysis' 
template, to be included as an output for the all cases in the database 
that meet the IND Report inclusion criterion for all dates.

Add Displays a list of memorized Case Data Analysis Reports that have 
been marked for availability in a periodic report.

Remove Click this button to remove a selected report.

Additional Separate 
Page Numbering for 
Summaries

Enables you to include additional separate page numbering for 
summaries.

Include Summary of 
Unlocked Cases

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.
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Scheduling Frequency  Description of fields in Scheduling Frequency:

***********************************************************************************************

Security Tab  The Security tab is used to configure the security level for the IND 
Reports.

Field Description

Start Date This is the International Birth Date for the IND Report product. This 
date is computed as the earliest Awarded date for any license of any 
type.

Recalculate Allows a user to recompute the International Birth Date of the IND 
Report Product. This date can be overwritten/manually entered, if 
needed.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned.

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.
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***********************************************************************************************

The following table lists and describes the fields on the Security tab.

US NDA Periodic Reports
The US NDA Periodic Reports enable you to define an NDA Periodic report. You can 
add a new report as well as copy, modify and delete existing reports.

Field Description

Share this Report 
with Other Users

Click this check box to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the "Execute" or "Modify and Execute" list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the IND Report template. Click 
Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared IND 
Report template.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared IND Report template.
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Use the following procedure to create an NDA Periodic report

To create NDA Summary Reports:
1. Select Reports --> NDA Reports to open the NDA Subject of Report view.

2. Click New Report to create an entirely new report,

OR

Select an existing report from the list and click Copy or Modify.

3. When you click New Report, the NDA Line Listing Reports dialog opens.

4. Enter an appropriate report name in the Report Name field

5. Use the tabs in this dialog to configure the NDA Report.

6. From each tab in the NDA Report, you can choose to Print all configuration 
criteria on separate cover pages (PDF Only).

General Usage Information
When using NDA Reports be aware of the following:

■ You can print an Index of Cases included in the NDA report.

■ If you select this option, the system lists the cases from the following sections once 
at the end of the configuration pages:

– Sequential List of cases

– Serious Listed Initial/Follow up

– Non Serious Listed Initial/Follow up

– Non Serious Unlisted Initial/Follow up

– 15 Day Submission

■ The page numbering for this sub-report continues from the configuration pages.

■ You can separate initial case events from follow-up case events in the Summary 
Tabulation tab of the NDA Report.
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– If you select this option, the system counts events in the Initial section if the 
case is in the Serious Listed, Non-Serious Listed, or Non-Serious 
Listed/Unlisted sections.

– If you select this option, the system counts events in the Follow-up section if 
the case is in the Serious Listed or Non-Serious Listed/Unlisted follow-up 
sections of the NDA report.

– For the 15 Day events, if the case has not been previously reported in a NDA, 
the system counts it in the Initial section then the Follow-up section.

– If you select List cases once under the Primary Event System Organ Class 
(SOC), the system displays a footnote with an asterisk ( * ) printed across all 
the System Organ Classes on the report and the following statement: Primary 
Event System Organ Class.

■ If you select the Print FDA-3500A/VAERS form at the end option, the system 
prints the report sections in the following order:

■ Configuration (Including Case Indices (e.g. Sequential Case Listing, Listing by 
Seriousness/Listedness, Listing of Cases Missing Analysis)

– Line Listing

– Summary Tabulations

– MedWatch/VAERS reports at the end of the report

■ Page numbering for the MedWatches reports continue from the last page of the 
NDA report.

■ The configuration pages have been updated to reflect the updates made to the 
NDA Reports

■ The configuration pages are printed at the beginning of the NDA report.

■ By default, these are unchecked on all the existing configured reports.

Common Fields
The Report Name, Report Category and Report Sub-Category fields are common to 
all tabs of the Reports. The following table describes these fields:

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.
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Subject of Report Tab
On the Subject of Report tab you can select multiple Ingredients for a configured 
NDA Report per allowable variations of product and license configuration and 
periodic reporting requirements for the FDA. Select multiple ingredients to view the 
multiple licenses to be selected for the report.

***********************************************************************************************

The following table describes the items in the Subject of Report tab.

Field Description

Primary Agency Select the Primary Agency.

Reporting 
Destination

Displays the list of configured Regulatory Agencies. Select an agency 
from the list displayed in Reporting Destination and click Add to add 
the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Selected Destination Displays the list of agencies where the report is being sent. Select an 
agency from the list displayed in Reporting Destination and click Add 
to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Likewise, select an agency from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Company Name If a regulatory agency is selected, the company name associated with 
the regulatory agency (this association is created by the Administrator) 
is automatically entered in this field.
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Product Selection Tab
The Product Selection tab enables you to select product information to include on the 
report.

Ingredient This field is populated with ingredient selected in the Subject of 
Report tab.

Note: Click the checkbox corresponding to this field to choose whether 
you want this field to appear on the report.

Approval This field is automatically filled with License numbers, separated by 
commas. This is an editable field.

Trade Name Automatically displays the Trade Name.

Multiple trade names are also populated from license trade name 
(formulation, concentration) of selected licenses, separated by commas.

Note: Click the checkbox corresponding to this field to choose whether 
you want this field to appear on the report.

Award Date Automatically displays the earliest license awarded date, when a user 
selects an Ingredient and a Product.

Note: Click the checkbox corresponding to this field to choose whether 
you want this field to appear on the report.

Print all 
configuration criteria 
on separate cover 
page

Click this checkbox to print out the configuration of this report when 
the report is printed. This is only available when the PDF option is 
selected during printing.

Print page numbers 
on reports

When checked, this option enables the user to print page numbers on a 
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

■ The "Use Periodic Numbering on the reports" option in the NDA 
Line Listing tab is grayed out and inactive

■ The "Additional Separate Page Numbering for UD Summaries" in 
the NDA Summary Tabulations tab is grayed out and inactive.

■ The system removes all existing report page numbering and the 
option to check page number check boxes on the report 
configuration tabs are grayed out and inactive.

Allow access to 
report cases through 
Hit List

When the report is run as final, it creates a Hit List, which can be 
retrieved from other areas of the application where advanced 
conditions can be selected. Click this checkbox to report cases through 
the Hit List.

Field Description
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***********************************************************************************************

The following table lists and describes the fields on the tab.

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Indication This list contains a list of all the indications for the products containing 
the selected ingredient. The selections made from this list are displayed 
in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulations configured for the product 
containing the selected ingredient and indication. The selections made 
from this list get displayed in the Selected Products section.

Note: You can select multiple Formulations from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Available Licenses This list is automatically populated with the licenses from the 
Indication section.
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Inclusion Criteria Tab
The following table describes the items in the Inclusion Criteria tab.

***********************************************************************************************

Selected Licenses This list contains licenses selected by the user from the Available 
Licenses list. When a product is selected, the Trade Name and Award 
Date fields are auto-populated with the license trade name 
("formulation", "concentration") and earliest License Award Date for the 
product.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select the Age Groups checkbox to activate the age groups and 
select all the age group categories that apply.

Option (Applicable to 
Non-15-Day Selection 
Only)- 
Domestic/Foreign 
Cases

This option allows the user to include domestic and foreign cases 
within the periodic report. Select Domestic if Country of Incidence is 
USA and Foreign if Country of Incidence is not USA.

Field Description
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Line Listing Tab
The NDA report comprises of three tabs. The options for these tabs can be configured 
in the Line Listing tab.

***********************************************************************************************

The following tables lists and describes the fields on the tab.

Option (Applicable to 
Non-15-Day Selection 
Only)-

Exclude Literature 
Cases/Study Cases

This option allows the user to exclude Literature and Study Cases from 
being considered for the NDA Report. Select Exclude Literature Cases 
to exclude literature cases and select Exclude Study Cases to exclude 
study cases.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.

Add Cases not 
Included in a 
previous reporting 
period Start Date

Enter the start date. This adds cases not included in a previous 
reporting period with the specified start date.

Include Unlocked 
Cases

Allows you to include unlocked cases in the periodic report.

Evaluate Primary 
Suspect Drug Only

Allows you to select only the Primary Suspect Drug.

Field Description
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Field Description

Tab 1: FDA - 
3500/VAERS Forms

Select this checkbox to generate the MedWatch 3500A (Drug) or VAERS 
reports which are serious listed or non-serious

Suppress printing of 
non-serious listed 
reports

Select this checkbox to prevent printing the non-serious listed reports 
but print their case numbers in the main NDA report indices

Note: Tab 1 of the NDA Line Listing report cannot be generated 
without Tab 2. However, Tab 2 can be generated without Tab 1

Tab 2: Index of 
Submitted Forms in 
Tab 1

Select this checkbox to generate an index of the forms from Tab 1 It 
prints all MedWatch/VAERS forms for the following cases:

■ Serious Listed

■ Non-Serious Unlisted

■ Non-Serious Listed

Note: Previously expedited 15-day reports that are Serious and 
Unlisted that have already been submitted to the FDA do not need to 
be re-submitted with this periodic report

Tab 3 Part 1: NDA 
Line Listing of 15 
Day Reports 
Submitted

Select this checkbox to generate a list of all serious unlisted expedited 
reports within the specified time period.

Note: The dates in these reports are in GMT.

TAB 3 Part 2: 
Tabulation by System 
Organ Class (SOC) of 
All Event Reports 
Submitted

Select this checkbox to generate a tabulation by System Organ Class 
(SOC) of all events reported during the specified time period. This 
includes the cases for which expedited reports were previously 
generated, as well as the cases that are submitted as part of the current 
report

TAB 3 Part 3: Cases 
sent to FDA under 
another NDA

Select this checkbox to print a list of all the serious unlisted events for 
which reports were submitted to the FDA previously

Note: If you select to print out the Tab 3 Part 3 section, the NDA report 
looks for other submissions (E2B, MW, MW Drug, or VAERS) to the 
same agency for the same case against other (not included in selection 
criteria for this report) marketed licenses. Any submission matching 
this criterion is listed on the Tab 3 Part 3 section of the NDA report. If 
there are multiple submissions against different licenses, then each one 
is listed. Each license is listed only once

Include Periodic 
Submissions

Select this checkbox to include all cases that have been sent under 
another NDA

Start Page Number Select the page number for the first page of the report

Listing Options These options for "List cases only once, under the primary event body 
system" and "List cases under all events body systems" only apply to 
the NDA Line Listing of Expedited Reports Submitted report

List cases only once, 
under the primary 
event System Organ 
Class

Select this option to list cases only once

List cases under all 
events System Organ 
Classes

Select this option to list cases under each SOC for each event

Include Summary of 
Cases Missing 
Assessments

Select this checkbox to include a Summary of Cases missing 
Assessments at the end of the report

Include Summary of 
Unlocked Cases

Select this option to include a summary of unlocked cases
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Summary Tabulations Tab
The Summary Tabulations tab allows you to specify which summary tabulations will 
appear along with the line listing.

***********************************************************************************************

The following table lists and describes the fields on the tab.

Include Listing of 
Nullified 15-day 
Alert Cases 
Submitted During 
the Reporting Period

Select this option to include cancelled 15-day alert cases during the 
reporting period

Note: The dates in these reports are in GMT.

Use Periodic 
numbering on the 
Reports

Select this option to use periodic numbering on reports

Custom Case 
Summary Tabulation

Enter the Summary Report Title

Advanced Condition Select the Advanced Condition from the drop-down list

Field Description

Include these 
summary 
tabulations/listings 
based on the set of 
cases presented in the 
line listing

Allows you to select from pre-configured summary 
tabulations/listings. These tabulations are based only on the data 
included in the line listing. Select the Exclude Follow-up Cases check 
box to filter out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected on the 
Inclusion criteria tab, this option is ignored and follow-up cases are 
always filtered out.

Field Description
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Scheduling Tab
The Scheduling tab allows you to specify details of how often the periodic report will 
be scheduled.

***********************************************************************************************

The following table lists and describes the fields on the tab.

Include these 
summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case Data Analysis' 
template, to be included as an output for the all cases in the database 
that meet the NDA Report inclusion criterion for all dates.

Add Displays a list of memorized Case Data Analysis Reports that have 
been marked for availability in a periodic report.

Remove Click this button to remove a selected report.

Additional Separate 
Page Numbering for 
Summaries

Enables you to include additional separate page numbering for 
summaries.

Case Count 
Summary Report

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.

Field Description

Start Date This is the International Birth Date for the NDA Report product. This 
date is computed as the earliest Awarded date for any license of any 
type.

Recalculate Allows a user to recompute the International Birth Date of the NDA 
Report Product. This date can be overwritten/manually entered, if 
needed.

Field Description
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Scheduling Frequency  The following is an illustration of the Scheduling Frequency 
section.

***********************************************************************************************

The following table lists and describes the Scheduling Frequency fields.

Security Tab
The Security tab is used to configure the security level for the NDA Reports.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned.

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

Field Description
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***********************************************************************************************

Bulk Reporting
Bulk Reporting enables you to print, transmit and/or submit reports in bulk.

Select Reports --> Bulk Reporting to view the Bulk Report screen shown in the 
following illustration.

Field Description

Share this Report 
with Other Users

Click this checkbox to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the 'Execute' or 'Modify and Execute' list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the NDA Report template. 
Click Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared NDA 
Report template.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared NDA Report template.
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***********************************************************************************************

Bulk Reporting Filter Section
The Bulk Reporting Filter sections enables you to filter reports.

***********************************************************************************************

The following table lists and describes the fields in this section

Field Description

Destination Select an Agency to filter reports by that particular agency. Only the 
agencies that have reports in the Scheduled, Approved and Generated 
states are displayed. Click Filter to select multiple agencies from the 
Reporting Destinations dialog. The previous filtering criteria is saved 
and retained when the user invokes this dialog. By default, all agencies 
are assumed.

Report Form Select any of the listed report forms to view reports belonging to the 
selected report form only.

Report Status Choose either Scheduled/Generated, Pending, Failed, or 
Printed/Transmitted from the drop-down list.

Print Regulatory 
Report

Prints the report as Draft or Final. The Draft option is disabled when 
the printing option is set to Transmit. Select Medical Summary to view 
the list of only medical summaries of distinct cases in a PDF.

Approved Reports 
Only

Filters reports for only approved reports.
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Total Number of Rows Section
The system displays the search results in the Total Number of Rows section.

***********************************************************************************************

The following table lists and describes the fields and columns in this section.

View All Displays the bulk reports applicable to your filter selections.

Product Family Enter a Product family to view all cases where the scheduled reports 
belong to the searched Product family.

Specific Case # Searches a specific case. To do so, enter the Case Number of the case 
you wish to search and click the Retrieve button. This stores the agency 
selections last made.

Field Description

Selected Allows the user to select the report.

Lock State Displays the Case status of the case to depict if the case is locked or 
un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the status to view the report details.

Case Number Displays the Case number.

Click the Case Number link to open the case.

Country of Incidence Displays the view Country of Incidence.

Report Type Displays the Case Report Type

Suspect Product Displays the Trade Name for which the report has been scheduled. If 
more than one Suspect Company Product exists for the case, an "(+)" is 
placed at the end of the product name.

For Reports which were scheduled for the Device, the Device name is 
displayed.

Diagnosis Displays the Primary Event Diagnoses PT

(Event Verbatim) Displays the (Verbatim as reported) of the Primary Event.

Field Description
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Printing Options
Several printing options are available to you.

The following table lists and describes the available printing options

S/U/R ■ Displays the Case Level Assessments:

■ Serious (Y/N)

■ Unlisted (Y/N)

■ Causality (Y/N)

■ Unknown is treated as a "?"

■ The SUR link displays the Case Summary associated with the 
selected case.

F or LT Fatal / Life Threatening

If any of the events in the case are Fatal or Life Threatening F or LT is 
displayed.

If the case is both F and LT, only F is displayed.

If the case is neither F nor LT, only No is displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the Description of the report

Click the Report form link to view the DRAFT Report as a PDF.

Destination Displays the report destination (agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Initial or Follow-up

If Follow-up, the follow-up number is printed

Due Date Displays the due date.

Days Past Due Displays the number of days the report is past due date.

Downgrade Allows the user to view if the report is downgrade.

Displays Yes if the report is a downgrade report else.

View All Allows administrator and workflow manager to see all items in the 
system.

Tip: The icon   (displayed in the lock state) in the Reports-> Bulk 
Reporting screen denotes a SUSAR (Suspected Unexpected Serious 
Adverse Reaction) case.

Field Description

Blind Study Product Select this check box to print study cases with blinded information.

Mark as Submitted Select this check box to mark reports as Submitted when the 
transmission/e-mail has been sent.

A dialog is displayed is this check box is not selected. This dialog 
prompts you to confirm if the report is to marked as submitted or not.

Select Yes or No, as required. This selection is remembered for the next 
time when you print a report.

Field Description



Reports

10-110 Oracle Argus Safety Japanese User's Guide

User Options
The following options are available to you.

■ Lock State Header Options

■ Lock State Icon Options

Lock State Header Options  To sort the cases based on the following case status, click the 
Lock State header row. A pop-up appears listing the following sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Lock State Icon Options  Click the Lock State icon to view the list of options.

The following table describes these options:

Incoming E2B Reports
The Incoming E2B Reports page enables you to:

Print Medical 
Summary

Allows the user to print the Medical Summaries.

Print Allows you to choose the printer for the selected report from the Select 
Site Printer dialog. 

Select the Site and Printer Name where you wish to print the report 
and click OK.

Print List Allows the user to print the current view of the Bulk Reporting.

Tip: The icon   (displayed in the lock state) in the Reports-> Bulk 
Reporting screen denotes a SUSAR (Suspected Unexpected Serious 
Adverse Reaction) case.

Field Description

View Report Displays the Draft report.

Report Details Displays specific information about the report as entered in the 
Regulatory Reports section.

Case Summary Displays the Case Summary dialog

Remove Report Deletes the report from the case on being asked for a justification

Mark for 
Non-Submission

Displays the Submission tab in the Report Details dialog.

Select No for Mark for Non-Submission and enter the reason for the 
non-submission.

Remove Multiple 
Reports

Deletes multiple reports from the case on being asked a justification.

Mark Multiple for 
Non-Submission

Deletes multiple reports from the case on being asked a justification. 
The notes and date entered for the selected report are applicable for all 
the reports selected for Non Submission.

Field Description
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■ View the E2B reports sent by the agency or the trading partner

■ Process an incoming E2B report.

You can do the following:

■ Check all the E2B values of the reports sent and determine whether to accept or 
reject the reports

■ Provide a user password and acceptance notes/rejection reason and accept or 
reject an incoming E2B report

Select Reports --> E2B Pending Reports to view Incoming E2B Reports page show in 
the following illustration.

***********************************************************************************************

Incoming E2B Reports Fields
The following table describes the fields on the IncomingE2B Reports page.

Field Description

Trading Partner Enter the trading partner. Click Filter to select an agency to filter by that 
particular Trading Partner. This allows you to select multiple agencies 
by clicking Add from the Select Reporting Destinations dialog.

Product 
Name/Generic Name

Enter the product name or generic name, as required.

Report Type Select the report type, as applicable.

Transmit Date Range Enter the range of the Transmit Date from the From and To fields. You 
can also select the range from the Range drop-down list.

Trading Partner Displays the name of the Trading Partner of the case.
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Button and Right-click Options  The following table describes the different buttons and 
right-click options available on Incoming E2B Reports page.

Initial / F/U / Null The report version of the report

■ Initial: If the case received is an Initial Case.

■ Follow -up: If the case received is a Follow-up Case.

■ Nullification: If the case received is a Nullification Case.

World Wide Unique # The worldwide unique number of the received case.

Sender Case # Displays the case number of the sender.

Transmission Sent Displays when the transmission was sent.

MDN Sent Date Displays the date the MDN was sent.

Interchange 
Processed Date

Displays the date the interchange was processed.

Case Receipt Date Displays the date the case was received.

Country of Incidence Displays the country where the incident occurred.

Report Type Displays the report type of the case.

Imported Case # Displays the number of the imported case.

Product Name Displays the product name.

Generic Name Displays the generic name of the product.

Event PT Displays the Primary Event and Verbatim as Reported.

Event LLT Displays the Event LLT for the Event Information.

Is/Will be assigned 
to this site

Displays the site membership of the case.

Pat Initials Displays the initials of the patient.

Study ID/Pat. ID Displays the Study ID/ the ID of the patient in the case.

Reporter Type Displays the primary reporter's Reporter Type.

Reporter Displays the first and last name of the Primary Reporter.

Button Description

ICSR Viewer Select this right-click option to launch the E2B viewer. For details, refer 
to the ESM User Help.

Note: At the time of generating an E2B report, some characters entered 
by the user in the case form may not be displayed the same in the E2B 
report. For example, the E2B report equivalent of the "&" character 
entered in the case form is &. Similarly, there are other such characters 
that are represented differently in the E2b report. The table below 
contains the list of such characters and their equivalent representations 
in the E2b report:

View Error/Warning 
Message

Select this right-click option to view all warning messages including 
M2 validation errors and Multiple E2b Codes log.

Duplicate Search Select this right-click option to perform Duplicate Search for the case 
being imported with the case present in the system.

Field Description



Reports

Argus Reports 10-113

Pending Reports
When using E2B Pending reports, be aware of the following:

■ The system uses the Oracle Text profile settings for the duplicate search in E2B 
Pending configured in the Argus Schema Creation Tool.

■ The user can right click on the row and select the following:

Case Summary. This displays the Case Summary (current functionality)

Medical Summary. This displays the Medical Summary report, if the user has 
permission to access the Medical Review dialog.

Case Form Print. This launches the Case Form Print dialog to enable the user to print 
the case form in a new IE window.

Bulk Incoming E2B Reports
The Bulk Incoming Reports dialog allows the user to import multiple E2B reports that 
have been sent by the agency or trading partner.

Be aware of the following:

Accept ISCR Selects the incoming E2B report

Execute these steps to accept an E2B Case:

1. Click the Accept E2B Case button. The Acceptance of Initial Report 
Confirmation dialog opens.

2. Enter your user password, date, and select a justification from the 
pre-defined list of justifications.

3. Click OK.

Reject ICSR Rejects the incoming E2B report

Execute these steps to reject an E2B Case:

1. Click the Reject E2B Case button. The Rejection of Initial Report 
Confirmation dialog opens.

2. Enter your user password, date, and select a justification from the 
pre-defined list of justifications.

3. Click OK.

Reject ICSRs Enables you to reject multiple ICSRs by selecting the checkbox against 
each ICSR to that needs to be rejected. You can select the type of report 
to be followed up from the Follow Up Report Form screen.

This screen allows you to select a Follow-up Report format for a Report 
Form.

Select the desired option and click OK to print out the CIOMS or the 
MedWatch Report Form as a PDF report whilst importing the cases.

Accept ICSRs Enables you to accept multiple ICSRs by selecting the checkbox against 
each ICSR to that needs to be accepted.

You can select the type of report to be followed up from the Follow Up 
Report Form screen.

This screen allows you to select a Follow-up Report format for a Report 
Form.

Select the desired option and click OK to print out the CIOMS or the 
MedWatch Report Form as a PDF report whilst importing the cases.

Button Description
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■ The reports that are imported can be a combination of Initial, Follow-up and 
Nullification reports.

■ The only pre-requisite for this dialogue is that Case numbering should be set to 
auto-numbering and not manually.

■ Bulk Incoming Reports does not prevent the duplicate cases to be loaded into the 
system.

To view Bulk Incoming Reports:
1. Select multiple reports from the Incoming E2B Reports screen and click Accept 

ICSRs.

2. The system opens the Bulk Incoming Reports screen.

The following table lists and describes the fields in the Bulk Incoming Reports dialog 
box.

Duplicate Search
The Duplicate Search dialog for an E2B report enables you to search for possible 
duplicate cases in the Argus Safety system. You can select different combinations of 
search criteria. When more than one criterion is selected, only cases that satisfy all 
criteria are listed. By default, only the fields that are present in the E2B Report are 
checked for the Duplicate Search.

Duplicate Search Dialog Box Fields and Field Descriptions
The following table describes the fields present in the Duplicate Search dialog.

Field Description

Agency Name This drop down list contains unique trading partner from the E2b 
reports have been received. You can select a particular agency/trading 
partner to filter the E2b reports.

Product Name This drop down list contains unique suspect Product Names extracted 
from the received E2b reports. Select a particular suspect product to 
filter the E2b reports. If an Agency Name is selected, the Product Name 
list contains all suspect products belonging to that agency name.

Follow Up Output 
Format

This drop down list contains CIOMS-I, MedWatch and Case Form. You 
can print all E2b reports in CIOMS-I, MedWatch or Case Form format 
only if the Follow Up checkbox has been selected.

Source Count Displays the total number of E2b reports with breakdown in 'Initial' 
'Follow Up' and 'Nullification' category.

Report Type Displays the report type.

Selected Count Displays the number of E2b selected by the user to load the E2b reports 
in Argus Safety. Selected count can be changed by checking the 'Initial' 
or 'Follow Up' or 'Nullification' checkbox.

Import Imports all the reports.

Note: For the Import process, if the system receives an E2B report with 
the Medically Confirm field set to 1, the Primary reporter is marked as 
HCP.

Cancel Removes the Import E2B reports window.
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Field Description

Agency The name of the primary agency.

Original Case 
Number

The original case number.

Message Number The message number of the case.

Product Name The product name that caused the adverse event.

Generic Name The generally known, popular name of the product.

Report Type The type of report.

Study ID The Study ID.

Receipt Date The date the report was received by Argus and saved in the system.

Center ID The ID of the center.

Sal. The salutation such as Mr. or Mrs.

Suffix The suffix, if applicable, that follows the name.

First Name The first name of the patient.

Last Name The last name of the patient.

Country of Incidence The country where the incident occurred.

State The state where the incident occurred.

Postal Code The postal code of the area where the incident occurred.

Patient Name The name of the patient.

Event Desc. A description of the adverse event.

Initials The initials of the patient.

Onset Date The date from when the first reaction or adverse event occurred.

Pat. ID The ID of the patient.

Age/Units The age of the patient.

Pat. DOB The date of birth of the patient.

Gender The gender of the patient.

Reference # National Regulatory Authority's Report Number, used as a Reference 
Number.

Journal The journal name related to the adverse event.

Nullification Reason The reason why the case was nullified.

Accept Initial E2B as 
Follow-Up

Enables you to accept initial E2B as a follow-up

Search Finds results matching the specified search criteria.

View E2B Enables you to view the E2B report.

Accept E2B Case Enables you to accept an E2B case.

Reject E2B Case Enables you to reject an E2B case.

View Warning Enables you to view warnings associated with the case.
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Duplicate Search for Incoming Review
The Duplicate Search in Argus Central Incoming review enables you to search on 
Reference ID and Keyword field in Argus cases.

The following table lists and describes the fields on the Duplicate Search screen.

View Differences Allows viewing differences between the current XML to be imported (a 
message that is not yet imported into the database), the current case 
data in the database, and if a case has been imported before, the last 
imported case.

Note: This button is available only for follow-up and nullification 
reports.

Case Number Displays the case number of the case matching the search criteria.

Pat. Initials Displays the initials of the patient in the case matching the search 
criteria.

Action Enables you to view the Case Summary dialog.

Project ID Displays the Project ID of the case matching the search criteria.

Study ID Displays the Study ID of the case matching the search criteria.

Date Displays the date of the case matching the search criteria.

Country Displays the country name of the case matching the search criteria.

Product Displays the product name involved with the case matching the search 
criteria.

Event Displays the event involved with the case matching the search criteria.

Report Type Displays the report type of the case matching the search criteria.

Reporter Displays the reporter involved with the case matching the search 
criteria.

Tip: The system displays the search results the Total Number of 
Rows section. Click the Action icon to view the case summary dialog.

Field Description

Product Name The product name that caused the adverse event.

Report Type The type of report.

Receipt Date The date the report was received by Argus and saved in the system.

Generic Name The generally known, popular name of the product.

Study ID The Study ID.

Reference ID Enables you to search for a duplicate case based on reference ID.

Keyword Enables you to search for a duplicate case based on a keyword.

Sal. The salutation such as Mr. or Mrs.

Suffix The suffix, if applicable, that follows the name.

First Name The first name of the patient.

Last Name The last name of the patient.

Country of Incidence The country where the incident occurred.

Field Description
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Be aware of the following:

■ The Reference ID field searches on the following fields in the Argus case:

– Additional Info | Case Reference ID

– Reporters | Reporter's Reference #

– Argus Case Number

■ By default the system populates the Keyword field with the first value from the 
incoming affiliate event.

View Differences Report
The View Differences Report enables you to view differences between the current 
XML to be imported (a message that is not yet imported into the database), the current 
case data in the database, and if a case has been imported before, the last imported 
case.

Note: View Differences is available for follow-up reports only. This option is enabled 
only when an initial case or case number is selected in the duplicate search output 
section.

Click View Differences from the Duplicate Search screen to view the View Difference 
report. This displays the E2B Difference Report.

The following table describes the fields in the report.

State The state where the incident occurred.

Postal Code The postal code of the area where the incident occurred.

Initials The initials of the patient.

Pat. ID The ID of the patient.

Age/Units The age of the patient.

Gender The gender of the patient.

Onset Date The date from when the first reaction or adverse event occurred.

Event Description. A description of the adverse event.

Field Description

Trading Partner Allows you to view the Trading Partner name from whom the E2B 
report is received.

Note: The Lock/Archive icon displayed with this field denotes the 
status of the case.

DTD Version Allows you to view the DTD version of the follow-up E2B report.

Case Number Displays the original case number of the E2B report.

Follow Up # Displays the sequence number of the follow-up for the E2B report.

Total Number of 
Rows

Allows you to select the type of E2B Difference to view from: Current 
E2B vs. Current Case in Database

■ Current E2B vs. Last Imported E2B

■ Current Case in Database vs. Last Imported E2B

Import Select this check box to highlight import differences.

Field Description
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Displaying Differences
The system displays the differences in the E2B reports as follows:

■ Addition -- New elements are highlighted in grey.

■ Deletion -- Deleted elements are highlighted in red.

■ Modification -- Modified elements are highlighted in yellow.

Accept Initial E2B Cases As Follow-Up  This option is enabled only when an initial case or 
case number is selected in the duplicate search output section.

1. Click this button to add an ICSR as a follow up to the Case Number, which you 
have highlighted in the duplicate search output section.

2. A pop-up dialog appears: "Do you want to add this ICSR as a Follow-up to the 
Case Number<Num>?"

3. Click OK to proceed.

4. The Argus application attaches the incoming ICSR as a follow-up, to the selected 
case number highlighted in the duplicate search screen.

Processed E2B Reports
The Processed E2B Reports page contains a list of all the processed E2B Reports.

Click the Processed E2B Reports tab on the Incoming Reports screen to view the 
Processed E2B Reports screen.

E2B Element Select this check box to highlight E2B differences.

Current E2B Select this check box to highlight differences in the current E2B.

Current Case in 
Database

Select this check box to highlight differences in the current case in the 
database.

Last Imported E2B Select this check box to highlight differences in the last imported E2B.

Accept Follow-up Allows you to update the corresponding fields for the selected E2B 
elements in the Argus case.

Reject Follow-up Does not update the corresponding fields for the selected E2B elements 
in the Argus case.

Print List Provides the difference report in a PDF format.

Tip: Click Cancel to return back to the duplicate search screen.

Field Description
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Search Criteria Section
The system enables you to enter search parameters in the Search Criteria section.

The following table lists and describes the fields in the Search Criteria section.

Total Number of Rows Section
The system places the search results in the Total Number of Rows section.

Field Description

Trading Partner Enter the trading partner. Click Filter to select an agency to filter by that 
particular Trading Partner. This allows you to select multiple agencies 
by clicking Add from the Select Reporting Destinations dialog.

Product Name Enables the user to select a Product Name as a search criterion.

Import Status Enables the user to select Import Status as a search criterion.

Report Type Select the report type, as applicable.

Date Range Enables the user to select and specify the Date Range as the search 
criteria.

Start Date Enables the user to enter the start date for the search.

End Date Enables the user to enter the end date for the search.

Range Enables the user to select a Range as a search criteria.

Retrieve Enables the user to retrieve any stored search criteria.
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The following table describes the columns in the Total Number of Rows section.

PMDA Reports
You can view or print a submitted report from the Submitted Reports dialog box. 
Select Reports-->Compliance-->Submitted Reports to access the Submitted Reports. 

Expedited Reports
This section contains information about regulatory reports and includes discussions of 
the following:

Field Description

Originated Case# Displays the Originated Case Number of the case.

Initial/F-U/Nullification Displays the Initial/F-U/Nullification status.

Trading Partner Displays the name of the trading partner.

World Wide Unique# Displays the World Wide Unique # of the case.

Import Status Displays the import status of the case.

Warnings / Errors Displays warnings/errors associated, if any.

Accepted / Rejected By Displays who accepted or rejected the case.

Notes Displays the notes for the case, if any.

Interchange Date Displays the Case Number with which the case has been 
imported on the specified interchange date.

Date Imported/Rejected Displays the date the case was imported/rejected.

ICK/ACK Sent Displays the status of the ICK/ACK.

■ Yellow is displayed if it is still pending.

■ Orange is displayed if it is accepted by warnings / 
errors.

■ Red is displayed if Rejected by user or system.

■ Green denotes successful import in the system.

EDI Out Displays the EDI Out status.

■ Yellow is displayed if it is still pending to send the 
report out of the EDI / XML or PHY out folders.

■ Green is displayed if it is already sent out of the EDI / 
XML or PHY out folders.

■ Red denotes that the EDI gateway failed to send the 
report out of the EDI / XML or PHY out folders.
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■ General Usage Information

■ Scheduling Expedited Reports

■ Viewing Submitted Reports

■ Faxing or E-mailing Reports 

■ Viewing Blank Report Forms

General Usage Information
This section provides general usage information for expedited reports and includes 
discussions of the following:

■ Paper Reports

■ Report Generation Rules

■ Case Deletion

■ Changes to Cases

■ Manually Schedule Nullification Reports

■ Downgrading a Report

■ Draft Reports

Paper Reports  The system enables you to generate and submit 12 expedited paper 
reports: six (6) for marked drugs and six (6) for Investigational Drugs.

■ PMDA Forms for Marketed Drugs

– Drug AE/Infection Case Report  -- Form 1

– Drug AE/Infections Case  -- Form 2 (5 pages)

– Surveillance Report on Drug, Quasi, Drug, Cosmetic Case Report --  Form 3

– Surveillance Report on Drug, Quasi Drug, Cosmetic Case Report -- Form 4

– Surveillance Report on Measures Taken for Drug Outside Japan such as 
Product Termination, Recall, Rejection, etc. -- Form 5

– Surveillance Report on Measures Taken for Drug Outside Japan such as 
Product Termination, Recall, Rejection, etc. -- Form 6

■ PMDA Forms for Investigational Drugs

– Investigational Product A/E Infection Case Report -- Form 1

– Investigational Product AE/Infections Case  -- Form 2 (5 pages)

– Surveillance Report on Investigational Product Research Report --  Form 3

– Surveillance Report on Investigational Product Research Report -- Form 4

– Surveillance Report on Measures Taken for Investigational Product Outside 
Japan such as Product Termination, Recall, Rejection, etc. -- Form 5

– Surveillance Report on Measures Taken for Investigational Product Outside 
Japan such as Product Termination, Recall, Rejection, etc. -- Form 6

The following table shows the relationship between the reporting category and the 
paper form.
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■ The system displays the following PMDA form list in all the report listing sections 
of the application:

– Marketed Drug Case Report Form 1 and Form 2

– Marketed Drug Research Report form 3 and Form 4

– Marketed Drug Measures in Foreign Countries Report Form 5 and Form 6

– Investigational Drug Case Report Form 1 and Form 2

– Investigational Drug Research Report Form 3 and Form 4

– Investigation Drug Measures in Foreign Countries Report Form 5 and Form 6

■ Reports are grouped according to their characteristics. For example, market report 
1 and 2 will be generated together on the same PDF.

Category 
Identifier E2B Value Reporting Category Paper Report

A 1 Domestic/Infection Report 
(marketed drug)

Marketed: Form 1, 2 (5 pages)

B 2 Domestic/ADR Report (marketed 
drug)

Marketed: Form 1, 2 (5 pages)

C 3 Overseas/Infection Report 
(marketed drug)

Marketed: Form 1, 2 (5 pages)

D 4 Overseas/ADR Report (marketed 
drug)

Marketed: Form 1, 2 (5 pages)

E 5 Research/Infection Report 
(marketed drug)

Marketed: Form 3, 4

F 6 Research/ADR Report (marketed 
drug)

Marketed: Form 3, 4

G 7 Measures in foreign countries 
including discontinuing 
manufacture, recall, and 
withdrawn (marketed drug)

Marketed: Form 5, 6

H 8 Domestic Infection Report 
(investigational drug)

Investigational: Form 1, 2 (5 
pages)

I 9 Domestic/ADR Report 
(investigational drug)

Investigational: Form 1, 2 (5 
pages)

J 10 Overseas/Infection Report 
(investigational drug)

Investigational: Form 1, 2 (5 
pages)

K 11 Overseas/ADR Report 
(investigational drug)

Investigational: Form 1, 2 (5 
pages)

L 12 Research/Infection Report 
(investigational drug)

Investigational: Form 3, 4

M 13 Research/ADR Report 
(investigational

Investigational: Form 3, 4

N 14 Measures in foreign countries 
including discontinuation of the 
manufacture, recall, and 
withdrawn (investigational drug)

Investigational: Form 5,6

O 15 Research Report (Quasi Drug) Marketed: Form 3, 4

P 16 Research Report (Cosmetics) Marketed: Form 3, 4
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■ The names of Japanese forms display in both Japanese and English.

■ The report form list appears in the following locations in the application:

– Console J: Expedited Report Rules, Form Section

– Console J: Code List/Batch Report Generation Case Form Regulatory 
Reporting Tab, Draft

– Schedule New Expedited Report Dialog Box: Form Section

– Utility Blank Report Form UI

– E2B Viewer Report Form Listing UI

– Medical Review: Preview of Expedited Report

– Create Unscheduled Report

– View Submitted Report

– Worklist Report Filter

– Bulk Report by Form

Regulatory Reporting Rules Algorithm  The regulatory reporting rules and algorithm 
enable you to create and schedule reports based on the regulatory specifications.

Reporting Rules Configuration Fields
The reporting rules algorithm schedules reports for Japan based on the License 
caegory and Reporting category fields.

Japanese Aware Date
The reporting rules algorithm caulates the due date for Japanese reports based on the 
Japanese aware date as follows:

■ For a domestic case, the Japanese aware date is the same as the latest significant 
follow-up date or the Initial Receipt date (from the PMDA tab) whichever is latest.

■

■ In a foreign case, the Japanese aware date is the same as the Japanese significant 
follow-up date of the Japanese Receipt Date (from the PMDA tab) whichever is 
latest.

Multiple Reports for a Case
The reporting rules algorithm schedules multiple report for a cased based on PMDA 
requirements. PMDA requies submitting multiple reports for  multiple marketed and 
investigational licenses. The number of reports submitted is determined based on the 
following:

■ The system submits reports for valid (not withdrawn) marketing or investigational 
licenses in Japan only for the suspect company products in the case.

■ The system submits a separate report for each suspect company product with a 
license in Japan as defined in Argus Console in the "allow multiple reports for 
single case for Marketed and Investigation" parameter.

■ The system display a single row for each report on the Case Form 
Analysis-->PMDA-->General tab.
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■ If the "Allow multiple report for Maketed" parameter is set to No, auto scheduling 
schedules a report with a direct Japanese license. If there are multiple direct 
Japanese licenses, the system selects the licese with the earliest award date.

Report Generation Rules  Be aware of the following report generation rules.

■ You can manually schedule with any available report forms. When the system 
generates the report form, it checks the association between the reporting category 
and the report forms If the report forms don’t match the selected reporting 
category, the system presents the following message: "This case does not have a 
matching reporting category for the selected report forms."

■ The expedited reports retrieve report data from the E2B XML file. If the system 
encounters errors during this process it presents an error message.

Nullification Report Scenarios  The following scenarios describe how the nullification 
reports are scheduled.

■ Case Deletion

■ Changes to Cases

■ Manual Scheduling

Case Deletion
If you delete a case that has submitted rpeorts to the Japanese authority, the system 
prompts you to provide a justicfication for deleting the case and opens the Action 
Justification dialog box. the system requires you to enter data in eevery field in the 
dialog box. You can select the justification from the drop-down list or  enter the 
justification manually. However, if you choose to enter the justification manually, you 
must enter the justification in both Japanese and English.

Changes to Cases
The application automatically schedules a nullification report when you do any of the 
following to a case:

■ Delete a company product

■ Modify a company product in such a way that it is no longer a company product

■ Recode a company drug to another company drug

■ Make a change to patient exposure for a study drug

■ Change a drug so that it is no longer a suspect drug

Manual Scheduling
You manually schedule and E2B nullification report. This function is available only to 
Japanese users.

To manually schedule a nullification report
1. Select Report-->Compliance-->Submitted-->Search Case or select 

Report-->Unsubmit submitted E2B Report.

2. Click the Submitted icon to open the Unsubmit Report menu and click Unsubmit 
Report.

3. Select Nullification to open the Justification dialog box.

4. Enter the justification information and click OK.
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5. The system schedules the nullification report.

Downgrading a Report  The application permits you to downgrade a report if necessary. 
You must perform this action manually using the New Expedited Report dialog box.

To downgrade a report
1. In the New Expedited Report dialog box, select Downgrade Report from the 

Report Information drop-down list.

2. Enter the appropriate information in the fields and click OK.

3. When the system opens the Justification dialog box, enter the reason for 
downgrading the report and click OK.

Draft Report  The system enables you to print a draft version of a report as follows:

■ Click the Draft button on the Regulatory Reports tab.

■ Click the Draft icon on the Toolbar.

■ Print a draft version from the Medical Review tab.

Scheduling Expedited Reports
You can go to Case Form --> Regulatory Reports to manually schedule expedited 
reports from the Expedited Reports dialog box.

The following table lists and describes the fields in the Expedited Reports dialog box.

Field/Control Name Description

View Individual Click to view an individual report.

View Group Click to view a group of reports assigned to a specific group.

View All Click to view all reports.

Total Number of Rows The total number of rows in the list.

Displaying Rows The number of rows that display at the same time.

Page Size The number of rows that display on a single page.

Selected Click this checkbox to select a report.

Lock State Identifies the status of the report. Report status can be one of the 
following:

■ Scheduled

■ Overdue

■ Non-submit

■ Generated

■ Disapproved

■ Approved

■ Submitted

Case Number The unique value that identifies a specific case. If the report does not 
have a Japanese value, the system displays the English value 
followed by "no translation."

Country of Incidence The name of the country where the adverse event occurred.If there 
is not a Japanese value for this field, the system displays the English 
value followed by "no translation."
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Scheduled Expedited Reports
You can go to the ARgus Main Menu-->Reports-->Compliance-->Expedited to view 
scheduled reports. This provides access to the list of previously scheduled and 
generated, but not submitted, expedited reports. You can also schedule a new 
expedited report from this dialog. 

Report Type Identifies the type of report. This information is from the Case form.

Suspect Product The name of the product suspected to have caused the adverse 
event.

Diagnosis The diagnosis for the adverse event.

Event Verbatim Can be one of the following:

■ S-U-R

■ F/LT

■ 7/15

Report Form The name of the form used for the report.

Destination The name of the agency the report is being sent to.

Initial/Follow-up Indicates whether the report is the initial report (I) or a follow-up 
(F/U) report.

Due Date The date the report is due in YYYY/MM/DD format.

Days Past Due The number of days the report is past due. 

Downgrade

Batch Print or Create 
Report

Enables you to create a batch for printing or print a single report.

Print List Click this button to print a list of reports.

Field/Control Name Description
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Periodic Reports
This section provides information about Period Reports and includes discussions of 
the following:

■ PSR/ReSD Reports

■ Clinical Study Periodic Safety Reports

■ Scheduled Periodic Reports

■ Unscheduled Periodic Reports

PSR/ReSD Reports
The system enables you to define Periodic Safety Reports (PSR) for specific products. 
The purpose is to define a fixed set of PSR reports for a Primary Agency and associate 
products with the reports. Once defined, you can have the system schedule automatic 
delivery of these reports.

The system provides a configuration screen that enables you to define a PSR. Select 
Reports-->Periodic Reports-->PSR/ReSD to open the Periodic Safety Report window.

Select Reports-->Periodic Reports-->PSR/ReSD to open the Periodic Safety Report 
Library screen. From this screen, you can open the configuration window that enables 
you to define a PSR. You need to choose New to create a new configuration or Modify 
to modify an existing configuration.  The system provides a list of reports that includes 
the following information:

When viewing this page, be aware of the following:

■ This page shows a list of PSRs stored in the system. You can do the following:

– Click New Report to create a new report.

– Click Copy to make a copy of an existing report.

* When you copy an existing PSR, the system copies the entire report 
including the timeframe rows.

* The name of the copy has "Copy of" before the report name.

Field/Control Name Description

Category Identifies the category the report belongs to.

Subcategory Identifies the subcategory the report belongs to.

Report Name Indicates the name of the report.

Inclusion Start 
Date/Stop Date

Identifies the date range for the report.

Draft/Final Indicates whether this is a draft or final version of the report.

Author Created The name of the person who created the report.

Author Modified The name of the person who modified the report.

Date Created The date the report was created.

Date Modified The date the report was modified.

Justification The reason for creating or modifying the report.
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* When you copy the report, the system copies the past dates in the 
schedule frequency, JAD, IBD, and the assigned date as read-only text. You 
can modify other sections of the report 

* When you copy an unsubmitted PSR report, the system copies the entire 
report including the timeframe rows. Because the report was unsubmitted, 
the timeframe rows, JAD, IBD, and Assigned are editable or non-editable 
depending on their configuration in the original report.

– Click Modify to display the report definition.

– Click Delete to delete a report. The system presents the confirmation message. 
Click "Yes" to delete the report. 

– Click Print to print the report. The system presents a dialog box to enable you 
to select from several preview or direct export options.

■ The Delete function is available only if no final reports have been generated. 
Clicking Delete hides the report but does not delete it from the system.

■ In the Periodic Report section, a link is available for the last executed report only if 
the report is still available on the report server.

■ When you click New or Modify, the system opens the PSR Configuration window.

■ When the state of the report changes to "Submitted," the system disables the OK 
button to prevent you from updating the PSR configuration. 

■ When a report has a Submitted status, the system only prints the configuration 
page.

■ You can copy a report as long as the configuration for the report is available.

■ Before the system permits you to save a PSR configuration, you must enter a value 
in the Report Name, Primary Agency, Product Selection and time frame fields.

– If you fail to enter a Report Name, the system presents the following message: 
"Report Name is not entered. It is necessary to enter the above information in 
order to save the configuration."

– If you fail to enter the Primary Agency, the system presents the following 
message: "Primary Agency is not entered. It is necessary to enter the above 
information in order to save the configuration."

– If you fail to select a product, the system presents the following message: 
"Product is not selected. It is necessary to enter the above information in order 
to save the configuration."

– If you fail to enter at least one time frame, the system presents the following 
message: "Investigation time frame is not configured. It is necessary to enter 
the above information in order to save the configuration."

– If you fail to enter multiple parameters, the system presents the following 
error message: 

" <Parameter> is not entered.

Parameter> is not entered.

It is necessary to enter the above information in order to save the configuration."

■ If you click the Modify, Copy, Delete, or Print buttons without selecting a report, 
the system presents the following error message: "Please select a report." Click OK.
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PSR Main Window
Once you select a report, the system opens the PMDA Reports window. The window 
has the following tabs:

■ Subject of Report

■ Product Selection

■ Periodic Safety Report/ReSD

■ Scheduling

■ Security

Subject of Report tab  The Subject of Report tab enables you to define a periodic report. 
The following is an illustration of the Subject of Report tab.

The following tables lists and describes the fields on the Subject of Reports tab.

Field Name Description

Report Name Enter the name of the report. The name you enter in this field displays 
on the Reports-->PSR Reports dialog box.

Report Category Enter the report category name in this field. The name you enter here 
displays in the Reports-->PSR Reports dialog.

Report Subcategory Enter the report subcategory name in this field. The name you enter 
here displays in the Reports-->PSR Reports dialog.

Selection of 
Reporting 
Destination

This is a list of the Regulatory Authorities configured in List 
Maintenance. If there is no Japanese authority name configured, the 
system lists the English name.

You can select multiple agencies from the list to enable simultaneous 
submission to multiple agencies.
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Product Selection Tab
The Product Selection tab enables you to select the products to include in the report. 
The following is an illustration of the product selection tab.

The following table provides information about the fields on the Product Selection tab.

Primary Reporting 
Agency

Select the Primary Agency from the drop-down list.

If a message profile is not defined for the Primary Agency, the system 
presents the following message: "Selected Primary Agency doesn’t have 
configured Message Profile (I or J) in Argus Console/Reporting 
Destination/EDI. When you click OK, the Primary Agency reverts to 
the previous selection. 

Selected Reporting 
Destination

The list of Regulatory Authorities that receive the report.

Report Number Enter the unique value that identifies the report in this field.

Print all 
configuration criteria 
on separate cover 
page

When checked, the system prints the report configuration when it 
prints the report. The system prints the configuration page at the 
beginning of the PSR/ReSD report. Page numbering for the report does 
not include the configuration page.

Field Name Description

Ingredient When you select a product, the application displays a list of ingredients 
for the selected product.

You can filter the ingredients in the list of available ingredients by 
entering the Ingredient name and clicking Filter.

Field Name Description
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When a new product containing the same ingredient is released, you must set up the 
new configuration. Be aware of the following:

■ If a Japanese ingredient, indication, or formulation is not configured, the system 
displays the English name.

■ If you add or delete a product in the product selection field before the PSR/ReSD 
status is "Submitted," the system displays the following error message: "If the 
content of the selected product is changed, IBD, JAD, and Assigned date can 
possibly be changed. Do you want to proceed?"

■ If you add or delete the products in the Product Selection field before the first PSR 
report is submitted, the system updates the IDB Japan award date, and the 
Assigned Date based on the new product set.

■ If you copy an existing submitted PSR, and the JAD, IBD, and assigned dates are 
read-only, the subject dates do not change and the system displays the following 
error message: "Because the configuration has the record of past investigation 
period, JAD, IBD, and Assigned Date for scheduling configuration will not be 
changed by modifying the Selected Products. It is necessary to use the "Reset" 
button and re-configure the investigation period if new PSR needs to be created 
based on modified product selection."

■ All forms printed as PSR and ReSD contain only the information about the 
selected product.

Periodic Safety Report/ReSD Tab
This tab enables you to select and configure either a PSR or an ReSD. The tab contains 
two radio buttons that enable you to select the type of report you wish to configure. 
Click Periodic Report to configure a PSR or click ReSD to configure an ReSD report. 
The following is an illustration of the tab.

Selected Ingredients The list of selected ingredients for the PSR product family.

Indication A list of indications configured for the product containing the selected 
ingredient. 

To select multiple indications, hold CTRL and click each ingredient you 
want to include.

If a Japanese name is not available for the indication, the system 
displays the English name. 

Formulation A list of formulations configured for the product using the selected 
ingredient.

To select multiple formulations, hold CTRL and click each ingredient 
you want to include.

If a Japanese name is not available for the formulation, the system 
displays the English name. 

Available Products The system displays a list of products containing the selected 
ingredient. If a Japanese name is not available, the system displays an 
English name.

Selected Products A list of products you selected from the Available Products list. When a 
product is selected, the field has a blue background.

Field Name Description
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The following table lists and describes the fields on the tab.

Report Section Field Name Field Description

PMDA

Forms Configuration

Periodic Safety Report Enables you to choose 
whether to create a PSR or 
and ReSD report.

Re-examination Submission 
Dossier

Enables you to choose to 
create a PSR or and ReSD 
report.

Data Counting Configuration

Count Configuration
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Exclude events which don’t 
meet the condition from the 
past data

Enables you to eliminate 
events from the report. 
Reasons for not including an 
event in a report include the 
following:

■ Event was deleted

■ Event was downgraded

■ The report was nullified

■ When this occurs, the 
system presents the 
following message: "One 
of the cases in the nth 
report nullified during 
this investigation time 
frame."

■ The default for this field 
is unchecked.

Exclude events which were 
reported on the Paper Report 
Form

■ Enables you to exclude 
events reports on the 
paper form during the 
investigation phase from 
the report.

■ The default for this field 
is unchecked.

Exclude Incompletion report 
from output.

■ Enables you to exclude 
events reported on the 
incompletion report from 
the report.

■ The default is unchecked.

PSR Report Form 3

Form 3 Selection ■ Check this checkbox to 
print the PSR Form

■ The default is checked.

Print Only the Term ■ Enables you to select 
whether PT or LLT will be 
printed on Form 3.

■ Click Preferred Term to 
print the PT (preferred 
term) on the form.

■ Click Lower Level to 
print LLT (lower level 
term) on the form.

Classify based on SOC ■ Check this checkbox to 
group the PSR Form 3 
PT/LLT section by SOC. 

■ The default is checked.

Print the report content as 
Case Listing in a separated 
report. 

■ Check this checkbox to 
print a separate version of 
the report.

■ The default is unchecked.

Report Section Field Name Field Description
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PSR Report FORM 4

Form 4 Select ■ Check this checkbox to 
print the PSR Form 4.

■ The default is checked.

Print only the term ■ Enable you to choose 
which term (PT or LLT) to 
print on the report. 

■ PT is the default.

Order SOC Alphabetically ■ Click this checkbox to 
print the SOC in 
alphabetical order.

■ If this is unchecked, the 
system prints the report 
in the MedDRA order.

■ The default is unchecked 
(MedDRA Order).

Non-Serious Unlisted PSR 
Report

Paper Report Click Paper Report to generate 
the paper report format. This 
is the default.

FD Report Click FD Report to generate 
the report in CSV report 
format.

PSR Report Form 7-1

Form 7-1 ■ Click this checkbox to 
print PSR Form 7-1.

■ This is the default.

Print a Blank Form ■ Click this checkbox to 
print a blank form.

■ The default is unchecked.

PSR Report Form 7-2

Form 7-2 Selection ■ Click this checkbox if you 
want to print PSR Form 
7-2

■ The default is unchecked.

Print a separate Case Listing 
report.

■ Click this check box to 
print a separate Case 
Listing report.

■ The default is unchecked.

Separate Page Numbering ■ Click this checkbox to 
start each form with page 
1.

■ Checked is the default.

ReSD Report Form 4

Form 4 ■ Click this checkbox to 
print an ReSD Form 4.

■ The default is checked.

Report Section Field Name Field Description
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Print Only the Term ■ Click Preferred Term to 
print PT on ReSD Form 4.

■ Click Lower Level to 
print LLT on ReSD Form 
4.

■ PT (Preferred Term) is the 
default.

Classify based on SOC ■ Click this checkbox to 
group the PT?LLT section 
on PSR Form 3 by SOC.

■ This is the default.

Print a separate Case Listing 
Report.

■ Click this checkbox to 
print a separate Case 
Listing report.

■ The default is unchecked.

ReSD Report Form 5

Form 5 ■ Click this checkbox to 
print ReSD Form 5.

■ The default is checked.

Print Only the Term Enables you to select which 
term (PT or LLT) to print on 
the form.

■ Click Preferred to print 
PT on the report.

■ Click Lower Level to 
print LT on the report.

■ The default is PT.

Order SOC Alphabetically ■ Click this checkbox to 
print the SOC in 
alphabetical order.

■ If left unchecked, SOC is 
printed in MedDRA 
order.

■ The default is unchecked.

ReSD Report Form 7

Form 7 ■ Click this checkbox to 
print ReSD Form 7.

■ The default is checked.

ReSD Form 8

Form 8 ■ Click this checkbox to 
print ReSD Form 8.

■ The default is checked.

ReSD Form 9

Form 9 ■ Click this checkbox to 
print ReSD Form 9.

■ The default is checked.

Report Tabulations

Report Section Field Name Field Description
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Scheduling Tab
This tab enables you to configure report scheduling. The following is an illustration of 
the Scheduling tab.

Tabulations ■ Click this checkbox to 
include all tabulations in 
the section in the printed 
report.

■ The default is checked.

Tabulation for Unlisted Events ■ Click this checkbox to 
include the tabulation for 
unlisted events in the 
report. 

■ Check ed is the default.

Tabulation for Listed Events ■ Click this checkbox to 
include the tabulation for 
listed events in the report. 

■ Check ed is the default.

Case Overview Tabulations ■ Click this checkbox to 
include case overview 
tabulations in the report. 

■ Check ed is the default.

Overdose Tabulation ■ Click this checkbox to 
include the overdose 
calculation in the report. 

■ Check ed is the default.

Accident Exposure Tabulation ■ Click this checkbox to 
include the accident 
exposure tabulation in the 
report. 

■ Check ed is the default.

Report Section Field Name Field Description
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The following table lists and describes the fields on the scheduling tab.

Field/Control Name Description

Assigned Date The system automatically populates this field. with the report date 
based on the values in either the International Birth Date field or the 
Japan Award date field.

■ When the first report is still unsubmitted, you can manually 
change the assigned date and the system automatically repopulates 
the date in the Frequency of Schedule field based on the assigned 
date.

■ If you try to change the assigned date after the report has been 
submitted, the system presents the following message: "The 
assigned date is different from the dates in the IBD and JAD. Do 
you want to change the date?" Click OK to modify the date. Click 
Cancel to replace the new date with the original date in the field.

■ When you create a copy of an existing report and click Reset to 
remove all previous periods, you can modify the Assigned Date. 
The system puts the new date in the Frequency of Schedule field. 

■ If the modified assigned date is earlier than the IBD, the system 
displays the following message: "Assigned date cannot be earlier 
than the IBD" and resets the date to the original value.

■ If either the JAD or IBD is unavailable, the system does not 
populate the Assigned Date and Start Date fields. You must 
manually enter the Assigned Date.

■ You can edit the Assigned Date field if the report has not been 
submitted and does not have any read-only time frames. Once the 
report has been submitted, you cannot edit the Assigned Date.
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International Birth 
Date (IBD)

This is the date the product was first licensed.

■ When you select an ingredient and a product, the system 
automatically populates this field based on the earliest product 
license date.

■ If you modify this date and the new date is later than the JAD, the 
system displays the following message: "IBD cannot be later than 
JAD."

■ If you change the IBD, the system displays the following message: 
"If you change the IBD, the Assigned date will be changed. Do you 
want to proceed?" If you click "Yes," the new date remains in the 
field. If you click "Cancel" the system replaces the new value with 
the old date.

■ You can modify the IBD if the report has not been submitted and 
does have any previous, non-editable timeframes.

■ Once you submit the report, you can no longer modify the IBD 
field.

Japan Award Date 
(JAD)

The date the product was licensed in Japan.

■ When you select an ingredient and a product, the system 
automatically populates this field. 

■ If you select multiple products, the system populates this field with 
the earliest award date.

■ If you change this date and it is earlier than the IBD, the system 
presents the following message: "JAD cannot be earlier than IAD."

■ If you modify the JAD, the system presents the following message: 
"If you change the JAD, the Assigned date will also be changed. Do 
you want to proceed? If you click OK the new value remains in the 
field. If you click Cancel, the system replaces the date you entered 
with the old date.

■ If the JAD is not configured for one or more products, the system 
leaves the field blank so you can enter the JAD manually.

■ You can edit the JAD if the report has not been submitted and does 
not have any previous non-editable timeframes. Once you submit 
the report, you can no longer edit this field.

Report is due xx after 
the selected end date

This field enables you to set the PSR due date a specific number of days 
after the end date for the scheduling period. The system adds the value 
you enter in this field to the current end date and identifies it in the 
printed report as the report due date.

Group This field enables you to specify which Argus group is responsible for 
the Periodic report after the application schedules it. This information 
appears on the group’s Report worklist.

Field/Control Name Description
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Configuring Delivery Quantity
The Scheduling tab includes a Delivery Quantity section to enable you to specify the 
number of reports to print. 

The following table lists and describes the fields in the Delivery Quantity section on 
the Scheduling tab.

Start Date The date the reporting timeframe began. You can enter the start date for 
each report timeframe starting period.

■ The first report timeframe start date is the same as the Assigned 
Date.

■ Start date is a read-only field.

■ If you need to enter additional rows for start/end date, you must 
enter them one at a time.

■ The system auto populates the Start Date and resets it to the 
Assigned Date value only if the first start and end dates are 
modifiable.

■ If the system auto populates the start date and the end date is 
already specified, the system displays the following message: "The 
Start Date for the reporting period has changed. Please update the 
Ed Date accordingly."

■ If you enter a start date that is older than the latest end date, the 
system presents the following message: "The start date must be the 
same or later than the end date." When you click OK, the system 
removes the incorrect start date.

End Date The day the reporting timeframe ended. You can enter the end date for 
each report timeframe.If you enter an End date that is earlier than the 
start date, the system presents the following message: "End date must 
be after the Start date." When you click OK, the system removes the 
incorrect end date.

Reset Click Reset to delete all the existing timeframe rows (editable and 
non-editable). Clicking "Reset" also enables you to enter values in the 
Assigned Date, JAD, and IBD fields. 

The system presents the following message: "Clicking Reset removes all 
previous data. Do you want to proceed?" Click OK to continue with the 
reset. If you click Cancel, the system leaves the past data in the table.

Add Click Add to add a timeframe row.

■ A new report (unsubmitted, uncopied) does not have a timeframe 
row. You must click Add to add one.

■ When you generate a report, the system generates it based on the 
last timeframe row.

■ Once you submit a report, you can no longer edit the timeframe 
rows.

Delete Click Delete to delete an editable timeframe row. The system does not 
permit you to delete a timeframe row that cannot be edited. When you 
click Delete, the system presents the following message:" Do you want 
to delete the highlighted row?"

Field/Control Name Description
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Security Tab
The Security tab enables you to share a report with other users. The following is an 
illustration of the Security tab. 

The following tables lists and describes the fields on this tab.

Field Name Description

Clear All ■ When you click this button, the system 
clears the delivery quantity and delivery 
unit information from all fields 

■ The system presents the following 
message: "If you continue, the entered 
information will be erased. do you want to 
continue?" Click OK to delete the 
information. 

Products ■ The system displays the product names in 
the PSR by default.

■ You can change the names only the first 
time the report is generated. Otherwise the 
names are read-only.

■ You can enter a maximum of 70 characters 
in this field.

Delivery quantity during this period ■ Enter the number of reports to print.

■ You can enter up to 12 characters 
(including the decimal point and the 
numbers) in this field.
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Printing a PSR/ReSD
The system enables you to print batches of reports. You define the batch print 
parameters in the Report Batch Printing dialog box . The following table lists and 
describes the fields in the Report Batch Printing dialog box.

To print a report
1. Select Reports-->Compliance-->Periodic Reports-->View Report.

2. Check out the report from the "View and edit PSR/ReSD popup.

3. Edit the document as necessary and check it in.

4. Publish the resulting PDF file.

Printing Requirements  Be aware of the following printing information

■ You can print the report and use Word to update the resulting document.

■ You can change the configuration for the investigational timeframe multiple times 
before you submit the report. However, once you submit the report, you cannot 
change the configuration. 

■ You can view the report by selecting Reports-->Compliance-->Periodic 
Reports-->View Report.

The following table lists and describes the fields on the Periodic Report list.

Field Name Description

Share this report 
with others?

When clicked, the system shares the reports with selected users and/or 
user groups.

User Groups Contains a list of users you can share the report with.

Selected User 
Groups

Contains a list of users you selected to share the report with.

Modify & Execute Enables you to modify the members of the groups.

Field Name Description

Run at Enables you to specify the date and time to run the report. Date and time 
entry must be in the following format: YYYY/MM/DD 00:0.

If you fail to enter a date in this field, the system presents the following 
message: "Please enter a run date." Click OK and enter a run date in the 
field.

Print As Enables you to specify how you want the report to print. Available 
options are Final, Draft, Internal, or Other. If you specify Other, you must 
enter a value in the associated text field.

Due Date Automatically populates the this field based on the due days entered on 
the scheduling tab.

Field Name Description

View All Enables you to view a list of all periodic reports.

Total Number of 
Rows

Indicates the total number of rows the system displays in the window.

Page Size Enables you to select the number of rows to display on each page of the 
list.
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■ Report output is in a Word document to enable you to edit the report before 
generating a final version. You must check the Word documents in and out. 

– When you generate a report, the system displays the Check Out button to 
enable you to revise the document. The "Publish" button is disabled.

– Only one user at a time can check a document in or out.

– When you check out a document, the button label changes to "Check In." Click 
this button to check a file in.

– You can check a document in and out multiple times. However, more than one 
user cannot check out the same document simultaneously.

– You can check out and check in unpublished documents. Once a document is 
published, you can no longer check it out.

– The system enables the Publish button the first time a document is checked in.

– When you check in a document, the system opens a dialog box to enable you 
to specify a file name.

– The system disables the publish button when a document is checked out.

– Once a document is published, it cannot be checked out.

– When you Publish a document, the system converts the document to PDF 
format and the Word version of the document is no longer available to you.

Trade Name The trade name for the drug. If a Japanese name is available, it displays 
here. If a Japanese name is not available, the system displays the drug’s 
English trade name.

Destination Displays the destination for the report. If Japanese data is available, the 
system displays it. If it is not available, the system displays English 
data.

If a destination is not available, the system displays the following: "No 
specific receiver."

Due Date The date the report is due. The system displays this information in 
YYYY/MM/DD format.

Status Identifies the status of the report. Status can be one of the following:

■ Deleted

■ Scheduled

■ Generated

■ Approved

■ Not Approved

■ Submitted

■ New Data Available

■ No Longer Required

Field Name Description
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Deleting a PSR/ReSD
The system enables you to delete a PSR/ReSD. When you select a report and click 
Delete, the system presents the following message: "Are you sure you want to remove 
this report configuration?" Click "Yes" to continue with the delete operation; otherwise, 
click No.

Scheduling Periodic Reports
The system enables you to schedule Periodic Reports from the Periodic Reports 
window. Select Reports-->Regulatory Reports--> Periodic Reports to open the window.  

The following table lists and describes the fields on the Periodic Reports window.

Note: If the generated report has a row spanning the whole height of 
the page and there seems to be data missing in that row, the user 
needs to select the table, do a right click, select Table Properties and in 
the Rows tab in the properties dialog, check the checkbox for “Allow 
row to break across pages”. This will allow the row to span across 
multiple pages and the truncated data will be shown on the next 
page.” 

Field/Control Name Description

View All Click this checkbox to view a list of all 
periodic reports

Total Number of Rows: 150 The maximum number of rows that display in 
the window.

Displaying Rows Identifies the rows currently being displayed.

Page Size Indicates the number of rows that display on 
each page.

Trade Name The name of the drug. If there is not a 
Japanese name for the drug, the system 
displays the name in English followed by "no 
translation."

Destination The name of the agency receiving the report.

Description The generic name of the drug.

Due Date The date the report is due in YYYY/MM/DD 
format.
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Creating Unscheduled Periodic Reports
The system enables you to create the following kinds of unscheduled periodic reports:

■ ICH PSUR

■ IND

■ NDA

■ CTPR

■ PSR/ReSD

■ Clinical Study PSR (CSPSR)

To create an unscheduled periodic report
1. Select Reports-->Compliance-->Periodic to review the list of scheduled periodic 

reports.

2. Click Create Unscheduled Report.

3. When the system opens the dialog box, select the type of report to create.

4. Enter the appropriate information in the dialog box and click OK.

5. When the system opens the scheduling dialog box, enter the appropriate 
information and click OK.

Clinical Study Periodic Safety Reports (CSPSR)
You can configure and generate Clinical Study Periodic Safety Reports for various 
products. Once you define a fixed set of CSPSR for a Primary agency, you can associate 
products in the reports and schedule the CSPSR so the system generates them 
automatically. 

Configuring CSPSR Reports  You can define a CSPSR by selecting Reports-->Periodic 
Reports-->Clinical Study Periodic Safety Report. The system opens the window that 
displays a list of all CSPS Reports stored in the system.

Status The status of a report. This can be one of the 
following:

■ Scheduled

■ Overdue (scheduled)

■ Non-submit

■ Generated

■ Overdue (generated)

■ Disapproved

■ Overdue (disapproved)

■ Non-submit (disapproved)

■ Approved

■ Non-submit (approved)

■ Submitted

Create Unscheduled Report Click to create an unscheduled periodic report.

Print List Click to print the report list.

Field/Control Name Description



PMDA Reports

Argus Reports 10-145

When you configure a CSPSR, you must, at a minimum, provide the following 
information:

■ Report Name

■ Primary Agency

■ Time frame

The following table lists and describes the fields and controls in the Clinical Study 
Periodic Safety Report window.

Field/Control Name Description

Category Identifies the report category.

Sub Category Identifies the sub category the report is associated with.

Report Name The name of the report.

Inclusion Start Date/Stop Date The date range for the report. The date is in the following 
format:

YYYY/MM/DD -- YYYY/MM/DD.

Draft/Final Indicates whether the report is in a draft or final state.

Author Created The name of the person who created the report.

Author Modified The name of the person who modified the report.

Date Created The date the report was created in the following format: 
YYYY/MM/DD.

Date Modified The date the report was modified in the following format: 
YYYY/MM/DD

Justification The reason for creating/modifying the report.

Search Enables you to search for a report.

Clear When clicked, clears all data from the fields on the screen.

Total Number of Rows The total number of rows of report information.

Page Size The number of rows of data that display on each page.

New Report Click this button to create a new CSPSR. The system opens 
the CSPSR Configuration window.

Copy Click this button to copy a selected CSPSR.

When you copy a CSPSR, the system copies all report 
configuration information, including timeframe rows.

The name of the copied report is Copy of <Report Name>.

If you copy a submitted report, the following information is 
read-only

■ Past Schedule Frequency Dates

■ Clinical Study Plan Submit Date

■ Clinical Trial for Partial Change Submit Date

■ Assigned Date

If you copy an unsubmitted CSPSR, the system copies all the 
configuration information, including timeframe rows. 
Depending on how they were configured in the original 
report, the configuration information may be editable. 
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Submit Status  When you submit a report, the system changes the status of the report to 
"Submitted." Once the status has been changed, you cannot modify the CSPSR 
configuration. If you try to modify a submitted report, the system presents the 
following error message: "This configuration is not modifiable because the status of 
this Clinical Study Periodic Report is Submitted. If you wish to modify a submitted 
report, you must unsubmit it.

Entering CSPSR Parameters  You define a Clinical Study Periodic Safety report by 
entering report information on the following tabs:

■ Subject of Report

■ Product Selection

■ CSPSR

■ Scheduling

■ Security

Subject of Report Tab  The system permits you to enter information about the report and 
its recipients on this tab.  

Modify Click this button to modify a selected CSPSR. The system 
displays the report definition.

When you open a report that is currently in use, the system 
presents the following message: "The report which is 
selected is being used by <User Name> and cannot be 
modified."

Delete Click this button to delete a selected CSPSR. The system 
presents a confirmation dialog box to enable you to confirm 
or cancel the delete operation.

The delete option is available only if no Final Reports have 
been generated.

The delete operation removes the report from the list, but 
does not delete it in the database.

Print Click this button to print a selected CSPSR.

Field/Control Name Description
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The following table lists and describes the tab fields/controls.

Product Selection Tab  This tab enables you to select ingredients, indications, and 
product formulations to include on the CSPSR. The following is an illustration of the 
Product Selection tab.

Field/Control Name Description

Report Name Enter the name of the report in this field. 

Report Category Enter the Report Category name in this field.

Report Subcategory Enter the name of the Report Subcategory in 
this field.

Agency Select the name of the agency that is to receive 
the report from the list.If there is no Japanese 
authority, the system lists the English name.

Select the agency from the list and click >> to 
move it to the Selected Agencies list on the 
right.

Multiple Agencies If you need to submit the report to more than 
one agency, select them from the drop-down 
list.

Report Number Enter the report number in the field.

Print all configuration criteria on separate 
cover page.

Click the checkbox to print the report 
configuration at the beginning of the CSPSR. 

Allow access to report cases through Hit List Click this checkbox to place a final report on a 
Hit List. This enables you to retrieve the report 
from other areas of the application using 
advanced conditions functions.
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The following tables lists and describes the fields/controls on the Production Selection 
tab.

Be aware of the following:

■ The system displays English names if Japanese ingredients, indications, or 
formulations are not configured in the Console.

■ If you move a product without a compound number to the Selected Products field, 
the system displays the following error message: "Selected product does not have 
a clinical compound number. The study product license must have at least one 
clinical compound number in order to include it in the report."

■ If you move a product without a matching study to the Selected Products field, the 
system displays the following message: "Studies that have the selected product’s 
clinical compound number doesn’t exist. Do you want to include the product in 

Field/Control Description

Available Ingredients Select a list of ingredients to include in the report. Click >> to move 
the selected ingredients from the Available Ingredients list to the 
Selected Ingredients list.

Indication Select the appropriate indications from the list.

Formulation Select the appropriate formulations from the list.

Available Products The system populates this field with a list with all products that 
contain the selected ingredients. Select one or more products from 
this list and click >> to move them to the Selected Products list on the 
right.

Selected Products This field contains a list of products selected from the Available 
Products list on the left.
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the report." If the user selects "Yes," the system places the product in the Selected 
Products field.

Clinical Study Periodic Safety Report Tab  This tab enables you to configure the CSPSR. The 
following is an illustration of the tab.

The following table lists and describes the fields on the tab.

Field/Control Name Description

Report Form -- Clinical Study Serious AE Case 
Periodic Report

Click this checkbox to configure a report with 
this name.

Print Blank Form Click this checkbox to print a blank report 
form.

Report Form -- Serious AE Case Occurrence 
Status Listing

Click this checkbox to print a report with this 
title.

Number of Subject: Domestic Study __ 
Foreign Study

Enter the total number of subjects for the 
entire clinical study, domestic and foreign. You 
can enter a maximum of seven (7) digits in 
each field.

Order SOC Alphabetically Click this checkbox to print the SOC in 
alphabetical order based on their English 
names. If you leave this box unchecked, the 
system prints the SOC in MedDra browser 
order.

Include Foreign AE marked as "Not include 
for the report in Japan"

Click this checkbox to include AEs in foreign 
cases with flags for "Not include for the report 
in Japan."

Separate Page Numbering Check this checkbox to start page numbering 
at 1 for each CSPSR Line Listing.
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Scheduling Tab  This tab enables you to schedule reports. The following is an illustration 
of the Scheduling tab.

The following table lists and describes the fields on the scheduling tab.

Print the content of the report as case listing 
on separate page.

Click this checkbox to print the case listing on 
a separate page.

Field/Control Name Description

Assigned Date The system automatically populates this field.

Clinical Study Plan Submit Date (CSPSD) Enter the date the Clinical Study Plan was 
submitted.

If the date you enter in this field is greater 
than the date for the Clinical Trial for Partial 
Change Plan Submit Date, the system presents 
the following error message: CSPSD cannot be 
after CTPCSD.

If you change the Clinical Study Plan Submit 
Date, the system presents the following 
message: "If CSPSD is changes, assigned date 
will be changed. Do you want to proceed." If 
you click OK, the new value remains in the 
field.

You can edit this field only if the a CSPSR is 
unsubmitted. Once submitted the field is 
read-only.

Field/Control Name Description
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Security Tab  The security tab enables you to share a report with other users. The 
following is an illustration of the Security tab.

Clinical Trial for Partial Change Plan Submit 
Date (CTPCSD)

If you change this date to a date earlier than 
the CSPSD, the system presents the following 
error message: "CTPCSD cannot be earlier 
than CSPSD."

If you change this date the system presents the 
following message: "If CTPCSD is changed, 
the assigned date will be changed. Do you 
want to proceed?" If you click "OK," the new 
value remains in the field.

You can edit this field only if the CSPSR has 
not been submitted and does not have 
previous non-editable timeframes.

Report is Due xx Days after Selected End Date Enter the due date of the CSPSR to be xx 
number of days after the end date specified for 
the scheduling period.

Group Select the name of the Argus group to be 
responsible for the Periodic report.

Start Date The date the CSPSR reporting period begins.

If you enter a date that is earlier than the most 
current end date, the system presents the 
following message: "Start date must be the 
same day or after the latest end date."

When the system auto-updates the start date, 
it presents the following message: "Start date 
for the reporting period has changed. Please 
update the End date accordingly."

End Date Enter the date the reporting period ends.

If you enter an end date that is earlier than the 
start date, the system presents the following 
message: "End date must be after the start 
date.

Reset Click Reset to delete all existing timeframe 
editable and non-editable time frame rows.

When you click Reset, the system presents the 
following message: "By using Reset, all past 
data will be removed. Do you want to 
proceed? If you click "OK’ the system proceeds 
with the reset. 

Add Click Add to add a single editable row.

Delete Click Delete to delete an editable row. You 
cannot use this button to delete a non-editable 
row.

Field/Control Name Description
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The following table lists and describes the fields on the Security tab.

Printing a CSPSR   After you configure the CSPSR, click OK to print the report. The 
system opens the following dialog box. 

The following table lists and describes the fields on the Report Batch Printing dialog 
box.

When printing a report, be aware of the following:

■ You can print a report and update the Report output in a Word document.

Field/Control Name Description

Share this report with other users Click this checkbox if you want to share the report with 
other users.

User Groups Select the user groups you want to sent the report to and 
click Add to move the selected users to the Selected Users 
field.

Field/Control Name Description

Run at Enter the date and time to run the report in the following format: 
YYYY/MM/DD 00:00

Run Now Click this button to run the print now.

Print As Click the appropriate button to print a Final report, a Draft report, an 
Internal report, or Other report.

Due Date The system populates this field with report due date.
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■ When you select Draft, Internal, or Other, the system prints a watermark on the 
report. 

Viewing Periodic Reports  You can view a report by selecting 
Reports-->Compliance-->Periodic Reports-->View Reports. The system put the report 
in an uploadable Word document.

If an English user has permission to access the CSPSR, the user can perform 
check-in/check-out, publish, and upload operations. The application UI displays in 
English. The following table lists and describes the fields on the Periodic Report List 
screen.

When viewing Periodic Reports, be aware of the following:

■ The system outputs the report in a Word document. This enables you to edit the 
document outside the system and publish a final Word document.

■ You must check out a report in order to revise it.

■ The system enables the Publish button after a document has been revised and 
checked in.

■ After the final Word document is created, the system saves the document in the 
repository. 

Field/Control Name Description

View All Click to view all reports.

Total Number of Rows Indicates the total number of rows to display on the page.

Displaying Rows Lists the number of rows that display on the page.

Page Size The number of rows that display on each page.

Trade Name Displays trade names for a list of selected products. 

If the selected product does not have a Japanese trade name, 
the system displays the English trade name.

Destination Display the destination for the report.

Description Displays a description of the report

Due Date Displays the due date for the report.

Status Displays the status of the report. This can be one of the 
following: 

■ Scheduled

■ Generated

■ Approved

■ Disapproved

■ Submitted

■ New Data Available

■ No Longer Required

Create Unscheduled Report Enables you to create an unscheduled report.

Print List Click this button to print the Periodic Report List.

View Report Click this button to view the Periodic Report List.

Report Details Click to display detailed information about a selected report.
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■ When you click Publish a document, the system creates a PDF file.

You can view a report, check in a report, check out a report, or publish a report from 
the View and Edit  CSPSR dialog box.

■ Click View to see a report.

■ Click Publish to publish the report.

■ Click Check-Out to check out a report. 

■ Click Check-In to check in a report.

The following table lists and describes the fields/controls in the dialog box.

Checking a Report In or Out  When you click Check In, the system presents the CSPSR 
Check In dialog box.

To check in or check out a report
1. Click Check in on the View and Edit PSR/ReSD dialog box.

2. When the system opens the Check In/Check Out dialog box, Enter the name of the 
file to check in/check out in the File name field.

3. Click OK.

Deleting a CSPSR  When you delete a CSPSR, the system opens the confirmation dialog 
box. Click Yes to continue with the Delete operation.

Field/Control Name Description

View Click View to look at a Periodic Report.

Check In/Check Out Click Check In to check in a checked out file. Once the document is 
checked in, the button label changes to Check Out.

Publish Click Publish to convert the checked in document to a PDF.
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11Dashboards

This chapter describes the dashboards in the Argus Safety application.

Dashboards Options
Dashboards option is available on the menu bar. Place the cursor over Dashboards in 
the menu bar to view the options available in it.

The following is list of available dashboard options.

■ Open Case Summary Reports

■ Open Action Items Reports

■ Quick Signal Reports

■ Increased Frequency Reports

■ Expedited Report Status

■ Workflow Status

■ Reports Due Soon

■ Personal Argus Status

■ Case Workload

Open Case Summary Reports
The Open Case Summary Report displays a summary of all open cases sorted in 
ascending order according to the number of days the case has been open.
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To view the Open Case Summary Report
1. Select Dashboards --> Open Case Summary.

2. The system displays the Open Case Summary Report in PDF format.

When using the Open Case Summary Report, be aware of the following:

■ The Date Received column prints the initial receipt date or the latest follow-up 
date for the case.

■ If there are no follow-ups for a case, the system calculates open cases based on the 
initial receipt date.

■ If there are follow-ups for a case, the system calculates the days open based on the 
most recent follow-up in the case. If the latest follow-up date is older than the 
previous follow-up, it considers only the last follow-up.

■ The system also calculates days open based on the latest follow-up date for the 
case.

The following table lists and describes each field in the Open Case Summary Report

Field Description

As of (date) Displays the report as per the current date (in dd-mmm-yyyy format).

Case ID Displays the Case ID of each listed case.

Date Received Displays the date when the case was received.

Product Displays the Product Name.

Event Displays the Event Info/Preferred Term.

Assigned To Displays the Workflow/Case Owner.

Days Open Displays the number of days since the initial receipt date.

Status Displays the Case Status.

Total Cases Displayed at the end of the report, it shows the total number of cases 
listed in this Open Case Summary Report.
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Open Action Items Reports
The Open Action Items Report displays all outstanding action items. This report is 
sorted as per the Case ID of the listed cases.

To view the Open Action Items Report
1. Select Dashboards --> Open Action Items.

2. The system displays the Open Action Items Report in PDF format as shown in the 
following illustration.

The following tables lists and describes the fields in the Open Action Items Report.

Quick Signal Report
The Quick Signal Report displays the changes in numbers of events over the past 
year. This report is a summary listing of events, which have triggered signals.

Field Description

As of (date) Displays the report as per the current date (in dd-mmm-yyyy format)

Case ID Displays the Case ID of each listed case.

Action Item Lists the status of the case and the action that needs to be taken.

Date Assigned Displays the date when the case was opened/assigned.

Assigned To Displays the Workflow/Case Owner.

Date Due Displays the date when the action item was due.

Days Open Displays the number of days that have lapsed since the date when the 
case was opened.
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Click the following link for information about the information in the fields on the 
report.

Quick Signal Report Fields
The following table lists and describes the fields in the Quick Signal Report.

To enter information in the Product Browser
1. Select Quick Signal Report from Dashboards.

2. This displays the Product Browser dialog.

To search through the Product Browser dialog
1. Click the entities being displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For 
example, if Product Name is searched, it displays the Product Name as well as the 
Family Name and Trade Name.

2.  Search for Products based on the following criteria:

Field Description

Product Displays the Product Name.

As of Displays the report as per the current date (in dd-mmm-yyyy format).

Term Displays the Event Information in alphabetical order Body system and 
sort them within the body system in descending order.

Last 6 Months 
(Selected Drug)

Displays the number of cases received in the past 6 months for the 
selected drug.

All Cases (Selected 
Drug)

Displays the total number of cases recorded for the selected drug.

Last 6 Months (All 
Products)

Displays the number of cases received in the past 6 months for all the 
drugs.

All Cases (All 
Products)

Displays the total number of cases for all the drugs.
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■ Ingredient - Displays the ingredients of the product

■ Family - Displays the family of the product

■ Product Name - Displays the Formulation (Dosage Form), Concentration 
(Strength) and Indication to aid in the selection of the correct product.

■ Trade Name - Searches the License Trade Name, Country fields.

3. When the system displays the results, select the appropriate Product.

4. Click Select to view the Quick Signal Report that matches the entered criteria.

Memorized Reports
The system enables you to recall a previously memorized case listing or case data 
analysis report for printing. In addition to the reports for a specific user, the system 
displays a list of reports whare are shared by all users.

You can select a memorized report from the dialog box. When you select the report, 
the system enables the Open button to permit you to open the selected memorized 
report. Click Cancel to close the dialog box. Click Delete to delte the selected 
ememorized report.

To memorize a configured report, click the Memorize button on the configuration 
dialog box for the Case Listing or Case Data Analysis report.The system opens the 
Memorized Report .

The system enables you to save the memorized report, make it available for , and 
Share the report with other users.

Increased Frequency Reports
The Increased Frequency Report displays events that have occurred at increased 
frequency for a given product and indication, based on a FDA formula (modified 
t-test).

To generate an Increased Frequency Report
1. Select Dashboards --> Increased Frequency.
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2. When the system opens the Increased Frequency Wizard, enter the appropriate 
information in the fields and click Generate.

Increased Frequency Criteria Fields and Field Descriptions
The following table lists and describes the fields in the Increased Frequency Criteria 
section.

The following table lists and describes the information that appears in the Increased 
Frequency Report.

Increased Frequency Wizard
The Increased Frequency Wizard enables you to determine which events have 
occurred at increased frequency for a given product and indication based on an FDA 
formula (modified t-test).Select Utilities --> Increased Frequency Wizard to open the 
Increased Frequency Wizard dialog box shown in the following illustration.

Field Description

Product Allows the user to select the product on which this report is to be based.

Indication Allows the user to select an indication for this product.

Reporting Date 
Range From Date

Defines the starting date.

Reporting Date 
Range To Date

Defines the ending date.

Comparison Date 
Range From Date

Defines the starting date for the comparison period.

Comparison Date 
Range To Date

Defines the ending date for the comparison period.

Units Distributed in 
Reporting Interval

Allows the user to adjust the number of units distributed in the 
reporting interval.

Units Distributed in 
Comparison Interval

Allows the user to adjust the number of units distributed in the 
comparison interval.

Units Allows the user to adjust the unit term as appropriate.

Generate button Generates the Increase Frequency Report.

Field Description

Adverse Event Displays the name of the adverse event.

Number of Adverse Events Displays the number of adverse events.
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The following table lists and describes the fields on the Increased Frequency Wizard 
dialog box.

Expedited Report Status
The Expedited Reporting Status page enables you to search for and field information 
about the status of expedited reports. Expedited Reporting Status also appears on the 
Worklist Group menu. Additionally, if you have access to Expedited Report Status, 
you wil also have access to the Report Due Soon dashboard. The following is an 
illustration of the Expedited Report Status screen.

Field/lControl Name Description

Product Enables you to select the product on which this report is to be based.

Indication Enables you to select an indication for the product

Reporting Date 
Range From

Enables you to define the starting date.

Reporting Date 
Range To

Enables you to define the ending date.

Comparison Date 
Range From Date

Enables you to define the starting date for the comparison period.

Comparison Date 
Range To DAte

Enables you to define the ending date for the comparison period.

Units Distributed in 
Reporting Interval

Enables you to adjust the number of units distributed during the 
reporting interval.

Units Distributied in 
Comparison Interval

Enables you to adjust the number of units distributed during the 
comparison interval.

Units Enables you to adjust the unit term as appropriate.

Generate Click Generate to generated the Increase Frequency Report.



Dashboards Options

11-8 Oracle Argus Safety Japanese User's Guide

1. Select Dashboards --> Expedited Report Status to open the Expedited Reporting 
Status screen.

2. When the system opens the Expedited Report Status screen, enter the appropriate 
information in the fields in the Search Case section and click Retrieve.

3. he system creates the report based on the search criteria you entered.

Expedited Report Status Fields and Field Descriptions
The Expedited Report Status screen contains the sections mentioned below:

■ Search Case

■ Grouped Expedited Reporting Status

■ Expedited Reporting Status

Search Case Status  This section enables you to enter the search parameters for the 
report

The following table lists and describes the fields

Field Description

Product Family Allows the user to select which Product Family to be included in the 
dashboard.

Site Allows the user to filter the workflow statuses to the selected site.

Serious Case Displays if the case is serious or not.

If Yes is selected, the seriousness criteria are enabled.

Note: A case that does not have a seriousness specified (i.e. blank) is 
treated as serious.
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Grouped Expedited Reporting Status (Pie chart)  Click on the Color Coded Areas of the pie 
to open all the Reports or Cases within that section instead of just the bar.

Expedited Reporting Status (Bars)  Click on a bar to open the Worklist displaying the cases 
that belong to the reports or the actual reports. These reports belong to the specified 
timeframe.

Workflow Status
You can view the Workflow Status based on case owner, site, case seriousness, and 
other criteria. The following is an illustration of the Workflow Status screen.

To view the Workflow Status
1. Select Dashboards --> Workflow Status to open the Workflow Status Screen.

2. When the system opens the Workflow Status screen, enter the appropriate data in 
the Search Case fields and click Search.

3. The system displays the Workflow Status information.

Related Case Filters on the relatedness of the case. A case is only included if it meets 
the relatedness criterion.

Death/LT Only Select this option to include any case that has any of the Fatal or 
Life-Threatening seriousness criteria.

All Other Serious If this seriousness criterion is checked, the case only gets included if 
any of the following seriousness criteria of any event are checked: 
Hospitalized, Disability, Congenital Anomaly, Medically Significant, 
Intervention Required or Other.

Cases Enables you to search for cases.

Reports Enables you to search for reports.

View All Enables you to view all.

Retrieve Prints the currently selected dashboard, including filter criteria.

Field Description
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General Usage Information
When using the Workflow Status screen, be aware of the following:

■ Workflow Status appears on the Worklist Group menu.

■ You can:

Click on a bar graph and select from a dashboard menu to open the list of cases in 
the Workflow Status Dashboards.

Click on the graphical bars to drill down on the specific workflow state details.

■ If no updates are made to cases during case processing, the cases the system 
displays the number of cases you clicked during the drill down.

■ If one or more cases change workflow state between loading the dashboard screen 
and loading the worklist-specific screen, a discrepancy in case numbers may occur.

■ The system maintains user preferences once you return to the Workflow Status 
Dashboard.

■ By default, the system displays only the first filtering results and makes other 
filters available when you click More Filtering.

■ Worklist Status. This screen provides filtering capabilities by site, workflow state, 
product family, date range, advanced condition, serious or non-serious, study or 
non-study by clicking the More Filtering option. The More Filtering options also 
hide additional filtering elements.

■ Site Filter. The Site Filter is a multiple selection screen that enables you to use the 
CTRL and Shift keys to select multiple sites. The default value is All Product 
Family. When you use the site filter, the system displays all active (undeleted) 
sites in the Argus Code List. However, the system does not display LAM sites.

■ Workflow State Filter. The Workflow State filter is a multiple selection screen. You 
can select use the CRTL and Shift keys to select multiple groups.

– The system displays all active (undeleted) workflow states, except 
archived/closed, in the Argus Utilities - Configuration.

– The default selected value is <All>Product Family.

– The Product Family filter is a type ahead field.

– The default selection on the type ahead is blank (no filtering on Product 
Family). By default, the system displays a maximum of 25 rows.

– The system displays all active (undeleted) product families configured in the 
Argus Code List Product & Family in the Product Family Filter results.

■ Date Range Filter. In this module, the Date Range function works in the same 
manner as it does in other parts of the application.

– The default value for range is last month.

– The system automatically populates the values in the From and To fields with 
the dates based on the This Month option.

– The date fields functions as they do in other parts of the application.

– The system evaluates Aware Date to fall in between the date range specified in 
the Date Range filter.

■ Advanced Condition Filter.The Advanced Condition functions as it does in other 
part of the application.
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■ Serious or Non-Serious Filter. Five (5) sub-filtering options are available.

– All

This is the default option. When you select this option, the report returns all 
cases whether serious or non-serious.

– Serious

When you select this option, the system returns only those cases that are 
serious. The system evaluates seriousness at the event level. If any event is 
serious, the system considers the case serious and returns it in the results.

– Non-Serious

When you select this option, the report returns only non-serious cases. All the 
events must be non-serious before the system returns the case in the search 
results.

– Death/LT Only

When you select this option, the report returns cases that have an event where 
Death or Life Threatening is checked. The system disables this check box when 
you select the non-serious option.

– Serious other than death or life-threateningFilter. 

When you select this option, the report returns only those cases that have an 
event with a seriousness criteria other than Death or Life Threatening.The 
system disables this check box when you select the Non-Serious option.

■ Report Type Filter. The Report Type filter is a multi-selection screen that enables 
you use the CTRL and Shift keys to select multiple items. The default value is All.

■ Project ID Filter. The Project ID filter is a multi-selection screen that enables you 
to use the CTRL and Shift keys to select multiple items. The default value is All. 
All active Project ID values are configured in the Argus Utilities Protocol ID Code 
List.

■ Default Report Configuration Filter. When no other filters are used, the default 
report configuration returns all cases for the current month. The system uses the 
case Aware Date for evaluation purposes.

■ Search Filter. When you click Search, the system displays the Workflow Status 
screen.

■ When you click the Bar Graph, the system displays a menu. You can select Late, 
Over Normal, Normal or All to go to the worklist-specific screen. When you 
double-clicks the bar, the system displays the worklist-specific screen.

■ Print. When you click Print, the system uses the standard Argus Print function to 
print the search results. This is the same as CDA print functionality.

Workflow Status Fields and Field Descriptions
The Workflow Status screen includes the following sections:

■ Search Case

■ Workflow Status

Search Case  The Search Case section enables you to enter appropriate search criteria to 
search for workflow information.
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The following table lists and describes the fields in the Search Case section.

More Filtering Section  The More Filtering section provides additional criteria for 
filtering cases. The following is an illustration of the More Filtering section.

The following table lists and describes the fields in the More Filtering section.

Field Description

Site Allows the user to filter the workflow statuses to the selected site.

Date Range From/To Enables you to filter workflow status based on a specific date range

Range Enables you to filter workflow status based on a pre-define date range 
(e.g., last 30 days, etc.)

Case Owner Enables you to filter the workflow status based on the case owner.

Related Case Filters on the relatedness of the case. A case is only included if it meets 
the relatedness criterion.

Search Click Search to search for the workflow status.

More Filtering Click More Filter to display more filtering options on the More 
Filtering section

Print Prints the currently selected dashboard, including filter criteria.

Field Description

Workflow State Enables you to filter the workflow status based on workflow state (e.g., 
data entry, medical review, etc.)

Report Type Enables you to filter the workflow status based on the report type.

Project ID Enables you to filter the workflow status based on the Project ID.

Serious or 
Non-Serious

Enables you to filter workflow status based on the Serious/Non-serious 
criteria as follows:

■ All -- Search for all workflow statuses

■ Serious -- Search for workflow status for serious cases

■ Non-Serious -- Search for workflow status for non-serious cases

■ Death/LT Only -- Search for workflow status for Death or 
life-threatening cases

■ All Other Serious -- Search for the workflow status for all serious 
cases other than death or life-threatening.

Product Family Search for workflow status based on product family.

Advanced Condition Search for workflow status based on a selected advanced condition
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Workflow Status (Bars)  Bar graph colors indicate the following statuses:

■ Red -- Late Cases

■ Yellow -- Outside of Normal Cases

■ Green -- Normal Cases.

Click on the bar to view a Worklist with cases of the selected state (red, green or 
yellow).

Reports Due Soon
As report scheduling is commonly configured to be executed when significant changes 
are made to a case, it is possible that expedited reports may be delayed if a case never 
gets locked. You cannot know that a report is late if it has never been scheduled. In 
order to address this potential compliance issue Argus Safety assesses case 
reportability prior to formal report scheduling. Workflow and Expedited Status 
monitoring screens identify unlocked cases due soon.

To view a list of unlocked cases with reports due
1. Select Dashboards --> Reports Due Soon from Dashboards.

2. The system opens the Unlocked Cases with Possible Reports Due Soon screen is 
displayed.

The Workflow and Expedited status include another report with cases that have not 
had reports scheduled but that may generate a report with a due date in the near 
future. This graph is displayed below the graph detailing the actual case status.The 
reports included in this sub-dashboard are limited to the filter criteria specified for the 
main dashboard

The following table lists and describes the fields on the Reports Due Soon screen.

AC Enables you to create an Advanced Condition.

Print Prints the currently selected dashboard, including filter criteria.

Field Description
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Click the graphical bar to view a Worklist with cases of the selected state (red or 
yellow).

Personal Argus Status
The Personal Argus Status screen of the Argus Safety application displays a list of 
Cases Assigned, Contact Log Entries and Action Item Entries sections that are specific 
to the logged-in user. The following is an illustration of the Personal Argus Status 
screen.

To view the Personal Argus Status screen
1. Select Dashboards --> Personal Argus Status.

2. The system opens the Personal Argus Status screen

To search for a case
Use the following procedure to search for a specific case.

1. Type the case number in the Case Quick Launch field of the Home page and click 
Open.

2. Click the link displaying a case number to view the case details.

By default, each section and header column is sorted by Case Number in 
ascending order.

Field Description

State Name Displays the workflow state of each listed case is.

Graph Red bars indicate that the report is likely to be due within the next 5 
days.

Yellow bars indicate that the report is likely to be due in the next 10 
days.

Total Displays the number of cases within the displayed workflow state.

R/Y Number of cases in Red/Yellow
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3. Select the check box for any of the headers to enable that section.

The sections in which the check box is not selected are displayed at the bottom of 
the screen.

Cases Assigned Section
The system displays the Workflow status for displayed cases in the Cases Assigned 
section. You can right-click on the case row and select the Accept option. This moves 
the cases to their Worklist Open list.

The following table describes the fields in the Cases Assigned section:

Contact Log Entries Section
The following table describes the fields in the Contact Log Entries section:

Action Items Entries
The following table below describes the fields in the Action Items Entries section:

Case Workload
The Case Workload feature enables an administrator to view the case workload for 
individuals and one or more sites. The Case Workload feature is available for only 
Workflow Managers. For example, if a user belongs to a group which has access to this 
menu option but is not a Workflow Manager, this option will not be displayed.

Field Description

Country (Case 
Number)

Displays the name of the country to which the case belongs, with the 
Case Number listed in brackets.

Report Type Displays the report type of the case.

Product Displays the product name.

Event Displays the event name

Field Description

Country (Case 
Number)

Displays the name of the country to which the case belongs, with the 
Case Number listed in brackets.

Contact Date Displays the contact date

Description Displays the description of the case

Field Description

Country (Case 
Number)

Displays the name of the country to which the case belongs, with the 
Case Number listed in brackets.

Due On Displays the date when the case is due.

Description Displays a description of the case.



Dashboards Options

11-16 Oracle Argus Safety Japanese User's Guide

To view case workload information
1. Select Dashboards --> Case Workload.

2. The system opens the Case Workload screen.

The following table lists and describes the fields in th Case Workload screen.

Field Description

Site Enables you to view the Cases part of the site.

Displays the specific Worklist where the user can view the case 
numbers.

Click + to view the next level and expand either the Workflow State or 
Workflow Group.

Workflow State Enables you to view the Workflow State of the Cases part of the site.

Displays the specific Worklist where the user can view the case 
numbers.

Click + to view the next level and expand to User Name.

Click the Header to toggle between Workflow Group or Workflow 
States.

Workflow Group Displays the Workflow Group of the Cases part of the site.

Displays the specific Worklist where the user can view the case 
numbers.

Click the Header to toggle between Workflow Group or Workflow 
States.

Click + to view the next level and expand to User Name.

Week Forecast Enables the user to view the number of cases projected in the next 5 
days for the current workflow state or group.

If a case is routed to multiple workflow states/groups, it is counted 
multiple times within the Week Forecast.

The Projected Week Forecast is based on the Dynamic Workflow 
calculation for the entire case, as per the configuration settings.



Dashboards Options

Dashboards 11-17

User Name Enables you to view the User Name to whom the cases are assigned.

Displays the specific Worklist where the user can view the case 
numbers.

Click + to view the next level and expand to Priority.

Online Users can view the Online icon and their User Names appear in 
bold.

Priority Enables you to view the Priority of the Cases part of the User.

Click the link to view the specific Worklist where the user can view the 
case numbers.

Due In Enables you to view the Due In of the Cases part of the User.

Displays the specific Worklist where the user can view the case 
numbers.

Due In is based on the Days remaining field, similar to the Worklist | 
New dialog.

# of Cases Enables you to view the Total number of the Cases for the row entity.

Click the link to view the specific Worklist where the user can view the 
case numbers.

Refresh Enables you to only refresh the number and the entities but not the 
entire page.

Enter a value in the text field for Auto-Refresh automatically refresh the 
dialog every N minutes up to a maximum of 99 minutes.

Expand All (+) Enables you to expand all entities across the Summary Tabulation.

Collapse All (|) Enables you to collapse all entities across the Summary Tabulation, 
leaving only the Sites Total.

Print Enables you to print the Load Balancing Dashboard in PDF format.

Export to XLS Enables you to export the Load Balancing Dashboard in Excel format.

Field Description
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12Utilities

This chapter discusses the different utility functions to help you view, change, or 
retrieve case-related information.

Utilities
To access the Utilities menu, place the cursor over the Utilities menu bar to view the 
available options.The following utilities are available to you.

■ Change Password

■ MedDRA Browser

■ MedDRA J Browser

■ User Login List

■ Logs

■ E2B

■ Argus Reconciliation

■ Undelete

■ Batch Reports

■ Blank Report Forms

■ End of Study

■ Clear Cache

Change Password
The Change Password functionality allows users to change the password that they use 
to login to Argus. When you log on to the system for the first time, change the 
password that has been assigned to you.
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To change your password
1. Select Change Password from the Utilities menu.

2. When the system opens the Change Password dialog box:

■ Enter your current password in the Old Password field.

■ Enter your new password in the New Password field.

■ Re-enter your new password in the Confirm Password field to verify it.

■ Click OK to change your password,

3. Your password has been changed.

Be aware of the following:

■ If the system has difficulty confirming the password, it presents the Password 
Confirmation Failure dialog box.

■ You cannot re-enter the password you are currently using when the system 
prompts you to change your password.

■ When you update your password, the system displays the system date and time.

MedDRA Browser
Use the Medical Dictionary for Regulatory Activities (MedDRA) to encode diseases, 
symptoms, signs, and so forth. In Argus Safety, the usage of such a dictionary provides 
consistency to the assignment of terms for adverse events.

Note: LDAP users cannot change their passwords.



Utilities

Utilities 12-3

1. Select Utilities --> MedDRA Browser.

2. The system opens the MedDRA Browser screen.

MedDRA J Browser
For all Japanese cases, use the MedDRA J to code all medical terms. The following is 
an illustration of the MedDRA J browser.

When using the MedDRA browser, be aware of the following:
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■ The system requires both MedDRA and MedDRA J data files to be loaded in the 
database.

■ The application supports both MedDRA and MedDRA J, but only one can be 
active at a time.

■ If you encode a MedDRA J term in Japanese, the system also encodes the 
equivalent MedDRA term. and put it in the English MedDRA data field with the 
corresponding LLT code.

■ When you code MedDRA/MedDRA J terms, the coded terms could be 
non-current in the other language. The system identifies such terms with a special 
symbol as shown in the following illustration.

■ After you perform the first coding, you can change the LLT coding in the same PT 
level only for that language without synchronizing the alternate language 
MedDRA coding.

■ Changing the PT level or above from the MedDRA J browser updates MedDRA 
MedDRA. Changing the PT level or above from MedDRA updates the MedDRA J 
coding.

User Login List
The User Login List displays a list of all the current users and their security levels. It 
also displays a list of all the currently logged in users. The following is an illustration 
of the User Login List.

To view the User Login List
1. Select Utilities --> User Login List.

2. The system opens the User Login List screen.



Utilities

Utilities 12-5

General Usage Information
When using the User Log List, be aware of the following:

■ You can click a column heading to sort the displayed records.

■ By default, the system displays the User Login List in ascending order based on 
Login Time.

The following table lists and describes the fields on the User Login List.

■ You can configure the number of cases to display from the Page Size drop-down 
list in the User Login List dialog box. The Page Size drop-down list contains the 
following values:

■ 50

■ 100 (default)

■ 250

■ 500

■ 1000

■ 2000

■ The system displays the number of cases currently in view and automatically 
updates the range as defined by the Page Size drop-down list. For example, if the 
user selects 100, the system separates the rows to display into groups of 100 cases.

■ You can go directly to a range of cases by selecting a range from the Displaying 
Rows drop-down list.

■ You can scroll through the User Login List search results in page-by-page 
increments.

■ You can select multiple users or click the All users check box in the header.

■ When you select a user and click Reset User, the system resets all selected users in 
the list.

■ The system does not permit you to reset your login.

Logs
Logs are a repository of all the cases in the database, displaying the Activity, Audit 
Data, User ID, and Date/Time entries. Three (3) types of logs are available in Argus:

■ View Audit Log

■ LAM Audit Log

■ View Error Log

Field Description

Full Name Displays the full name of the user.

Login Time Displays the login time.

Workflow Manager Displays whether the user is a workflow manager or not.

OS User Name Displays the Operating System user name.

Terminal Displays the name of the terminal.

Print List Allows you to print the user login list.
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To view a log
1. Select Utilities --> Logs --> <Log Type> to view a log.

2. The system open the selected log type.

View Audit Log
The audit log is a chart that show modifications that have been made to a particular 
case since the case's inception.

It also shows which user made the changes, the date and time the changes were made, 
and the old and new field values. Run the AG Service Audit Log update to audit log 
all the cases.

To view an Audit Log
1. Select Utilities --> Logs --> View Audit Log.

2. The system opens the Audit Log screen.
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Search Conditions Section
The Search Conditions section enables you to enter information about the logs you 
want to view.

The following table lists and describes the fields in the Search Conditions section.

Total Number of Rows Section
The system displays the search results in the Total Number of Rows section.

The following table lists and describes the fields in the Total Number of Rows section.

Field Description

Category Select the category for the search criterion.

Tip: You can also search for Advanced Conditions in this Application 
release.

The system enables you to Select All to view all updates performed by a 
user. You can select a category and filter on a specific field elements, and 
you can view all revisions at the same time by clicking the checkbox near 
the Revisions column.

Case Number Enables you to search for logs for a specific case number

Date Range Select the date range from the given drop-down list. This selection 
automatically populates the From and To fields.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

User Name Select the User Name for the search.

Search button Displays the results of the specified search criteria.

Field Description

Action Displays the Audit Log Details screen

Activity Displays the status of the activity. Displays whether it has changed or 
not.
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Audit Log Details Screen
The Audit Log functionality tracks all central coding activities for the code-able event 
and products.

Audit log for the case has the record of the central coding related changes. These 
changes display the Username as the associated Central Coding Username 
concatenated with Central Coding.

Multiple selections can be made to view the details of revisions.

To view the Audit Log Details screen
1. Click the Action icon to view the Audit Log Details screen.

2. 2. Click a row displaying a revision to display the details in the upper portion of 
the screen.

The following table describes the fields in the Audit Log Details screen.

LAM Audit Log
The LAM Audit Log enables you to track changes made while using the LAM module.

Audit Data Displays the audit data in the following format:

Name of the entity (such as Advanced Condition): deleted or changed 
(as applicable) in entity (such as Advanced Condition)

User Displays the last user who made changes to the case.

Date/Time Displays the last time the case was changed.

Note: The time displayed is as per GMT.

Print List button Prints the list of all the logs.

Field Description

Total Number of 
Rows

Displays the total number of rows in the list.

Parent Displays the parent screen where the change has been made.

Field Displays the field where the change has been made.

Old Value Displays the previous value.

New Value Displays the new, changed value.

Rev Displays the revision number. The list is sorted in descending order of 
the revisions that have been made so the latest revision is displayed at 
the top.

User Name Displays the name of the last user who made a change.

Revisions Date Displays the last date when the change was made.

User Displays the name of the user who last made the revision.

Field Description
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To view the LAM Audit Log
1. Select Utilities --> Logs --> LAM Audit Log.

2. The system opens the LAM Audit Log screen.

General Usage Information
■ When using the Argus Safety Audit Log, be aware of the following:

■ In the Argus Audit Log Options, Category has an <ALL> option that enables 
viewing of all updates made by a user.

■ If you select All, you must select the appropriate User Name from the drop-down 
to enable the Search button. The system updates the default User Name to the 
name of the user who is logged in.

■ The system identifies the category on the UI.

■ The print list displays the Category.

■ The system updates the element field label based on the category selected by the 
user. If you do not enter an element value, the system returns the audit details as is 
does in the current system.

■ You can view All revisions at the same time by selecting the check box near the 
revisions column. This system displays the entire audit trail for the elements.

Using the Argus Affiliate Audit Log  When using the Argus Affiliate Audit Log be aware of 
the following:

■ You can filter for a specific Affiliate event in the audit log.

■ You can view all revisions at the same time by selecting the check box near the 
revisions column. The system displays the entire Audit trail for the elements.

■ You can view all LAM user updates made for Argus Safety cases under the LAM 
Audit Trial. For example, the action Items which can be closed or local labeling 
performed by a Affiliate user is visible under the LAM audit trail.

■ Central User updates do not display under the LAM audit trail.
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■ Any user who has access to LAM Audit Log can view All cases associated with 
that site.

■ The audit trail detail print includes only the revisions the selected by the user.

Search Conditions  The Search Conditions section enables you to enter information for 
retrieving the audit logs you want to view.

The following table lists and describes the fields in the Search Conditions sections.

Total Number of Rows  The system puts the search results in the Total Number of Rows 
section.

The following table lists and describes the fields in this section.

Audit Log Details  The Audit Log functionality tracks all central coding activities for the 
code-able event and products.

Audit log for the case has the record of the central coding related changes. These 
changes display the Username as the associated Central Coding Username 
concatenated with Central Coding.

Multiple selections can be made to view the details of revisions.

To view the Audit Log Details screen
1. Click the Action icon to view the Audit Log Details screen.

2. Click a row displaying a revision to display the details in the upper portion of the 
screen.

The following table describes the fields in the Audit Log Details screen.

Field Description

Local Event Number Enter the appropriate local event number.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

Search button Displays the results of the specified search criteria.

Field Description

Action Displays the Audit Log Details screen.

Activity Displays the status of the activity. Displays whether it has changed or 
has been added.

Audit Data Displays the audit data.

Category Displays the category data.

User Displays the last user who made changes to the case.

Date/Time Displays the last time the case was changed.

Note: The time displayed is as per GMT.

Print List button Prints the list of all the logs.
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Error Log
The Error Log screen provides information about errors that occurred during case 
processing.

To view the error log
1. Select Utilities --> Logs --> View Error Log.

2. The system opens the Error Log screen.

3. In the Search Conditions section, enter or select a date range and click Search.

4. The system displays the search results in the Total Number of Rows section.

5. Locate the error log you want to view and click to view the error message text.

Search Conditions Section
The Search Conditions section enables you to search for error logs based on 
pre-defined or custom date ranges.

Field Description

Total Number of 
Rows

Displays the total number of rows in the list.

Parent Displays the parent screen where the change has been made.

Field Displays the field where the change has been made.

Old Value Displays the previous value.

New Value Displays the new, changed value.

Rev Displays the revision number. The list is sorted in descending order of 
the revisions that have been made so the latest revision is displayed at 
the top.

User Name Displays the name of the last user who made a change.

Revisions Date Displays the last date when the change was made.

User Displays the name of the user who last made the revision.
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The following table lists and describes the fields in the Search Conditions section.

Total Number of Rows Section
Total Number of Rows

The system retrieves the error logs for the specified date range and places the results in 
the Total Number of Rows section.

The following table lists and describes the fields in the Total Number of Rows section.

E2B Screens
The purpose of the E2B Transmit Status and E2B Receive Status screens is to monitor 
the incoming and outgoing messages and acknowledgments. E2B screens are 
categorized as:

■ E2B Transmit

■ E2B Receive Status

To view the E2B screens
1. Select Utilities --> E2B --> <E2B Category>.

2. The system opens the appropriate E2B screen.

E2B Transmit Status Screen
The E2B Transmit Status screen enables you to track outgoing messages. The 
following is an illustration of the E2B Transmit Status screen:

Field Description

Date Range Select the date range from the given drop-down list. This selection 
automatically populates the From and To fields.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

Search button Displays the results of the specified search criteria.

Field Description

Total Number of 
Rows

Displays the total number of rows in the list.

Argus User Name Displays the Argus User Name of the user who got the error.

OS User Name Displays the OS User Name of the user who got the error.

Error Date Displays the date and time of the error.

Application Displays the name of the application where the error occurred.

Terminal Displays the name of the terminal where the error occurred.

Machine Displays the name of the machine where the error occurred.

Error Text Displays the text of the error.

Note: click the Zoom icon to view the complete text.

Print List button Prints the list of all the errors.
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To view E2B transmit status data
1. Select Utilities --> E2B --> E2B Transmit Status.

2. When the system opens the E2B Transmit Status screen:

■ Enter the appropriate search criteria in the Search Reports section.

■ Click Search to display the search results in the Total Number of Rows 
section.

Search Reports  The Search Reports section enables you to enter information for 
retrieving transmission information.

The following table lists and describes the fields in the Search Reports section.

Field Description

Agency/Trading 
Partner

Select the agency/trading partner as the receiver from this list.

Search button Displays all the E2b messages and acknowledgments only for the 
specified receiver.

Note: If 'Any' is selected as the Agency, the search results display all 
messages and acknowledgements for all receivers.

Transmit Date Range Select this radio button to specify the date range for all transmissions.

From Enter the initial date of the specified period

To Enter the end date of the specified period.

Message # Range Select this radio button to specify the date range for all messages.

From Enter the initial date of the specified period.

To Enter the end date of the specified period.

Range Select the desired range from the list.

Type Select the desired type from the list.
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Total Number of Rows  The system displays the search results in the Total Number of 
Rows section as shown in the following illustration.

The following table lists and describes the fields in this section.

Type Icon Options  Click the Type icon to view these options:

■ Any - Displays all the E2B messages and acknowledgments

■ MSG - Double-click on MSG to view messages in the E2B Viewer.

■ ACK - Double-click on ACK to view the acknowledgement.

When you click these options, the system opens the Message Acknowledgement 
screen shown in the following illustration. This screen contains all the safety report 
detail information such as, if the report is loaded or not loaded with error and enables 
you to monitor message acknowledgements.

The following table lists and describes the fields in the Message Acknowledgement 
Status dialog box.

Field Description

Total Number of 
Rows

Displays the total number of rows that displayed in the list, as shown in 
the parenthesis.

Type Allows the user to view the type of entity transmitted.

Click the Details icon to view the attachment as a PDF.

Reports Allows the user to view the number of attachments transmitted.

Trading Partner Allows the user to view the Reporting Destination to which the 
attachment is transmitted.

Control # This field is left blank for attachment transmission only.

Local Msg# Displays the local message number.

Remote Msg# Displays the remote message number.

File Name Allows the user to view the filename transmitted by EDI Gateway.

Transmit to EDI Allows the user to view the date and time when the attachment was 
transmitted to the EDI Gateway.

EDI Tracking ID Allows the user to view the EDI Tracking ID.

EDI Transmit Date Allows the user to view the EDI Transmit Date and Time from the 
gateway.

Transmission Status Allows the user to view the Transmission Status of the attachment file 
transmitted from EDI Gateway such as Failure / Success / Pending.

EDI Receive Receipt Allows the user to view the date and time of the EDI MDN 
Acknowledgement date.

Print button Prints the list.

Field Description

ICSR Message Number Displays the ICSR Message Number.

ICSR Message Receiver ID Displays the ICSR Message Receiver ID.

ICSR Message Sender ID Displays the ICSR Message Sender ID.

Sender Acknowledgement 
Message #

Displays the acknowledgement message number of the 
sender.
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E2B Receive Status
The E2B Receive Status screen enables you to monitor incoming E2B messages. The 
following is an illustration of the E2B Receive Status screen:

Search Reports  The Search Reports section enables you to search for received 
messages.

The following table lists and describes the fields in the Search Reports section.

ICSR Message Date Displays the ICSR Message Date.

Acknowledgement Message 
Initiated On

Displays when the acknowledgement was initiated.

Transmission Acknowledgement 
Code

Displays the Transmission Acknowledgement Code.

Case # Displays the Case #.

Message Displays the message.

Authority # Displays the Authority #.

Local Case # Displays the Local Case #.

Other # Displays the Other #.

Report Status Displays the Report Status.

E2B Report Type Displays the type of the E2B Report.

Field Description

Agency/Trading 
Partner

Select the agency/trading partner as the receiver from this list.

Receive Date Range Select this radio button to specify the date range for all transmissions.

From Enter the initial date of the specified period.

To Enter the end date of the specified period.

Field Description
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Total Number of Rows  The Total Number of Rows section contains the search results.

The following table lists and describes the columns

Type Icon Options  Click the Type icon to view these options:

■ Any - Displays all the E2B messages and acknowledgments

■ MSG - Double-click on MSG to view messages in the E2B Viewer.

■ ACK - Double-click on ACK to view the acknowledgement.

When you click these options, the system opens the Message Acknowledgement 
screen. This screen contains all the safety report detail information such as, if the 
report is loaded or not loaded with error and enables you to monitor message 
acknowledgements.

The following table lists and describes the fields in the Message Acknowledgement 
Status dialog box.

Range Select a predefined date range from the drop-down list.

Message # Range Select this radio button to specify the date range for all messages.

From Enter the initial date of the specified period.

To Enter the end date of the specified period.

Type Select the desired message type from the list.

Search Initiates the search and displays all the E2b messages and 
acknowledgments only for the specified receiver.

Note: If 'Any' is selected as the Agency, the search results display all 
messages and acknowledgements for all receivers.

Field Description

Total Number of 
Rows

Displays the total number of rows that displayed in the list, as shown in 
the parenthesis.

Type Displays the Type icon containing options.

Trading Partner Displays the name of the trading partner.

Control # Displays the control number.

Local Msg# Displays the local message number.

Remote Msg# Displays the remote message number.

Total Reports Displays the total number of reports.

Rejected Reports Displays the number of rejected reports.

File Name Displays the file name.

Receive from EDI Displays the messages received from EDI.

Transmission Status Displays the Transmission Status.

Print Enables you to print the list.

Field Description

ICSR Message Number Displays the ICSR Message Number.

Field Description
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Argus Reconciliation
The Argus Safety Reconciliation module enables you to configure and edit/reconcile 
records as per requirements.

Select Reconciliation from the Utilities menu to view the options available under 
Argus Reconciliation.

Source Database Definition
This Source DB Definition screen enables you to define the mapping of the 
Reconciliation databases to the Common Interface of the CDMS.

To open the Source DB Definition screen
1. Select Utilities --> Reconciliation --> Source DB Definition.

2. The system displays the Source DB Definition screen.

ICSR Message Receiver ID Displays the ICSR Message Receiver ID.

ICSR Message Sender ID Displays the ICSR Message Sender ID.

Sender Acknowledgement 
Message #

Displays the acknowledgement message number of the sender.

ICSR Message Date Displays the ICSR Message Date.

Acknowledgement Message 
Initiated On

Displays when the acknowledgement was initiated.

Transmission 
Acknowledgement Code

Displays the Transmission Acknowledgement Code.

Case # Displays the Case #.

Message Displays the message.

Authority # Displays the Authority #.

Local Case # Displays the Local Case #.

Other # Displays the Other #.

Report Status Displays the Report Status.

E2B Report Type Displays the type of the E2B Report.

Field Description
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The following table lists and describes the tables on the Source DB Definition screen.

Editing Source Database Definition  Use the following procedure to edit the source 
database definition.

To edit the source database definition
1. Click the Active check box, as required.

2. Click Select in Argus Study Num to configure a study that has been set up in 
Argus Safety.

3. Click Select on the Source DB Definition screen.

4. When the system opens the Clinical Trial Selection dialog box:

■ Enter the appropriate study information (i.e., Project, Study, Center) and click 
Search.

Field Purpose

No Displays the serial number of the row

Active Enables you to include the reconciliation source in the next 
reconciliation run

Instance Displays the name of the instance

Schema Displays the name of the database schema

CDMS Protocol Displays the CDMS Protocol

Argus Study Num Enables you to select a study from the Study Lookup dialog

Access Data using 
User

Displays the username used to access the data

Password Displays the password used to access the data

SAE Common 
Interface View Name

Enables you to specify the view name to be accessed that returns the 
expected reconciliation fields

Match-up Enables you to configure a match-up
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■ When the system displays the search results in the Total Number of Rows 
section, locate and click the row containing the study information to be 
configured.

■ Click Select to configure the selected information.

5. Click Select in SAE Common Interface View Name to configure a view name to 
be accessed that will return the expected reconciliation fields.

6. When the system opens the Reconciliation Database Connection dialog, modify 
the database connection details as appropriate and click OK.

Reconciliation Database Connection Fields and Field Descriptions  The following table lists 
and describes the fields in the Reconciliation Database Connection dialog box.

■ 7. Click Select in Match-up to configure a match-up behavior per study.

■ 8. When the system opens the Reconciliation Match-up Configuration dialog box:

– Select an Argus Tab as required, from the Argus Tab drop-down list for the 
corresponding Reconciliation Field.

– Select an Argus field as required, from the Argus Field drop-down list for the 
corresponding Reconciliation Field.

– Click the Only Reconcile if present in CDMS checkbox to reconcile a field, 
only if it is also present in CDMS.

Tip: Enter specific search criteria to refine the search results.

Field Description

Database Enables you to enter the Database Name for fetching the data for the 
view.

View Schema Owner 
Name

Enables you to enter the Schema Owner Name.

View Schema Owner 
Password

Enables you to enter the Schema Owner Name password for connection 
to the database.

Connect to CDMS 
Database

Enables you to check if connection is successful or parameters entered 
are incorrect.

Create New View Enables you to create a new view for the Database and the 
corresponding Schema Owner.

Use Existing View Enables you to select an existing view from the Database and the 
corresponding Schema Owner.

CDMS View 
Definition

Enables you to enter SQL statement for the view definition.

Create Public 
Synonym for View

Enables you to create a Public Synonym for the CDMS View in the 
CDMS Database.

Grant "SELECT" on 
View to User / Role

Enables you to grant "Select" permission to the specified User and Role 
for the CDMS View in the Schema Owner.

Create/Update View Enables you to create or update the View in the Schema Owner.

Drop View and 
Public Synonym

Enables you to drop the View and Public Synonyms in the Schema 
Owner after Creating / Updating / Deletion of the View.

OK Enables you to return back to the Reconciliation Sources Database 
Definition dialog.
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– d. Click OK to save the changes made to the section.

Sample SQL for Creating Views  The following is sample SQL code to use when creating 
views.

create or replace view RECON_STUDY_A as

SELECT ct_recid, saeid1, saeid2, saeid3, saeid4, saeid5, saesuffix1, saesuffix2,

saesuffix3, saesuffix4, saesuffix5, tracknum, firstaetrack, subpage,

study, pid, ptinit, treatnone, treatdrug, treatnondrug, ae, llt_code,

aestartdd, aestartmm, aestartyy, aestopdd, aestopmm, aestopyy, deathdd,

deathmm, deathyy, severity, appraisala, appraisalb, appraisalc,appraisald,appraisale,

outcome, entry_datetime

FROM A.ae_all

WHERE NVL (status, -1) IN (0, 1)

Interactive Reconciliation
This Interactive Reconciliation screen enables you to view and configure an 
interactive reconciliation report.

To open the Interactive Reconciliation screen
1. Select Utilities --> Reconciliation --> Interactive Reconciliation.

2. The system opens the Interactive Reconciliation screen.

Interactive Reconciliation Screen Fields and Field Descriptions
The following table lists and describes the fields on the Interactive Reconciliation 
screen.
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Editing Interactive Reconciliation Reports
The Interactive Reconciliation Report screen enables you to edit and configure 
interactive reconciliation reports.

Be aware of the following:

■ You can search for records by entering a filter criterion below the header row.

■ If multiple filter criteria are specified, only those records that meet all the specified 
criteria are displayed. For example, select the filter criteria for Status as Approved, 
enter Pat ID as 1234 and click Search.

■ Only the record with Patient ID 1234 and Status as Approved, will be displayed in 
the search results.

Applying a Filter  Use the following procedure to apply a filter.

Field Purpose

Show Discrepancies Only Displays only those reconciliation records that contain 
discrepancies.

Unmatched Records Displays only unmatched Argus and CDMS records.

Date Ident/Res Displays the date of resolution.

Status Displays the status of the record.

Study # Enables you to select the study number of the record.

Note: It is mandatory to select a Study # to perform a search.

The default value is the first study in the list.

Inv ID Displays the Investigator (Reporter) ID of the record.

Pat ID Displays the Patient ID of the record.

Init. Displays the event initials.

Death Date Displays the event death date in the record.

SAE ID Displays the SAE ID of the record.

SAE ID Suffix Displays the SAE ID Suffix of the record.

Verbatim Displays the verbatim of the event for the record.

LLT Displays the LLT for the record.

Start Displays the event start date for the record.

Stop Displays the event stop date for the record.

Intensity Displays the event intensity level of the record.

Treatment Displays the event status on treatment of the record.

Outcome Displays the event outcome of the record.

Causality Displays the event causality status for the record.

Search Enables you to search for cases that match the specified filter 
criteria.

Print List Prints the displayed list as a PDF.

Tip: Click Clear Filters to remove all the search criteria entered 
under different headers such as Unmatched Records, Status, Study #, 
etc.
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To apply a filter
Right-click on any column header to display the filtering criteria.

Filter on Reconciliation Status Filtering Options  The following table lists and describes the 
Filter on Reconciliation Status options.

Configuring an Interactive Reconciliation Report  Use the following procedure to configure 
an Interactive Reconciliation Report

To configure an Interactive Reconciliation Report
1. In Unmatched Records, click the Yes check box to filter out any paired records and 

view only unmatched Argus and CDMS records.

2. Select the Status of the record such as Pending or Accepted, as required.

■ Click any cell within Pending records to display the Reconciliation Options 
menu, containing the Accepted and Pending options.

■ Select Accept to accept the discrepancy for the selected field and change the 
status to Accepted.

3. When the system opens the Justification dialog:

■ Enter a justification for changing the status in your own words in the Please 
enter a justification for performing this action text box

OR

Select a justification from the drop-down list containing pre-defined 
justifications.

■ Click Add.

■ Click OK.

4. Enter other filter criteria such as Study #, Pat ID, SAE ID, etc., as required.

5. Click Search.

6. The results matching the specified filter criteria are displayed in Total Number of 
Rows.

Filtering Option Purpose

No Discrepancy Enables you to view only those records that do not have any 
discrepancy between Argus and CDMS records. This displays the 
selected filtering criteria in green.

Accepted Enables you to view only Accepted records.

The color associated with this filtering criteria is orange.

Pending Enables you to view only Pending records.

The color associated with this filtering criteria is red.

(Any) Enables you to view all records, irrespective of their status.

The color associated with this filtering criteria is blue.

Tip:  Alternatively, you can also click the orange/red icon denoting 
the status of a record to view the Justification dialog.
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Manually Matching Unmatched Records  Unmatched records are CDMS records that do not 
match with Argus cases. These records are listed in the CDMS Records Not Matched 
to Argus Case section.

To manually match unmatched records
1. Select the record to be matched from the CDMS Records Not Matched to Argus 

Cases section.

2. Select Attach to the desired Argus record.

3. The system matches the record to Argus.

Reconciliation Scheduling
Reconciliation Scheduling enables you to run a reconciliation now or schedule a time 
for the reconciliation for a later date.

To open the Reconciliation Scheduler dialog box
1. Select Utilities --> Reconciliation --> Reconciliation Scheduling.

2. This displays the Reconciliation Scheduler dialog box.

Reconciliation Scheduler Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Reconciliation Scheduler 
dialog box.

Note: The icon in the Status column of a record denotes that it has 
been matched manually.

Field Purpose

Select Days of the 
Week

Enables you select the days of the week when the scheduler will run.

Select Start Time Enables you to specify the time when the scheduler will run.

Run Now Runs the scheduling as soon as this button is selected.
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Editing Reconciliation Scheduling
Editing the reconciliation scheduling from the Reconciliation Scheduler dialog box 
shown in the following illustration.

To edit reconciliation scheduling
1. Select the days for which the reconciliation is to be scheduled in the Select Days of 

the Week section.

2. Specify the time (hh:mm:ss AM/PM format) for the reconciliation to start in the 
Select Start Date and Time section.

3. Click OK.

4. The system schedules the reconciliation for the specified days and time.

Case Undelete
The Case Undelete option enables you to restore deleted cases.

To restore deleted cases
1. Select Utilities --> Case Undelete.

2. When the system opens the Undeleted Cases screen, enter the appropriate 
information in the Case Search Criteria fields and click Search.



Utilities

Utilities 12-25

Case Search Criteria Fields and Field Descriptions
The Case Search Criteria enables you to enter information to help you retrieve deleted 
cases.

The following table lists and describes the fields in this section.

1. When the system displays the search results in the Total Number of Rows section:

■ Locate the case you want to restore and click the check box associated with its 
case number.

■ Click Case Undelete.

Total Number of Rows Fields and Field Descriptions
The system displays the search results in the Total Number of Rows section on the 
Case Undelete screen.

The following table lists and describes the columns in the Total Number of Rows 
Section

Field Description

Case Number Enables you to enter the number for a specific case.

Date Range Enables you to select a date range from which cases may be selected. 
The selection made from the Date Range drop-down list automatically 
populates the From and To fields.

From Displays the initial date of the search period

To Displays the end date of the search period

Search Click to display the Search results that match the specified search 
criteria
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1. When the system opens the Action Justification dialog box:

■ Enter the justification manually in the Please enter a justification for 
performing this action field

OR

Select a preconfigured justification from the Select a standard justification for 
this field drop-down list.

■ Click OK.

General Usage Information
When using Case Undelete functions, be aware of the following:

■ You can search for a specific case from the Case Undelete dialog shown in the 
following illustration.

■ If you enter the Case Number to search for a specific case, the following apply:

The system disables the date range fields including From and To.

If you enter an invalid case number, the system displays the following message:

The Case Number entered is not valid. Please enter a correct Case Number and search 
again.

■ You can configure the number of cases to display in the Case Undelete dialog box 
from the Page Size drop-down list.

■ The Page Size drop-down list contains the following values:

– 50

– 100 (default)

Field Description

Total Number of 
Rows

Displays the total number of rows in the list

Check Box Enables you to select the case to restore.

Case Number Displays the case number of each deleted case.

Initial Receipt Date Displays the initial receipt date of the case.

Product Displays the product category that the belongs to.

Event Displays the event related to the deleted case.

Workflow State Displays the workflow state of the case.

Serious Displays if the deleted case was serious or not.

Deleted By Displays the name of the user who deleted the case.

Deleted Date Displays when the case was deleted.

Justification Displays the justification for deleting the case.

Note: Click the check box corresponding to the case to view the 
justification for its deletion.

Case Undelete Displays the Justification dialog box.

Enables you to restore the selected case number.

Print List Prints the current worklist for reference.
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– 250

– 500

– 1000

– 2000

■ The system displays the number of cases currently in view and automatically 
updates the range as defined by the Page Size drop-down list. For example, if you 
select 100, the system separates the rows to display into groups of 100 cases.

■ You can go directly to a range of cases by selecting a range from the Displaying 
Rows drop-down list.

■ You can scroll through the Case Undelete search results in page-by-page 
increments as defined in the Page Size drop-down list.

Action Justification Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Action Justification dialog box.

Batch Reports
The Batch Reports dialog displays a list of those batch reports that have been 
scheduled for generation.

To view a list of batch reports
1. Select Batch Reports from Utilities in the menu bar.

2. The system opens Batch Reports dialog box with a list of batch reports along with 
their report titles and next run dates.

Field Description

Please enter a justification for 
performing this action

Enter the text that justifies the need to un-delete a 
case.

Select a standard justification for this 
field

Contains standard, pre-configured descriptions of 
justifications for un-deletion.

Spell Check Checks the entered/selected text for any 
grammatical errors.

OK Saves the justification entered/selected for case 
un-deletion.

Cancel Exits out of this dialog without saving any 
justification.
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To delete a batch report from the list
1. Select the check box corresponding to the batch report to delete.

2. Click Delete.

Blank Report Forms
The Blank Report Forms screen enables you to view and print blank report forms for 
the following reports:

To view and print blank report forms
1. 1. Select Utilities --> Blank Report Forms.

2. 2. When the system opens the Blank Report Forms screen, locate the form you 
want to view or print and click its Name.

■ CIOMS-I

■ US FDA MedWatch 3500A

■ US FDA VAERS

■ EU EMEA Clinical

■ EU EMEA Spontaneous

■ EU Device Vigilance Initial

■ EU Device Vigilance Final

■ German BfArM Form 643

■ German PEI Form 643

■ French CERFA

■ MCA Clinical

■ MCA Spontaneous

■ US FDA MedWatch 
3500A Drug

■ MHLW Spontaneous

■ MHLW Clinical

■ CERFA 65-0044

■ CIOMS-I (Local)

■ CERFA 65-0040

■ Spanish Clinical

■ Spanish Spontaneous

■ Canadian Device Form

■ Canadian ADR

■ Case Form
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3. 3. The system opens the selected form in PDF format.

End of Study
When a study is complete, use the End of Study utility to unblind all the cases 
associated with the study at the same time instead of unblinding them one by one.

To unblind a study
1. Select Utilities --> End of Study.

2. The system opens the End of Study Unblinding dialog box.

End of Study Unblinding Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the End of Study Unblinding 
dialog box.
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1. Select the appropriate study from the End-of-Study Unblinding drop-down list.

2. When the system displays the selected information, locate the appropriate study 
and click Select in the End of Study dialog.

3. When the system opens the Dosage Regimens dialog box, enter the drug dosage 
information as required.

4. Click OK to save the changes, update the cases, and close this dialog.

Clear Cache
A cache contains a record of the items you have seen or downloaded from the Web, 
including images, logs of Web pages, etc. Typically these items are stored in the 
Temporary Internet Files folder.

Storing these files in your cache can make browsing the Web faster because it usually 
takes your computer less time to display a Web page when it can call up some of the 
page's elements or even the entire page from your local Temporary Internet Files 
folder. If you believe that you have a less than current version of a page, you can clear 
the cache in your browser to avoid viewing the same page again. Clearing your cache 
can significantly improve the speed and performance of your browser.

To clear your cache of previously stored information
1. Select Utilities --> Clear Cache.

2. The system clears the cache and displays the following message in the Clear 
Cache dialog box.

Field Description

Display only 
Unbroken cases

Enables the user to view only unbroken cases

End of Study 
Unblinding

Only those studies that are "Eligible for unblinding" (as determined via 
List Maintenance) are displayed in this list. Select a study from this list. 
This populates the list of cases based on the study chosen.

Case ID Displays the ID of each case.

AE Date Displays the Associated Event Date for the case.

Pat ID Displays the Patient ID.

Rand No Displays the Randomization Number of the case.

Drug Received Displays the name of the drug received.

Dosage Displays the Select button to view the Dosage Regimens screen.

Note: For each case that is unblinded by this method, the Blinding 
Status is adjusted to "Broken After Study" if the study type is single or 
double blinded and fills information about the Unblinding Date, 
Study Drug, Follow-up Received Date, Mark case as Significant, and 
Dosage Regimen.
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Advanced Condition Library
The Advanced Condition Library option enables you to access the advanced 
condition library and do the following:

■ Create a new advanced condition

■ Reassign an advanced condition

■ Set advanced condition permission levels

■ Modify an existing advanced condition

■ Delete an advanced condition

■ Print a list of advanced conditions

To open the Advanced Condition Library
1. Select Utilities --> Advanced Condition Library.

2. The system opens the Advanced Condition Library screen.

For further information about Advanced Conditions, see chapter 6 of this document.
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13About dsNavigator

The dsNavigator application interfaces with the centralized MedDRA database for 
MedDRA coding in the Argus Safety system.

dsNavigator
The centralized coding process is conducted between the following:

■ Argus Safety User

■ Argus System

■ Coding Integration Layer

■ dsNavigator Application

■ dsNavigator User

dsNavigator Coding Process
The complete coding process can be divided into several steps.

Case Processing - Event Coding Process Flow
This is the first step of the coding process and is initiated as soon as the need for 
coding an event is determined.
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The following event related fields in the case form are eligible for the central coding 
process:

■ Parent Tab - Other Relevant History | Description (Multiple)

■ Products Tab - Primary Indications (Multiple)

■ Analysis Tab - Company Diagnosis / Syndrome
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■ Event Tab

– Description to Reported

– Description to be Coded

– Cause of Death (Multiple)

– Autopsy Results (Multiple)

■ Patient Tab

■ Other Relevant History - Description (Multiple)

■ Lab Test Data (Multiple)

List Maintenance Coding Process Flow
The illustration shows the business process supported by the dsNavigator.
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Central Coding Process Management
This process is defined for Argus Safety only. It includes the following:

■ Managing Verbatim Modification

■ Coding Status Reporting
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■ Audit Trail

Manage Verbatim Modification  Verbatim as reported in the Argus might change because 
of the request by the DsNavigator User, Quality Control review, follow up reports or 
for any other significant business reason. Once the verbatim is modified, the 
application does the following:

1. Initiates the same process as if a new event or product has been entered

2. Changes the status of the event / product in Argus to "Pending Coding."

The status of the coding has no impact on the process if the previous coding status is 
in pending and verbatim has been changed

Coding Status Reporting  Argus institutes additional reports to determine the status of 
the coding with regard to the items sent to the central coding interface, turnaround 
time and aging of the pending items.

Audit Trail  Argus provides for the logging of the central coding transactions to maintain 
history of data transfers and to audit changes made to coding records outside of the 
safety database system.

Configuring through dsNavigator
The following features are available after configuring them through dsNavigator. Click 
the links to access configuration information

■ Central Coding Options

■ Coding Review and Coding Status Role

Configuring Central Coding Options
The Administrator can configure central coding options through dsNavigator. The 
configuration is a one-time process and enables the following:

■ Central Coding in the Case Form

■ Clicking Encode to send event terms to the central coding interface

Configuring central coding also enables users to make dictionary selections.

Configuring Sections of the Case Form  The Administrator can configure the following 
sections of the Case Form for Central coding.

Products Tab - Primary Indication
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Events Tab - Description to be Coded

Events Tab - Death Details Section

Patient and Parent Tab - Other Relevant History
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Analysis Tab - Company Diagnosis

Configuring Encode
The Administrator can configure Encode to enable users to manually send event terms 
to the central coding interface when they click the button.

Configuring Coding Review and Coding Status Role
The Modify Group screen enables you to configure User Groups to enable access to 
the coding review screen and coding status screens.

Select the Enabled or Disabled radio button to allow or deny access to users.
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